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The Grafis system

The Textbook and the training courses

The Grafis CAD clothing construction includes first
pattern development, grading and an industry stand‐
ard marker making system. Patterns can be graded
by application of the construction system or using
grade rules.

This textbook is designed to allow for an autodidactic
introduction to Grafis and/or can be used as teaching
support material during Grafis training courses.

During the styling process Grafis internally creates a
record of the modification steps. The record can then
be re‐called to create other sizes automatically thus,
eliminating incremental grading.
Grafis also records how patterns are derived from
one another, capturing the interdependence of the
pieces. Alterations made to one piece are automati‐
cally applied to all interdependent pieces.
Construction parameters can be applied during pat‐
tern development. This enables the user to comfort‐
ably modify already finished patterns by simply
changing the construction parameters.
Prerequisites
The following are requirements for learning to use
Grafis:
 basic knowledge in the use of computers, in par‐
ticular the use of keyboard and mouse as well as
working with files and folders and
 good knowledge of garment pattern cutting.
The application of Grafis can also be learned without
knowledge of garment pattern cutting for example
for use in the upholstery industry. Grafis replaces the
user's pencil, ruler and set‐square but not the pat‐
tern cutters' knowledge.

Training courses Grafis I and Grafis II are offered in
Viersen/ Germany. Chapters 1 to 10 of the Grafis
Textbook form the content of training course Grafis
I. Chapters 11 to 17 of the Textbook are covered in
Grafis II. Special emphasis is given to digitising of a
style or nest and its further application when dealing
with Chapter 16 “Grade Rule Grading“.
All chapters of the textbook are available for down‐
load from the internet in English and German.
Outlook
Grafis can only be used at its optimum if the user is
comprehensively trained. To further training, the
Grafis Team continue to make available a free train‐
ing version. Videos to accompany the Textbook are
available on our website. Current information and
downloads are published under www.grafis.de.
Viersen, April 2017
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1.1. Important rules for work with Grafis
Grafis measurements
Grafis works with the following measurements:
length
distance
mm (millimetres)
radius
body measures
mm (millimetres)
angle
degrees (right angle =90°)
direction
area
mm2 (square millimetres)
per cent
relative length

0‐100%

Please note that all length and distance values are
displayed and entered in millimetres.
Mouse keys in Grafis
and
In all texts of this book the symbols
used for the left and right mouse button.

The right mouse button is the ‘retreat key’ and is
used for abort / end of a function or return to the
next higher level menu. The position of the cursor is
of no consequence.
The mouse wheel is used for scrolling the screen and
zoom.
Function key assignment
The function keys F1 to F12 are assigned special func‐
tions in Grafis. Here, an overview of the functions
with reference to the chapter where they are ex‐
plained in more detail:
F1
F2
F3

are

The left mouse button is the ‘do‐key’ in Grafis and is
used for selection, click and activating (Picture 1‐1).
Left mouse key
Selection, Click, Activate
Right mouse key
Abort, Return, End

F4
F5
F6
F7
F8

F9
F11
F12

Mouse wheel
Scrolling the screen, zoom

Function
call context related help
zoom screen content in / out
move / rotate / flip parts and
roll two parts
refresh screen
part positioning
centre screen content
Show / hide measurements
Toggle between pieces in their
original position and their posi‐
tion after dragging with <F3>
Show/ hide pixel image
calculator function for calcula‐
tion of z values
Display of called interactive
constructions in the style

chapter
3.2
1.4
3.5
3.6
1.4
3.1
1.4
7.2
3.5

Further important rules
Picture 1‐1

The decimal symbol is the point (.).
e.g.:
10.4
45.2° 67.9% 12.7cm2

15.9
12.2
2.4
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Text and value entries are to be completed with
<ENTER>.
To abort a text or value entry press <ESC>.
The data base is explained in detail in chapter 4.1. It
is organised in Grafis as follows:
drives
according to hard and software
A:,...,Z:
folders and subfolders in
collection
folders
\Grafis\Basis_d\Kollekt
styles
saved as *.mdl files in the collec‐
tion folders or sub‐folders
parts
max. 500 parts per style
objects
points, lines, texts, hatching, con‐
struction record, construction pa‐
rameter etc.

As soon as you have selected a measurement sys‐
tem, more information about it is displayed in the
right part of the screen. The selected measurement

Picture 1‐2

1.2. Starting Grafis
Step‐by‐step guide to starting Grafis
 Click the relevant icon on the desktop or double‐

click onto grafis.exe in the folder \Grafis
 Open the File pull‐down menu (Picture 1‐2) and

click on New... or Open...
 Select the required measurement system
 For the option Open…: Select drive and collection

folder
 For the option Open...: Double‐click onto an ex‐
isting style or enter a new style name in the File
name field and press <Enter>.
The Select measurement system dialogue
The examples and exercises relate to the system Op‐
timass (Basis_A). The information also applies to all
other measurement systems.

system is started by pressing <ENTER> or double click
with on the respective line or clicking Select meas‐
urement system.
In the case of Open..., after having started a meas‐
urement system, the Open style dialogue appears
(Picture 1‐3).
The Open style dialogue
In the Open style dialogue first select the drive and
then the required collection folder. Styles can be
generated only in collection folders and their sub‐
folders. The File name field remains blocked until a
collection folder has been selected by double‐click‐
ing. Then, a new file / style name can be entered (Pic‐
ture 1‐3).

Open a new subfolder
Style in the folder Alpha

Display options:
- detail or list view
- preview part list or style

Subfolder in the collection
folder Alpha on drive G:
Entry of a new style name

Picture 1‐3

Chapter 1 Calling basic blocks
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Collection folder:
Style name:
Measurement system:

Alpha
Jacket
55‐Werte‐OPTIMASS

Control of
construction record

Work area
for the construction
Part rack
Function strip of the basic menu
With the left mouse button you select the function.
With the right mouse button you return to this menu.
Current part:
number, name

Current size:
___N38_0

Picture 1‐4

Create a new collection folder

The Grafis basic menu

Select the drive where the collection folder should
be created. If applicable, go up one level to the par‐
ent folder with
and then open the new folder
with
. The collection folder can be structured with
up to 7 subfolders.

The Grafis basic menu appears on screen (Picture 1‐
4). Compare it with your screen.

Delete styles and folders
The Open Style dialogue also permits deleting folders
and styles. Select the folder or the style and click to
delete
. The style or the folder including all styles
is deleted after a security check.
Note: If Grafis cannot delete the folder, there are fur‐
ther files situated within this folder.
Make regular backups of your styles and measure‐
ment charts from the beginning. This is the only way
your data can be restored after a hard disk failure,
for example.
Naming a new style
The name for a style or a folder may consist of the
numbers 0...9, the letters A...Z and the special char‐
acters ‘‐’ [hyphen] and ‘_’ [underscore].
The style name A03HGTRD would be correct. How‐
ever, you should apply content relevant and system‐
atic names as it is difficult to keep track of your
styles, otherwise
Start Grafis and select File → Open…. Open the new
style ‘Start’ in the folder Alpha. Double‐click on the
folder Alpha and enter the style name ‘Start’. After
having clicked on Open or pressing <ENTER> the style
is generated and can be edited.

1.3. Calling basic blocks
When opening a new style, the first part is openend
automatically in the part organisation and visible in
the part rack.
Basic menu (extract)
reset ▪ restore record
N amount of reset
record counter
test run ▪ grading
part organisation
call basic blocks ▪ insert

More detailed information about part organisation
and the part rack can be found in Chapter 3 and in
Chapter 14.

12
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Step‐by‐step guide
 In the basic menu: click call
 Select the required basic block. Information will

be displayed in text and images
 Double‐click the required construction to start it

The function call
All basic blocks available in the selected measure‐
ment system can be started with the function
call
.

F2
F3
F4
F6

Function
Zoom in/ Zoom out screen contents
Drag/ turn parts towards one another and
roll two parts (sections 3.5 and 3.6)
Refresh screen
Centre screen contents

The construction is not influenced by the changes to
the screen display.
Move / Zoom with the mouse wheel
The screen display can be altered at
any point with the mouse wheel. The
following applies:
move up/down
move right/left
zoom

wheel only
<Shift>+ wheel
<Ctrl>+ wheel

Drag / Zoom

List of available
constructions

Information about
the construction

Under General you can find constructions that can be
called in a number of measurement systems. The
section Optimass (Basis_A) contains constructions
that can only be called in the current measurement
system.
Calling a basic block
A selected basic block (Picture 1‐5) is called by dou‐
ble‐click.
Start Grafis Bodice 50. Your first basic block is dis‐
played on screen. Before calling a different basic
block click on reset in the basic menu. The previously
called basic block is thus reset.

1.4. Alter the screen display
Overview
The patterns can be displayed on screen in scales
from approx. 100:1 to 1:100. The setting is infinitely
variable or can be controlled with certain values. The
function keys F2, F3, F4, F6, the arrow keys and the
mouse wheel are used for adjusting the screen dis‐
play. They have the following significance:

Patterns can be enlarged/ reduced in
stages or moved on the screen with the
Drag/Zoom function
in the Edit
pull‐down menu or from the toolbox.
After having clicked Drag/Zoom a mag‐
nifying glass with the following func‐
tions appears:
enlarge click left mouse button
reduce click right mouse button
move
keep left mouse button
pressed
Picture 1‐5
Enlarging and reducing ensues with the
magnifying glass as the centre. Click the relevant
points or lines with . Reduce with and move the
mouse with pressed left mouse button.
Centre picture with <F6>
Pressing the <F6>‐key automatically adjusts the scale
and position of the whole construction to display all
objects on the screen. The construction is centred on
screen.
Zoom in with <F2>
Press <F2> to zoom into the screen contents. First
click in the lower left corner of the area to be en‐
larged. Move the mouse to open a rectangle. Extend
the rectangle to the top right (Picture 1‐6) and click
again .
The rectangle content becomes the screen contents.
Press the <F6>‐key and your complete construction
re‐appears on screen.

Chapter 1 Calling basic blocks
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Practise zooming in on various areas of your con‐
struction. Press <F6> after each zoom operation.
2nd click point

1.5. Quit Grafis
To quit Grafis select between the following in the
pull‐down menu File:
Save
Save the current state of the style under
the current name.
Save as…
Save the current state of the style under a new
name and/or a new drive (disk/ net drive)
and/or a new folder.
Close
If the style has not been saved a security
question appears.

1st click point

Picture 1‐6

Move with arrow keys
Use the arrow keys to move the picture. The moving
speed is increased by keeping the keys pressed
down.
Reduce the construction and move the screen con‐
tents with the arrow keys.
Refresh screen with <F4>
The <F4>‐key rebuilds the whole screen content.
Identical objects lying on top of each other twice,
four or six times cannot be seen on screen as they
delete each other’s image. Objects lying once, three
or five times on top of each other can be seen. After
pressing <F4> objects deleting each other’s image
are always displayed.
Please use this key from time to time as a means of
control.

1.6. Exercises
1st Exercise
Start the measurement system Optimass (Basis_A),
call the basic block Bodice 10 and save the style as
‘Bodice’ in the collection folder Alpha.
Quit working on the style ‘Bodice’ via File → Close.
Open a new style with File → New… , call the basic
block Trouser 10 and save the style as ‘Trousers’ in
the Alpha collection folder. Quit Grafis via File → Exit
Grafis.
Start Grafis and open the style ‘Bodice’. Close the
style via File → Close.
Delete the styles no longer required in the Open style
dialogue. Select the styles and click on
.
2nd Exercise
Start Grafis and open a new style via File → New…
Click on the call function in the basic menu, select
different constructions and study the explanation for
the constructions on the corresponding file cards.
3rd Exercise
In the measurement system Optimass (Basis_A) cre‐
ate the new style ‘Start’ and call different basic
blocks (skirt, trouser, bodice) from the General sec‐
tion. After each call reset the record by clicking reset.

Chapter 2
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In Grafis, first patterns are originally developed in the
base size. All construction and modification steps are
registered by imperceptibly creating a record.

This construction record can be recalled with other
sizes, thus creating the patterns in the respective size
automatically.
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2.1

Measurement charts

Grading with measurement charts
Grafis works according to the same principle de‐
scribed in textbooks for pattern construction, using
the computer. First patterns are created in three
stages.
First stage: Generating measurement charts con‐
taining body measurements from official or com‐
pany‐specific measurement tables or measurements
of specific individuals.
Second stage: On the basis of measurement charts,
prepared basic constructions such as e.g. bodice,
skirt, trousers, and sleeves are calculated. The basic
constructions can be adjusted interactively accord‐
ing to fit, design and technological aspects.
Third stage: The basic constructions from stage two
are the starting point for styling of the development
patterns from which the production patterns will be
derived.
Thus, the construction principle does not require
grading increments. The basis for generating the first
pattern in the different sizes are measurement
charts. Each size is represented by a specific meas‐
urement chart.
Measurement charts in Grafis
Measurement charts are accessible at all times and
can be generated for prepared standard sizes, own
size runs as well as for specific individuals.

Filter for type of
measurement
List of existing meas‐
urement charts

Filter for names

Each measurement chart is valid for a particular
measurement system (e.g. measurement system for
men, women or children). It is also possible to imple‐
ment own measurement systems into Grafis.
Selection of the measurement system ensues when
starting Grafis, already (see section 1.2).
Grafis distinguishes between standard measure‐
ment charts and individual measurement charts.
Standard measurement charts contain the measure‐
ments of prepared ’off‐the‐peg’ sizes. The values and
names of these charts cannot be altered. Individual
measurement charts contain measured body meas‐
urements or body measurements of company‐spe‐
cific grade runs. Individual measurement charts can
be altered at all times.
The designation of standard measurement charts al‐
ways begins with ‘_’. The measurement chart
___N36_0 is the standard measurement chart for
size 36 in the active measurement system. Please
note the different indicators for figure types, such as
prefix ‘S’ for short or prefix ‘L’ for long figure types in
some women’s measurement systems.
Each measurement chart is a single file, stored in
the indicated folder on your computer. Measure‐
ment charts are not saved within the style. In par‐
ticular, your individual measurement charts must
be part of your regular data backup.
Measurement charts are edited in the Edit measure‐
ment chart dialogue (Picture 2‐1), which is accessed
via the pull‐down menu Extras →
Edit measurement charts. In the
centre of the window, you can see
the existing measurement charts.
On the left hand side of the list you
can decide which measurement
charts are to be displayed. A filter
for names of measurement charts
can be found below the list. A
number of measurement charts
can be selected within the list. A
context menu with functions for
copying, cutting and deleting
amongst other options can be
opened with the right mouse but‐
ton .
You can display measurement
charts via the Open button. The
type of display is different for one
single measurement chart and a
number of measurement charts.
Picture 2‐1

Chapter 2 Grading
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Generate standard measurement charts
Step‐by‐step guide
Extras → Edit measurement charts
Button New
Activate the option standard measurement chart
Select the figure type required
Enter the required size range and the size differ‐
ence, Picture 2‐2.
 Button OK






Generating ‘half‐sizes’, such as ‘_N41_0’ or ‘_N39_0’
is also possible. Simply adjust the settings for the size
range and the size difference.
Generate an individual measurement chart
Step‐by‐step guide
 Extras → Edit Measurement Charts
 Button New
 Activate the single individual measurement chart

option
 Enter the name for the measurement chart
 Button OK
 Edit the individual measurement chart by enter‐

Picture 2‐2

Grafis automatically generates the standard meas‐
urement charts as they are required during grading.

Body measurement
filter

ing the measurements taken on the person into
the table.
Generate an individual measurement chart accord‐
ing to the step‐by‐step guide. Enter the desired
name for the measurement chart into the Name
field, e.g. the name of the person or a customer num‐
ber. The name can be a maximum of 8 characters
long and must not begin with ‘_’. Having clicked on
OK, the preliminary individual measurement chart is
created. The window for editing the individual meas‐
urement chart opens (Picture 2‐3 background). Now,
the individual values must be entered.

Edit/ Create body
measurement filter

Filter name

Body measurements
to be displayed

Constructions for which the
body measurements are to be
displayed at all times

Picture 2‐3

18
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Editing individual measurement charts
Having created a new individual measurement chart
or opened a single individual measurement chart,
the dialogue according to Picture 2‐3 (background)
appears.
Initially, all body measurements available in the cur‐
rent measurement system are displayed. Some
measurement systems, such as Optimass contain a
large number of measurements. The particular body
measurement basic blocks apply only certain meas‐
urements. The measurements used by the respective
basic block are listed in the help to the basic block.
The basic block Skirt 10 for example uses the body
measurements hip, waist and waist to hip. The block
Skirt 30 is a finished measurement construction. It
does not require body measurements but is adjusted
interactively via break sizes.
Each user can set up his/her own body measurement
filter (Picture 2‐4) for ease of use. When setting up
the filter (Picture 2‐4 foreground) the measurements
to be displayed are selected on the left. In addition,
the Grafis basic blocks with which the user works can
be selected on the right.
Create a body measurement filter ‘all basic blocks‘
and activate all Grafis blocks. Thus, only the meas‐
urements required for this textbook will appear.
In the column Individual enter a few concrete meas‐
urements of a person. The column Standard remains
unassigned. Before the measurement chart can be
saved, the nearest fitting standard measurement
chart must be selected.

Initially, the standard measurement chart is used for
pre‐assigning the measurements. Furthermore, it is
of great significance when working with x values
later on and for the use of interactive constructions.
First, deactivate the switch Auto BestFit and select a
suitable size from the combo box on the left. The col‐
umn Difference shows the difference between the
measured and the pre‐set values. Select a different
size and then, decide on a suitable size.
For automatic search of a fitting standard measure‐
ment chart, use the BestFit functions (Picture 2‐4).
Open the BestFit settings and on the left, select the
figure types in which a standard measurement chart
is to be searched. First, select only the figure type for
normal sizes. Only when you actually work with
styles for different figure types or for example with
men’s sizes in Optimass, select one or more different
figure types, here. On the right hand side of the win‐
dow you can activate the main measurements for
BestFit. On the basis of these measurements, Grafis
attempts to suggest a matching standard measure‐
ment chart.
The switch Auto BestFit can be active during entry of
body measurements. After each value entry, a suita‐
ble size is searched automatically. If the switch is not
active, start the search with the button Search Best‐
Fit.
If you want to search for a suitable size yourself, de‐
activate Auto BestFit and set up the standard meas‐
urement chart manually, as described.

BestFit function

Picture 2‐4

Chapter 2 Grading
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You can enter or edit measure‐
ments in an individual measure‐
ment chart at any time. Double‐
click on the measurement chart in
the list of available measurement
charts (Picture 2‐1) displays it ac‐
cording to Picture 2‐3.
NB: all length measurements
must be entered in mm! The val‐
ues displayed in bold apply.
Alteration to the basic block/ pat‐
tern will become effective after
recalculating the construction.
This ensues by clicking on test run
or grading.
Generating an individual grade
run
Step by steg guide
 Extras → Edit measurement charts continue with

Create
 Activate grade run from individual measurement

charts and select the required figure type
 Set up size range and size distance
 Enter designation, e.g. ‘A‘. The designation can

be placed before or after the number. Alterna‐
tively, with free a free designation can be given,
for example for the size designations XS, S, M, L,
XL.
 Continue with OK. The individual measurement
charts of your grade run are offered for editing
according to Picture 2‐6.
Edit variations

Picture 2‐5

There are three edit variations (Picture 2‐6):
 Edit measurements and display differences
 Edit measurements of the base size and edit
differences
 Edit measurements
Use the first variation edit measurements and dis‐
play differences (Picture 2‐6), to enter body meas‐
urements one after the other. The differences to the
neighbouring sizes are calculated automatically after
each entry.
Use the second variation edit measurements of the
base size and edit differences (Picture 2‐7) if you
want to change a body measurement by a fixed
amount across all sizes or if you want to enter the
Filter for body measure‐
ments

Value

Differences to
the neighbouring size

Picture 2‐6
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base size and the dif‐
ferences. The changes
are applied to the sizes
linked together. The
link is symbolised by
the respective symbol
or
in the
third row and can be al‐
tered by clicking.
The third variation edit
measurements is the
shortest view in which
all body measurements
are entered one after
the other.

Base size
Edit variation

The TAB ‐ key jumps to
the entry for the next
size. The Enter ‐ key
jumps to the entry of
the next body meas‐
urement. Altered val‐
ues are marked in red. The red marking is reset after
saving. Alterations can be undone and reinstated.
Set up an individual grade run according to Picture 2‐
7. Both grade runs contain 5 sizes each based on the
figure type _N women regular. The two grade runs
differ in their distances between body measure‐
ments and their values of the respective base size 40.
To generate the table in Picture 2‐7, both size runs
have to be set up separately according to Picture 2‐5
with a size range between 36 to 44 respectively. In
the dialogue Edit measurement charts (Picture 2‐1)
select all ten measurement charts A36 to A44 and
B36 to B44 and click on Open. The measurement
charts are organised according to their standard
measurement charts. Select the second editing vari‐
ation and activate the body measurement filter all
basic blocks. Now, organise the sizes in the order
shown by dragging in the first line. Then, unlink the
two grade runs so that alterations apply to one grade
run only.
Exercises
1st Exercise
Generate an individual measurement chart for Mrs
BERGER in the OPTIMASS measurement system us‐
ing BestFit. Edit the following measurements taken
of Mrs BERGER:
 bust:
925mm
 hip:
960mm
 waist:
710mm.

Unlinksize ranges ’A’ and ’B’
for value alteration

Dragging the first line al‐
lows for reorganisation of
the measurement charts.
Ensure you have a suitable

organisation!

Picture 2‐7

Generate individual measurement charts for Mrs
MEIER and Mrs SCHULZE and alter various values
such as bust, hip, shoulder.
Delete the measurement charts of Mrs MEIER and
Mrs SCHULZE.
2nd Exercise
Generate an individual grade run in the OPTIMASS
measurement system (Basis_A) for the figure type
_S Women short, regular hip, size range 34 to 44,
size distance 2 and the prefix ‘Test’. Mark the size
Test38 as base size in the overview. Use the second
variation edit measurement of base size and edit dif‐
ferences to edit the measurements. Alter the differ‐
ences for the bust to 35mm between sizes 34 and 40
and the hip to 45mm. Then, save the individual grade
run.
3rd Exercise
Generate an individual measurement chart for Mr.
Muller in the OPTIMASS measurement system (Ba‐
sis_A) using BestFit. Create a measurement filter
which shows only trouser measurements. In the
BestFit settings define search for mens figure types
only. Edit the following measurements taken of Mr.
Muller:
 hip:
900mm
 waist:
670mm
 thigh:
555mm

Chapter 2 Grading
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2.2

Size Table

Calling the size table
Calling this menu ensues via Extras → Size Table.
Open the size table and read the explanations in Pic‐
ture 2‐8.
The contents of the size table
With each style a size table is saved. The first position
of the size table shows the measurement chart used
for pattern development, the base size. In the Opti‐
mass measurement system (Basis_A), size N38 is en‐
tered automatically. The user can enter a different
measurement chart as base size at any point, even
an individual measurement chart. All other measure‐
ment charts required for the style are entered into
the other positions of the size table.
Pattern development ensues on the base size. Grad‐
ing means automatic application of the registered
construction record to the activated measurement
charts contained in the size table. Automatic re‐con‐
struction is possible because Grafis has registered all
construction steps and repeats those with other
measurement charts.
Entry and alteration in the size table
To insert a measurement chart, click on the desired
position in the column of measurement charts. A
window appears to the right of the size table show‐
ing all available standard measurement charts and all
available individual measurement charts.
‘‘ active
‘‘ inactive
for automatic construction

If you want to insert standard measurement charts
into the size table, activate the option standard
measurement charts and select the desired figure
type. The option individual measurement charts lists
all available individual measurement charts. In case
the required individual measurement chart does not
appear in the list, it has to be created, see section
2.1.
Then, click on the measurement chart to be entered
into the size table. The current line for entry auto‐
matically moves one position downwards so that en‐
try can continue without interruption. A number of
measurement charts can be selected and transferred
at the same time. Using the right mouse button
terminates entry.
To remove measurement charts from the size table
select the measurement chart or a number of meas‐
urement chart with <Shift> or <Ctrl>. Clicking on the
Delete button or using the <Del> key removes the
measurement chart(s) from the size table but not
from the list of available measurement charts. The
measurement chart can be re‐entered in the size ta‐
ble to be available for grading.
As not all measurement charts in the size table are to
be graded each time, a selection option is integrated
in Grafis. The measurement charts to be graded are
marked with ‘‘(activated) in the size table. By click‐
ing you can toggle between activated ‘‘ and deac‐
tivated ‘‘.
Consecutive number
Automatic construction ensues
in this order.

Selection options for the list of
available measurement charts
For standard measurement
charts, the figure type must also
be selected.

X value reference
(Chapter 11)
Description / Name of
measuerement chart

List of available standard meas‐
urement charts or individual
measurement charts
The list appears after having
clicked on a measurement chart
position in the size table.

Picture 2‐8
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A simple operation is offered by dragging the mouse
with pressed left mouse button. Thus, entries in the
size table can be copied quickly to the next position.
This applies to the symbol ‘‘ and empty measure‐
ment chart positions.
Edit measurement charts displays all measurement
charts of all sizes contained in the size table in the
form of a table.
Exercise
In this exercise, a size table similar to Picture 2‐8 is to
be generated.
After having opened a new style the size table con‐
tains size N38 as base size. Enter size N36 onto the
second position. Click the second position in the
measurement chart column. The window with all
available measurement charts opens to the right. Se‐
lect the measurement chart type Standard measure‐
ment charts and the figure type _N women regular.
Click on the sizes ‘__N36_0’ and ‘__N38_0’. The
measurement charts appear on the 2nd and 3rd po‐
sition of the size table. Click to terminate the pro‐
cess.
Toggle between active and not active for these
measurement charts by clicking on the position num‐
ber ‘ 02’ a few times.
Now select the 4th position and select the sizes
‘__N42_0’ to ‘__N46_0’ from the list of measure‐
ment charts on the right with the left mouse button
pressed down. Select the figure type _S women
short, normal hip for short sizes and transfer the
sizes ‘__S36’ to ‘__S46’ to the following positions. Se‐
lect all short sizes and remove them from the size ta‐
ble.
Now arrange the other measurement charts dis‐
played in the size table as you have just learned.
Have all measurements of the sizes in the size table
displayed with Edit measurement chart.

2.3

Grading with measurement charts

Grading in Grafis
In Grafis grading is an automatic similar construc‐
tion. All construction steps of the base size are re‐
peated with the measurement charts to be graded.
During construction the succeeding similar construc‐
tion is to be considered, already. Construction with
Grafis thus does not become more difficult but more
elegant and more interesting.

Start grading
Grading is started with: Basic
menu → grading.
Only sizes entered into the size
table and activated will be
graded.
Create a size table according to Picture 2‐8 and call
the Bodice 10. Start grading. The bodice construction
appears on your screen in the sizes N36 to N46.
The base size always appears in blue on a white
screen or in yellow on the black screen!
Enter the short sizes ‘__S36’ to ‘__S46’ into the size
table and deactivate the sizes already graded. Start
grading and your screen displays all previously
graded sizes plus the short sizes. Alteration in the
size table lead to grading of further sizes but not to
deleting already graded sizes. To refresh the screen
test run or a different record function from the basic
menu must be started. Then you can grade anew.
Exercise
Activate all measurement charts in the size table and
grade.
Activate the base size and the short sizes, only in the
size table and grade. Start test run from the basic
menu and then grading again. On the screen you can
see the basic block in the base size and the short
sizes.
Start other basic blocks and grade them. Reject the
graded basic blocks by clicking reset in the basic
menu. Change the size table also.
Note
It is to be recommended to use grading from time to
time during construction as a test. A number of ex‐
treme measurement charts should be activated in
the size table, e.g. N36, N46 and N54.
This allows you to check the construction steps as
you go and avoids having to reset at a later date.

Chapter 2 Grading
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2.4

Adjust interactive construction

Step‐by‐step guide
 Call construction (see section 1.3)
 Activate construction with double‐click or from

the overview with <F12> or by right click to the
contour and selection in the context menu
 Set options for the construction
 Activate drag areas and adjust the construction;
use raster and also compare
Menu for interactive constructions

Picture 2‐9

load shape ▪ save shape

The window on the right contains a preview of the
selected construction. A construction is activated
with double‐click or selection and Start.

break sizes

Set options

raster

+/‐magnet ▪ +‐ruler

After having activated a construction the menu for
interactive constructions appears.
There are a greater or smaller number of options
available for each construction. The list of options
(Picture 2‐10) opens by switching to +options in the
right menu.

+/‐ comments ▪ +/‐options ▪
+‐values
+/‐measurements ▪ set measure‐
ments
+/‐compare ▪ set compare
+/‐stack ▪ set stack

alteration steps
original state ▪ undo alteration step ▪
redo alteratio step
end ▪ abort
help for construction

Activate construction
All constructions loaded into the style can be acti‐
vated with either
 double‐click on the respective construction or
 <F12> in the list of interactive constructions
(Picture 2‐9).
 right click to the contour and selection in the
context menu.
The list of interactive constructions (Picture 2‐9) con‐
tains all constructions called into the style and the
number of the part into which they were called. They
are listed according to part numbers.

Picture 2‐10

The options window can be resized as re‐
quired. A scroll bar appears at the edge of
the window if not all options are visible. The active
option is highlighted (Picture 2‐10 top left). Using the
arrow keys, the mouse wheel or altering the slider to
the left of the image alters the active option. A dif‐
ferent option is selected by clicking.
The alteration of an option is immediately applied to
the construction behind. We recommend working
with a reduced option window so that you can follow
the alterations to the construction.
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Exercise
Open a new style and call the basic block Skirt 20 into
part 001. Activate the construction. Set the following
options (Picture 2‐10):
 contour identical side seams
 adjust waist at side seam: yes
 link hem direction at side seam
Drag areas
Each construction has
one or more drag areas.
The drag areas are se‐
lected via the context
menu which opens with
right mouse click. The
drag areas were intro‐
duced to give greater
control so that not too
many points can be al‐
tered at the same time.
Picture 2‐11
After having activated an
interactive construction the first drag area is active.
It is indicated by a tick mark in the context menu (Pic‐
ture 2‐11).
Drag points
In the drag area small red points appear at the con‐
struction. With these so‐called drag points the con‐
struction can be altered interactively. Close to a drag
point a symbol at the cursor indicates how this drag
point can alter the construction. The following sym‐
bols may appear:
The drag point is moved ...
free
in x direction only
in y direction only
free, symmetrical
in x direction only, symmetrical

The angle is altered ...
free
symmetrical
asymmetrical
The point slides along a line.
A drag point is activated by clicking. The point addi‐
tionally marked with a green rectangle
active drag point.
The value window (Pic‐
ture 2‐12) contains the
values for the active drag
point. Only one or two
size‐dependent values
can exist per drag point.
Two values exist only if
the point with cursor
can be moved free in x
and y direction.

is the

Picture 2‐12

Dragging a point
Each drag point can be altered
 interactively by dragging the point or
 by entering a value directly into the value win‐
dow.
When dragging a point interactively the raster can be
switched on. Click on one of the numbers 00 01 05
10 25 25 in the menu on the right. The value at‐
tached to the drag point behaves according to the
selected raster. To deactivate the raster set it to 00.
With +values the value is displayed at the
cursor during dragging.
Switch to +compare to show a comparison
with the state of alteration at the last click
of set comparison or the original state.

free, asymmetrical

By clicking <= or => you can undo al‐
teration steps or redo them. The
state ‘00’ corresponds with the orig‐
inal state

in x direction only, asymmetrical

Save/ load shape

in y direction only, asymmetrical

Clicking save shape saves the
current adjustments of the con‐
struction as a shape. Clicking
load shape opens the list of available shapes for the
construction. Shapes are saved with date, time, com‐
puter name and user name. Double‐click opens a dif‐
ferent shape from the list.

in y direction only, symmetrical

The curve is altered ...
free
symmetrical
asymmetrical
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Exercise

2nd Exercise

Adjust the following on the prepared Skirt 20:
 the skirt length to 650mm in the Line relocation
area
 close the 2nd dart in the Dart front area
 close the 2nd dart in the Dart back area
 the side seam adjustment to 0mm in the Hem
area
Save the adjusted shape and the style as ‘Straight
skirt’. It will be the basis for exercises in the follow‐
ing chapters.
Grade the construction in the sizes N38 to N46. The
result is shown in Picture 2‐13.

Grade the basic block Skirt 10 in the sizes N38, N40,
N42, N44 and N46.

3rd Exercise
Call the basic block Bodice 10 and grade in the sizes
N38, N40, N42, N44 and N46

Picture 2‐13

2.5

Exercises

1st Exercise
Grade the basic block Skirt 20 in the sizes N38, N40,
N42, N44 and N46.
4th Exercise
Grade the basic block Trouser 10 in the sizes N38,
N40, N42, N44 and N46.
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5th Exercise ‘Shirt blouse’
Open a new style, call the basic block Bodice 10 into
part 001 and activate it. Set the following options:

6th Exercise ‘Bodice with vertical panel seams’
Open a new style, call the basic block Bodice 10 into
part 001 and activate it. Set the following options:
 centre back fold
 position shoulder dart as bust dart
 position waist dart back relative to waist
 length waist dart to hem
 link hem direction at side seam
 panel seam in the back: yes
 8 segments
Adjust the following in the Tolerance horizontal+vertical area:
 tolerance at bust: 60mm
 tolerance at waist: 55mm
 tolerance at hip: 60mm
 tolerance at across bust: 10mm
 tolerance at across back: 10mm
 tolerance at shoulder width front/back: 10mm







centre back fold
straight side seam
bust dart in side seam
link hem direction at side seam
4 segments

Adjust the following in the Tolerance horizontal+vertical area:
 tolerance at bust: 100mm
 tolerance at hip: 100mm
 tolerance at across bust: 15mm
 tolerance at across back: 15mm
 tolerance at shoulder width: 10mm
Adjust the following in the Bust dart area:
 loosen armhole by 20mm
Adjust the following in the Shoulder dart area:
 close shoulder dart
Adjust the following in the Neckline area:
 increase neckline by 5mm at shoulder, centre
front and centre back
Adjust the follwing in the Shoulder area:
 relocate shoulder by 10mm to the front
Save the adjusted shape and the style as ‘Shirt
blouse’. It will be the basis for exercises in the fol‐
lowing chapters.

Adjust the following in the Line relocation area:
 length to 750mm
Adjust the following in the Bust dart area:
 position dart at 50% of shoulder seam
 loosen armhole: 5mm
Save the adjusted shape and the style as ‘Bodice
with vertical panel seams’. It will be the basis for ex‐
ercises in the following chapters.
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3.1

Step by step guide

Extracting pieces

Style development with Grafis ensues in
three stages:
 Call and adjust the basic block
 Develop a draft with all required design ele‐
ments
 Derive the production patterns such as front,
back, waistband, facings, lining etc.
The parts from these developmental stages are con‐
nected so that alterations to the basic block are ap‐
plied to the draft pattern und thus, to the production
patterns.
This section initially deals with the extraction of
pieces. More detailed explanation on part organisa‐
tion and hereditary automatic can be found in Chap‐
ter 14.
Objects of up to 10 parts can be inserted into each
part.

 Open part organisation via: part rack → Bu on
or basic menu → part organisation or Extras
→ Part organisa on....(Picture 3‐1)
 Create new parts with open new part
 Enter/Edit the name of the selected part with edit






part name
or after double‐click on the part
name
Click to activate the part into which objects
(points, lines) are to be inserted. The active part
is highlighted in colour.
Show
part(s) from which lines and objects are
to be inserted into the active part part and re‐
move all other parts.
Quit the part organisation dialogue with
Basicmenu → insert

Part organisation

Part rack

Preview

Picture 3‐1
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Part rack menu (extract)
Show invisible parts ▪ open part organisation
show all parts ▪ hide all parts ▪ show parts …
1st part active and visible

 Select the type of object to be inserted by acti‐
vating points, lines or parts below select object:
 Click objects in the inactive parts displayed in
black on white screen.
The inserted objects appear in a different colour
(red) and, after having pressed <F5> removed
from the donor part.
 Click on without transformation inserts the ob‐
jects into the active part. Only then, will the in‐
serted objects appear in the blue colour of the ac‐
tive part and can be modified.
 Press to return to the basic menu.
Open and label parts
Create a new style ‘Jacket’, call Bodice 50 and click
on part organisation in the menu on the right. The
dialogue part organisation shown in Picture 3‐1
opens. Initially, only part 001 with the temporary
name ‘NN’ is available. By clicking on open new part
in the menu on the right you can create further parts
in this list. The active part is highlighted and a pre‐
view of the part appears below in the window. Open
seven further parts.

Partorganisation menu (extract)
Lock/ unlock window ▪ close
open new part ▪ insert part
move part up ▪ move part down
duplicate part ▪ duplicate part to…
delete part ▪ remove part ▪ reduce part
call all ▪ hide all ▪ call production pieces▪ call part …

insert reference ▪ update reference ▪ +/‐part information
copy ▪ print ▪ text
call module ▪ save module

Double‐click on the
first part and enter
the name ‘Bodice
50’. Name the sec‐
ond part ‘Front 40’
and the third part
‘Back 40’ in the same
way. To label the
other parts use a
function from the
menu on the right.
First, select part 004 and then, click on edit part
name and enter the texts one after the other accord‐
ing to Picture 3‐1. As opposed to editing with double‐
click, the line of text for the next part opens auto‐
matically after pressing <ENTER>. Abort text entry
with <ESC>. Parts can be deleted or removed from
this list with the functions delete and remove. Delete
means that all record steps are reset; remove means
the part is removed from the list.
The part list also contains other important infor‐
mation. The character ‘*’ in front of the part number
indicates that this part is a mother part. A mother
part has successor parts that are affected by altera‐
tions to the mother part. Further information can be
found in Chapter 14.
The icon
signifies that the respective part is visi‐
ble on the screen. Clicking this symbol in the part list
or the part rack toggles between the part being visi‐
ble or not visible. The active part, selected by the bar,
is always visible. You can switch all parts invisible by
clicking on hide all. You can make all parts visible by
clicking on show all. Removed parts are no longer
visible on screen but have not been deleted.
To quit the part organisation click the right mouse
or click on a function of the basic menu.
button
The selected part is then available for editing. If the
respective part is a mother
part, a warning message ap‐
pears in the status bar at the
bottom of the screen.
During construction the active
part is always displayed in
blue on a white screen.
In the basic menu all visible
parts can be activated by
clicking. It is not necessary to
open the part organisation
menu to activate a part!
Now select part 002 ‘front part
40’, mark part 001 ‘Bodice 50’
with ‘
‘ for visible and quit
part organisation with . You
are back in the basic menu.
The basic block is visible but
displayed in black.
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Call the construction Front part 40 from the call list
under Grafis‐Bodices → Womens bodices → Front
part tools.
The front and back part tools can either be bound
onto Bodice 10, 50, 60, 70 or onto Bodice 80. Bodice
50 has already been called into part 001. Now, the
Back part 40 is to be called into part 003 and also to
be linked to Bodice 50. Activate part 003 in the part
list and leave part 001 visible. Call the construction
Back part 40 from the call list under Grafis‐Bodices
→ Womens bodices → Back part tools and bind it
onto Bodice 50 with a single line click, also. In the fol‐
lowing section, lines and points from part 003 ‘back
part 40’ are inserted into part 004. Activate part 004
in the part rack, switch part 001 to invisible and parts
002 and 003 to visible.

Activate the object type lines by clicking. Now click
the lines required for finishing the back pattern (Pic‐
ture 3‐2). The clicked lines appear red or purple and
are positioned to the side of the donor part after
pressing <F5>.

Insert objects/ extract objects from another part
The following important rules apply when inserting
objects:
1. To insert an object the part into which the objects
are to be inserted must be active.
2. The part from which objects are to be extracted
must be visible on screen but inactive.
3. Objects can only be inserted from parts with a
lower part number into parts with a higher part
number.
Insert menu
Insert objects
points ▪ lines ▪ parts

Picture 3‐2

The <F5> key arranges all visible parts of a style in a
rectangle.
Then, swap to the object type ‘points’ by clicking on
points and insert also any other points required. The
selected objects are inserted after clicking without
transformation in the deposit objects section. Quit
the insert menu with .

reset single ▪ reset all

deposit objects
without transformation ▪ move ▪
turn and move

reset

006
Tools Insert
points ▪ lines ▪ part

Open the insert menu by clicking onto insert in the
menu on the right.

005

004
Picture 3‐3

Continue with parts 005 and 006 in the same way
(Picture 3‐3). Activate the next part in the part list,
hide part 004 ‘back centre’, keep parts 002 and 003
visible and so on.
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In the basic menu the following applies:
 clicking an inactive part  activates this part
 dragging an inactive part  removes this part
to the background memory.

Open the delete menu in Grafis by clicking on delete
in the basic menu. Press <F1>. The textbook chapter
on the subject Delete opens.

3.2

3.3

When help is needed

Exercise

Pattern output

Overview

Clipboard

 Constant help in the instructions window or the
status line (Picture 3‐4)
 Context related help via the <F1>‐key or via the
pull‐down menu Help → context.

Grafis supports the Windows clipboard for
processing patterns in other Windows applications.
The function Copy (clipboard) in the Edit pull‐down
menu copies the visible contents of the Grafis screen
to the clipboard. The contents of the clipboard can
be inserted into other Windows applications such as
Word, Paint or Excel to create further material about
the style or teaching material for example.
Grade a basic block in 5 sizes, centre with <F6> and
copy the graded nest to the clipboard via Edit → Copy
(clipboard). Now start a different Windows applica‐
tion (e.g. Paint) and insert the contents of the clip‐
board into this application. Process the graded nest
by changing the line colour, fill in the shapes or add
annotation for example.

Constant help
Constant help is given in the instructions window or
the status line where the next steps required are ex‐
plained. The instructions window is located in the
top right corner of the working area. The status line
makes up the lower border of the Grafis screen (see
in the basic
Picture 3‐4). Click transformation
menu. Read the instructions and close the transfor‐
mation menu with .
Context related help
Context related help can be found by pressing the
<F1>‐key or via the pull‐down menu Help → Context.
The relevant textbook chapter opens.
All contents of the help function can be obtained
with Help → Help topics.

Info Box with short help to the
next operation.

In the View pull‐down menu you select which
additional windows are displayed.
Grafis beginners require the Status Bar and the
Info Box. As a rule, experienced Grafis operators
require the Status Bar and the Toolbox, only.

Status bar with the help texts
of the Info Box.
Part rack

Picture 3‐4
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Output to plotter/printer
Output of patterns to plotters (drawing de‐
vices) or printers ensues via the Plot/Print menu. A
special feature of the pattern output function in
Grafis is the automatic wrap. It allows for quick out‐
put of full size patterns to small scale printers by di‐
viding the pattern into partial pictures which can be
joined subsequently.
The Plot/Print menu is opened via the File → Plot/
Print... pull‐down menu or from the toolbox.
Plot/Print menu
printer/ plotter setup

to LPT1
to File

direct output to the parallel port LPT1
a file with control information for the
output device is generated
(WIN)
output to a device with Windows driver
(DOS)
output to a device without Windows
driver
(Winspool) The control information is sent to a de‐
vice attached to the USB port. The Win‐
dows driver is used to spool the vector
data to the device. Please note that not
every driver can perform this function.
For the following exercises, a Windows‐installed A4
printer is sufficient. Further information can be
found in the Appendix of the Grafis help function.
The plot format

portrait/landscape ▪ place frame ▪
centre frame

The measurements of the active format are dis‐
played in millimetres under plotformat. The other
plot formats of your output device can be adjusted
via the Plotter/Printer Setup.
The plot frame on your screen corresponds with the
printable area of your output device. The content of
the plot frame is printed. Press the <F6>‐key to dis‐
play the plot frame as well as the plot picture.

text position ▪ +/‐ seam allowance

Selection of portrait or landscape

horizontal wrap ▪ automatic wrap

Clicking portrait/ landscape toggles between portrait
and landscape.

enlargement
adapt enlargement

Selection of plot scale
vertical wrap
start output

Preparation of plot picture
 Set up or change the plotter/printer (plotter type,
paper format,...)
 Click centre frame and press <F6> to get an over‐
view
 Adjust the following settings:
 portrait or landscape
 plot scale with enlargement
 activate the automatic wrap
 position the plot frame with align/centre
and/or dragging
 Position the frame text
Output of plot picture
 Start output (plot picture is generated internally)
Change plotter/printer
The selected output device is displayed under plot
device. The extensions mean:

The plot scale is adjusted by entering the scale factor
in the enlargement line. The pattern will be re‐
duced/enlarged for output according to this scale.
The scale factors mean the following:
1.0
scale 1:1
0.5
scale 1:2
0.25 scale 1:4 etc.
Adjust to scale 1:2 by entering 0.5 into the field be‐
low enlargement (click, type, <ENTER>) and press the
<F6>‐key. You will notice that the plot frame now co‐
vers a greater area of the pattern. Repeat with other
scales. Change also between portrait and landscape.
The adapt option adjusts the scale so that the whole
screen content fits the plot frame. Use this option
only for scaled printouts and sketches as it alters the
scale!
The scale can also be entered in the Plot file dialogue,
which is accessed via plot device change.
Position the plot frame
Positioning the plot frame ensues either by dragging
(cursor on plot frame, press left mouse button and
move mouse) or via clicking on the menu functions
align or centre. Practise these options! Align always
positions the pattern at the lower right edge of the
frame, optimised for plot output.
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Centre positions the plot frame centred over the plot
image. Use align for full‐scale plots and centre for
scaled output in A4. Practise positioning the plot
frame in conjunction with format and scale changes.
Activating automatic wrap
The automatic wrap is
useful for output of full
size patterns to devices
with small format, i.e. A4
printers. A raster is super‐
imposed onto the pattern
(Picture 3‐5 and Picture 3‐
6) and each field is output
separately. The partial
pictures can then be
joined together frame by
frame. The raster is gen‐
erated or eliminated by
clicking horizontal wrap
or vertical wrap. Auto‐
matic wrap adjusts the
number of raster so that
the complete pattern lies
within the raster.
Practise the automatic
wrap in conjunction with
adjustment of plot scale,
portrait/landscape and
Picture 3‐5
positioning of the plot
frame. Apply scale 1:1 also and press the <F6>‐key
from time to time.

Picture 3‐6

Select with/ without plot frame
Clicking on printer/plotter setup opens a dialogue
with further plot options (Picture 3‐7). Activating
plot with frame outputs the frame on the plot. This
option should be active for output with wrap.

Positioning the frame text
A standard annotation at the plot frame can be out‐
put with the picture for easy identification of the
plot, especially on partial pictures when using auto‐
matic wrap. It contains collection and style name,
part number and field co‐ordinates (Picture 3‐6). By
clicking on text position the text is positioned at the
left, right, upper or lower edge of the plot frame or
it is not visible. Position the text at the left plot
frame.

Picture 3‐7

Detailed information on the Settings and Print op‐
tions dialogues including details on how to set up
plotters/ printers can be found in the appendix.
Output of plot picture
Clicking on start output transmits the control infor‐
mation directly to the attached output device
(printer/plotter) for output as an image or in partial
images. Naturally, the output device must be on‐line.
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Output to file
Output to file is required if your plots
 are to be output onto a plotter not directly at‐
tached to your computer and not accessible via
a network or
 are to be transferred into a text or drawing soft‐
ware as HPGL files.
Plot to file is only possible for printer/plotters with‐
out windows driver. If the target for the plot device
in the menu on the right is not yet displayed as to
File:, open the Grafis – Plot file dialogue via
printer/plotter setup. Select the plotter, click on Set‐
tings, activate the Edit button, set the option con‐
nected to to FILE and accept the settings. To gener‐
ate HPGL data select the HPGL‐2 plotter.
If output to file is active, the control information is
saved in one or more files (for automatic wrap). After
initiating start output, you are requested to enter a
file name.
Grafis is not required for output of plot files to a plot‐
ter inland or abroad. It is important that the control
information was generated especially for this plot‐
ter. For example, plot files generated with the ‘Algo‐
tex (to FILE)’ setting can only be read by an Algotex
plotter.
To transfer the file to the plotter click on Start |
Run…and enter
copy C:\test.plt com2:
in the Open dialogue.

3.4

Stack

The stack menu
The stack menu is opened via the Extras → Stack
pull‐down menu or from the toolbox. With the func‐
tions of this menu, the graded stack of a part can be
stacked at a construction point or the point of a line.
The outlay function spreads all sizes next to one an‐
other in the order in which they are listed in the size
table. The outlay is reset with repeated stacking or
test run.
Stack menu
stack point
direction point

set recorded stack point
delete recorded stack point

outlay

Step‐by‐step guide

C:\test.plt must be the complete path to the
plot file including the name of the plot file. com2:
must be the port to which the plotter is connected.
The copy command cannot be used for output to
USB ports.

Stack at a construction point or point of a line:
 Select stack point and click the stack point in the
construction
 If required: determine direction point in the same
way

Exercises

Set stack point

1st Exercise
Output the basic block Skirt 20 in size 40 in full scale
to an A4‐printer. Use +frame and frame text to be
able to join the partial pictures frame by frame after‐
wards.

Having selected stack point opens the sub‐menu
point construction, which is explained in detail in
Chapter 6. To learn about the stack function, only the
options shown in Picture 3‐8 of this sub‐menu will be
explored.
With the option

2nd Exercise
Output the following basic blocks onto A4 paper:
 Trouser 10 in scale 1:2
 Bodice 10 in scale 1:3
 Bodice 20 in scale 1:5
If you know how to use Word for Windows or Corel‐
Draw, import the plot pictures into these systems via
the clipboard for processing.



(click p) of the point construction, the
cursor can select only points of the construction
as stack points,



(click l) of the point construction, only
lines can be clicked,
 click l and <Shift> you can select the starting
point or the end point of a line,


(intersection) of the point construction,
the intersection of two lines is set as the stack
point by clicking the two lines one after the
other.
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 The most used option is free mode. In the free
mode, no button of the point construction
menu is pushed in. This mode is a combination
of click p, click l, click l and <Shift>.
click P ‐ points

With the function Set recorded stack point a point
can be selected as the stack point for the active part.
Stacking always ensues at the end of the grade run.
Activating Delete recorded stack point displays the
current stack point. Clicking deletes it.
Exercise

click L ‐ lines
intersection of
two lines

Picture 3‐8

To stack a graded part first, activate set stack point,
select a suitable option from the sub‐menu point
construction and then, click the required stack point
of the construction, see Picture 3‐9 left.
Set direction point
Having stacked a part at a particular point, a direc‐
tion point can be determined. The patterns remain
stacked at the stack point. The sizes of the part are
rotated about the stack point so that the direction
from stack point to direction point is identical in all
sizes, see Picture 3‐9 right.
stack point

Recorded stack point

direction point

Grade the basic block Bodice 10 in the sizes _N36 to
_N48 and stack the part:
 with click p at the bust point,
 with click l and <Shift> at the upper end of the
centre front ,
 with intersection at the centre front at bust line
level,
 in free mode at the sleeve pitch and then, again
at the bust point.
Align the piece at the right bust dart line. Then, stack
it at the shoulder/armhole corner and align it in rela‐
tion to the front pitch.

3.5

Drag, rotate, flip parts

<F3> or the pull‐down menu Edit →
Drag/rotate parts opens the drag/rotate menu.
Here, parts can be dragged, rotated or flipped to one
another. Rolling parts, explained in the following sec‐
tion 3.6, is also controlled via this menu
The part to be moved is to be clicked. A drag cursor
in form of a crosshair with circle appears offering the
following functions:
Drag
Click inside the circle and drag with the left mouse
button pressed down.
Rotate
Click outside the circle and rotate with the left mouse
button pressed down.
Flip (mirror)
Click the symmetry axis about which the part is to be
flipped (mirrored).
Additional functions
After having clicked on a part, the following functions
are also available:

Picture 3‐9

Scale
Adjust the display scale by clicking
1 : 0.2
for 5 times enlargement
1:1
for scale 1:1 (original size)
1:3
for 1/3 scale
1:5
for 1/5 scale
1 : 10
for 1/10 scale
The current scale is indicated immediately below this
button.
NB: The function keys <F2>, <F4> and <F6> are still
active.
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The <F8> function key switches between ‘parts in
original (construction) position’ and ‘parts in trans‐
formed working position’.

Drag/Rotate menu <F3>
drag/rotate activate ▪
set drag cursor ▪
set drag cursor to point

Exercise
Place parts 001 and 004
from the exercise in section
3.1 together at the arm‐
hole/ side seam corner and
rotate one of the parts so
that you can check the con‐
tinuation of the armhole
(Picture 3‐10). Move, rotate
and flip other parts also.
Quit the drag/ rotate menu
with .
Press also the <F8> key. The
parts have now been re‐
turned to their original posi‐
Picture 3‐10
tion. Pressing <F8> again
shows the parts as previously positioned.
With <F5> all parts are arranged in a rectangle. Now
press <F8> again.

roll see section 3.6

select scale
current scale

rotate part

3.6

Rolling Parts

Roll parts along one another can also be
found in the drag/rotate menu, accessed via the
<F3> key or via the pull‐down menu Edit → Move
parts, see section 3.5.

nil the direction of the part
current direction of the part

Roll parts in Drag/rotate menu <F3>
Direction
Rotating the drag cursor in degrees by clicking the
relevant button in the rotate part section. The cur‐
rent rotation is indicated immediately below this
button.
Nil rotation of the part
Reset the rotation of the part to nil.
Set drag cursor
The drag cursor can be reset with the sub‐menu
point construction, see explanation in the previous
section.
Set drag cursor to point
The part is moved to a constructed point of another
part with the drag cursor.

drag/rotate see section 3.5 ▪

activate roll ▪ set roll
select size for roll ▪
set new start point for roll

The Right principle
With the right principle not only the objects are de‐
termined when clicking the line/curve but a direction
in which the object is to be used for the instructed
construction.

Drag another part
the drag cursor can be moved
After pressing
quickly to another part and dragged immediately.
End
Dragging is terminated with 2x

.
Picture 3‐11
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Grafis supports the operator with the so‐called ‘right
principle cursor’ which also contains a direction indi‐
cator, see Picture 3‐11.
Set roll
Step‐by‐step guide:
 Select set roll from the menu
 Click one or more roll lines in the part to be
moved. The roll direction must be considered and
communicated to the system with the help of the
right principle.
terminates line selection in the part to be

moved.
 Click one or more roll lines in the part to remain
stationary. Here, the roll direction must also be
communicated.
 terminates line selection in the stationary part.
 Determine start point for rolling in the part to be
moved.
 Determine start point for rolling in the stationary
part.
Exercise concerning roll

Adjust roll
With set new start point for roll new start points can
be selected. Setting new start points is useful where
ease has been included and the line sections are to
be checked one after the other. In the example in Pic‐
ture 3‐12, set the two intersections with the waist
lines as new start position for roll.
Roll ensues in the base size only. Occasionally, other
sizes are to be checked as well as the base size. Acti‐
vate select size for roll. All sizes in which both parts
are available will be offered. Select a size and roll.
Switching to the drag mode from section 3.5 is pos‐
sible via activate drag/rotate. Switching from the
drag mode back to the last set roll mode is possible
via activate roll.

3.7

Exercises

1st Exercise
Grade the basic block Trouser 10 in the sizes 38 to 46
and stack the pattern at the dart apex of the trouser
front.

Roll the panel seams of parts 004 and 005 from the
exercise in section 3.1 along another. Carry out the
exercise according to the above step‐by‐step guide
and consider the click succession in Picture 3‐12.

3.
4.

1.
2.
6.

Print the shown trouser front full size onto A4.
5.
Picture 3‐12

Having correctly determined the roll lines and the
start points, the drag cursor appears on part 004.
Rolling ensues via dragging the drag cursor. Flip is
possible even during rolling.
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2nd Exercise
Grade the basic block Skirt 20 in the sizes 38 to 46
and stack at the hip point of the skirt front. Output
the pattern onto A4 in reduced scale.

3rd Exercise
Grade the basic block Bodice 20 in the sizes 38 to 46
and stack at the side seam / armhole corner point.
Print the pattern in 1:4 scale onto A4 paper.

The basic block Bodice 20 is prepared for finished
measurement construction. Only the vertical meas‐
urements are taken from the measurement charts.
The horizontal measurements are adjusted interac‐
tively according to finished measurement lists. Fur‐
ther information on size‐dependent adjustment of
interactive constructions can be found in Chap‐
ter 13.
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4.1

The Grafis‐data structure

Collection folders

Styles

Summer

Objects

Gabriele

Ilona

Administrated in dialog with you
Administrated Grafis internally
Parts

Points
Lines

Winter

001

002

Stefanie

003

Construction record
Technological information

Text

Picture 4‐1

The data structure
In Grafis construction data is organised according to
collection folders, styles and parts (Picture 4‐1). The
number of folders and styles is unlimited. However,
it is advisable to transfer styles no longer required to
CD ROM or the network or to delete them.
It is important to know which styles are saved in
which folder. Create an overview list for yourself.
Each style can contain up to 500 parts which will
be named by Grafis with a 3‐digit number. The
parts consist of objects, e.g. points, lines and texts.
The dialogue to open or delete styles opens auto‐
matically after having selected a measurement
system or via File → Open.

4.2

The construction record

left group of numbers indicates the record step at
which test run was last activated.
Test run starts the run through the construction rec‐
ord. It can also be run in a step‐by‐step mode. Imme‐
diately after having selected test run press the <S>
key once. Pressing the space key shows the following
construction steps one after the other. Press <S>
again to quit the step‐by‐step mode.
Basic menu (extract)
Construction record of the active part…
reset ▪ restore
reset N steps
record counter
test run ▪ grading

Purpose of the construction record
Grafis saves the construction and modification steps
during pattern development in the base size by im‐
perceptibly writing a record. The operator has the
option of calling the construction record with other
measurement charts and thus, creates a similar con‐
struction for these sizes. Incremental grading is omit‐
ted.
The construction record is similar to the notepad of
an attentive student who notes down each of the
teacher’s steps and can then recreate the construc‐
tion with different measurements.
Indication of record steps, test run
The number of recorded construction steps is con‐
stantly indicated in the basic menu in Grafis with two
blocks of record counters containing three numbers
respectively. The block on the right indicates the
number of construction steps recorded so far. The

Reset the construction record
The reset function resets the construction record by
one step. If a larger number of reset steps is re‐
quired, click on reset N steps and enter the number
of steps to be reset. The construction record is auto‐
matically reset.
As soon as you detect a mistake in your construc‐
tion, reset the construction record back to the error
and resume construction without the mistake.
Please do not try to ‘patch up’ your construction as
following construction steps may be affected inad‐
vertently. Correcting mistakes in time avoids errors
during automatic construction (grading).
If you have reset too many steps, you can go back to
the state before deleting the record steps with the
function restore.
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Exercise
Call the basic block Skirt 20, click on reset. The screen
is empty as calling a basic block already counts as a
construction step. You can now call a different basic
block. This is the quickest way to view various basic
blocks.
Call two more basic blocks, resetting the record by
one step each time. All functions of the basic menu‐
from call onwards are record functions. They are‐
recorded internally in the system.

Picture 4‐3 shows a few points and their respective
co‐ordinates.
y axis

4
3
2

(3,2)

(0,2)
(1,1)

1

4.3

Geometrical basics

0

The co‐ordinate system
The co‐ordinate system is used for the description of
point positions on a plain. In clothing construction
the plain is comparable to the paper on which the
pattern is designed.
All points on the plain relate to an agreed source (a
starting point). The x and y axis run through this point
in a right angle towards one another. Unless other‐
wise stated, the x axis runs horizontally, the y axis
vertically (Picture 4‐2).

(2,1)

(3,1)
x axis

(0,0)

0

1

2

3

4
Picture 4‐3

The position of a point can also be defined relative
to another point in the construction. In Picture 4‐4
the new point of reference is point (5.5,2.5). The ab‐
solute co‐ordinates of the point result from its rela‐
tive co‐ordinates and the co‐ordinates of the point of
reference.
Point:
Absolute co‐ordinates: (6.5 ,5)
Relative co‐ordinates: (1 ,2.5)

X and y co‐ordinates of a point
The position of a point is clearly defined by its dis‐
tance to the x and y axis. The distance to the y axis is
the x co‐ordinate of the point, the distance to the x

2

*

1

y axis

(5.5,2.5)

2

1

2

1

point with
(x,y)

(0,0)

y co‐ordinate

1
2
Co‐ordinate system of the construction

Picture 4‐4
co‐ordinate
source

x co‐ordinate

x axis
Picture 4‐2

axis is the y co‐ordinate of the point (see Picture 4‐2).
A minus in front of the x co‐ordinate places the point
to the left of the y axis. The y co‐ordinate is negative
if the point lies below the x axis. A point is clearly de‐
fined by stating (x,y) (Picture 4‐2).

Polygon
All lines, circle arcs and curves are displayed as poly‐
gons in Grafis. A polygon consists of a number of
points connected by straight lines (Picture 4‐5). As a
rule, the fulcrums of the polygon are not visible.

Picture 4‐5

With the function raster0 (section 5.2) they can be
made visible as points if necessary.
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The fulcrums of a circle arc have the same distance
between one another. The fulcrums of a curve are
denser in the bends (Picture 4‐6).

y

Direction according to
rotation angle
positive
rotation angle

x
negative
rotation angle

Picture 4‐6

The right principle

Picture 4‐8

For certain construction steps the beginning and end
of a line have to be determined. The line receives a
direction.
For this purpose the right principle was introduced.
Grafis supports the operator with the so‐called 'right
principle cursor’ which also contains the direction in‐
dicator (Picture 4‐7).

4.4

Deleting objects

The delete menu
The delete menu is activated via Basic menu → de‐
lete. Single objects (points, lines/curves, texts) can
be deleted by clicking; several objects within a rec‐
tangle to be drawn up can be deleted in one opera‐
tion.
Delete menu
delete single...
points ▪ lines ▪ texts

Picture 4‐7

To illustrate the right principle imagine the
line/curve to be clicked as the central reservation of
a road. The required direction of travel is communi‐
cated to the system by clicking the line. This relates
to driving on the right side of the road, only. The right
principle and its application is explained in detail in
the chapter 4.
Angle definition
Definition of angles is required for rotation transfor‐
mations, determination of direction in certain curve
points or construction of lines. The following rules
apply (Picture 4‐8):
1. The definition of angles ensues from the positive
x axis ‐ if no other reference is present. This
agreement is important for definition of points
through their distance to the source and their di‐
rection.
2. A positive rotation angle creates anti‐clockwise
rotation, a negative angle results in clockwise ro‐
tation.

delete inside rectangle…
points ▪ lines ▪ all
texts
delete inside rectangle…
notch symbols ▪ inner symbols ▪
seam lines

reset

Step‐by‐step guide
 Activate the object type to be deleted under the

required option (delete single or delete inside rec‐
tangle)
 Click the objects or draw up rectangle
Delete single
To delete individual objects the type of objects under
delete single is to be activated and the object to be
deleted is to be clicked. This is the object nearest to
the cursor, marked by a fine thread and coloration.
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Delete inside rectangle
To delete several objects in one operation first, the
type of object is to be selected under delete inside
rectangle. All objects of this type completely lying
within a rectangle to be drawn up will be deleted.
The rectangle is drawn up by clicking
the corner
of the area to be deleted, moving the mouse and
clicking the opposite corner.
When deleting several objects the objects lying
completely within the rectangle are deleted only!
With reset you can reset the last deletion step.
Please note that deleting is a construction step and
will be performed automatically during test run or
grading. Start both functions from the basic menu.
One or more deletion steps can also be reset by re‐
setting the construction record.
Exercise on deleting
Call the basic block Bodice 10 and delete all dashed
lines and all points in the front individually.

and the points within the rectangle are de‐
Click
leted. If different points are deleted you opened the
rectangle over a different area. To correct click reset
and repeat the steps.
Exercises
1st Exercise
Call the basic block Skirt 20 and delete
 all points in the skirt front
 reset
 all lines in the skirt back
 reset
 the complete skirt front
 reset
 the complete skirt back.
Reset the construction record to 000 in the basic
menu.
2nd Exercise
Call the basic block Bodice 10 and delete the com‐
plete back. Centre the front with <F6> on the screen.
3rd Exercise
As opposed to the 2nd exercise, now delete the
whole front and centre the back on screen.
4th Exercise
Call the style ‘Shirt blouse’ from Chapter 2 Section
2.5 (Picture 4‐10) and delete individual lines and
points. Then, reset the record and delete all lines of
the front and all points of the back.

Picture 4‐9

the point or the line to be deleted. A fine
Click
thread to the cursor indicates the nearest point.
If a different point is deleted, the thread cursor did
not indicate the point to be deleted. If a different ob‐
ject is deleted, a different type of object was active.
To correct click reset and repeat deleting.
Delete all lines and points of the back and armhole
with delete inside rectangle: all, see Picture 4‐9.
Click a corner of the area and move the mouse. A rec‐
tangle opens that you can draw up as shown.

Picture 4‐10
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4.5
4.5.1

Parallels
Interactive tools and non‐interactive
functions

Up to Grafis Version 9, only non‐interactive menu
functions, in the following called ‘functions’, were
available within the software. From Grafis Version
10, new interactive tools for the construction of par‐
allels, raster, link and curves have been introduced.
The main differences are as follows:
 Point of entry of parameters
When using the functions, the required parame‐
ters, such as distance of a parallel or the number
of raster points, must be entered first. Then, the
relevant objects can be clicked. When working
with interactive tools, the objects are clicked first
and then, the parameters are adjusted interac‐
tively.
 Speed of processing
The functions are processed faster than the inter‐
active tools during grading. This difference is
markedly noticeable when grading curves using
processors of less than 1GHz frequency. On faster
computers, these differences are hardly obvious.
 Subsequent alterations
When working with functions, x values (see Chap‐
ter 11) can be introduced as parameters. Only
with the application of x values can functions be
altered subsequently. Tools, however, can be al‐
tered interactively by double‐clicking on the rele‐
vant objects or via the <F12> list at any time.
 Listing in the <F12> list of constructions
All tools are listed in the <F12> list of construc‐
tions in the order of use. The functions do not ap‐
pear in this list.
Recommendation: If you are certain that the use of
a function for the respective construction operation
will obtain the required result, you should apply this
function. This way, you avoid too many unnecessary
entries in the <F12> list and thus, reduce the pro‐
cessing time for grading.
All buttons with direct access to tools are indicated
by a small green dot. Further tools can be accessed
via the ‘tools‘ button in the menu on the right at the
very bottom if required.

4.5.2

The parallel menu

Application of parallels
Parallels are significant for the construction of
 overlap and button catch
 turn‐ups on jackets, coats and trousers
 seam allowances and hem and others.
Parallel menu

fixed distance values for
parallel function

distance value

Un‐parallel
distance value 1
distance value2

+/‐ copy ▪ +/‐ chain ▪
+/‐ move symbol
reset

Parallel 10 ▪ Parallel 20

start the tool automatically

The construction of parallels ensues with the parallel
menu from the basic menu. This menu contains the
parallel function as well as the Parallel 10 tool and
the Parallel 20 tool.
As a rule, the parallel function is used, possibly with
the application of x values. The Parallel 10 tool is
useful if the distance of a parallel is to be different at
starting point and final point, e.g. for the seam allow‐
ance of the crotch seam.

Chapter 4 Create and alter perimeter

45

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

4.5.3

The parallel function

Step‐by‐step guide
 Select distance or enter special distance value in

Exercise on creating parallels to single lines
Call the basic block Bodice 20 and construct the seam
allowances displayed (Picture 4‐11):

the menu

10

 Select +/‐chain
 Select +/‐copy
 Click the line/curve to which a parallel is to be

15
10

generated
Determine distance value
If the required distance (in millimetres) is listed in the
menu, click the respective button. Otherwise, a spe‐
cific value has to be entered in the distance value
field followed by <ENTER>. The point is the decimal
sign.
A distance value already entered can be reactivated
by clicking the distance value button.
Un‐parallel
The function un‐parallel constructs a new line with
the distance to the original line changing evenly
along the course of the line. The distances at the be‐
ginning and end of the line are set. The un‐parallel
applies only to individual lines, not line sequences.
Significance of +/‐chain and +/‐copy
If +chain is set the parallel is generated not only for
the clicked line/curve but for all lines and curves con‐
nected with the clicked line. Clicking chain activates
or deactivates this option.
The switch +/‐copy determines whether the original
line remains existent (+copy) or not existent (‐copy).
Toggle by clicking on this button.

40

15

30
Picture 4‐11






neck and armhole: 10mm
shoulder and side seam: 15mm
hem 30mm
overlap centre front 40mm

Exercise on creating parallels with chain
Call the basic block Skirt 20 and construct a parallel
of 10mm to the complete perimeter of the skirt back
(Picture 4‐12). Set +chain. Construct a single parallel
of 10mm or 30mm at the hem of the front skirt. Set
–chain beforehand.

Direction for parallel generation
Clicking decides on which side of a line/curve the
parallel is generated. The parallel is generated in the
direction from which the line/curve is clicked. There‐
fore, click next to the line and not on the line!
Attention! If identical objects are lying on top of each
other 2, 4 or 6,... times they cannot be seen on
screen as they delete their respective image. If they
lie on top of each other 3, 5,... times they are visible.
When practising the parallel function for the first
time this is a common mistake. After <F4> even ob‐
jects deleting each other’s image are displayed. If
you cannot see a new parallel straight away, press
<F4>. Make sure that points or lines are never placed
on top of one another by using reset or delete.

Picture 4‐12
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4.5.4

The Parallel 10 tool

4.5.5

The Parallel 20 tool

Step‐by‐step guide

Step‐by‐step guide

 Call Parallel 10
 Click on the line/curve to which the parallel is
to be constructed
 Double‐click on the new parallel and adjust start‐
ing distance and end distance interactively

 Call Parallele 20
 Click several lines/curves, to which the parallels

Exercises for the creation of parallels with Paral‐
lel 10
Call the basic block Trouser 10 and construct the
seam allowances indicated Picture 4‐13) with the
function Parallel 10:
10

25

10
20

are to be constructed
 Double click on once of the new parallels and ad‐
just the distance interactively.
You can adjust all parallels to one distance and then
assign an additional distance to single lines/curves.
You optionally adjust every parallel separately.
Exercise for the creation of parallels with Parallel 20
Call the basic block Bodice 30 and construct the seam
allowances with Parallel 20. Adjust the distance in‐
teractively to 10 mm. Then change the distance for
the shoulder to 20 mm and for the hem to 30 mm
(Picture 4‐15).

10
20

10
20

10

40

Picture 4‐13

 waist, side seam, internal leg seam: 10mm
 crotch seam: 10mm
Construct the crotch seam with the Parallel 10 tool
and adjust it interactively, see Picture 4‐14.

Picture 4‐14

30

Picture 4‐15

Exercises
1st Exercise
Call the style ‘Straight skirt’ from Chapter 2 Section
2.4 and create parallels at a distance of 40mm from
the centre front and further parallels at a distance of
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Initial options for the corner function and the inter‐
active Corner 40 tool
A corner is built of two lines/curves which do not
need to intersect but may have more than one inter‐
section (Picture 4‐16). Before each corner construc‐
tion, the relevant objects are extended (internally)
by 500mm at the beginning and end. Thus, corners
outside the objects can be constructed. If Grafis de‐

40mm from the hem in the skirt back and further
parallels of 70mm respectively from the hem.
Picture 4‐16

4.6

Corners

The Corners menu
The construction of corners ensues with the corners
menu from the basic menu. This menu contains the
functions corner, straight line, curve and circle as
well as various interactive corner tools.
Corners menu
corner

tects more than one corner on curves they are indi‐
cated and the one required has to be clicked.
The right principle
For the construction of corners the right principle
must be followed when clicking the objects, section
3.6.
With this principle not only the objects are deter‐
mined when clicking the line/curve but a direction in
which the object is to be used for the instructed con‐
struction. The first object is to be clicked so that you

reset
corner with curve ▪ corner with circle
▪ corner with line
Co‐ordinated corner with curve ▪
Co‐ordinated corner with circle
U corner ▪ Co‐ordinated U corner
Mirror corner ▪ mitred corner ▪
vent corner

Picture 4‐17

are driving towards the requested corner, the sec‐
ond click must be driving away from the corner, see
Picture 4‐17.

Hem corner

Stepped corner
Angle corner ▪ Co‐o. Angle corner
Tapered corner ▪ Co‐o. Tapered cor‐
ner
start the tool automatically
Picture 4‐18
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The right principle is very powerful. Grafis supports
the operator with the so called ‘right principle cur‐
sor’ which also has the direction indicator, see Pic‐
ture 4‐18
For illustration of the right principle imagine the
line/curve to be clicked as the central reservation of
the motorway. The construction of corners resem‐
bles driving onto a motorway junction. You are driv‐
ing along the first line towards the junction and then
turn onto the second motorway.
The direction of travel is determined by clicking the
lines, following the right principle. The stretches of
motorway you are driving remain existent, the oth‐
ers are deleted.

Call the basic block Bodice 10 and created a corner at
the side seam/hem with the Corner 40 tool (Pic‐

The corner function
Step‐by‐step guide
 Activate corner
 Click two lines, following the right principle

The corner function creates a corner directly from
the intersection of the two objects.
Call the style ‘straight skirt’ from Chapter 2 section
2.4 and create 5 parallels of 40mm to the centre
Picture 4‐20

ture 4‐20). One after the other, adjust the corner in‐
teractively to a curved corner, a straight line corner
and a circle and grade.
The interactive Mirror Corner 10
As opposed to the corner function and the Corner 40
tool, this corner requires four lines: the two stitch
lines and the two seam allowance lines.

Picture 4‐19

front, centre back and to the hem respectively. Then,
create the depicted pattern (Picture 4‐19) with the
use of the corner function.
The interactive Corner 40 tool with the options
curve, circle, straight line and corner
Step‐by‐step guide
Call Corner 40 with curve
Click on two lines, following the right principle
Double‐click on the new corner
Adjust the options of the corner
Interactively design the corner







Picture 4‐21
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Step‐by‐step guide
 Call Mirror Corner 10
 Click on the four lines, following the right princi‐
ple in the clicking order shown in Picture 4‐21:
allowance – seam – seam – allowance.
 Double‐click on the new corner
 Adjust the options for the corner
 Interactively design the corner
Call the basic block Bodice 10 and construct a hem
allowance of 40mm and a seam allowance of 10mm.
Create a mirrored corner at the side seam/hem with
the Corner 10 tool (Picture 4‐21).

The interactive Co‐ordinated Corner 50
With Corner 50 two corner constructions of the same
part are adjusted towards one another. The step‐by‐
step guide is identical to Corner 40. The order of
clicking depends on the position of the corners to
one another. Detailed information can be found on
the Attach file card in the call function under Grafis‐
Corners. Of the total of 3 click variations available,
we will introduce only the most commonly used click
variation here, see Picture 4‐24 and Picture 4‐25.

The interactive Mitred Corner 20
Step‐by‐step guide and order of clicking allowance –
seam – seam – allowance are identical to Mirror Cor‐
ner 10.

Picture 4‐24

Picture 4‐22

The first clicked corner has a higher priority than the
corner clicked second. Alterations to the first corner
apply to both corners. Alterations to the second cor‐
ner apply to the second corner, only. Therefore, ad‐
just the first corner and then, adjust any asymmetry
at the second corner.

Call the basic block Bodice 10 and construct a seam
allowance and hem allowance of 40mm. Create a mi‐
tred corner at the side seam/hem with the Corner 20
too (Picture 4‐22).
The interactive Vent Corner 30
Step‐by‐step guide and order of clicking allowance –
seam – seam – allowance are identical to Mirror Cor‐
ner 10.
Call basic block Bodice 10 and construct a hem allow‐
ance of 40mm and a seam allowance of 10mm at the

Picture 4‐25

The interactive Angle Corner 60

Picture 4‐23

centre back. Create a vent corner at the centre back/
hem with the Vent Corner 30 tool (Picture 4‐23).

The step‐by‐step guide is identical to Mirror Corner
10. The order of clicking allowance – seam – seam –
allowance is similar to Mirror Corner 10. First, it is
imperative to click on the allowance line to be ex‐
tended. Both click variations are shown in Picture 4‐
26.
Use this corner for corners not to be co‐ordinated on
symmetrical pieces for example, e.g. neckline, shoul‐
der seam or centre back seam.
Call the basic block Bodice 10 and construct a seam
allowance of 10mm. Create an angled corner at the
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Picture 4‐26

shoulder/armhole with the Corner 60 tool (Picture 4‐
26).
The Co‐ordinated angle Corner 70
If two angled corners are to be sewn together, they
must be adjusted towards one another. The co‐ordi‐
nation should ensue via a joined mother part so that

4.
6.

no unnecessary dependencies are created. There‐
fore, in addition to the active part, make the mother
part visible, also. The order of clicking is allowance
of seam to be sown first – seam – seam – allowance
and then in the mother part corresponding seam to
be sown first – seam of the relevant corner.
Now the corner can be shaped interactively. Via the
options you can switch between angle corner and cut
corner. If the option angle corner is selected, the
length of the angle corner can be shortened interac‐
tively from the top or the bottom. This value is not
updated automatically for both corners but must be
adjusted separately for each corner by be user.
This value is not updated automatically on both cor‐
ners but must be adjusted for each corner sepa‐
rately.
Call the style from Chapter 3 section 3.2 and con‐
struct a seam allowance of 10mm and a hem allow‐
ance of 40mm in the back side panel. Close the cor‐
ners at the hem with Corner 10. The corner at the
armhole is to be co‐ordinated with the centre back
panel. Make the back part 40 visible in the part or‐
ganisation. Construct the corner with the Co‐ordi‐
nated angle Corner 70 (Picture 4‐27).
The interactive Hem Corner 80

3.

The click sequence is seam allowance – hem – hem
2.
5.

1.

4

6.

3

2.
1.

5.

Picture 4‐28

Picture 4‐27

allowance – seam allowance, see Picture 4‐28. It is
important that the seam lines are a continuous
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curve. Alternatively, the side seam can be clicked di‐
rectly instead of the seam allowance. In this case, the
notches will not be visible.
The inside turn up can be made visible with the sec‐
ond option. It is created as a parallel to the hem.
The interactive Slant Corner 90
As opposed to the previous corners, this corner re‐
quires three lines: one stitch line and the two seam
allowance lines.

As Corner 50 the first clicked corner has a higher pri‐
ority than the corner clicked second. Alterations to
the first corner apply to both corners. Alterations to
the second corner apply to the second corner, only.
Therefore, adjust the first corner and then, adjust
any asymmetry at the second corner.
The interactive U‐shaped corner 110
This corner requires three clicks: Seam – seam –
seam. Clicking inside or outside is of no consequence

Picture 4‐29

Step‐by‐step guide
 Call Slant Corner via tool button.
 Click on the three lines, following the right prin‐
ciple in the clicking order: allowance–allow‐
ance–seam or allowance –seam–allowance, see
Picture 4‐29.
 Double‐click on the new corner
 Interactively design the corner.

Picture 4‐31

Step‐by‐step guide
 Call u‐shaped corner
 Click on three lines, following the right principle

in the click sequence seam – seam – seam, see
Picture 4‐31.
 Double‐click on the new corner
 Interactively shape the corner.

The interactive Co‐ordinated slant Corner 100
Step‐by‐step guide
 Call Co‐ordinated slant Corner
 Click on the six lines, following the right principle

in the clicking order shown in Picture 4‐30:
corner 1:
allowance–seam–allowance,
corner 2:
allowance–seam–allowance,
 Double‐click on the new corner
 Interactively design the corner.
Picture 4‐32

The u‐shaped corner 110 is used for example for
treating edges of belts and bartacks, Picture 4‐32.

Picture 4‐30
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The interactive co‐ordinated u‐shaped corner 120

The interactive stepped corner 130

The two click variations are displayed in Picture 4‐33.

The step‐by‐step guide is identical to mirror corner
10. The click sequence is seam allowance – seam –
seam – seam allowance. It is imperative to click on
the seam allowance line first. The two click variations
are displayed in Picture 4‐35.

Step‐by‐step guide
Call co‐ordinated u‐shaped corner 120 via the tool
button
 Click on six lines following the right principle in
the click sequence according to Picture 4‐33:
Corner 1: seam – seam – seam
Corner 2: seam – seam – seam
 Double‐click on the new corner
 Interactively shape the corner.

Picture 4‐35

Step‐by‐step guide
 Call Stepped corner 130
 Click the four lines following the right principle in
the click sequence according to Picture 4‐35:
seam allowance – seam – seam – seam allow‐
ance
 Double‐click on the new corner
 Interactive adjustment of the corner

4.7
Picture 4‐33

Exercises

1st Exercise
Call the style ‘Straight skirt’ from Chapter 2 Sec‐
tion 2.4, delete the skirt front and construct the
following parallels:
 vent height centre back: 200mm
 vent height side seam: 300mm
 seam allowance waist, side seam and centre
back: 10mm
 vent width: 30mm
 hem: 30mm

Picture 4‐34

With this corner also, the first clicked corner has a
higher priority over the second clicked corner Pic‐
ture 4‐34. Modifications made to the first corner ap‐
ply to both corners. Modifications made to the sec‐
ond corner apply to the second corner only. There‐
fore, adjust the first corner first and then, adjust any
desired asymmetry to the second corner.

Close the corners and grade the skirt in various sizes.
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2nd Exercise
Call the style ‘straight skirt’
from chapter 2 section 2.4,
delete the front skirt and
construct following paral‐
lels:
 tolerance waist, side
seam and centre back
with 10mm
 hem extension 30mm
Construct the vent with the
Corner 30 tool like exercise
1 and adjust the shape of
the vent interactive.
3rd Exercise
Call the style ‘straight skirt’ from Chapter 2 section
2.4, insert the lines of the front skirt into a new part
in the part organisation and construct the following:
 seam allowance of 10mm
 parallel to the hem with Parallel 10
 parallel to the centre front CF with Parallel 10
 curve at the CF with Corner 40; The curve is to
start 200mm from hem at the CF and end
100mm from CF at the hem.
 overlap of 30mm at CF with Parallel 10 tool.

4th Exercise
Call the construction Bodice 50
and construct an angle at the CF/
hem. Use Corner 40. The angle is
to start 120mm from the hem at
the CF and end 60mm from the
CF at the hem.

5th Exercise
Call Bodice 50 and insert the objects of the back into
a new part in the part organisation.
Construct a seam allowance of 10 mm to the shoul‐
der, the armhole, the side seam and the centre back
from the waist. At the centre back down to the waist
and at the hem construct a seam allowance of 30
mm. Close the corner at the centre back with the
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stepped corner, as displayed. As the hem corner re‐
quires a continuous seam and hem line, close the
hem corner at the side seam and the centre back
with mirror corner 10, all other corners are closed
with the angle corner.
6th Exercise
Call the style ‘shirt blouse’ from Chapter 2 section
2.5, insert the lines of the front and back into a new
part in the part organisation.
Construct a curved hem using the Co‐ordinated Cor‐
ner 50. Adjust the corners interactively. Then, switch
the options to corner with straight line and corner
with circle respectively.

7th Exercise
Call the style from Chapter 3 section 3.1 and con‐
struct a seam allowance of 10mm and a hem allow‐
ance of 40mm to the back with the parallel function.
Close the corners at the hem with Hem Corner 80. All
other corners are to be closed with the Angle Corner
50.

Chapter 5

Easy line functions

___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Content
5.1
5.2
5.3
5.4
5.5
5.6

Linking lines .............................................................................................................................. 56
Raster........................................................................................................................................ 60
Lengthening and shortening lines ............................................................................................ 62
Cut, ‘cut on’ and separate lines ................................................................................................ 63
The tool Front edge 30 ............................................................................................................. 65
Exercises ................................................................................................................................... 66

56

Chapter 5 Easy line functions

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

5.1

Linking lines

End

The link menu
The link menu is opened from the basic
menu. It allows for the linking of lines or the
joining of lines by a curve.

2.

Link menu

Begin
End

link single ▪ chain ▪
reset link step
deposit

reset

Link 20 tool

start the tool automatically

Begin

1.
Picture 5‐1

Picture 5‐1 shows the linking of two lines with single
or chain. Beginning and end of the lines are deter‐
mined by the right principle. For further information
read the explanations in sections 4.6.
Picture 5‐2 shows linking of two lines which are not
touching with a straight line. Here, also, the right
principle is to be followed.
Begin

End

Linking lines (connect with each other)
Step‐by‐step guide

2.

 Activate the option single or chain
 Click the lines to be linked following the right

principle
 Correction (several possible) by clicking reset link
step
 Terminate linking with deposit
The top four buttons are used for linking lines by
bridging the gaps between the lines with a straight
line.
Linking lines is required when two or more lines are
supposed to be treated as one during further con‐
struction steps.
First you have to choose between the options single
or chain. With chain all tangential lines (without kink)
will be linked automatically in one operation. At the
beginning, the simpler option single is recom‐
mended.
Reset link step resets the individual linking opera‐
tions step‐by step. The link operation is terminated
only with deposit and treated as one construction
step in the record.
The end of the already linked lines (= basic line) is
linked to the beginning of the clicked line. For the
determination of direction the right principle ap‐
plies.

1.

End
result: one line
Begin
Picture 5‐2

Further functions
With reset the last construction step can be undone.
The interactive link tool Link 20
Step‐by‐step guide
 Call Link 20 tool
 Click on the two lines to be linked or click on two
positions of a line to be shaped, following the
right principle
 Construct the start and end point.
 Double‐click on the new continuous line
 Adjust the options
 Interactively design the curve
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The options define
 whether start/end of the connecting piece is to
be moved along the original lines or whether
one/both of the original lines are to be replaced
completely (Picture 5‐3),
 whether the basic direction of the connecting
piece at beginning/end is identical to the origi‐
nal lines or free and
 whether the base points can be moved in mm
or in %.

If the cursor takes the shape
at these points,
they can be moved along the corresponding line.
Dashed extensions with little points at the begin‐
ning/end of the curve are direction handles ‘2’. If the
cursor takes on the shape
at these points, the di‐
rection can be dragged.
2

1

1
4

1 – base points
2 – direction handle

3

2

4

3 – shape point 1st priority
4 – shape point 2nd priority

Picture 5‐4

There are one or three shape points between two
neighbouring base points:
 one shape point 1st priority ‘3’, displayed as a
slightly larger red point and
 possibly two shape points 2nd priority ‘4’, dis‐
played as small red points.

Picture 5‐3

The shape of the connecting piece and the additional
directions at its beginning/end can be interactively
adjusted, see explanations in the following section.
The interactive co‐ordinated link tool Link 30
With Link 30 two lines are connected and synchro‐
nized twice simultaneously.
The connecting piece of the first two lines has a
higher priority than the second connecting piece. Al‐
terations to the first connecting piece apply to both
connections. However, alteration to the second con‐
necting piece apply to the second connection only.
Therefore, adjust the first connecting piece first and
then adjust the required asymmetry for the second
connection.
Adjusting an interactive curve using the example of
the tool Link 20
The same principles apply to the adjustment of
curves in all interactive constructions. These princi‐
ples are now explained using the example of tool
Link 20, see also Picture 5‐4
Base points ‘1’ are positioned at the beginning and
end of the curve, marked by a point and a red circle.

The position of the shape points is controlled via two
values: a value in percent for the position of an im‐
aginary line between the two base points and a sec‐
ond value for the distance to the imaginary line. The
second value is usually measured in millimetres. The
zero position of the shape points is normally 50% and
0mm.
The above objects have the following priorities:
Base points

Direction handle

Shape point 1st priority

Shape point 2nd priority
Priority means that the objects of lower priority are
changed with the alteration of objects of higher pri‐
ority, but not the other way around. Moving base
points alters the position of the shape points and re‐
sults in direction changes, if the direction depends
on the base point.
Important: Always start adjusting the objects with
the highest priority.
If these principles are applied to the tool Link 20, the
following step‐by‐step guide for adjusting the con‐
necting piece is recommended (Picture 5‐5):
1. Initial state: It is possible to link two lines or to
design a single line in a particular area.
2. The Link 20 tool is called. The two small black
points indicate beginning and end of the new
linking piece. These are exactly the positions,
which were clicked.
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3. The two base points at beginning and end of the
section can be moved along the original line.
4. and 5. The required curve direction is adjusted at
both base points.
6. The shape of the curve is roughly adjusted with
the shape point 1st priority.
7. The shape of the curve can be finely adjusted
with the shape points 2nd priority.

Exercises
1st Exercise
Call the basic block Bodice 10. Create parallels to the
4. link
single

2. link
chain

If you want to adjust an interactive curve subse‐
quently, first set the shape points back to the zero
position by selecting raster 10 for example and drag‐
ging the points to 50% /0. Then, set the raster value
back to 0 or 1 and adjust the curve to your require‐
ments. Always start with the objects of the highest
priority.

1. link
single

1.
2.
3.

4.

5.

5. Link 20
tool

3. link
chain
Picture 5‐6

6.

7.

Picture 5‐5

armhole and the shoulder with 10mm distance. Link
the following lines (Picture 5‐6):
 the side seam with link single
 the armhole with link chain
 the hem line with link chain
 the parallels to armhole and shoulder with link
single
 the centre front with the hem with the Link 20
tool
Always click on the right side of the line in the direc‐
tion of travel. If you have made an error, click reset
link step (several times if required) and then, con‐
tinue. Terminate linking by clicking deposit
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2nd Exercise
Call the basic block Skirt 20 and create the following
parallels
 30mm from the hem outside
 40mm from the centre front outside
 100mm from the centre front inside with the
tool Parallel 10
 200mm from the hem inside

Picture 5‐8

Picture 5‐7

Link the centre front and the hem with the tool
Link 20 and construct further parallels of 10mm to
the hem and the centre front on the outside respec‐
tively. Then, construct the displayed corner with the
function corner (Picture 5‐7).

4th exercise
Call the basic block Skirt 20 and adjust a straight side
seam interactively. Construct the following parallels:
 10mm to the centre front, waist and side seam
from hem to hip
 30mm to the hem
 20mm to the side seam from waist to hip
Link the side seam with the Link 20 tool and close the
other displayed corners with the corner function
(Picture 5‐9). Adjust the linked connection interac‐
tively.

3rd Exercise
Call the basic block Skirt 20 and adjust a straight side
seam interactively. Construct the following parallels:
 30mm to the centre back to the outside for vent
width
 20mm to the centre back to the outside for con‐
cealed zip
 10mm to the side seam, centre back and waist
for seam allowance
Construct the displayed corners and then, link the
centre back with Link 20 according to Picture 5‐8. Ad‐
just the corners and the linked connections interac‐
tively. Grade in different sizes.

Picture 5‐9
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5.2

Raster

The raster menu
The raster menu offers functions for the
construction of point sequences. The point se‐
quences are generated along a line.
Raster menu
rastern 0 ▪ convert to line

+/‐copy ▪ reset

Raster 20 tool
Picture 5‐10
start the tool automatically

The functions raster 0
In Grafis each line is a polygon (see section 4.3). With
raster 0 the fulcrums of a line are displayed. On a
straight line this would be the starting and final
point. An example for a curve is shown in chapter
4.3.

With the Raster 20 tool point sequences are con‐
structed, which can be adjusted subsequently re‐
garding position and number of points.
The only option of this tool (Picture 5‐10) decides
whether the point distance is determined by the po‐
sition of the last point or vice versa.

Step‐by‐step guide
 Activate the raster 0
 Set +/‐copy
 Click on the line, following the right principle

1

Convert to line

3

The convert to line function is the reverse function to
the raster functions. Activating convert to line and
clicking a point sequence creates a line from the
point sequence. Here, also the +/‐copy switch ap‐
plies.

4
1

+/‐copy, reset

2

With the +/‐copy switch you decide whether or not
the original object remains existent. When changing
a line into a point sequence with
+copy
both line and point sequence are
existent,
‐copy
only the point sequence is existent.
With reset the last construction step is undone.

3

4

The interactive Raster 20 tool
Step‐by‐step guide
 Call Raster 20 tool
 Click on a line
 contruct the start and end point
 Double‐click on the new point sequence
 Adjust the options
 Interactively design the point sequence (Pic‐
ture 5‐10).

2

5

distance to the
base line
number
of
points
start of point
sequence from
beginning of
the line
depending on
option: point
distance or dis‐
tance of the
last point to
the end of the
base line
angle to the
base line
5

Picture 5‐11
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Exercises
1st exercise
Call the basic block Bodice 10 and construct the fol‐
lowing in the front:
 The fulcrums of the neckline. Set the switch to
+copy to retain the original line.
 A total of five equally distributed points on the
outer shoulder.
 A total of 8 points for buttons. The 1st point is
situated 20mm from the neckline. The last but‐
ton is placed at a distance of 180mm from the
hem.
2nd exercise
Call the basic block Skirt 20 or the exercise from sec‐
tion 5.1 and construct a button stand at the centre
Picture 5‐13

4th exercise
Call the basic block Bodice 10 and place paired but‐
tonholes on the centre front. A total of 8 button pairs
are to be created with a distance of 60mm between
the pairs. The first button is positioned 20mm from
the neck on the centre front. The distance between
the two buttons in a pair is 15mm (Picture 5‐14).
Construct the paired buttonstand with two point se‐
quences and the following settings with the Ras‐
ter 20 tool:
35mm
 distance to the top 20mm
8
 number of points 8
60mm
60mm
 distance

Picture 5‐12

front with the Raster 20 tool. The first button is to be
situated 20mm from the waist. A total of 6 buttons
with a distance of 60mm are to be placed, see Pic‐
ture 5‐12.
3rd exercise
Call the basic block Skirt 20 or the third exercise from
section 5.1 and construct a button stand on the cen‐
tre back from the hem. The first button is to be
placed 20mm from the hem. A total of 4 buttons with
a distance of 40mm are to be positioned, see Pic‐
ture 5‐13.

Picture 5‐14
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5.3

Lengthening and shortening lines

The lengthen menu
The lengthen menu contains functions for
lengthening and shortening lines at the ends (linear).
These functions are especially significant for the ad‐
justment of line lengths such as side seams, body
seams and crotch seams.

Exercises
1st exercise
Call the basic block Bodice 10 and construct a parallel
of 30mm to the centre front. Lengthen the neckline
Lengthen by 30mm linear

Lengthen menu
lengthen to…
length
lengthen by…
length
reset

Lengthen by 30mm linear
Picture 5‐16

Step‐by‐step guide
 Enter the length value for the alteration under

lengthen by or lengthen to
 Activate lengthen by or lengthen to
 Click the line to be altered, following the right

and the hem line linear by 30mm. Follow the right
principle when clicking (Picture 5‐16).
2nd exercise
Call the basic block Bodice 10 and construct a parallel
of 100mm to the hem lines.

principle
Type of length alteration
With linear the line is lengthened straight at its end
or shortened along the line (Picture 5‐15). The end of
the line is determined according to the right principle
when clicking.
Lengthen to and lengthen by
With lengthen to a line is lengthened linear to the
pre‐set length. The required length is pre‐set accu‐
rately.
With lengthen by a line is lengthened (positive value)
or shortened (negative value) linear by a given
amount, see Picture 5‐15.
linear
lengthen by L=10

Picture 5‐17

linear
lengthen by L=‐10

Picture 5‐15

Then, lengthen
 the shoulder by 30mm
 the armhole by 20mm
 the centre front, centre back and side seam by
100mm
Follow the right principle when clicking (Pic‐
ture 5‐17).
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3rd exercise
Call the basic block Bodice 10 and shorten the centre
front, centre back and the side seams by 50mm. Use
lengthen linear by –50 and follow the right principle
when clicking (Picture 5‐18). Then, move the hem
line by 50mm with the parallel function using
‐copy.

Separate menu
click cutting line ▪
cutting line from point
separate ▪ cut

separate in corner

+/‐cut mark

reset

Separate/cut at a cutting line

Picture 5‐18

5.4

Cut, ‘cut on’ and separate lines

The separate menu
Cutting and separating lines can be called
from the basic menu via separate.
Separate divides a line into two lines which touch at
the separation position and can be processed indi‐
vidually. If the cut mark switch is set to +cut mark the
separation position is marked by a large point.
Cut shortens or lengthens a line up to the intersec‐
tion. Lengthening is called ‘cut on”. Reset resets the
last separation or cutting operation respectively.
separate
 2 Lines
cut/cut on
 1 Line

Separating or cutting with a cutting line is the accu‐
rate option. First, a cutting line is to be determined.
One or several lines can be separated or cut with it.
The top four buttons of the separate menu relate to
separate with cutting line.
First, the cutting line is to be defined. Grafis offers
two options:
1. With click cutting line an existing line is deter‐
mined as cutting line.
2. With cutting line from point the first point of the
cutting line is constructed and the other point is
defined freehand by moving the mouse.
cutting line

separate with cutting line
cut with cutting line
and ‘cut on‘

The separate/cut position can be determined in
three different ways.
Step‐by‐step guide
Separate or cut at a cutting line
 Define/construct a cutting line with click cutting

line or cutting line from point
 Activate separate or cut
 Adjust +/‐cut mark
 Click lines to be separated or cut

Separate in a corner
 Activate separate in corner
 Adjust +/‐cut mark
 Click the corner in which the lines are to be sepa‐

rated outside

Picture 5‐19

The current cutting line is displayed in a different
colour. Whether to cut or separate with this cutting
line is determined by activating the appropriate
function cut or separate.
1. With separate with cutting line the clicked line is
divided at the intersection with the cutting line
provided the two lines intersect. Practise this op‐
tion with +cut mark. The separation position is
marked by a point and thus easier to recognise.
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2. With cut with cutting line the part of the line be‐
yond the cutting line in respect to the click posi‐
tion disappears. The click point defines the part
of the line to remain existent. Result of this oper‐
ation is one line, only.
It is not absolutely necessary for the cutting line
and the line to be cut to intersect. A line ending
before the cutting line is lengthened up to it
when cutting with cutting line. This is known as
‘cutting on” amongst Grafis operators. ‘Cutting
on’ is possible to a maximum of 500mm.
The different options are depicted in Picture 5‐19

Exercise
Call the basic block Bodice 10 and construct 5 paral‐
lels each to the hem at a distance of 50mm. Cut the
parallels along the side seam (Picture 5‐21). Please

Define the side seam as cut‐
ting line, cut the parallels to
the hem on the right!

Separate in a corner
This function separates a continuous line in a corner.
The respective curve is to be clicked on the outside
as Grafis separates at a point where an imaginary
lightning would strike (lightning principle). As a result
a small arrow is shown at the separation position for
a short while (Picture 5‐20).

Continue with
the side seam in
the same way.

Picture 5‐21
click point
*
separation
position

Picture 5‐20

Further functions
The cut mark switch decides whether or not a marker
is to be set when separating lines. As a rule, use +cut
mark, as it is easier to recognise the separation posi‐
tion. A cut mark is a point with the attribute big point
(see section 7.6). The cut markers can be deleted as
points.
Reset can undo the last construction step.

note that clicking defines the side for cutting off. Er‐
rors can be corrected with reset. Continue and re‐
move also the pieces of the parallels from the dart.

The dart lines become
cutting lines. First, sepa‐
rate the parallels and
then, cut.

Continue with
the back in the
sane way.

Picture 5‐22

Define the first dart line as the cutting line and sepa‐
rate initially. Then, define the other dart line as the
cutting line and cut (Picture 5‐22).

Chapter 5 Easy line functions
65
___________________________________________________________________________________________
© Friedrich: Grafis – Textbook, Edition 2017

5.5

The tool Front edge 30

All three front edge tool varia‐
tions require three or four
lines:
 the neck line
 a continuous line for the
centre front
 a hem line and
 a reference line for the
revers point

Switch between high
collar and revers

Adjustments for de‐
signing the neckline

Designing the front
edge

The tool Front edge 30 is suita‐
ble for high collars and for re‐
vers collar constructions.
Call Bodice 50 and interac‐
tively shorten the hem. Then,
call the tool Front edge 30
from the Grafis‐Support pro‐
grams. Click exactly on the re‐
quested lines, following the
right principle. If you require
this construction for the right
front panel of an asymmet‐
rical style development, call
the front edge from Grafis‐Support programs (mir‐
rored).
First, the options must be adjusted (Picture 5‐23).
The first option, high collar or revers construction, is
important. This option defines the buttonstand con‐
struction, starting at the neckline or at the clicked
reference line. Only in case of
a high collar construction, fur‐
ther options for shaping the
neckline are available. The
options for designing the but‐
tonstand are similar to the in‐
teractive Raster 20 tool. A fur‐
ther option for double‐
breasted fronts is available.
After all options have been
adjusted, the interactive ad‐
justments in the three drag
areas ensue.

Options for designing
the buttonstand

Picture 5‐23

In the first drag area Overlap (Picture 5‐24 left) the
indicated drag points define the corner points for the
contour. All other drag points help adjusting the
curves, see section 5.1. In the second drag area Front
point (Picture 5‐24 centre) the indicated points de‐
fine the contour.

Picture 5‐24
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Picture 5‐25

All other points help designing the curve. In the third
drag area Buttons (Picture 5‐24 right) the indicated
points define the position of the button stand. The
bottom point can adjust the button stand at an an‐
gle. All other points are as in Raster 20 tool.
Adjust the front edges displayed in Picture 5‐25 in‐
teractively.

5.6

Exercises

1st Exercise
From the basic block Skirt 20 construct a skirt with
gathering. Call Skirt 20 and insert the lines of the
front skirt into a further part in the part organisation.
Construct a parallel of 30mm for the overlap.
Lengthen the hip line and hem line by 250mm. Move
the side seam by 250mm with parallel using ‐copy.

Then, construct a button stand on the centre front.
A total of 6 buttons are to be set. The first button is
positioned 20mm from the waist and the last button
100mm from the hem. Set the gathering symbols
once you have worked through Chapter 7.
2nd Exercise
From the basic block Skirt 20 construct a skirt with
vent in the side seam and an overlap with button
stand. The vent height is 200mm, vent width is
30mm, overlap and hem are 30mm and all seam al‐
lowances are 10mm. The first button is to be posi‐
tioned at 20mm from the waist. A total of 8 buttons
with a distance of 65mm are to be placed.
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3rd Exercise
Construct five pin‐tucks in the front of basic block
Bodice 10. First, delete the waist dart. Create the first
parallel at a distance of 40mm to the centre front.
The other four pin‐tucks should be positioned at a
distance of 10mm from the first pin‐tuck. Link the
neckline with the shoulder with link single. This gives
you a continuous cutting line. Construct the cut away

5th Exercise
Open the style ‘Straight skirt’ from Chapter 2 Section
2.4. Construct five parallels at a distance of 70mm to
the hem and five further parallels at a distance of
40mm to the centre front and centre back. Create
the displayed pattern with corners.

Construct a seam allowance of 10mm and close the
perimeter with link (waist) and corners.

with the tool Link 20. Cut the parallels at the hem,
the neckline and at the shoulder with the separate
function.
4th Exercise
Call the basic block Bodice 10, link the hem lines in
the front and in the back and create a parallel of
40mm to the centre front, centre back and the hem.
Cut the parallels at the side seam and at the waist
darts. Use the separate function.
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6th Exercise
Call the basic block Bodice 20 and construct parallels
to the centre front and centre back at a distance of
40mm to the inside and further five parallels at a dis‐
tance of 10mm to the new parallel lines. Cut the par‐
allels at the hem, neckline and at the shoulder. Con‐
struct an overlap of 40mm to the centre front and
the displayed seam allowance of 10mm with the tool
Front edge 30. Close the perimeter with the corners
function.

shoulder, the armhole, the side seam, the hem and
the centre back with link single respectively. Create
a co‐ordinated corner (120/80mm) with the Corner
50 tool. Construct a sequence of 6 points on the cen‐
tre front, starting 40mm from the neckline at a dis‐
tance of 75mm between points. Create parallels for
pin‐tucks. The first pin‐tuck is to be positioned 50mm
from the centre front. The other pin‐tucks are placed
at a distance of 15mm. Cut the pin‐tucks at the neck‐
line and the shoulder. Construct an overlap of 40mm
and close the corners of the overlap.
Save the style as ‘Blouse with pin‐tucks’.
8th Exercise
Call the basic block Bodice 50. Open a new part in the
part organisation and call the Front part 20 tool into
the new part. Switch the options to princess seam.
Construct an overlap with the tool Front edge 30 and
adjust an overlap breadth of 20mm and a one button
line with 4 buttons. The distance for the opening is
120mm from the base neck line.

Adjust the position of the buttons of Front edge 30
to create 8 buttons with a distance of 60mm respec‐
tively. The first button is positioned 20mm from the
neckline. The other points are generated with the
Raster 20 tool using the following parameters: 8 but‐
tons, distance 60mm, 35mm from neckline. This re‐
sults in a point pair with a distance of 35mm – 20mm
= 15mm, see also 4th exercise in section 5.2. Close
the perimeter with corners.
7th Exercise
Open the style ‘Shirt blouse’ from Chapter 2 Section
2.5 and delete the points on the centre back, the
waist dart and the auxiliary lines. Link the lines of the

Adjust the shown (pictured) front point in the tool
Front edge 30, whereas you start with the option ad‐
justment. Insert the pattern pieces into new parts of
the part organisation and construct the seam and
hem allowance with the functions parallel and cor‐
ner.
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6.1

Line construction in conjunction with
the sub‐menu point construction

Grafis works with the construction objects point and
line. For the construction of these objects, the sub‐
menus point and direction construction are of partic‐
ular significance. The sub‐menu point construction is
explained in the following using the example of line
construction with line from point to point.

6.1.1 Point construction with click p, click l, free‐
hand and the free mode
Construct line on existing points with click p

Line from point to point
Step‐by‐step guide
 points and lines
 Activate line from
point to point
 Construct the first
point
 Construct the sec‐
ond point
This function constructs a
line between two points.
Having called the func‐
tion, the sub‐menu point
construction opens for
the construction of start‐
ing and final point.
It is not necessary to attach the line to existing point
objects! The position of starting and final point of
the line is determined with the point construction
sub‐menu.
Significance of point construction

Picture 6‐1

Step‐by‐step guide
 points and lines → line from point to point
 Activate
(in the following click p)
 Click on the first point
 Click on the second point
During grading, a point set with click p is always at‐
tached to the clicked point. Activate click p and move
the cursor over the pattern. A fine thread originating
from the cursor (thread cursor) and a green circle
mark the position for the new starting or final point
of the line after . In this case, the thread cursor
points at existing points, only, see Picture 6‐1.

Point construction determines the position of the
point in the base size and all other sizes.
Therefore, it is important to reflect for each con‐
struction step which option of the point construction
is the most appropriate for the specific step. On a line
of 100mm length, points constructed at 20% and
20mm are placed at exactly the same position. When
the length of the line changes, the two points are po‐
sitioned at different locations.

P

P

38

34 ‐ 46

Picture 6‐2

Construct a line from the hip point to the centre front
with click p and grade in sizes 34, 38 and 46 (Pic‐
ture 6‐2).
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Construct a line on existing lines with click l
Step‐by‐step guide
 points and lines → line from point to point
 Activate
(in the following click L)
 Click on the first point
 Click on the second point

Construct a line in the free mode and with freehand
point
Step‐by‐step guide
 points and lines → line from point to point
 Deactivate an active button if applicable, Pic‐
ture 6‐4
 Click the first point
 Click the second point

Picture 6‐3

With click l a point is constructed on a line, at the po‐
sition on the line closest to the cursor. During grad‐
ing, this point is moved relative to the length of the
line. With this type of construction, it is important to
check the base line: it should not be linked unneces‐
sarily across corners. A point on the side seam is
graded differently if the side seam is linked with the
hem. In this case, the point is graded relative to the
length of the linked side seam and hem.
Activate click l and move the cursor over the pattern.
The thread cursor will point to the nearest line, re‐
spectively. The colour of the line also changes, see
Picture 6‐3. Pressing <Shift> selects the starting
point or final point of the line.

Picture 6‐5

The free mode is active if no button is pressed in the
dialogue. In the free mode, the point constructions
click p, click l and freehand point are active, simulta‐
neously. The point constructions click p and click l
have already been explained. A freehand point can
be set as soon as the cursor has taken on the shape
. Freehand points are placed in the same posi‐
tion for all sizes. Freehand points should be avoided
and used under special circumstances, only as they
contain no grading information.

L

P

38

38

34‐46

34 ‐ 46

L

Picture 6‐6
Picture 6‐4

Construct a line from the end of the dart to the hem.
Set the starting point using the <Shift> key. Grade in
sizes 34, 38 and 46 (Picture 6‐4).

Set the free mode (see Picture 6‐5) and construct a
line according to Picture 6‐6. The starting point is set
onto the hip point with click p in the free mode and
the final point is set as a freehand point. Grade in
sizes 34, 38 and 46 (see Picture 6‐6).
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Exercises on point construction with click p, click l
and the free mode
1st Exercise
Call the Bodice 50 and con‐
struct a line from the bust
dart to the front pitch. Use
the free mode for the point
construction with <Shift> or
directly with click p. Construct
a second line from the centre
front/neckline to the bust
dart. Use <Shift> in the free
mode. Grade in sizes 38 to 46.
Picture 6‐9

2nd Exercise
Call the Skirt 20 and construct
Picture 6‐7
an inverted pleat with a depth
of 60mm in the centre back using parallel and line

P

6.1.2 Point construction with relative length and
partial length
Construct a line onto an existing line with relative
length rlg
The variation relative length rlg generates a point at
the relative length of a line. The relative length in %
relates to the total length of the line. The right prin‐
ciple must be followed when clicking the line, as the
relative length is measured from the beginning of the
line.

L

Step‐by‐step guide
 points and lines → line from point to point
 Activate
(in the following click rlg)
 Click on the first point
 Click on the second point
Setting a point at a relative position can ensue in
three different variations:
Picture 6‐8

1. Free value, no raster

from point to point and a separate pleat back, see
Picture 6‐8.
3rd Exercise
Call the Skirt 10 and construct two panel seams start‐
ing at the waist, ending at the corner side seam/hem.
Use the free mode or click l, directly in conjunction
with <Shift> for the point construction. Grade in sizes
38 to 46, see Picture 6‐9.

Picture 6‐10
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2. Free value, with raster

Construct further panel seams using the three varia‐
tions introduced above.
Construct a line onto an existing line with partial
length plg
As opposed to click rlg, click plg generates a starting/
final point at the partial length of a line. Here also,
the right principle must be followed as the partial
length is measured from the beginning of the line.
The length is displayed at the cursor.

Picture 6‐11

Step‐by‐step guide
 points and lines → line from point to point
 Activate
(in the following click plg)
 Click on the first point
 Click on the second point
Setting a point at a partial length ensues in three dif‐
ferent variations, as with click rlg:

3. Fixed entered value

1. Free value, no raster

Picture 6‐12

X, g and z values can be entered as rlg (see Chapters
11 and 12). A fixed entered value can be deleted with
.
Construct a panel seam with line from point to point
(Picture 6‐13). The panel seam starts at the waist at
50% of the first part of the waistline from the centre
front and ends at the hem at 30%. Grade in sizes 34,
38 and 46.

Picture 6‐14

2. Free value, with raster

rL
50%

Picture 6‐15
38

34‐46

30%

rL
Picture 6‐13
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3. Fixed entered value

rlg
25%
plg
140mm

Picture 6‐16

Picture 6‐18

X, g and z values can be entered as plg (see Chapters
11 and 12). A fixed entered value can be deleted with
.
Construct a panel seam in the basic block Skirt 20
with line from point to point. The panel seam starts
at the waist at 100mm from the centre front and
ends at the hem at 130mm from the centre front.
Grade in sizes 34, 38 and 46 (Picture 6‐17).

2nd Exercise
Call the Trouser 60 and construct a panel seam in the
front and back trouser leg. The panel seam starts at
inside leg seam at 240mm from the hem and ends at
the side seam at 30% from the hem. Use click rlg and
click plg for the point construction. Picture 6‐19.
Grade in sizes 36 to 46.

plg
100mm

38

rlg
30%

34‐46

plg
240mm

130mm

plg
240mm

plg
Picture 6‐17

Construct further panel seams using the three varia‐
tions introduced above.
Exercises on point construction with click rlg and
click plg
1st Exercise
Call the Bodice 50 and construct a yoke in the back.
The yoke starts at 25% of the armhole from the
shoulder and ends at the centre back at 140mm from
the neck. Use click rlg and click plg for the point con‐
struction. Grade in sizes 36 to 46.

Picture 6‐19

6.1.3 Point construction with intersection
Construct a line with the intersection of two lines
Step‐by‐step guide
 points and lines → line from point to point
 Activate
(in the following intersection)
 Construct the first point
 Construct the second point
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Using intersection generates a starting/final point at
the intersection of two lines or curves. The lines
and/or curves are to be clicked one after the other.
when the first line is to be
The cursor displays
clicked and
when the second line is to be clicked.
The first clicked line is highlighted in colour. During
, a green circle appears when touching the
stage
second line at the point of intersection created after
. An intersection is also constructed if both lines in‐
tersect only in their extension of 500mm maximum.
Ensure that the lines will actually intersect after
grading. If the 500mm limit is exceeded, a warning
appears.
Construct a line from the end of the dart to the cor‐
ner point centre front/hem with line from point to
point. Construct starting and final point with inter‐
section. Grade in sizes 34, 38 and 46 (Bild 6‐20).

Exercises on point construction with intersection
Call the Bodice 50 and construct panel seams in the
back according to Picture 6‐21.

Picture 6‐21

Set the starting and final points with intersection.
Grade in sizes 36 to 46.
6.1.4 Point construction with xy co‐ordinates
Construct a line with xy co‐ordinates

38

34‐46

Bild 6‐20

Construct further panel seams with intersection.

The position of xy points relates solely to the co‐or‐
dinate origin, see section 4.3. The points are not
linked to any objects of the construction. They re‐
main in the same position during grading. xy points
should be used for ‘zero run constructions’ in con‐
junction with construction parameters, only (see
Chapters 11 and 12).
Step‐by‐step guide
 points and lines → line from point to point
 Activate
(in the following xy point)
 Construct the first point
 Construct the second point
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Setting a point at absolute co‐ordinates can ensue in
three different variations as for click rlg and click plg:

3. Fixed entered value

1. Free value, no raster

Picture 6‐24
Picture 6‐22

2. Free value, with raster

X, g and z values can be entered as x and y co‐ordi‐
nate (see Chapters 11 and 12). A fixed entered value
can be deleted with
.
Construct a rectangle of 120mm width and 160mm
height with line from point to point. The lower left
corner point is to be the co‐ordinate origin. Use the
raster. Grade in sizes 34, 38 and 46 (Picture 6‐25).
X=0
Y=160

X=120
Y=160

X=0
Y=0

X=120
Y=0

Picture 6‐23

Picture 6‐25

The rectangle will have the same position and same
measurements in all sizes. Grading information can
be related with the use of construction parameters
(Chapters 11 and 12).
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6.2

Point construction

The points and lines menu
The points and lines menu can be called from the
basic menu, directly. The points and lines menu con‐
tains four options for the construction of a single
new point. Indirectly, new points can also be created
from existing points via move, turn or mirror trans‐
formations, see Chapter 10.
Points and lines menu (extract)
single point

P

point at a distance toa base
point on a line (short: p+d on l)
distance value
point between two points on
a line (p+rel+p on l) ▪ point
between two points (p+rel+p)
relative value

6.2.1 Single point
Step‐by‐step guide
 points and lines
 single point
 Construction of the point with the point con‐
struction sub‐menu
Call the Bodice 50 and
construct a point on the
front neckline at a partial
length of 10mm from the
centre front for the collar
position, Picture 6‐26.
Call the Bodice 30. Con‐
Picture 6‐26
struct a parallel to the
bust line and to the centre front with the Parallel 10
tool. Set the parallel interactively to 50mm. Con‐
struct a point at the intersection of the two parallels.
Then, delete the two parallels. The parallels remain
interactively adjustable even after deletion via
<F12>. Call the Pocket 10 and bind the pocket to the
constructed point, Picture 6‐27.

Picture 6‐27

6.2.2 Point at a distance to a base point on a line
Step‐by‐step guide
 points and lines
 Enter the distance value
 Activate the function Point at a distance to a
base point on a line (short: p+d on line)
 Construct the base point with the point con‐
struction sub‐menu
This function constructs a new point on an existing
line with a fixed distance to an existing point. The en‐
tered distance is measured along the line and consid‐
ered also during grading. The right principle must be
followed when clicking the line.
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In Picture 6‐28 two
75mm
new points were con‐
structed for a pocket
140mm
in the side seam of
Skirt 20, using single
point and p+d on line.
The first point on the
side seam is con‐
structed as a single
point at a partial
length of 75mm. Ac‐
tivate the menu op‐
tion single point in
the points and lines
menu and construct
Picture 6‐28
the point at 75mm
with click tlg.
For the second point first enter the distance value
140. Clicking on p+d on line opens the point construc‐
tion sub‐menu for selection of the base point. Use
the free mode or click p. Then, the base line is to be
clicked, following the right principle. The right princi‐
ple defines the direction in which the distance is to
be measured.

6.2.3 Point between two points on a line
Step‐by‐step guide
 points and lines
 Enter the relative value
 Activate the function point between two points
on a line (short: p+rel+p on l)
 Construct the first base point
 Construct the second base point
 Click the base line
The new point is constructed on the base line at a
relative position between two base points. The dis‐
tance between the base points is measured along
the line.
As opposed to the example in Picture 6‐28 the new
points in Picture Picture 6‐30 were constructed at a
relative length position. For the point on the centre
front enter the relative value 70. in the points and
lines menu. Clicking on p+rel+p on l opens the sub‐
menu point construction to define the two base

70%

70%

Picture 6‐30
100mm

100mm
38

42

Picture 6‐29

If the base point is not positioned on the base line,
the construction starts at its perpendicular point to
the base line. In Picture 6‐29 the bust point is the
base point. The new point is constructed at a dis‐
tance of 100mm from its perpendicular point onto
the centre front.

points between which the new point is to be con‐
structed. Click the waist point and then the hip point
on the centre front with click p. With this succession
you define that the distance is measured from the
waist. After having clicked the base line, (here: cen‐
tre front) the new point is constructed. Should the
base points not be placed on the base line, their per‐
pendicular points onto the base line are used.
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6.2.4 Point between two points

6.3

Step‐by‐step guide
 points and lines
 Enter the relative value
 Activate the function point between two points
(short: p+rel+p)
 Construct the first base point
 Construct the second base point
The new point is constructed at a relative position
between two base points. No base line is required.
The position is determined relative to the first base
point.
In Picture 6‐31 three new points are constructed
with the function p+rel+p in the basic block Bodice
10. For the bisector of the bust dart enter the relative
value 50. After having clicked on p+rel+p and the two
final points of the dart line, the new point is con‐
structed. The centre point on the waist line of the
front was placed in the same way. The third point is
constructed by first linking the hem line and then,
defining the relative value as 33.3.
50%

Line constructions

The points and lines menu
The different construction principles for the creation
of line objects with the functions of the points and
lines menu form the subject of this section. A further
line construction in conjunction with direction con‐
struction is the subject of the following section.
Points and lines menu (extract)
line from point to point ▪
horizontal line ▪
vertical line
freehand line from point ▪
perpendicular onto a line
reset

Line 10 tool ▪ Line 20 tool

start the tool automatically

6.3.1 Line from point to point and Line 20 tool
This principle has already been used to explain the
sub‐menus point construction in section 6.1.
Step‐by‐step guide
 points and lines
 Activate line from point to point
 Construct first point
 Construct second point

50%

With line from point to point a line is constructed be‐
tween two points. After having called this line con‐
struction the sub‐menu point construction is opened
for construction of the starting and final point of the
line.

33.3%

Picture 6‐31

Clicking on p+rel+p and the end points of the hem
line constructs the point. The succession in which the
points are clicked determines the direction from
which the 33.3% are measured.
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6.3.2 Line 20 tool
The Line 20 tool also constructs a line from point to
point. However, as opposed to the function line from
point to point this line can subsequently be moved
interactively and if required it can even be released
from its base line.
In the trouser back of Trouser 10 construct a line for
the pocket mouth using the tool Line 20. Construct
the line starting at the endpoints of bisector of the
two darts respectively. In the options of Line 20

The functions horizontal line and vertical line con‐
struct horizontal or vertical auxiliary lines. After
having activated the respective function the
starting point of the line is to be defined and then
a second point is to be determined for calculation
of the final point. For calculation of the final point
with horizontal line the x co‐ordinate of the sec‐
ond point is applied, with vertical line the y co‐
ordinate is used.
horizontal line

final point for
horizontal line

vertical line
final point for
vertical line

Picture 6‐32

switch the option ‘release base points‘ to permitted.
Now move the base points interactively by 20mm
away from the dart points and lengthen the lines in
both directions by 20mm. Then, grade in the sizes
N40, N42 and N44, see Picture 6‐32
6.3.3 Horizontal and vertical lines
Step‐by‐step guide
 Activate the function horizontal line or vertical
line
 Construct the starting point of the line
 Determine auxiliary point for calculation of the fi‐
nal point

Picture 6‐33

In Picture 6‐33 the following was constructed in basic
block Bodice 20
 a horizontal auxiliary line from the corner point
neck/ shoulder to the final point of the shoulder
and
 a vertical auxiliary line from the corner point
shoulder/neck to the front pitch.
Having clicked horizontal line, the corner point neck/
shoulder is clicked in the free mode with <Shift> and
then, the end point of the shoulder or the front pitch
is clicked with click p or again with <Shift>.
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6.3.4 Freehand line from point

6.3.5 Perpendicular onto a line

Step‐by‐step guide
 Activate the function freehand line from point
 Construct the starting point
 Determine the final point freehand

Step‐by‐step guide
 Activate the function perpendicular onto a line
 Construct the starting point
 Click the line onto which the perpendicular is to
be dropped

This function creates a line with a fixed length in any
direction. Length and direction are constant
throughout all sizes. Freehand line is particularly suit‐
able for horizontal, vertical or oblique auxiliary lines.
In Picture 6‐34 a total of four lines were constructed
with freehand line. After having activated freehand
line the starting point of the line is to be defined with
the point construction sub‐menu. Length and direc‐
tion of the line can then be determined by moving
the cursor freehand. The preferred directions hori‐
zontal and vertical act like a magnet, the line ‘jumps”
to these directions.

Picture 6‐35

With perpendicular a perpendicular is dropped from
a point onto a line. After having activated the func‐
tion perpendicular the starting point is to be deter‐
mined, first. Then the line onto which the perpendic‐
ular is to be dropped must be clicked. The perpendic‐
ular takes on a right angle to the clicked line.

auxiliary lines
constructed
with
freehand line

33%

33%
Picture 6‐34

Construct all lines depicted in Picture 6‐34 in the
style ‘Straight skirt’ from Section 2.4. The lines can
be extended to the side seam or cut off at the waist
with separate. Grade sizes 40 and 44.

Construct the perpendiculars in basic block Bodice 10
shown in Picture 6‐35:
 the perpendicular from the bust point onto the
centre front
 the perpendicular from the bust point onto the
side seam
 the perpendicular from the darts onto the hem
in front and back
 the perpendicular from the back pitch to the
centre back and
 the perpendicular from 50% of the neckline
onto the hem.
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Exercises
1st Exercise
Call the basic block Bodice 20 and construct the fol‐
lowing lines, see Picture 6‐36:
 from the corner shoulder/armhole onto the
centre front, measured 60mm from the neck
 from the corner shoulder/armhole onto the
centre back, measured 60mm from the neck
 the perpendicular from the respective pitches
onto the centre front and centre back
 from the intersection of the side seam and the
waist to the centre of the lower sections of the
centre front and centre back. Note: the centre
front and centre back are separated at the
waist.

3rd Exercise
In the style ‘Straight skirt’ from Section 2.4 construct
a parallel to the hem at a distance of 200mm respec‐
tively in the front and back skirt. Construct 7 equally
distributed points on the hem and 13 equally distrib‐
uted points on the parallels to the hem. Construct
the lines according to Picture 6‐38. Use the function
line from point to point.

Picture 6‐38

Picture 6‐36

2nd Exercise
In the style ‘Straight skirt’ from Section 2.4 construct
vertical panel seams starting at 33.3% of the hem,
measured from the centre front or centre back. Use
the function freehand line and cut the two lines at
the waist, see Picture 6‐37.

4th Exercise
In the style from section 2.4, construct the following
lines:
 from the hip point on the centre front and cen‐
tre back to the middle of the hip curve, respec‐
tively
 from 33% down the side seam, measured from
the hip point, to the hip point on the centre
front and centre back
 from 33% down the side seam, measured from
the hip point, to the corner point hem/centre
front and hem/ centre back according to Pic‐
ture 6‐39.

50%

33%

Picture 6‐39

Picture 6‐37
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6.4

Line with direction construction

The interactive tool Line 10 and the sub‐menu direc‐
tion construction

derived direction

With the interactive tool Line 10, the user can create
a line object with specific direction. The direction
construction ensues via its own sub‐menu, which au‐
tomatically appears for other construction purposes,
also, similar to the point construction sub‐menu.

difference angle

Points and lines menu (extract)
basic direction

Line 10 tool ▪ Line 20 tool
start the tool automatically

guide circle

The direction construction sub‐menu is required for
the following operations for example:
 construction of a line, to be adjusted parallel to
another line,
 construction of curves and
 adjustment of symbols.
Step‐by‐step guide for Line 10 tool
 Call Line 10 from the points and lines menu
 Construct the base point
 Adjust the line with the direction construction
sub‐menu (set base direction, adjust difference
direction)
 End the direction construction with the right
mouse button
 Interactively adjust the line (line length, possibly
moving of base point, possibly altering the line
direction)
 End the interactive adjustment with End in the
right menu

Picture 6‐40

The direction construction ensues in two steps:
1. Set the basic direction
2. Set the difference angle
Exactly these steps are repeated during automatic
grading. As a result the derived direction is con‐
structed:
derived direction
=
basic direction + difference angle

Explanantion of the direction construction sub‐
menu
In Grafis, the direction construction is called auto‐
matically if required by the operation. The guide cir‐
cle is an important element of the direction construc‐
tion. It works like a protractor. The arrow inside the
guide circle indicates the basic direction and corre‐
sponds with the base line of the protractor. The ele‐
ments of the guide circle are shown in Picture 6‐40.

basic
direction
derived direction

Picture 6‐41

In Picture 6‐41 a line is constructed at a right angle
to the centre back.

84
Chapter 6 Point, line and direction construction
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

applies. Use the <Shift> key if the starting/ final
direction of the line is required.
This function is active when opening the direction
construction.

Setting the basic direction
Step‐by‐step guide
 Set a fixed direction in the
entry field next to
or
 activate
and click
on a line or
 activate
line direc‐
tion at the base point and
possibly selection of a base
line or
 activate
and construct two points.

3.

Line direction at the base point

The basic direction is set with the upper group of
functions in the direction dialogue. There are four
construction principles available:
1.

Fixed direction

Picture 6‐44

The basic direction is taken exactly at the base
point of the guide circle from the nearest line. If
more than one line are positioned in the vicinity,
a prompt appears. In this case, the cursor is dis‐
played as a question mark and the base line is to
be clicked:

This function should be used for setting symbols
and construction of curves to ensure that the
basic direction is taken exactly where the curve
or the symbol is attached.

Picture 6‐42

A fixed direction value in degrees can be entered
into the field to the right of the button Fixed di‐
rection. Entry of x, g and z values is not permitted
for the basic direction. Clicking on the button ‘0°’
resets the basic direction to 0°.
2.

4.

Direction from point to point

Direction at click point
The basic direction is set parallel to a line/ curve
to be clicked. The direction of the line/ curve at
its click position according to the right principle

Picture 6‐45

The basic direction is determined by the con‐
struction of two points. It is set parallel to the di‐
rection from the first point to the second point.

Picture 6‐43
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Setting the difference angle
After having set the basic direction, the derived di‐
rection is to be set. The derived direction, in the
shape of a long line, first points in the direction of the
basic direction (see Picture 6‐40). It is changed by al‐
tering the difference angle to the basic direction.
This process corresponds with measuring an angle
on an adjusted protractor.
The difference angle is set with the functions in the
lower section of the direction dialogue with the fol‐
lowing options:
 Entry of difference angle or
 click on + and – next to the entry field or
 click on the guide circle with or without the use
of raster.
Increase/de‐
crease the dif‐
ference angle
by the current
raster value

current
difference
angle

set difference
angle to 0°
raster on/off

raster value
Picture 6‐46

The difference angle is adjusted interactively by
dragging the derived direction or by clicking the
guide circle. If raster is active, the difference angle
changes according to the set raster value. Entry of x,
g and z values for the difference angle is permitted
(see Chapters 11 and 12). Clicking on
sets the

derived direction back along the basic direction. To
quit the direction construction menu press .
Demonstration of the basic direction
Call the basic block Bodice 10 and construct lines one
after the other with the tool Line 10. Use a different
construction principle for the basic direction for each
line. Grade in sizes 34 to 52, respectively.
A) Using the interactive tool Line 10, construct a line
with basic direction 45° and difference angle 0°
(Picture 6‐47 A). Grade.
B) Using the interactive tool Line 10, construct a
line. Determine the basic direction with click l
onto the upper end of the armhole line, using the
<Shift> key. The difference angle remains 0°.
Grade (Picture 6‐47 B).
C) Using the interactive tool Line 10, construct a
line. Activate the base point button. The differ‐
ence angle remains 0°. Drag the base point inter‐
actively along the armhole line. Grade
Use ‘line direction at base point’ for setting
notches with a difference angle of 90°. The notch
always points at a right angle to the line inde‐
pendent of its position.
D) Using the interactive tool Line 10 construct a line.
The basic direction should correspond to the di‐
rection from start to end of the armhole line in all
sizes (Picture 6‐47 D). Activate direction from
point to point. The first point is the point at the
side seam. It can be clicked in the free mode. The
second point is the upper end of the armhole line
at the shoulder, selected using the <Shift> key.
Drag the base point interactively along the arm‐
hole line. The difference angle remains 0°. Grade.

45°

A

B

C

D
Picture 6‐47
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Exercise with interactive tool Line 10 in conjunction
with the difference angle
1st Exercise
Call the Bodice 50 and construct a yoke in the back.
The yoke starts at a right angle to the centre back,
120mm from the neck. Extend the yoke line interac‐
tively to the armhole and then cut at the armhole
Picture 6‐48. Extending the line is important as the
regular intersection search for function separate
searches up to 500mm extension. If the intersection
is positioned outside this area, a warning appears.

3rd exercise
In the Bodice 20, construct a yoke at a right angle to
the centre back (in the following CB), starting on the
CB at 80mm from the neckline. Extend the line to the
armhole and then, construct 4 evenly spaced points.
Construct two spread lines parallel to the CB (Pic‐
ture 6‐50 right). Use the Line 10 tool with a length
value of 600 and click the starting point of the spread
line in the free mode. Set the basic direction parallel
to the CB with direction at click point. Follow the
right principle and determine the basic direction
neckline → hem.

120mm

Picture 6‐48

2nd Exercise
Call Skirt 10 and construct two panel seams starting
at 50% of the waist line respectively, adjusted at a
right angle to the base point. Extend the lines to the
hem and cut them at the hem (Picture 6‐49.

50%

50%

Picture 6‐49

Picture 6‐50

The derived direction equals the basic direction.
Therefore, leave the difference angle at 0°, press
and the spread line appears on the screen. Grafis will
repeat these steps in all sizes, so that the spread lines
always run parallel to the CB. Cut the spread lines at
the hem line.
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6.5

contructed. The clicked periphery point is exactly in
the middle of the new circle arc. (Picture 6‐48).

Circle arcs

The Circles and rectangles menu
The circles and rectangles menu is called from the
basic menu. It allows for construction of circles and
rectangles.
Circles and rectangles menu
Circle 10 tool ▪ Circle 20 tool

Exercise on constructing circle arcs
In the style ‘Straight skirt’ from Section 2.4 construct
a panel seam at 33.3% from the centre front and the
centre back, extend the lines to the waist. Then, con‐
struct a point on the panel seam 200mm from the
hem. The two circle arcs are constructed with Circle

Rectangle 10 tool ▪ Rectangle 20 tool

The Circle 10 tool
When calling Circle 10, the centre point and a basic
direction for the circle are to be constructed. Radius
and size of the circle segment can be adjusted inter‐
actively.
Step‐by‐step guide
 Click on Circle 10 tool
 Construct the centre point for the circle
 Contruct the base direction, in which the circle
should be contructed.
 Radius adjust interactively
Clicking Circle 10 tool opens the sub‐menu point con‐
struction with which the centre point for the circle
can be determined. The basic direction for the circle
is to be constructed with the direction construction
sub‐menu. The radius of the circle can be adjusted
interactively.
The Circle 20 tool
Step‐by‐step guide
 Click on Circle 20 tool
 Construct the centre point for the circle
 Construct the periphery point
circle arc out of centre point cp
and periphery point p:
p

Picture 6‐52

20. The centre point is the new point and the periph‐
ery point is the intersection between the panel seam
and the hem, respectively.

6.6

Rectangles

The Circles and rectangles menu
Construction of rectangles also ensues with the cir‐
cles and rectangles menu, see section 6.5.
The tool Rectangle 10 and Rectangle 20
Step‐by‐step guide
 Click on Rectangle 10
 Construct the starting point
 Construct the base direction or the right lower
corner of the rectangle
 Enter the width and height or adjust interactively

height=
+50.0

starting point

width=+100.0
Picture 6‐53

cp

When calling Rectangle 10 the lower left corner and
the direction of the base line are constructed. Height
and width of the rectangle can be adjusted interac‐
tively (Picture 6‐53).
Picture 6‐51

Clicking circle 20 tool opens the sub‐menu point con‐
struction with which the centre point for the circle
can be determined and the periphery point can be
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When calling Rectangle 20 the left and right corner
of the rectangle are constructed. The width of the
rectangle results from these points. The height of the
rectangle is interactively adjustable (Picture 6‐ 54).

Complete the pocket flap as shown in the next pic‐
ture by deleting the auxiliary lines, curving the cor‐
ners with a radius of 10mm and creating a parallel of
5mm all the way around.

height=+30
starting point
final point
Picture 6‐ 54

Both interactive rectangles can be reshaped to a tra‐
pezium.

6.7

3rd exercise
In the Bodice 20 construct a yoke starting 100mm
from the neck on the centre back. The line is to run
at a right angle to the centre back. Cut the line at the
armhole.

Exercises

1st exercise
Construct a 160mm wide and 180mm high pocket.
Create a corner with straight line at the two bottom
corners with a distance of 30mm before and after

Construct a further line of 50mm length on the yoke,
starting at 40% from the centre back. Construct the
two other connecting lines.

the corner. Construct a parallel of 40mm to the up‐
per edge and drop a perpendicular from the centre
of the parallel onto the bottom edge.
2nd exercise
Construct a pocket flap from a 160mm wide and
60mm high rectangle by lengthening the base line to
the right and left by 10mm respectively. Construct an

auxiliary line of 25mm length vertically downwards
from the centre of the base line and construct the
displayed auxiliary lines.

4th exercise
In Bodice 10 construct the four lines shown at a right
angle to the respective dart lines of bust dart and
back shoulder dart.
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5th exercise
From the style ‘Straight skirt’ from Section 2.4 con‐
struct a skirt with separate godets. The godet height
is 200mm from the hem. The angle of the godets is
+/‐35° from the panel seams.

Use the interactive tools Parallel 10, Circle 20 and
Line 10. Thus, godet height and godet angle can be
altered interactively at a later date.
6th exercise
From the style ‘Straigth skirt’ from Section 2.4 con‐
struct a skirt with spread lines. Construct an auxiliary
line in the front skirt for a yoke, starting at 150mm
on the centre front and ending at 80mm on the hip
curve, measured from the waist. In the same way,
the line in the back skirt is to start at 150mm on the
centre back and to end at 80mm on the hip curve.

Create a total of 6 equally distributed points on the
yoke line and drop perpendiculars from the four in‐
ternal points onto the hem.

7th exercise
In the style ‘Straight skirt’ from Section 2.4 construct
a grown‐on godet at the centre front with a height of
200mm and an angle for the godet of 35° to the cen‐
tre front. Link the godet and the centre front with
Link 10 tool. Construct a seam allowance of 10mm
and at hem of 30mm. Close the corners.
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7.1

E - distance from an arbitrary point on the armhole
to the right bust dart leg

The temporary measure

B=60
A=76
C=75

E=42

Picture 7‐1

Temporary measure is opened via the pull‐down
menu Extras, with the shortcut <Ctrl>+M or via the
toolbox (Picture 7‐1). It is used for temporary meas‐
uring during pattern development. Grafis also offers
a recorded measurement function, which is dis‐
cussed in the next section.

D=40

Step‐by‐step guide
 start measure from the Extras pull‐down menu or
from the toolbox
 select a measurement type from the central
block of functions
 click on the objects of the construction
 set the display options for the active measure‐
ment
Distance measurements

Picture 7‐2

The position of each measurement can be altered by
clicking and dragging. Close measure.
Length measurements
There are four length measurements:
length of a single line

There are five distance measurements:
length of several lines
direct distance
partial length of a line
horizontal distance
perimeter length
vertical distance
perpendicular onto an imaginary line
between two points
distance from a point to a line
The different measurement type modes are well il‐
lustrated by the button symbols. The numbers indi‐
cate the order of clicking. When clicking, the sub‐
menu point construction opens automatically.
Measure the distance measurements indicated in
Picture 7‐2 on Bodice 10
A - dart content of the bust dart
B - neck width
C - neck depth
D - perpendicular distance from the sleeve pitch to
the connection between shoulder point and side
seam

Measure the length measurements indicated in Pic‐
ture 7‐3 on Bodice 10.
A - length of front width
B - total length of the four waist lines
C - partial length of the side seam between waist
and hip lines
D - length of the perimeter lines of the back
When setting measurement B, length of the four
waist lines, start with the line at the centre front and
click the four lines underneath, see Picture 7‐3. Al‐
ternatively, start with the centre back and click the
individual lines above. As the number of lines is vari‐
able, the measurement is only shown after a right
mouse button click . Position the measurements
suitably. Then, close measure.
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the future perimeter contour! Until the measure‐
ment has been set with , individual lines can be re‐
set with
reset single lines
Measure the area of the front and back of Bodice 10
using search lines for area perimeter automatically
(no picture). sets the measurement.

A=190
D=197

Internal partial areas can be deducted from an area
measurement. The partial areas must be marked be‐
fore the measurement is set.
Measure the area of the back of Bodice 10 without

B=380
C=61

Picture 7‐3

Area measurements
139968mm²

An area measurement can be set in two different
ways:
select single lines for perimeter of area
search lines for area perimeter auto‐
matically
Measure the area of Bodice 10 depicted in Picture 7‐
4 by clicking the single lines for the perimeter.

2.
3.

1.

2.
4.

3.

4.

A=5375mm
²

1.
Picture 7‐5

the area of the waist dart. First, define the outer con‐
tour of the back. A new partial area to be deducted
from the original area begins with

5.

start new partial area

Picture 7‐4

Click the five lines from the outside in order. After
having clicked the last line, press to set the meas‐
urement. A closed perimeter is created automati‐
cally from the clicked lines. Protruding lines are cut
off. The click point of the first line must be within

Then, click the four lines of the waist dart. Please
note the order (Picture 7‐5). Set the measurement
or define a new area to be deducted with
with
start new partial area.
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Angle measurements

Co‐ordinate/Vector measurements

There are four angle measurements:

The co‐ordinates/vector measurements measure
point co‐ordinates relating to the co‐ordinate origin
or to another constructed point. The change of these
point co‐ordinates correspond to the grade rules in
common grade rule grading.

angle between two lines at click point
angle at intersection point
angle about a turning point from a basic
direction to a point

A co‐ordinate/ vector measurement can be set in
two ways:
co‐ordinate/ vector from zero (origin)

angle out of three points
co‐ordinate/ vector from constructed
zero point

line direction in click point
Measure the angles in Bodice 10 shown in Picture 7‐
6.
A - angle between back neck and centre back at
20mm from corner respectively
B - angle between shoulder and armhole
C - shoulder angle for back shoulder
D - angle between dart legs of the shoulder dart
E - direction of the armhole in the sleeve pitch; As
there are two lines in the vicinity of this point,
the desired line must be clicked after having de‐
fined the point.
The measurement type line direction in click point is
useful if the construction direction /orientation of a
curve or a line is needed.

Grade Bodice 10 in different sizes and stack it at the
corner point neck/centre front (Picture 7‐7). Set a
measurement co‐ordinates from constructed zero
point. First, the zero point is constructed at the cor‐
ner point neck/centre front. The second point is the
corner point shoulder/neck. The x component of the
measurement shows the width of neck and the y
component indicates the depth of neck.

A=60/75

D=12.8°

C=10.8°

A=96.9°
B=94.0°

Picture 7‐7

Display measurements in a table
display measurements in a table

E=107.3°

All set measurements can be displayed in a table.
Measurements of a graded stack are shown in all
sizes. The table can be printed or copied to the clip‐
board.
Picture 7‐6

There are three display options:
normal view
difference to first size
relative difference/difference to the pre‐
vious size
sort measurements
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If a co‐ordinate/vector measurement is set in a
graded stack, the third display option shows the
grade rules between the sizes.
Options for measurements
Clicking selects a single measurement. With <Ctrl>+A
and <Ctrl> a number of measurements can be se‐
lected. <Del> deletes all selected measurements.
The following display options can be chosen for se‐
lected measurements:
normal or more number of
decimals
display of normal, doubled 2x
or quadrupled 4x value
In the pull‐down menu Settings units for length/ dis‐
tance and area can be seleted amongst others.
Set chain measurement
If a number of measurements are selected they can
create a chain measurement:
create chain measurement from a
number of selected measurements
Set four measurements for the length of the individ‐
ual waist lines of Bodice 10. Select all four measure‐
ments with pressed <Ctrl> key and use the button
chain. The measurement E is created as a sum of the
four individual measurements, see Picture 7‐8.

De‐activate doubling 2x for the individual measure‐
ments and select doubling 2x for measurement E
only.

7.2

Finished measurements

The record function dimension sets meas‐
urements which are saved with the style as opposed
to measure (section 7.1). Finished measurements are
automatically calculated for all sizes and the results
are stored in finished measurement tables. These are
significant for creating style descriptions, finished
measurement tables and other documentation. They
can be plotted together with the pattern.
First, the record function dimension is discussed. The
display of Finished Measurement Tables follows.
Set and alter measurements
The record function dimension can be found in the
menu on the right. Finished measurements can be
set in the active part. Manipulation of setting and al‐
teration of the measurements is identical with ma‐
nipulation of temporary measuring in section 7.1.
The following differences to temporary measuring
apply:
 The display of the measurement text in the pat‐
tern has been optimised for plot output.
 Additional display options are available.
 The measurement can be assigned a measure‐
ment designation or measurement code at
point of setting already. This designation will
appear in the finished measurement table.
 All measurements are given consecutive meas‐
urement numbers at entry: M1, M2, M3,... .
Display options
Alteration of the display options are applied to all se‐
lected measurements. The displayed state shows the
setting of the first selected measurement.

E=380

Show/hide…
A=82

B=116

C=91

D=91

measurement number, e.g. M01 or M07
measurement value in the respective size
measuring lines
measurement
description

Picture 7‐8

Now, select the four measurements A to D and set
the tick for 2x. The four individual measurements
have been doubled. Thus, E now indicates the cir‐
cumference.

code

measurement description

or

individual
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Settings
flip measurement text
about the measuring line
accuracy and multiples of
the value
enter individual designa‐
tion or select standard
designation
measurement text height
between 2 and 100mm
retake single
measurement

selected

Measurement code and measurement text
Each measurement can be assigned a standard
measurement designation, consisting of code and
measurement text or an individual measurement
designaiton with
. Both code and measurement
text appear in the finished measurement table.
When assigning a standard measurement descrip‐
tion the measure group is to be selected, first. Then,
select the measurement description. If Show graphic
is checked a graphic ‐ if available ‐ with explanations
about the measurement is opened. With double‐
click or <OK> the measurement description is ac‐
cepted.

Picture 7‐9

The set measurements are bound to points (click p)
or lines (click l, click plg, click rlg, intersection). If
points or lines of a measurement are deleted during
pattern development, Grafis gives an undefined
measurement after the next test run. You then have
the option to set the measurement again or delete
it.
Exercise
Open the 2nd exercise from section 5.6. Skirt front
and back are contained in separate parts, Pic‐
ture 7‐10.

Show and hide finished measurements
As long as the dimension menu is not open, set meas‐
urements can be shown or hidden with <F7>. Quit
the dimension menu with
, grade and press <F7>
a few times.
Pattern development after set measurement
After having set measurements, the pattern can be
developed further without restrictions. Hide the
measurements with <F7>. They are updated after
each test run or grading.
Set some measurements in a construction according
to Picture 7‐9. Then, lengthen the skirt by moving the
hem parallel with ‐copy and extend the centre front,
centre back and the side seams with separate or cor‐
ners. After test run, the respective measurements
are updated, as long as the measurements had been
attached to the line with click l and <Shift> and not
to the points. In the latter case set the measure‐
ments again with measurement: retake and click l
with <Shift>.

Picture 7‐10

Set the following measurements in the skirt front:
 M01 length of front section of the waist line.
Measure the length with the measurement
type partial length of a line
 M02 length of the lateral section of the waist
line
 M03 ’wSav’ hem width front skirt, again with
the measurement type partial length of a line
 M04 ’wHüv’ hip width
 M05 ’wTav’ chain measurement from M01 and
M02
 M06 length of vent as a vertical measurement
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In the skirt back set the measurements M01 ‚wTah’
waist width, M02 ‚wHüh’ hip width, M03 ‚wSah’ hem
width as well as the skirt length along the centre
back.

The order of sizes in the finished measurement table
originally corresponds with the order in the size ta‐
ble. To list the sizes of the size run use button:
sort sizes

Display finished measurement table
The finished measurements
are recorded and can be re‐
peated for other sizes. Grade
the construction measured
according to Picture 7‐10 in
the sizes 40, 42, 44 and 46,
quit the finished measure‐
ment menu and open the Fin‐
ished Measurement Table
from the Finished Measure‐
ments pull‐down menu. The
Grafis Finished Measurement
Spec window is opened as
shown in Picture 7‐11.
Each part has its own finished
measurement table. You can
switch to the finished meas‐
urement table of another part
with the file card tabs. The
style from Picture 7‐10 has finished measurements
in parts 3 and 4. The part name appears as a tooltip
on the file card tabs.
The measurements are arranged in lines and the
graded sizes in columns. The first column contains
part and measurement number. T3M4 stands for
fourth measurement in part 3. The arrangement of
rows/columns can be swapped with
swap rows and columns
The second column contains the measurement unit.
The third and fourth columns show the measure‐
ment designation (code and text). The following col‐
umns contain the measurement values in the availa‐
ble sizes. The position number in the size table is
stated in the first row and the size designation in the
second row.
Change the display of the finished measurement ta‐
ble via the pull‐down menu View → Display options.
Change the measurement units as well.
There are three display options:
normal view
difference to first size
relative difference/ difference to the previ‐
ous size

Picture 7‐11

For a single meaurement selected in the table you
can adjust the following:
The measurement is cen‐
tred on the screen. Thus,
it is easier to find in the
pattern.
Alter the measurement
code or the individual
measurement designa‐
tion.
Copy the displayed table to the clipboard via Edit →
Copy. Now, start a different Windows application
such as Word for Windows or Excel and insert the ta‐
ble from the clipboard. If you have already created
templates or forms in these applications, seam
length calculations or other calculations can be
solved quickly.
With Edit → Copy measurement into the calculated
finished measurement table or <Ctrl>‐B a selected
measurement is transferred into the calculated ta‐
ble.
In the style from the exercise shown in Picture 7‐10
transfer the measurements M03 to M06 from the
front skirt and M01 to M04 from the back skirt into
the calculated finished measurement table with
<Ctrl>+B.
Deleting finished measurements can only be done
via the function dimension.
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Calculated finished measurement table
Finished measurements from
different parts of a style are
combined in one table in the
calculated finished measure‐
ment table, see Picture 7‐12.
Finished measurements from
different parts can be calcu‐
lated together to establish a
circumference measurement
across different parts for exam‐
ple. The following additional
functions are available for cre‐
ation and editing of calculated
measurements:

Picture 7‐12

create a new calculated
measurement at the end of
the table
delete selected measurement
enter calculation formulae for
the measurement

double‐click

… onto the measurement in
the construction transfers it
into the active calculation for‐
mulae
centers the construction to
the measurement selected in
the formulae, here T1M4:

The fomulae for a calculated finished measurement
can be created with the arithmetic signs for addition,
subtraction, multiplication and division + ‐ * /. Ex‐
pressions in brackets are also permitted.
With Edit → Move measurement up or Move meas‐
urement down you can alter the order of the meas‐
urements in the calculated finished measurement ta‐
ble.
<Ctrl>+ 
<Ctrl>+ 

alter order of measurements

New measurements are initially a ‘number‘ without
measurement unit. Please note that internally, eve‐
rything is calculated in mm, mm² and °. Any conver‐
sion to the required measurement unit ensues after
value output in the table.
Alter the finished measurements transferred from
parts 3 and 4 according to Picture 7‐12 and create a
finished measurement table with the following
measurements of your style: skirt length, waist width
as circumference, hip width as circumference, hem
width as circumference and vent length.

7.3

Set and edit text

The text menu
This menu can be called from the basic
menu, directly by clicking on texts. It allows
for entry, editing, positioning and adjustment of
texts. The functions offered are sufficient for pattern
annotation or entry of making‐up instructions. They
cannot be compared to a word‐processing package.
Text menu
via keyboard ▪ via file

activate text ▪ copy text

delete active text ▪ delete all text

align left ▪ align centred ▪ align
right
+/‐ grading ▪ +/‐ autom. direction
+/‐ frame ▪ +/‐ autom. size

user‐defined text formats

set text formats
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Step‐by‐step guide for entry of new text
 basic menu → texts
 Click on via keyboard
 Enter text and/or specific information
 Quit text entry with clicking on OK or Cancel
 Position the text
 Manipulate the active text according to the ‘Step‐
by‐step guide for alteration of text’
 Quit with

The application of this function is especially interest‐
ing for pattern annotation with standard text.
via keyboard
After having pre‐positioned the text (Picture 7‐13)
the window for entry of new text opens.

Step‐by‐step guide for alteration of text
 basic menu → texts
 Click the text
 Alteration of text content:

 double‐click on the text
 alter the text
 quit with OK or Cancel
 Alteration of text position:
 drag as soon as the cursor
appears
 possibly: bind the text position onto the con‐
struction with the upper left corner of the text
frame
 Alter text alignment:
 drag the upper text frame as soon as the cur‐
sor
appears.
 possibly: bind the direction onto the con‐
struction with the upper right corner of the
text frame
 Alter text size
 drag the text frame as soon as the cursor
appears.
 Alter text format:

 click aligned left, align centred or aligned right
in the menu
 Set the switch +/‐grading
 Set the switch +/‐frame
Enter or activate text
The active text is surrounded by a solid frame with
active points. Existing text is activated by clicking.
This works within the text menu, only. Double‐click
on a text opens the window for text entry. All func‐
tions in the middle of the function strip relate to the
active text, only. A new text is set with:
via file
After having clicked via file the position for the text
is to be set, first (Picture 7‐13). Then, a window for
selection of prepared text masks opens. Prepared
texts should be saved on the current drive in the di‐
rectory \GRAFIS\TEXTE as ___.TXT files. ASCI text
files are permitted, only.

Picture 7‐13

Additionally, the following text blocks with specific
information can be inserted by clicking the buttons:
Display in text editor:
{F 1...}
date
time
{F 2}
Grafis version
{F 3.......}
size name
{F 4...}
collection
{F 5...}
style
{F 6...}
part number
{F 7}
part name
{F 8..................}
measurement system
{F 9.......................}
In Chapters 11 and 12 you will learn about x, g and z
values. These numerical values as well as the previ‐
ously discussed finished measurements can be in‐
serterd into text:
Display and significance in
text editor:
X value
{X00.2} Second x value of the
(active part)
active part.
Global x value
{XG01} First global x value
Z value
{Z05 }
Fifth z value of the ac‐
tive part
Measurement
{M04 } Fourth measurement
(active part)
of the active part
Calculated mea‐ {B1.3} Third
calculated
surement
measurement in the finished
measurement table
After OK the text is accepted and can be positioned,
aligned and altered in size.
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Position and align text
To position the text drag the text as soon as the cur‐
sor
appears (Picture 7‐17). The text is posi‐
tioned and remains in this position in all sizes.
Only after binding the text onto a line of the con‐
struction will its position change during grading. For

With bound direction point the text is also aligned
along an existing line. The direction tag is located at
the upper right corner of the text frame. It appears
only after the text has been bound according to Pic‐
ture 7‐16. As soon as the cursor takes on the shape
of the pin
near the upper right corner the text
direction can be bound (no picture). In the different
sizes the text is rotated about the angle the connec‐
tion between the binding points is rotated.
Text size and format
Adjust the text size with the active points according
to Picture 7‐17. Near these active points the cursor
takes on the shape of a double arrow
.

Picture 7‐14

binding the text the active point at the upper left cor‐
ner of the text frame can be used. As soon as the cur‐
sor
in the shape of a pin appears the text can be
bound onto a line (Picture 7‐15).
Picture 7‐17

Text of more than one line can be aligned left, right
or centred. This format relates to the alignment of
lines, only. The format for the active text is to be se‐
lected from the menu.

Picture 7‐15

To align the text freehand the text is to be dragged
at the upper right frame. As soon as the cursor takes
on the shape
the text can be rotated freehand
with pressed left mouse button (Picture 7‐16).

+grading or ‐grading
With this switch you decide whether or not the ac‐
tive text is graded.
‐grading
text appears in base size, only
+grading
text appears in all graded sizes
Text with +grading is displayed slightly lighter than
text with ‐grading.
+frame or ‐frame
With this switch you decide whether the active text
is displayed with or without frame.
Copy and delete text
After having selected copy text from the menu the
text to be copied is to be clicked. The copy is to be
postioned according to Picture 7‐13. NB: Text can
also be copied from an inactive piece into an active
piece. The menu functions delete active text and de‐
lete all text are used to delete text.

Picture 7‐16
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Prepared text format and automatic direction and
size adjustment
Clicking on of the ten prepared text formats (004 to
121 with delivery) assigns the active text with the re‐
spective settings. The text formats can be edited via
set text format.
With the switch +autom. direction you decide
whether the direction of the text is changed accord‐
ing to the direction point during grading. When bind‐
ing the direction point, the switch is automatically
activated.
With +autom. size the direction point is also respon‐
sible for enlarging/reducing the text during grading.
This ensures that the text is not positioned outside
the perimeter in small sizes.
Prepare and switch texts in different languages
A text module can be stored in different languages.
The text module must be saved as a *.txt file in Ger‐
man in the directory GRAFIS\TEXTE\049\ and in Eng‐
lish in the directory GRAFIS\TEXTE\044\. The file
name must be identical in both directories.
A prepared text module is called via the menu func‐
tion from file. Switching languages ensues via the
pull‐down menu Finished measurements | Language
for measurements. If the desired language is not
available, it can be entered in the file
\GRAFIS\Masscode.dat. The designated number is
the international access code, e.g. 049 for German
and 044 for English. When switching the language,
the text content is automatically recreated accord‐
ing to the contents of the text module file. Possible‐
individual alterations to already set texts are reset.
Alterations to the text module can be incorporated
into styles in this way.

7.4

Set symbols

The symbols menu
With the functions from this menu sym‐
bols can be set onto points or lines in any
direction. If the symbol is not to lie on the construc‐
tion line it can be moved to the seam allowance with
on allowance, later. The available symbols are listed
in the lower part of the menu. The active symbol is
highlighted.
Symbols menu
place on
symbol length
move on allowance...
at right angle ▪
in symbol direction ▪ +/‐copy
change symbol
slit notch (N1) ▪ drillhole ▪
grain line

notch ▪ pitch ▪ v notch (N2)
buttonhole ▪ arrow *=> ▪ cross
circle ▪ arrow =>* ▪ .CF
CB ▪ drillhole plotted ▪ scissors
repeat point weft ▪
repeat point warp ▪ text label
reset
Grain line 10 tool ▪
Convert into notch tool
Start the tool automatically

Setting a new symbol
Step‐by‐step guide
 basic menu → symbols
 Activate the symbol required
 Enter length of the new symbol
 Activate place on
 Construct position for the new symbol
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Note

Grain line 10 tool

The function ‘on allowance’ is always active. For
each new symbol the function ‘place on’ has to be
clicked!

From version 11 onwards, the very flexible interac‐
tive Grain line 10 is available. The length of the grain
line can be set. Alternatively, the grain line can be
lengthened to a cutting line to be selected, see Pic‐
ture 7‐19. The length of the grain line results from
the intersection with the cutting line. The direction
of the grain line as well as the lateral relocation can
be altered interactively.

Set a new symbol select the symbol from the lower
part of the menu. If the symbol is required in a length
different from the default length (Picture 7‐18) the
symbol length must be altered. With place on the
symbol can be at‐
tached to a point or a
line. Then, the direc‐
tion
construction
sub‐menu is opened
Picture 7‐18
for orientation of the
symbol. Symbols are treated as line sequences dur‐
ing further work. A placed symbol can be changed
into another symbol with change symbol. There are
no functions available for the alteration of size or di‐
rection of symbol, later. In this case the current sym‐
bol is to be deleted and a new symbol is to be set.

Step‐by‐step guide:
 Call Grain line 10 from the symbols menu
 Construct the base point
 Adjust the direction of the grain line with the sub
menu direction construction
 Quit direction construction with the right mouse
button
 If necessary, click a cutting line. Clicking the cut‐
ting line can be initiated in the interactive envi‐
ronment at a later stage.

Moving a symbol
Step‐by‐step guide
Prerequisite is a line onto which the symbol is to be
moved.
 basic menu → symbols
 Adjust +copy or ‐copy
 Activate on allowance
 Activate at right angle or in symbole direction
 Click the symbol
Frequently, a symbol, e.g. a notch, is to lie on the
seam allowance rather than the construction line.
The function on allowance is always active and the
symbol to be moved can be clicked, directly.
Grafis then asks for the seam allowance onto which
the symbol is to be moved. With the switch
+/–copy you decide whether a copy of the symbol is
created or whether the symbol is simply moved.
+copy
creates a copy of the symbol
‐copy
symbol is moved.
If relocate symbol at right angle is active, the symbol
is moved to the seam allowance line at a right angle.
If relocate in symbol direction is active, the symbol is
moved to the seam allowance line in the run of the
symbol direction.

Picture 7‐19
 Interactive adjustment of the grain line (length of

grain line, direction, lateral relocation). If a cut‐
ting line is required but has not been selected al‐
ready, select click cutting line in the context
menu.
 Quit interactive adjustment with End in the menu
on the right
The tool Convert into notch
With the Convert into notch tool, existing short lines
of up to 10 mm length can be converted into
notches. Follow the right principle when clicking the
line, the line is converted into a 5 mm long slit notch.
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7.5

Manufacturing symbols

As opposed to the symbols described in
section 7.4, the manufacturing symbols can consist
of multiple line elements and their shape may vary.
Notch 10 plays a special role, it does not generate an
independent object, but change the shape of the
line.
Menu manufacturing symbols
Seam 10 ▪ Seam 20 ▪ Seam 30

In the pattern pieces, the interactive seam symbols
should not be positioned outside the piece perime‐
ter or intersect the perimeter!
Otherwise, these seam symbols are integrated into
the perimeter and /or an error message appears dur‐
ing preparation for transfer to the layplan.
Overview over the interactive seam symbols
Seam 10
lockstitch
Seam 20
double lockstitch

Seam 40 ▪ Seam 50 ▪ Bartack 10
Button 10 ▪ Button 20 ▪
Button 20
Button 40
Notch 10 ▪ Notch 10 (v‐typ)
Notch 20 ▪ Notch 30
Perforation 10 ▪ Perforation 20 ▪
Perforation 30

Seam 30
zigzag stitch

Seam 40
decorative stitches

Marking line 10

Grain line10

start the tool automatically ▪ reset

The manufacturing symbols are not detected as
symbol objects during export and print/plot. Within
the pattern pieces, manufacturing symbols must
not be positioned outside the piece perimeter or in‐
tersect the perimeter.
Interactive Seam Tools
From Version 10, five additional interactive seam
symbols are available. As opposed to the symbols
from section 7.4, the seam symbols have no further
significance in the layplan or during data export.

Seam 50
gather
Step‐by‐step guide for setting interactive seam sym‐
bols






basic menu→ manufacturing symbols
Select seam symbol
Click on one or up to 45 lines
Click on Exit
Activate one of the new seam symbols with dou‐
ble‐click
 Adjust the options
 Interactive adjustment of stitch distance and
possibly stitch width
 End interactive adjustment with End
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Significance of the options and drag cursor
The first option determines the shape of the seam
symbol. The middle option in Picture 7‐20 deter‐
mines whether the seam width is to be adjusted in‐
teractively or set as a fixed inch value.
stitch shape

stitch interactively
adjustable or
as fixed inch value

inch value for
stitch width

Significance of the reference line, options and the
drag cursor
After having positioned the symbols, a reference line
can be clicked. Thus, all symbols are aligned parallel
to the reference line. The difference angle is then set
interactively.
symbol shape

symbol length
interactively adjustable
or as fixed inch length

inch value
for symbol length

Picture 7‐20

For the interactive adjustment of the seam symbols,
there is exactly one drag area in which the stitch
width, the distance to the base line and the length of
the seam symbol can be adjusted interactively, see
Picture 7‐21.
3

Picture 7‐22

With the first or first two options the shape and po‐
sition of the symbol is selected. The middle option in
Picture 7‐22 determines whether the length of the
symbol is to be adjusted interactively or set as a fixed
inch value.

1

1
2

3

1
1
2
3

distance to the base line
seam width
adjust length of seam symbol

2

2

1
2
3

symbole length
symbole direction
offset from reference
point/ non centred posi‐
tioning

3

Picture 7‐21

Interactive tools for buttonholes and bartack
Step‐by‐step guide for setting interactive button‐
holes and bartack
 basic menu → manufacturing symbols
 Select symbol
 Construct position of up to 45 new symbols with
the sub‐menu point construction
 End with
 Click reference line along which the symbols are
to be aligned or click on Exit
 Activate symbols with double‐click
 Adjust the options
 Interactive adjustment of symbol length and in‐
teractive alignment of the symbols
 Quit interactive adjustment with End

Picture 7‐23

There is one drag area for interactive adjustment of
symbols in which the symbol direction and depend‐
ing on the option and symbol type also the symbol
length and offset can be interactively adjusted, see
Picture 7‐23.
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Exercise on interactive symbols
Construct the tool Front edge 30 onto a Grafis Bodice
according to Picture 7‐24 left and set five button‐
holes with Buttonhole 10. Click the front edge as ref‐
erence line. Then, adjust the front edge according to
Picture 7‐24 right.
click
reference line

Buttonhole 10

Buttonhole 20

Buttonhole 30

Buttonhole 40

Picture 7‐24

Bartack 10

Notch 10

The buttonholes are aligned
along the reference line. Reset
calling the tool Buttonhole 10 in
the record and construct the
buttonholes again. End without
clicking a reference line by click‐
ing on the button Exit after hav‐
ing clicked the points and (Pic‐
ture 7‐25). The buttonholes are
now aligned parallel to one an‐
other.

Picture 7‐25

Tool Marking line 10 for creation of templates

Perforation 10

Perforation 20

Part of production preparation is the creation of
templates for sewing, for positioning of pattern
pieces or embroidery. The templates must be gener‐
ated for all sizes. The templates are constructed with
the Marking line 10 tool.
Step‐by‐step guide

Perforation 30







Basic menu→ manufacturing symbols
select Marking line 10
Click the lines for the marking line.
Adjust the options
End interactive adjustment with End
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After having clicked the required lines, various
options and adjustments can be selected, Picture 7‐
26.
gap position

width: Via option or
interactively

view

Variation 1: only one line sequence is clicked, the
fastening adjustments relate to the clicked line se‐
quence, see Picture 7‐28.

cutted y/n

gap width

variation 1

line sequence 1
Picture 7‐26

The number of gaps, the bridge width and the start‐
ing and end point can be altered in the drag area Ad‐
justments.
Exercise
Construct a template for a shaped waistband for
Skirt 20 with the tool Marking line 10.
Into the new part ‘template’ insert the waist line, the
centre front and the side seam of the front skirt and
close the darts. Create a parallel of 60 mm to the
linked waist line. Construct a seam allowance all the
way around at a distance of 10 mm. Activate the tool
Marking line 10 and click the respective lines. Adjust
the marking line to achieve a result corresponding to
Picture 7‐27.

Picture 7‐28

Variation 2: two line sequences are clicked. The fas‐
tening adjustments relate to the second line se‐
quence, see Picture 7‐29.
variation 2

line sequence 2
Picture 7‐27

line sequence 1

Construct a template for the skirt back waistband in
the same way.
Tool Fastening 10 (velco)
Step‐by‐step guide






Basisc menu → call → Grafis‐Support programs
Select Fastening 10 (velcro)
Click the lines for the fastening
Adjust the options
End interactive adjustment with End

Picture 7‐29
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7.6

Attributes

The attributes menu
This menu attributes which can be called
from the basic menu allows for alteration
of line type or changing of a point into a particular
mark.

Setting a point mark
Step‐by‐step guide
 basic menu → attributes
 Activate the mark type required
 Click the point
cross

asterisk

great point

arrow

Attributes menu
Line types...
continuous line ▪ dotted line small
distance ▪ dotted line great distance

small point

dashed ▪ dot‐dash rough ▪
dot‐dash fine
grain line ▪ split line ▪
annotation line
seam line ▪ cut internal line ▪
symmetry line
+/‐ chain

Picture 7‐30

Each point can be changed into one of the point
marks shown in Picture 7‐30. For further modifica‐
tion, it is still treated as a point.
To change a point into a mark activate the selected
mark type and click the point. The mark cross corre‐
sponds with the original point.

7.7
cross ▪ big point ▪ small point
asterisk ▪ arrow

reset

Alteration of line type

Exercises

1st Exercise
In the style ‘Straight skirt’ from Section 2.4 construct
a grown‐on godet at the centre back with a godet
height of 200mm and an angle for the godet of 35°
to the centre back. Link the godet line with the cen‐
tre back with the Link 20 tool. Then, construct the
hem and the seam allowance. Set the text and the
symbols.

Step‐by‐step guide
 basic menu → attributes
 Activate the line type required
 Click the line
Each line can be turned into one of the following line
types:
Line types with structure…
continuous, dotted line with small distance, dot‐
ted line with greater distance, dashed, dot‐dash
rough, dot‐dash fine or
Line types with significance…
annotation line, grain line, split line, cut internal
line or seam line.
After activating the line type, the line to be altered in
the construction is to be clicked.
If the option chain is active continuous lines, e.g. the
contour, are assigned the selected attribute.
The line types with structure have significance during
plot/print, e.g. for plotter/cutters. The line types
with significance are required in the marker making
and for data export.

Construct a godet as in Exercise 1 but in the front
skirt.
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2nd Exercise
Call the construction Bodice 50 and adjust the op‐
tions so that the waist dart is drawn to the hem.

3rd Exercise
Open the style from Chapter 5, Exercise 8 and set
notches onto the panel seams. Construct the posi‐
tion of the notches with intersection. To align the

Annotate the front and back, setting the following
text blocks automatically: name of collection, style
name, part number, size, how often the piece is re‐
quired per style and the material type.
notches, click on the respective marking lines. Set cir‐
cle symbols of 15mm length onto the points of the
front edge. Set the grain line symbol into each piece.
Grade the construction in various sizes and check the
position and direction of the notches.

Chapter 8

Darts and pleats

___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Content
8.1
8.2
8.3
8.4
8.5
8.6

Relocate dart ............................................................................................................................ 110
Shorten dart ............................................................................................................................. 113
Hoods on darts and pleats ........................................................................................................ 113
Pinch with new dart.................................................................................................................. 114
Spread for pleats, pivot open and close ................................................................................... 116
Exercises ................................................................................................................................... 117

110
Chapter 8 Darts and pleats
___________________________________________________________________________________________
©Friedrich: Grafis Textbook, Edition 2017

8.1

Relocate dart

The dart menu
Dart menu

Pivot direction for relocating darts
When clicking relocate darts in the dart menu you
will be asked which dart line is to be relocated to‐
wards the other. The succession of clicking the lines
determines the pivot direction (Picture 8‐1 and Pic‐
ture 8‐2).

relocate dart

shorten dart
shortening amount
2.click point*

*1.click point

reset

Dart hood 10 tool

Pinch 10 tool ▪ Pinch 20 tool

This menu offers functions for relocation and short‐
ening of darts, creation of dart hoods and pinching
with a new dart.
Prerequisites for relocation of darts
1. For the relocation of darts Grafis requires a
closed perimeter ‐ also across corners. Starting
and final point of the lines are allowed a maxi‐
mum of 0.5mm gap. The individual lines of the
perimeter do not have to be linked.
2. The dart must not be closed, i.e. with a dart hood.
If such a dart is to be relocated the hood is to be
removed with separate und cut or corners, first.
3. The dart lines must be of the same length and
share an apex.

Picture 8‐1

After having determined the pivot direction, the dart
is hatched. The direction of the hatching indicates
the pivot direction. The relocate dart menu opens,
see next page.

*2.click point

Step‐by‐step guide
 Check whether the conditions for dart relocation
are met
 basic menu → dart
 Click relocate dart
 Determine relocation direction by clicking both
dart lines (succession!)
 Adjust % of the dart to be relocated
 Switch +dart line or ‐dart line
 Click automatic
 Determine insert position with the sub‐menu
point construction
 Relocate additional objects; before clicking the
objects the switch +/‐copy is to be adjusted and
the object type lines or points is to be activated.
 Possibly, reset single objects with reset single or
reset all objects with reset all
 Continue with 5. or terminate with

1.click point*

Picture 8‐2

The dashed lines in Picture 8‐1 and Picture 8‐2 show
the shape of the bodice in case the full dart (100%) is
relocated.
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The relocate dart menu

Relocate 100% of the dart

Relocate dart menu

Relocating 100% of the dart is explained using an ex‐
ample. Call the basic block Bodice 10 and relocate
100% of the dart into the front pitch (Picture 8‐3):

amount of dart to be relocated
remainder of the dart
relocate automatic ▪ +/‐dart line
reset all
relocate additional…
lines ▪ points ▪ +/‐copy
reset

Amount of dart
In the first part of the menu you determine how
many % of the dart is to be relocated in the next step.
The line rest=0% shows the remainder of the dart
which can still be relocated.
relocate automatic
Activating the function relocate automatic starts the
relocation. The dart line switch determines whether
or not the dart lines are drawn at the new position:
+dart line draws the dart lines at the new posi‐
tion
‐dart line does not draw the dart lines at the new
position.
relocate additional
After having relocated parts of the dart important
construction points and lines are no longer posi‐
tioned correctly in relation to the part. These points
or lines must be relocated directly after relocating
the dart. The type of object (points or lines) is to be
selected and the copy switch is to be set:
+copy
object is copied
‐copy
object is relocated only.
reset
Clicking reset determines:
reset single
additional relocated objects can be
reset individually by clicking
reset all
the last relocation step is reset
completely.

Picture 8‐3

call
dart
relocate dart
The right dart line is to be pivoted to the left.
Click the right dart line first and then the left.
Enter 100% in the first line. The actual reloca‐
tion has not been carried out and the display
shows: (rest=100%).
+dart line
relocate automatic
click p in free mode
construct the front pitch as insert position
As two lines are assigned to the front pitch Grafis
asks for the base line required. You can click one of
the lines offered and the dart is relocated automati‐
cally.
Check whether further objects are to be relocated to
be positioned correctly in your construction. In this
example this is not necessary and the dart relocation
can be terminated with .
reset all
the dart is replaced in its original
position
Repeat relocation of the dart to a position on the side
seam 30mm from the armhole (not shown).
Please note that the construction points of the arm‐
hole have to be relocated as well with:
points
‐copy
click the points required
reset

reset construction record to 001
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Repeat relocating the dart with the left dart line be‐
ing pivoted towards the right. Click the left dart line
first and then the right. As opposed to Picture 8‐3 the
centre front is now angled, the position of the arm‐
hole remains unchanged.
Relocate parts of a dart
Relocating a portion of a dart is explained with an ex‐
ample. Call the basic block Bodice 50. Now, 25% of
the bust dart is to be relocated to the front pitch and
50% into the hem (Picture 8‐4).

Check whether any other objects must be relocated
so that they are in the correct position in your con‐
struction. Terminate with .
Exercises
1st exercise
Relocate 50% of the dart in the back of basic block
Bodice 10 into the back pitch and the remaining 50%
of the dart into the hem (Picture 8‐5).

25% remain

25%

Picture 8‐5

50%
Picture 8‐4

call
dart
relocate dart
The right dart line is to be pivoted towards the
left. Click the right dart line first and then the
left.
25% enter in the first line (rest=75%).
+dart line
relocate automatic
click P
front pitch
Please note that the construction points of the arm‐
hole have to be relocated as well:
‐copy
points
relocate construction points of the
armhole
50% enter in the first line (rest=25%)
+dart line
relocate automatic
click L
hem

2nd exercise
Construct a grown‐on yoke for Skirt 20. Use the func‐
tions line from point to point and the Line 10 tool for
the construction of the yoke. Relocate the dart into
the yoke line (Picture 8‐6).

Picture 8‐6
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8.2

Shorten dart

Step‐by‐step guide
 Basic menu → dart
 Adjust the shortening amount, by which the dart
is to be shortened
 Activate shorten dart
 Click both dart lines
Calling the function shorten dart
This function is contained in the dart menu. With this
function an existing dart can be shortened by a spec‐
ified shortening amount.
Entering a negative value lengthens the dart.
After having entered the amount and activated
shorten dart, Grafis asks for the two dart lines. The
shortened dart appears on screen. The distance be‐
tween the original and the new apex is exactly the
amount entered.
Exercises
1st exercise
Construct five pleats into the centre front of Bodice
50. The bust dart is relocated by 20% respectively
into the rastered centre front. Shorten the first two
resulting darts by 20mm, the third and fourth dart by
30mm and the fifth dart by 40mm (Picture 8‐7).

Picture 8‐8

2nd exercise
Relocate the dart in the basic block Bodice 10 into
the armhole, the side seam and the hem. Shorten the
side seam dart by 20mm, the dart in the armhole by
30mm and lengthen the dart in the hem by 20mm
(shortening amount =‐20.) (Picture 8‐8).

8.3 Hoods on darts and pleats
The tool for the construction of hoods on
darts and pleats Dart hood 10 is contained in the dart
menu.
Step‐by‐step guide

Picture 8‐7

 basic menu‐> darts
and call the Dart
hood 10 tool
 Click on four lines
contour – dart – dart
– contour in a contin‐
uous direction (right
principle!
(Pic‐
ture 8‐9)
 Close the darts menu
with
 Double‐click on the
new dart hood
Picture 8‐9
 Adjust the options (Picture 8‐10)
 Interactive adjustment of the drill hole
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Exercise

single dart hood or
box pleat/inverted
pleat

fold direction
for single dart
hood

1

1
1

single dart hood or
box pleat/inverted
pleat

Construct the
hoods for the
darts in the first
exercise of Sec‐
tion 8.2 with the
tool Dart hood
10
(Pic‐
ture 8‐12). Set
the third option
to pleat and po‐
sition the drill‐
holes interac‐
tively.

distance drill hole
from the dart apex
Picture 8‐12

Picture 8‐10

With the Dart hood 10 tool, a dart hood with drill
hole is constructed.
The first option (Picture 8‐10) determines whether a
single pleat or a box/inverted pleat is constructed.
The second option is only active for single pleats. It
defines the fold direction.

8.4

Pinch with new dart

The two tools Pinch 10 and Pinch 20
for pinching through new construc‐
tion of darts can also be found in the
darts menu.With both tools, the pinch amount and

Pinch 10 tool

dart or pleat

show pleat lines
yes/no

show pleat lines
yes/no
1 –base line
2 –symmetry point
3 –direction

drillhole for pleat
length

Pinch 20 tool

Picture 8‐11

The third option determines whether a dart or a
pleat is constructed. If the pleat is active, the pleat
length can be adjusted interactively. The fourth op‐
tion determines whether the lines of the pleat are
visible in the part, Picture 8‐11.

1 –base line
2 –symmetry point
3 –apex

Picture 8‐13

the correcting curve can be adjusted interactively.
The tools differ only in the way the apex point is de‐
fined. With the tool Pinch 10 the direction of the dart
is constructed and the dart length is adjusted inter‐
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actively. With the tool Pinch 20 the apex is deter‐
mined directly with the sub‐menu point construc‐
tion.
Clicking (1)(3)(3) instead of (1)(2)(3) when calling
the tool Pinch 20, creates the symmetry point as a
perpendicular from the apex onto the base line.
Step‐by‐step guide
 basic menu → darts and call the tools Pinch 10 or
Pinch 20
 Click the base line into which the dart is to be in‐
serted
 Construct the symmetry point
 Depending on the tool selected: construct the di‐
rection of the dart or the apex
 Close the darts menu with
 Double‐click on the new dart
 Interactive adjustment of the dart content
Exercises
1st exercise
In the style
‘Straight skirt’
from Section 2.4
construct
an
auxiliary line be‐
ginning 100mm
below the waist
on the centre
front running
Picture 8‐14
horizontally.
Drop a perpendicular from the centre (50%) of the
front waist onto the auxiliary line. Construct a dart
with a dart width of 10mm. The symmetry point and
the apex are the beginning and end point of the per‐
pendicular respectively (Picture 8‐14).

2nd exercise
Construct a dart
into the armhole of
Bodice 50 with a
pinch amount of
10mm (see Pic‐
ture 8‐15).

Picture 8‐15

3rd exercise
Call Bodice 50 and load the prepared shape004. In
the drag area Side seam set the relocation to 0. Open
another part, call Front part 30 and link it with Bodice
50. Open a further part and insert all lines for the side
front panel. Separate the side seam and the panel
seam at the waist curve. Now, the pattern is to be
pinched at the side
seam. A balanced
transition can be en‐
sured by creating
the symmetry point
from the perpendic‐
ular of the apex onto
the side seam. Call
the tool Pinch 20 us‐
ing the side seam as
the base line. Now,
click the side seam
twice at a relative
distance of 50%.
Thus, the symmetry
point is created as a
perpendicular onto
Picture 8‐16
the side seam.
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8.5 Spread for pleats, pivot open and
close
The spread menu
The spread function for preparation of
pleat construction is the contents of this
section.
Spread menu
click spread line
spread line defined by two points

re‐define spread line

 Activate spread: single points, single lines or all
and click the respective objects
 Possibly, reset by activating reset: single points,
single lines or all and clicking the respective ob‐
jects
 Adjust +/‐spread lines
 Terminate by clicking deposit
Spread line
After having constructed the spread line either
with click spread line or spread line defined by
two points, the actual spread menu opens. The
spread line is displayed in black (yellow ‐ if a line
of the construction is situated underneath) and
the target line in red. All required Grafis objects
will be spread according to spread line  tar‐
get line. Correction of the spread line is possible
by clicking re‐define spread line.
Distances between spread line and target line

spacing 1 at the starting point of the spread line
spacing 2 at the final point of the spread line
+/‐change direction
spread…
all ▪ single lines ▪ single points
reset…
all ▪ single lines ▪ single points
deposit ▪ +/‐spread lines

Step‐by‐step guide for spreading
 Construct the spread line or starting and final
point of the spread line with the functions of the
points and lines menu
 basic menu → spread
 Determine spread line via:
click spread line
if a spread line is available or
spread line defined by two points
if the spread line is to be defined by its start‐
ing and final point.
 Construct the spread line, then the actual spread
menu opens
 Possibly, construct the spread line again after
having clicked re‐define spread line
 Enter the spacing amount at the starting and final
point of the spread line and adjust +/‐change di‐
rection

The position of the target line is to be adjusted.
The following options are available:
 alter the spacing between the starting
points of spread and target lines spacing 1
 alter the spacing between the final points
of spread and target lines spacing 2
 alter the spread direction by clicking the
switch change direction
Spreading objects
As soon as the target line is in the required po‐
sition spreading of the individual objects en‐
sues. The option spread: all spreads the com‐
plete part from the spread line onwards. Then,
individual lines or individual points can be
spread, additionally by activating spread: single
points or single lines and clicking the objects. If
too many objects were spread with spread: all,
individual points or lines can be reset with re‐
set: single points or reset: single lines. With re‐
set: all all spread objects are reset.
Deposit
After having spread all required objects the switch
spread line is to be adjusted:
+spread line the spread line is drawn,
‐spread line the spread line is not drawn.
To terminate spreading click deposit.
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Exercises on spread
1st exercise
Construct three pleats in the back of Bodice 20 ac‐
cording to Picture 8‐17.

2nd exercise
Design two pleats in the front of Bodice 20. First, link
the shoulder and generate a point sequence of 5
points on the shoulder. Drop perpendiculars from
the front two points onto the hem. Spread the per‐
pendiculars with a spread amount of 40mm at the
hem. The pleats are not opened at the shoulder. Link
the hem lines (Picture 8‐18).
s1=0

s2=40.0

Picture 8‐17

First, raster the shoulder and then, construct three
lines from these points to the waist, parallel to the
centre back. Then, activate spread and click spread
line and click the first spread line.
When clicking the spread line the right principle is
to be followed. The starting point of the spread line
is spread by the value spacing 1, the final point by
spacing 2!
Enter the spread amount, here 0.0 and 40.0 and se‐
lect the correct spread direction from centre back to
the side seam by clicking on change direction. Click
on spread: all to spread. Set the switch to +spread
lines and deposit with deposit.
Before depositing, test also the following:
reset: single lines
click lines, with
spread: single lines
back
reset: single points
click points, with
spread: single points back
spread: all
reset: all
spread: single lines
click lines
spread: single points click points and restore
the shape shown.
Click the next spread line. Grafis transfers the spread
direction and spacing so you can continue with
spread: all and deposit. Construct dart hoods for the
pleats and measure the pleats.

Picture 8‐18

When clicking the spread line the right principle is
to be followed. The starting point of the spread line
is spread by the value spacing 1, the final point by
spacing 2!

8.6

Exercises

1st exercise
Design four pleats from the hip line in the front skirt
of the style ‘Straight skirt’ from Section 2.4. The
spread amount at the hip is 0 and the pleats are
spread by 40mm at the hem.

Design four pleats from the hip line in the front skirt
of the style ‘Straight skirt’ from Section 2.4. The
pleats are spread by 60mm at the hip and hem re‐
spectively. Create inverted pleats at hip and hem.
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2nd exercise
Construct four pleats from the knee in Trouser 10.
The spread amount at the knee is zero and 30mm at

Spread with a pleat content of 40mm at the neck and
70mm at the hem. Construct a single dart hood at
the neck and link the hem curve.
4th exercise
In the front of Skirt 20 construct a pleat at a distance
of 50mm from the centre front. The pleat content is

the hem. To the left of the crease line the pleats are
to be spread towards the side seam, to the right of
the crease line spread towards the inside leg. Link
the hem lines.
3rd exercise
Construct an asymmetrical pleat in the back of con‐
struction Bodice 10, beginning at 50% of the neckline

to be 50mm. First, construct a parallel of 50mm to
the centre front and then spread the front skirt at the
parallel.
5th exercise
Call Skirt 20 and construct a skirt with grown‐on
waistband and pleats in the skirt front.
60

33%

33%
180

160
40

and running vertically down. Do not construct the
spread line with perpendicular line as otherwise the
spread line would change when interactively altering
the hem curve.

40 40

180

Chapter 8 Darts and pleats
119
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

From this point, drop a perpendicular onto the cen‐
tre back.
Construct a point sequence of four points on the per‐

6th exercise
Construct a pocket with darts. First, construct a rec‐
tangle of 120mm width and 150mm height. Create
co‐ordinated round lower corners with the tool Cor‐
ner 50.

pendicular and construct two spread lines from
these points. The spread lines are to be aligned par‐
allel to the centre back. Extend the spread lines to
the hem with separate.
Construct a single dart hood for the bust dart in the
side seam.

Construct two spread lines and spread with a value
of 15mm. Shorten the darts by 120mm.

Construct the dart hood with the tool Dart hood 10.
Link the upper edge with Link 20 and then, shape the
edge interactively. Construct the seam allowance
and the symbols.
7th exercise ‘Blouse with pin‐tucks’
Open the style ‘Blouse with pin‐tucks’ from Section
5.6 and continue designing. Construct a point on the
back armhole, 100mm from the end of the shoulder.

Open another part 002 in the part organisation and
insert all lines and points of the front from part 001
into part 002. Hide part 001 and continue designing
with part 002.
In part 002 spread the pleats in the front with a pleat
content of 25mm at the shoulder and the hem re‐
spectively. Construct single dart hoods at the shoul‐
der and close the hem with link single. Construct a
seam allowance of 10mm with chain and set the
symbols and the text.
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9.1

Construction of curves

The curves menu
A new curve is created with the record
function curves from the basic menu.
Curves menu
create new curve
replace curve
start the tool automatically
manipulate curve

In the curves menu, three functions are available:
 new curve
...is the new curve function from version 10.
 replace curve
...as new curve, but an existing line/ curve to be
selected is replaced by a new curve. The curve
to be replaced must be clicked in the direction
of the green arrow.
 manipulate curves
… opens a menu with functions for relocating
starting and final point of curves and for refin‐
ing curve runs.
Base points and auxiliary points
A curve is shaped with so‐called base points and aux‐
iliary points.
Base points are points, which are bound to objects
(points or lines) of the construction. Each curve has
a minimum of two base points: starting point and fi‐
nal point. Base points constructed with click l, click
plg or click rlg can be moved along their base lines.
For all other variations, an additional displacement
line can be determined by clicking. The following ap‐
plies to base points:
 Base points are constructed, i.e. bound onto
the construction.
 Base points can be moved along an existing dis‐
placement line.
 In a base point, a direction can be assigned to
the curve.
 Base points are indicated by small crosses.

Auxiliary points are points, which are not bound to
the construction. The position of auxiliary points is
calculated relative to the zero curve. The zero curve
is displayed as a dashed line and generated exclu‐
sively on the basis of the assignments of the base
points. Auxiliary points are determined by their rela‐
tive position to the zero curve between two adjacent
base points. The following applies to auxiliary points:
 They serve to fine‐tune the shape of the curve
between base points.
 Auxiliary points can be dragged freely.
 Auxiliary points are displayed as small round
points.
The fewer the auxiliary points, the smoother the
curve. After construction of base points and assign‐
ment of directions, usually no or few auxiliary
points are necessary.
Step‐by‐step guide
 Basic menu →curves → new curve
 Construction of starting and final point of the
new curve
 Set the base points along the curve. This way, the
curve is moved with the base points during grad‐
ing:
 Insert points
 Bind points: The point becomes a base point.
 The basic points are given by default with the di‐
rection start/ final. If necessary, this can be
changed with the Set direction. Insert further
auxiliary points for fine‐tuning of the curve with
Insert points
 Insert further auxiliary points for fine‐tuning of
the curve with Insert points
 If necessary, base points, auxiliary points and di‐
rections can be deleted.
 Support during curve construction via the func‐
tions of the right menu strip:
 raster
 Set option Move base point in % and Allow
separation of base point from click point,
 various display options see Chapter 13 and
 redo and undo the steps within the curve con‐
struction.
 End or Abort to quit the curve construction
Important: Points must have a minimum distance of
5mm between each other!
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2

3

1 ‐ starting point
2 ‐ final point
3 ‐ set direction in the starting point
4 ‐ set dirction in the final point
5 ‐ insert auxiliary point

1

4

5

6

6 ‐ bind point
7 ‐ set straight line
8 ‐ insert auxiliary point
9 ‐ drag direction
10 ‐ drag auxiliary point

7

8

10

9

Picture 9‐1
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Construct new curve
Construction of a curve
starts with basic menu →
curves → new curve and
determination of starting
point and final point of the
curve. As the same con‐
struction step must be re‐
peated in other sizes, the
starting and final point of
the curve must be bound
to the construction.
In the case of replace
curve, in addition to deter‐
mining the starting point
Picture 9‐2
and final point, the curve to be replaced must be
clicked.
The individual steps are explained using the example
of a yoke curve in a skirt basic block (Picture 9‐1). Call
Skirt 20. Determine the starting point and final point
of the new yoke curve with click l respectively see
Picture 9‐1 (Picture 9‐1 No.1 and 2).
Having constructed starting point and final point of
the curve, the interactive interface with the Curve
construction menu (Picture 9‐2) opens and the curve
can be shaped. The Curve construction menu can be
positioned anywhere on the screen.
During direction construction, the direction of the
curve itself must be considered. It is indicated by an
arrow at the end of the curve (Picture 9‐3).

Picture 9‐3

You can use the options to unbind the starting and
final point from the line and to specify the shift vari‐
ant mm or % (Picture 9‐4).

The yoke curve is to start horizontally and end at a
right angle with the side seam in all sizes, according
to Picture 9‐1. These pre‐requisites are respected if
you activate Set direction and then, click the base
point. Start with the starting point of the curve on
the centre front and set a fixed direction of 0°, see
Picture 9‐1 No.3. Then, construct the direction in the
final point at the side seam and set the direction at a
right angle to the base line, see Picture 9‐1 No.4.
The direction must be determined along the direc‐
tion of the curve, i.e. from the starting point to the
final point. Direction assignments should be relative
to lines of the construction, such as the centre front
and the side seam as shown in Picture 9‐1.
The assigned direction is reset with Delete direction.
Insert and drag auxiliary points
If the curve is to be bound onto the construction
along its length, further base points are required.
Base points are generated by inserting an auxiliary
point and then, turning it into a base point.
Insert an auxiliary point by activating Insert points
and click on the curve, see Picture 9‐1 No.5. The
point is set. Now, activate Adjustment and drag the
point with pressed down left mouse button.
Construct base point
An auxiliary point becomes a base point by binding it
onto the construction with Bind point.
The yoke curve is to run through the end point of the
dart in all sizes, according to Picture 9‐1. To achieve
this, bind the auxiliary point onto the dart, see Pic‐
ture 9‐1 No.6. It becomes a base point. Activate Bind
point, click on the auxiliary point and construct its
new position with the point construction sub‐menu,
here with <Shift> in the free mode. Now, the curve
runs through this point in all sizes.
The position of a base point can be re‐assigned by
repeating the Bind point operation. This also applies
to the starting point and final point of the curve.
With Unbind point the binding of an auxiliary point
onto the construction is reset. The base point reverts
to an auxiliary point.
Delete points
With the exception of starting point and final point,
all base and auxiliary points of a curve can be deleted
with Delete point. To delete a point, activate Delete
point and click on the point to be deleted.

Picture 9‐4

Construct a direction in the base point
In a base point, the curve can be assigned a direction
with Set direction or Direction start/ final.
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Fine‐tuning in the drag area Adjustment

shape. Activate Insert point and set a further auxil‐
iary point, see Picture 9‐1 No.8. Activate Adjustment
again and move the auxiliary point, see Picture 9‐1
No.10. Having moved the auxiliary point, the zero
curve becomes visible. The zero curve is generated

In the curve construction menu, which can be posi‐
tioned anywhere on the screen, dragging of handles
is only possible with Adjustment. In all other menu
functions, targeted action is expected.
2

3

5

4
3
5

1

1
1

2
5

7

6

7

6

7
6

1 ‐ move base point along the displacement line
2 ‐ direction in the base point
3 ‐ straight line at beginning/ end
5 ‐ no direction assignment
6 ‐ direction at right angle to base line

4 ‐ auxiliary point
7 ‐ direction from start/final point
Picture 9‐5

Under Adjustment the following handles are availa‐
ble:
 Move base points along a base line or a dis‐
placement line, No.1 in Picture 9‐5.
 Drag auxiliary points, No.4 in Picture 9‐5.
 Adjust the straight line at the beginning and/or
end of the curve, No.3 in Picture 9‐5.
 Fine‐tuning of directions in base points, No.2 in
Picture 9‐5, as long as a direction has been as‐
signed to the base point.
Activate Adjustment and set a straight line of 20mm
length at the beginning of the curve, see Picture 9‐1
No.7.
The curve is shaped by inserting additional auxiliary
points between the constructed base points. As a
rule, one or two auxiliary points between adjacent
points are sufficient to obtain the required curve

exclusively on the basis of the settings of the base
points and displayed as a dashed line. Auxiliary
points are determined by their relative position to
the zero curve between two adjacent points.
Change the direction in the starting point of the
curve at the centre front, also, see Picture 9‐1 No.9.
Difference between Set direction and Direction
start/ final
In a base point
 the direction can be free, i.e. no direction as‐
signment, see No.5 in Picture 9‐5 or
 a constructed direction can be assigned, see
No.6 in Picture 9‐5 or
 the direction of starting point to final point can
be assigned, see No.7 in Picture 9‐5
These three variations are displayed for a curve with
two auxiliary points in Picture 9‐5. The differences
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become obvious when the final point of the curve is
moved significantly as in this example. Note particu‐
larly the directions of the curves in the starting point
and final point. In case 6 inPicture 9‐5, the direction
in the final point was assigned at a right angle to the
side seam.

All functions for shaping the curve previously de‐
scribed are available. However, the curve may only
be altered in so far as the logic of the following con‐
struction steps in the active part and in the daughter
parts remains untouched. These limits are at the dis‐
cretion of the user.

End curve construction

In the example in Picture 9‐6, a curve had originally
been constructed between centre front and side
seam. A corner treatment has been carried out in the
daughter part (2). Subsequently, the curve has been
attached to the dart. In the daughter part, the curve
treatment between curve and side seam is recorded
and therefore, processed (4).
The example in Picture 9‐6 demonstrates that
daughter parts should also be test run after im‐
portant changes to curves to ensure a correct con‐
struction run. Should errors occur, re‐activate the
curve and re‐construct its original state. Resetting
the record is not possible in this case as changes to
the original record step of curve construction would
occur.

With end in the menu on the right, the curve is de‐
posited in your construction. Abort in the menu on
the right rejects the current changes to the curve.
The curve becomes a straight line from starting point
to final point.
Subsequent curve correction
The curve can be re‐opened for processing via dou‐
ble‐click or the <F12> key at any point in the part in
which the curve had been created originally. The
construction record runs through to the respective
record step and opens the curve for processing.

2

1

1 – original final point of the curve in
the mother part
2 – corner treatment in a daughter part

4
3

3 – new moved final point of the curve
4 – corner treatment with side seam
according to the construction record
Picture 9‐6
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9.2

Manipulate curve

The manipulate curve menu
The manipulate curve menu is opened from the
curve menu. It offers two different functions:
 the manipulate curve function to relocate start‐
ing and final point of curves and
 the refine curve function for a more refined curve
run.
With both functions the character of the curve re‐
mains unchanged.
Manipulate curve menu
manipulate curve ▪ re‐set P1 ▪ re‐set P2
transition types ▪ +/‐formed
deposit curve ▪ +/‐copy
refine curve

reset

The switch +/‐copy decides whether or not the origi‐
nal curve remains existent. Deposit stores the manip‐
ulated curve.
Clicking on reset aborts the current curve manipula‐
tion or resets the last construction step.
Refine curve
Having activated refine curve, the start and end of a
curve section must be defined by clicking. This sec‐
tion is then refined through reducing the number of
curve points and subsequent interpolation. The
shape of the curve remains unchanged.
Exercise
Call Skirt 20 and adjust it according to
Picture 9‐7. Open a new part called
‘lining‘ and insert all lines and points
of the development part. The lining is
to be 20mm shorter and 10mm wider
at the hip than the outer fabric. Con‐
struct the corresponding parallels to
the hem and to the side seam, see Pic‐
ture 9‐7 left.
Now, the parallel to the side seam
must be connected with the new hem
and the waist line. Separate the paral‐
lel to the side seam at the hip. Acti‐
vate manipulate curve and relocate P1
of the upper side seam to the waist

Manipulate curve
Step‐by‐step guide
 basic menu ‐‐> curves ‐‐> manipulate curve
 Activate manipulate curve
 If required relocate the starting point of the curve
with re‐set P1
 If required relocate the final point of the curve
with re‐set P2
 Switch between the different transition types
 Adjust +/‐formed
 Adjust +/‐copy
 End with clicking on deposit curve
After activating the manipulate curve menu, a curve
has to be clicked. This curve will then display the des‐
ignation P1 for the starting point and P2 for the end
point of the curve. With re‐set P1 or re‐set P2 these
points can now be relocated.
The manipulated curve appears in black. It can still
be adjusted. Clicking on transition types alternates
between six different transition types. The switch
formed effects a change in the curve run for very spe‐
cific curve shapes only.

Picture 9‐7

line. It is important that a transition type which alters
the curve run very little and in particular keeps the
direction in the hip area, is selected before deposit‐
ing the curve. Continue the exercise according to Pic‐
ture 9‐7 right.
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9.3

The Part assistant

As detailed in Chapter 3, style develop‐
ment in Grafis ensues in three stages:
 call and adjust the basic construction
 development of one or more pattern develop‐
ment parts with all required styling elements
 derivation of production pattern pieces such as
front, back, waistband, trimming, facings, lining
etc.
Derivation of production pattern pieces usually in‐
volves the following repetitive operations:
 insert lines and points into the production part
 close the net contour
 add seam allowances
 close corners
 move existing symbols onto the seam allow‐
ance
 add symbols to the seam allowance
 set point symbols such as drillholes
 set grain line and special lines
 assign part parameter
The existing Grafis functions from the different
Grafis menus have been compiled in individual dia‐
logues for exactly these operations in the part assis‐
tant. The operations carried out with the part assis‐
tant are recorded with these Grafis functions.
Using the part assistant reduces the time required
for deriving production pieces significantly.
Having run through up to 10 dialogues, the part as‐
sistant switches to the next empty part and the user
can continue immediately with generating the next
production piece.
Start and navigate the part assistant
Start the part assistant via the basic menu→part as‐
sistant. If the active part is empty, the first dialogue
Insert objects opens. If the active part already con‐
tains objects (lines and points), the second dialogue
Search contour opens automatically.

reset ▪ exit
backward <D> ▪ forward <F>

The following buttons for navigation can be found in
all dialogues of the part assistant:
navigates backward and forward be‐
tween the dialogues. Once all operations in the ac‐
tive dialogue are completed,
(shortcut <F>)
switches to the next dialogue. If you realise in the last
dialogue part parameter that something needs
changing in a previous dialogue for example, you can
navigate back to the respective dialogue with
.
The recorded operations are preserved and carried
out again during forward navigation. This applies
only up to and including dialogue 4 Seam allowances.
Backward navigation to dialogue 3 Search contour
resets all previously recorded operations.
With
reset all recorded operations in the active
dialogue. Operations recorded in other dialogues re‐
main.
You can normally switch between the functions in
the dialogue with <TAB>.
saves the part in its current state and ends the
part assistant.
 Dialogue 1 – Insert objects
In dialogue 1 Insert objects all lines and points re‐
quired for completion of the production pattern are
transferred into the active part.
insert in frame all...
points ▪ lines ▪ continuous lines
individual points/lines in/out
list of source parts

Generate a new style and open three new parts in
the part organisation. Call Bodice 10 and Front
edge 30 into the first part and call Collar 40 into the
second part. Separate the mirror seam at the collar
point. The first and second part remain visible. The
third part becomes the active part into which the ob‐
jects for the production pattern ‘front’ are to be in‐
serted. Activate the part assistant from the basic
menu.
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First, attempt to find the contour with
search
contour automatically. Activate the function and
click on a line. If the desired contour is not found au‐

Picture 9‐8

Using <TAB> activate the third button in the first row
and drag a rectangle across the front. With the func‐
tion all continuous lines in frame, the continuous
lines are now transferred. Part 001 appears in the list
of source parts. Click on reset or
in the list of
source parts. Select the suitable function with <TAB>
and insert all required lines and points according to
Picture 9‐8.
With
individual points/lines in/out you can ac‐
cept or remove individual points in the source part
or the active part via clicking.
This dialogue of the part assistant may be used
simply for inserting objects for example for a pattern
development part. In this case, quit the part assistant
after having inserted the required objects with

.

All objetcts inserted in this dialogue cannot be re‐
leased subsequently with ‘Reset click’.
(shortcut <F>) switches to the next dialogue.

Picture 9‐9

tomatically, switch with <TAB> to
search con‐
tour step‐by‐step and click the lines of the contour
one after the other, see Picture 9‐9.
Only if button
is active is the net contour de‐
fined and you can move on to the next dialogue.
 Dialogue 3 ‐ Close contour
With dialogue 3 Close contour gaps or overlaps in the
contour are removed and dart and pleat hoods are
constructed. In this dialogue you find the function

link single ▪ Link 20 tool

 Dialogue 2 ‐ Search contour

separate in corner

With dialogue 2 Search contour the lines of the net
contour and their order and direction are deter‐
mined.

Dart hood 10 tool...
dart hood ▪ pleat hood

search contour automatically
contour step‐by‐step....
search ▪ reset

link single and the tool Link 20 from the link menu,
the function separate in corner from the separate
menu and the interactive tools for hood construc‐
tion.
All line transitions are marked by a green or red
point. The functions from this dialogue can be ap‐
plied to these line transitions.
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Red points indicate very flat line transitions which
should be linked. The user can treat flat transitions
either with link single or with the Link 20 tool. As the
assistant is aware of the order and direction of the
lines, a simple click on the line transition is sufficient.

assign standard distance ▪ distance
distance single...
assign ▪ distance
assign ▪ distance ▪
no seam allowance

link

assign unparallel ▪ 1st distance
2nd distance

For the construction in Picture 9‐11, enter a standard
distance of 10 mm and then assign a seam allowance
of 5mm to the front edge and 30 mm to the hem via
single lines. Then, move on to the next dialogue.

Picture 9‐10

In this dialogue separate in corner may be useful to
enable future corner treatment or in preparation for
export of the parts. After having activated the func‐
tion separate in corner the positions of the net con‐
tour, where it can be separated, are marked with
.
Hoods for darts and pleats are also constructed in
this dialogue. Instead of four clicks in the menu, here
only one click is required which also determines the
fold direction. Please note the echo depending on
the cursor position.
Close the contour of part 003 according to Picture 9‐
10 and then move on to the next dialogue.
 Dialogue 4 – Seam allowances
In dialogue 4 Seam allowances the seam allowances
are added to the net contour.

Picture 9‐11

 Dialogue 5 – Corners

As opposed to all other dialogues of the part assis‐
tant, this dialogue can be opened and edited subse‐
quently via <F12>.

In dialogue 5 Corners the remaining line transitions
are closed via corner treatment. The line transitions
are indicated by green points.

Initially, all lines of the net contour are assigned the
standard distance. The standard distance can now be
altered or an x or z value can be used. If individual
lines are to deviate from the standard distance, enter
the desired value under single lines and click the line.

Select the required corner type with <TAB>. When
the cursor is close to a line transition, a preview of
the corner construction appears. Click on the line
transition to re‐assign or edit the corner construc‐
tion.
For a co‐ordinated angle corner, the part to be co‐
ordianted must be visible as the line to be co‐ordi‐
nated must be clicked.
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Convert lines into notch
normal corner ▪ open corner
corner tools...
Mirror corner 10 ▪ Mitred corner 20
Vent corner 30 ▪ Angle corner 60
Hem corner 80 ▪ Co‐ordinated angle
corner 70

The first row of functions is only visible if there are
short, totally straight lines of maximum 15mm length
at the net contour which can be converted to a
notch. Such short lines are marked with a red point.
First, determine a length and then, convert all short
lines marked in red into notches with

. If not all

short lines are to be converted, activate
click the lines individually.

Step corner 130

and

Move line symbols

To alter a corner, no reset is required. The part assis‐
tant automatically updates the record.
For the example in Picture 9‐12 set a hem corner at
the hem, two angle corners at the shoulder and a
step corner at the transition collar / neckline.

With the functions of the second row you can move
line symbols onto the seam allowance. All line sym‐
bol which can be moved are marked by a green
point. By clicking on
you decide whether the
symbols are to appear ‘inside and outside | only in‐
side | only outside‘.

applies this setting to all

convert stripes
into notch

move/copy symbo‐
les

Picture 9‐13

lets you apply the setting to indi‐
line symbols,
vidual line symbols.
Picture 9‐12

 Dialogue 6 – Existing symbols
This dialogue appears only if there are line symbols
or short lines at the net contour. Otherwise this dia‐
logue is skipped.
convert short lines into notch...
single ▪ all ▪ length
move symbols...
single ▪ all ▪ move/copy/leave
delete individual symbols

Not required line symbols can be deleted with
Convert the short lines marked in red into line sym‐
bols and move them to the net contour and the outer
contour, see Picture 9‐13.
 Dialogue 7 – Contour symbols
In dialogue 7 Contour symbols, new contour symbols
are constructed to the outer contour. Select the re‐
quired contour symbol and enter the desired length.
By clicking
you select again wether the symbols
are to appear ‘inside and outside | only inside | only
outisde‘.

132
Chapter 9 Curves and Part assistant
___________________________________________________________________________________________
©Friedrich: Grafis –Textbook, Edition 2017

 Dialogue 8 – Point symbols
In dialogue 8 Point symbols new point symbols are
set inside the pattern.

stripe ▪ notch ▪ pitch
v notch ▪ symbol length
symbol move/copy
symbol position | symbol direction...
on point | right angle to contour ▪
from line | right angle to contour ▪
from line | in line direction

cross ▪ circle ▪ drillhole
drillhole plotted ▪ symbol length
reset last symbol

reset last symbol

Symbol position and symbol direction
With
the symbol is set with the sub‐menu
point construction and then moved at a right angle
to the net contour onto the outer contour.
With
a line is clicked and the symbol is set onto
the intersection of this line with the net contour and
then also moved at a right angle to the net contour
onto the outer contour.
With
a line is clicked and the symbol is set onto
the intersection of this line with the net contour.
However, the symbol is moved to the outer contour
in the direction of the line.
Set the notches displayed in Picture 9‐14.
set
symbols

First, enter the desired symbol length, active the
type of symbol and then set the symbol with the sub‐
menu point construction.
Set the drillhole symbol for the waist and bust darts,
see Picture 9‐8.
 Dialogue 9 – Special lines
In dialogue 9 Special lines, the grainline and annota‐
tion line are constructed or assigned.
grain line...
Grainline 10 ▪ assign grain line ▪ de‐
lete grain line
annotation line...
annotation line with Line 10 ▪ assign
ann. line ▪ delete ann. line
assign symmetry line ▪ delete
delete...
all points ▪ all unused lines

If a grain line or annotation line already exists, it can
be deleted with
or
and then re‐con‐
structed at a new position or with a new direction.
calls the tool Grainline 10. With
ing line can be marked as a grainline.
With

Picture 9‐14

an exist‐

an existing line can be marked as an an‐

notation line. With
, a new line is constructed
with the tool Line 10. It is instantly assigned the at‐
tribute annotation line.
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At the end of the actual construction process, it is
useful to delete all points and all unused lines. Click
once onto
and
respectively.
The part assistant saves the deleting of points and
unused lines as a last record step in this part. This
record step can be reset at a later date, if required,
and the points / lines become visible again.


Dialogue 10 – Part parameter
In the last dialogue of the part assistant, assign the
part name and the part parameter to the part, see
section 17.2.
After clicking
the system automatically move
on the next part or a new part is opened and the part
assistant begins with dialogue 1 Insert objects. Alter‐
natively, quit the part assistant with
to the basic menu.

and return

Subsequent alterations
Before quitting the part or the part assistant, you can
navigate and edit backwards and forwards at will
from dialogue 4 Seam allowances to dialogue 10 Part
parameter. Recorded steps in other dialogues re‐
main intact. Moving to dialogue 3 Close contour or
lower resets all subsequent steps.
After having quit the part or the part assistant, all in‐
teractive functions called within the part assistant
can be activated and adjusted via double‐click or
F12. Via F12 or double‐click onto the seam allow‐
ance, dialogue 4 Seam allowances can be opened for
this part. The record is saved in blocks in the order of
the dialogues. Resetting the record in the basic menu
is therefore possible.
Pictuer 9‐15

Set the grainline and the annotation line as displayed
in Pictuer 9‐15 and delete all points and all unused
lines.
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9.4

Exercises

1st Exercise
Construct a yoke in the back of Bodice 10. The yoke
is to run through the apex of the shoulder dart (see
Picture). The curve is to begin at a right angle to the
centre back 60mm from the neck and end at the arm‐
hole 80mm from the shoulder.

3rd Exercise
In the style ‘Straight skirt’ from Section 2.4 construct
a yoke and a separate hem curve. The yoke is to start
150mm from the waist on the centre back and centre

First, insert an auxiliary point in the curve and attach
the auxiliary point to the dart apex. The curve is to
run at a right angle to the centre back and horizontal
at the armhole.
Reset the curve construction and construct a yoke
curve in the same way, but not attached to the dart
apex.

front and to end on the side seam 80mm from the
waist. The curves are to arrive at a right angle at
starting and final point respectively. The hem curve
is to start 100mm from the hem on the centre front
and centre back and end 150mm from the hem on
the side seam. These curves are also to end in a right
angle.

2nd Exercise
In the front and back of Bodice 10 construct a prin‐
cess seam and curves in the hip area. The princess
line is to begin on the armhole 80mm from the shoul‐
der and end at the bust point. In the back, the curve
is also to start 80mm from the shoulder and run into
the waist dart. The curves in the hip area start at the

4th Exercise
Construct the displayed yokes in Bodice 20. The
yokes start at the armhole with a straight line of
80mm at 80mm from the shoulder. The lines are to
run parallel to the shoulder. A curve is to be attached
to the new line, starting at a right angle at the centre
front, measured 100mm from the neck and ending at
a right angle at the straight line. In the back, the
curve ends in a right angle at the centre back, meas‐
ured 120mm from the neck.

intersection of waist line and side seam and end at a
right angle 100mm from the hem on the centre front
and centre back respectively. The curves are to be
attached to the apex of the waist darts.
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5th Exercise
From Trouser 10 with turn‐
up set to 0. construct the
displayed shortened, flared
trouser front with yoke and
curved hem. The yoke is to
start on the side seam,
60mm from the waist and
end on the centre front,
120mm from the waist. The
curve is to run through the
dart apex.
The side seam is flared by
90mm. The inside leg seam
is to be vertical. Construct a
new side seam and inside
leg seam.
Shorten the hem by 220mm
at the side seam and
100mm at the inside leg.
Draw a new hem curve with a right angle at the side
seam and the inside leg seam.
6th Exercise
Construct the displayed pocket in Trouser 10 with
new curve. First, close the dart and link the waist line.
The pocket mouth begins on the waist at a distance
of 50mm from the side seam and ends on the side
seam at 130mm from the waist. Set all directions and
shape the pocket mouth. Construct the pocket bag
on the waist with a distance of 120mm from the cen‐
tre front and on the side seam with a distance of
180mm from the waist. Shape the pocket bag by set‐
ting directions and if necessary adding auxiliary
points. End curve construction.

Then, modify the pocket bag. Unbind the starting
point on the waist and bind it to the centre front. Set
directions in the starting point and final point of the
curve. The right angle at the centre front should re‐
main for the first 20mm of the curve.
7 th Exercise
Construct the collar band shown with the following
points:
 point 1 ‐ point 3: 150mm
 point 3 ‐ point 6: 40mm
 point 6 ‐ point 7: 45mm
 point 1 ‐ point 2: 35mm
 point 2 ‐ point 4: 20mm
 point 4 ‐ point 5: 40mm
 point 1 ‐ auxiliary point 9: 65mm
 point 1 ‐ auxiliary point 8: 155mm.
8

5
9
4
7
2

1

6

3

The connection between point 7 and point 8 is to de‐
fine the direction of the outer edge of the collar in
point 7. In the same manner, the connecting line be‐
tween point 3 and point 9 defines the direction of the
collar fold and neck line in point 3.
8 th Exercise
Construct the collar shown with the given measure‐
ments.

38

Change the pocket interactively into a jeans pocket
by moving starting point and final point of the curve
according to the image.

22

50

40
160

60
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9 th Exercise
Open the style ‘Shirt blouse’ from Section 2.5 and
construct a line at the front and back armhole, re‐
spectively at 100mm from the shoulder. The lines are
to be right‐angled to the centre front and centre
back respectively. Cut the lines at centre front and
centre back. Construct an auxiliary line for the yoke
point with the Parallel 10 tool. The auxiliary line is to
be 40mm long, start at 40% measured from the cen‐
tre front or centre back and be aligned at a right an‐
gle to the base line. Construct the displayed curves
from the yoke point to the armhole and to the centre
front or centre back. The curves are to run into the
base line.

The two new hem curves are to start at a right angle
at the end point of the centre front and centre back
and end at a right angle at the side seam, 80mm from
the hem.
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10.1 Transformation
The transformation menu
Transformation menu
move…
move…: by dx and dy
move value dx
move value dy
move…
from point to point ▪ set points
turn with…
turn point and angle ▪ set turn point
turn angle
turn with...
turn point from point to point ▪ set points
turn and move...
with four points ▪ set points
scale transformation
scale
scale value in x direction
scale value in y direction
mirror
mirror at…two points ▪ set points
mirror at…line ▪ set line
objects to be transformed
points ▪ lines ▪ part
+/‐copy ▪ revers transformation ▪ reset

Step‐by‐step guide
 Adjust the transformation parameters
 Select the type of object (points, lines...)
 Activate the transformation
 Adjust +/‐copy: the original objects re‐

mains/ does not remain existent
 Set the transformation direction with +/‐re‐

verse transformation in reverse/ normal di‐
rection, e.g. change of sign for set angle. No
significance with mirror!
 Click the objects to be transformed within
the construction.
Reset resets the last transformation step.
Move by dx and dy
This move function (translation) with pre‐set
values requires the entry of the move value in x
direction dx and y direction dy. A detailed expla‐
nation on the co‐ordinate system can be found
in chapter 4.3. The move values can be positive
or negative:
dx= - ....mm to the left
dx=+ ....mm
to the right
dy= ‐ ....mm
downwards
dy=+ ....mm
upwards
Move the shoulder and armhole of Bodice 10 by
dx=+200 and dy=‐50 (Picture 10‐1).
First, enter the values for dx and dy, select lines
and set the switches to +copy and ‐reverse
transformation. The move transformation move
is active. You can now click the lines to be
moved. Activate points and also move the cor‐
responding points. Set the switch to +reverse
transformation. You can now transform the ob‐
jects back again. The transform settings remain
in place also after quitting the transformation
menu.

transformation list

The functions of this menu allow for moving, rotat‐
ing, scaling and mirroring of Grafis objects. The eight
transformation types are:
 2 move transformations
 2 turn transformations
 1 turn and move transformation
 1 scale transformation
 2 mirror transformations

dy= ‐50.0

dx= +200.0

Object types
You can transform:
 single points
 single lines
 the complete part

Picture 10‐1
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Move from point to point
The objects are moved about the connecting line be‐
tween two points of the construction (Picture 10‐2).
starting point

final point
for move

Measure the bust dart of Bodice 10 in your base size
and relocate it into the side seam (Picture 10‐3).
First, construct an auxiliary line at the side seam for
the position of the dart and separate the side seam
at the auxiliary line.
Enter the measured angle as turn angle, click on set
turn point and select the bust point. Now, activate
lines or points and transform the objects of the
shoulder, the armhole, the upper side seam and with
+copy the auxiliary line. Grade.
Use this type of transformation only if the angle is
to be constant across all sizes or in connection with
x values or z values.
Turn about a turn point from point to point

Picture 10‐2

After having clicked set points the starting and final
point of the move line have to be constructed. Then,
move from point to point is active and the move of
objects can begin. In Bodice 10, move the armhole
curve of the front towards the back. Grade the con‐
struction.

This transformation rotates the objects about a con‐
structed pivot point. The angle is determined by the
angle between turning point → starting point of the
rotation angle and turning point → final point of the
rotation angle.
Having selected set points, the points are to be
clicked in the following order: turning point → start‐
ing point of the rotation angle → final point of the
rotation angle. Then, turn about a turn point from
point to point is active and the rotation of objects can
begin.

Turn with turn point and angle
With the transformation function turn with turning
point and angle the objects are rotated about a con‐
structed pivot point by a given angle (Picture 10‐3).
Note: The set angle remains constant throughout all
sizes!

3. final point for angle
2. starting point for angle

angle
15.8°

1. turn point/pivot
Picture 10‐4
pivot
Picture 10‐3

After having activated set turn point the pivot point
is to be constructed and the angle in ° is to be en‐
tered. Then, the line turn with turn point and angle
is active and turning of objects can begin.

Relocate the bust dart into the side seam (see Pic‐
ture 10‐4). First, construct an auxiliary line for the
position of the dart in the side seam and separate the
side seam at the auxiliary line. Click on set points in
the transformation menu and then, click the bust
point and the right and left dart legs one after the
other. Now activate lines or points and transform the
objects of the shoulder, the armhole and the upper
side seam; transform the auxiliary line with +copy.
Grade.
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Turn and move
The objects are moved and rotated in one operation.
For this function four points are to be clicked. The
move vector is defined by its starting and final point
(Picture 10‐5 top). The rotation angle is defined by
the moved starting point and the final point of the
angle (Picture 10‐5 bottom).
move vector

4

1

3

2

Transform the yoke by selecting set points for turn
and move from the transformation menu and click‐
ing the points in the suggested order. Activate the
object type lines and click the construction lines of
the back yoke. Transform the corresponding points
with +copy.
Scale
The objects are reduced and increased relative to ab‐
solute zero (Picture 10‐6).
The scale value in x (Fx) applies to the x component
of the objects in the construction only, the scale
value in y (Fy) to the y component.
original
reduction, scaled
with Fx=Fy=0.5

turn angle

absolute
zero point
Picture 10‐6

Picture 10‐5

After having activated set points the points are to be
clicked in the order: starting point of the move vec‐
tor → starting point of the rotation angle → final
point of the move vector → final point of the angle.
Then, turn and move is active and the transformation
of objects can begin.
This function is especially useful for relocating yokes
or relocating the shoulder seam. Turn and move a
yoke in the back according to Picture 10‐5. Relocate
the front dart into the side seam and the back dart
into the armhole. Drop a perpendicular onto the cen‐
tre back and separate the centre back.

Increase/reduction/stretching/shrinking of the pat‐
tern is required for stretch material for example, lin‐
ing or under collar or for the correction of changes in
length after washing. The following applies:
Fx=Fy=1.00 ‐ no change in scale; Fx=1.10, Fy=1.00 ‐
stretching of the pattern by 10% in horizontal direc‐
tion; Fx=Fy=0.90 ‐ shrinking by 10% in all directions.
Different values in Fx ad Fy distort the construction
in width and height. The same values increase or re‐
duces the construction to scale; Fx=Fy=0.5 halves
the dimension of the construction and Fx=Fy=2 dou‐
bles it.
Scale the Bodice 10 by half. The zero point of this
construction is positioned at the centre back at waist
height. Enter the values Fx=Fy=0.5 in the transfor‐
mation menu and activate scale. Set the switch to
+copy, click on part and click on a line of the con‐
struction. The construction is now reduced by 50% in
x and y direction in all sizes.
Reset the record and repeat with the values Fx=1.00
and Fy=1.10. Now increase single lines in y direction.
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Mirror at two points
The objects are mirrored at the connecting line of
two points (Picture 10‐7).

starting point of
the mirror line

+
mirror line

mirror
with p==>p

+

final point of the
mirror line

Picture 10‐8

Transformation list

Picture 10‐7

To activate this function set points for mirror is to be
clicked and the points of the mirror line are to be de‐
fined with the sub‐menu point construction. Then,
the objects to be mirrored can be clicked.
Draw new waist dart lines in Bodice 10. In the free
mode, construct the waist dart points exactly at
waist height using <Shift>. Then, delete the waist
dart lines and construct a new left waist dart with
curves. Mirror the new left waist dart line to the
right.
Mirror at a line
The objects are mirrored at an existing line of the
construction (Picture 10‐8).
To activate this function, first click set line and then
determine the mirror line within the construction.
Then, the objects to be mirrored can be clicked.
Mirror the displayed lines in Bodice 10 at the centre
front for a facing. Select set line in the transfor‐
mation menu and click on the centre front. Set the
switch to +copy, activate lines and click the lines to
be mirrored.
If you mirror the whole part the centre front is dou‐
bled and cannot be seen. In this case delete one of
the centre front lines.

All transformations carried out in the active part
can be re‐activated.
To activate the last transformation of a transfor‐
mation type, click on the corresponding button:
 move by dx and dy
 move from point to point
 turn with turn point and angle
 turn with turn point from point to point
 turn and move
 scale
 mirror at two points
 mirror at a line
In case no transformation of this type has been car‐
ried out in this part, setting of a new transformation
begins automatically.
Step‐by‐step guide for selection of a previous trans‐
formation:
 Activate the transformation type
 Click on transformation list
 Select one of the displayed record steps
 Clicking on an object shows a preview of the se‐
lected transformation. If required, the transfor‐
mation direction can be switched with +/‐reverse
transformation.
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Transformation list menu
record step
record step

+/‐reverse transformation

To select a previous transformation first, activate the
respective transformation type then, click on trans‐
formation list. The transformation list menu appears
showing up to ten previous transformations of the
active transformation type. The menu displays the
respective record step in which the transformation
has been carried out. In this menu you can also see a
preview of the transformation by activating the rec‐
ord step and then, clicking on individual objects of
the construction. The objects will be transformed for
a few seconds. Then, you can select a different rec‐
ord step and let individual objects be transformed
for a few seconds. Once you have found and acti‐
vated the required transformation switch back to the
transformation menu with . Transforming with the
previous transformation can begin.
Exercise on transformation list
In Bodice 80 two panel seams are to be constructed,
running from the front via the side seam to the cen‐
tre back. Before the panel seams can be constructed
with new curve, relocate the upper back to the side
seam of the front with turn and move, see Pic‐
ture 10‐9. The reference points are the corner point
at the armhole and a point at a partial distance of
40mm from the armhole respectively. From Chapter
11 onwards you can deposit this value as an x value
and have the curve run exactly through this point.
The lower back is to be transformed in the same way
with the reference points corner point hem and a
point at 50mm partial distance from the hem.
Construct the two curves and separate at the side
seam. In the transformation menu activate turn and
move. The transformation instruction for the back is
still active. Change the switch +/‐reverse transfor‐
mation and then, relocate the lines of the lower back
as well as the panel seam.

Picture 10‐9

Via transformation list open a menu with the previ‐
ous turn and move transformations. Activate the
transformation of the upper back, set the switch +/‐
reverse transformation and click a few objects of the
construction. If the required transformation is active,
switch back to the transformation menu with and
then, relocate the lines of the upper back and the
new panel seam back to its original position.

10.2 Align part
As opposed to the previous transfor‐
mations align part does not apply to indi‐
vidual objects of the construction but to
the whole active part
Align part menu
align part vertical
align part horizontal

The align part menu opens directly from the basic
menu. Parts can be aligned vertically or horizontally.
Having activated the corresponding function, a line
of the part is to be clicked following the right princi‐
ple.
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10.3 Insert with transformation
With the insert function from the basic menu, points,
lines or all objects of a part can be inserted into a part
with a higher part number. This process has already
been described in section 3.1 and practised a num‐
ber of times.
During insertion of objects one of the two insert
transformations can be carried out directly:
 move transformation move from point to point
or
 move‐rotate transformation turn and move.
Insert with transformation can be replaced by insert
without transformation and subsequent transfor‐
mation of individual objects. Insert with transfor‐
mation is sensible if a part with a large number of
points/ lines is to be inserted, see the embroidery
motif in Pictures 10‐10 and 10‐12.
Objects from a maximum number of 10 parts can be
inserted into the active part.
The two insert transformations in conjunction with
detailed explanations of the insert menu form the
content of this section.
Functions of the insert menu
Insert menu
select objects…
points ▪ lines ▪ part

The selected coloured objects are accepted into the
active part only after having called a function in the
deposit objects section of the menu.
Deposit objects:
This block of functions determines HOW the objects
or parts are deposited in the new part. In section 3.1
parts were inserted exclusively without transfor‐
mation. However, Grafis allows for parts to be
moved or rotated during insertion. This transfor‐
mation is stored as a hereditary step and repeated
automatically during grading.
1. move from point to point
Moving a point of the object to be inserted to a
point of the active part. All objects to be inserted
are moved accordingly.
2. turn and move
Move and rotation of the insert object according
to the identical instruction of the transformation
type with the same name in the transformation
menu.
This function is especially useful for inserting
yokes, sleeves or facings which already have the
correct dimensions.
3. without transformation
The selected objects are inserted without trans‐
formation, see section 3.1.
Reset undoes the last transformation step.
Quit insert with

.

Exercises on insert with move transformation
reset single ▪ reset all
deposit objects...
without transformation ▪ move ▪
turn and move

reset
Tools...
Insert points ▪ Insert lines ▪
Insert part

Select objects:
All visible objects belonging to an inactive part with
a lower part number can be inserted into the active
part with these functions. One of the type of objects
points, lines or parts is to be selected and the objects
are to be clicked one after the other. The inserted
objects appear in a different colour and, after having
pressed <F5> removed from the original object.
With reset single or reset all individual inserted ob‐
jects can be reset step‐by‐step or completely.

In part 002, construct a
small embroidery motif
from scratch with a radius
of approx. 35mm (accord‐
ing to Picture 10‐10). Call
the Bodice 10 into part
001, delete the auxiliary
lines, adjust the construc‐
tion as required and con‐
Picture 10‐10
struct positioning points for the embroidery motif
(Picture 10‐11 left). Construct a point in the centre of
the embroidery motif.
Insert all lines and points of the bodice construction
from part 001 into part 003. Use insert without trans‐
formation.
Then, insert the embroidery motif into part 003, cen‐
tred on the positioning points. Use the function in‐
sert with move from point to point. Activate select
object: parts and click on the embroidery motif. It ap‐
pears with red lines after having pressed <F5>.
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Picture 10‐11

Then, click on deposit objects: move. Now, click on
the first move point in the red group of objects. Click
the centre of the motif. Define one of the positioning
points in the active part as the final point for the
move. The menu remains active. You can insert the
embroidery motif a second time, a third time and so
on.
Exercises on insert with turn and move
Construct a yoke in the front of Skirt 20 which runs
through the dart apexes. Open the new part 002
‘front yoke’ and activate it. Insert lines 1 to 4 from
part 001 without transformation. Then, insert lines
1,5,6,7 with turn and move. Activate select object:
lines and click on the lines 1,5,6,7. They appear as red
lines after having pressed <F5>. Then, click on de‐
posit objects: turn and move. Click the end points of
the lines with click l or intersection in the order
shown in Picture 10‐12 A. The menu remains active.
You can now select the next lines by clicking and
then, deposit them in the part, taking into account
the clicking order shown in Picture 10‐12 B. Then, de‐
velop a production pattern from the inserted lines
(Picture 10‐12 bottom).

Picture 10‐12

Raglan sleeve construction
Construct a raglan sleeve from Bodice 10, using insert
with turn and move. Note: Grafis version 12 contains
an interactive raglan sleeve Grafis‐Sleeve 50, which
is not used at this stage during practising of the insert
transformation.
Call Bodice 10 into part 001. Loosen the armhole in‐
teractively by 10 to 20mm. Rotate the rest of the
bust dart into the hem with relocate dart. Relocate
the back shoulder dart into the armhole, see Pic‐
ture 10‐13 top.
Open a further part and call Sleeve 40. Adjust the fol‐
lowing in the options for the sleeve:
 4 segments
 grade sleeve hem as sleeve top
 sleeve head height as deduction from medium
armhole height.
Adjust a tolerance of 20mm in the Curve adjustment
drag area and in the Ease distribution area adjust
ease of approx. 10mm in the 2nd and 3rd segment.
Construct a line from the shoulder point to the hem
in the direction of the grain. Separate the sleeve
head and the hem at this line.
Open a further part and insert the lines of the front.
Construct an auxiliary line with 3mm length from the
front/back pitch horizontally to the outside using the
Line 10 tool. Construct a second auxiliary line with
10mm length from the shoulder point to the outside
in direction of the shoulder. Construct a third auxil‐
iary line of 5mm length for raising the shoulder see
Picture 10‐13 bottom.
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Insert the lines and points of the front sleeve into the
front. When inserting, use the insert transformation
turn and move, clicking in the following order:
 sleeve pitch of sleeve
 shoulder point of sleeve
 end of 1st auxiliary line
 end of 2nd auxiliary line.
auxiliary line

10.4 Complex exercises
1st exercise
Construct a yoke in the style ‘Straight skirt” from Sec‐
tion 2.4 starting at 150mm on the centre front or
centre back and ending at 75mm on the hip curve,
measured from the waist respectively. Then, move
the yoke away from the skirt with move dx=0 and
dy=60.

horizontal line 3mm
line in shoulder direction 10mm
raising the shoulder 5mm

2nd exercise
In the construction Bodice 10 move the waist dart in
the front by 25mm towards the side seam and in the
back by 30mm towards the side seam. Use the trans‐
formation type move (dx,dy). Grade in a number of
sizes.

Picture 10‐13

Construct a curve from the neckline to the sleeve
hem and attach the curve to the end of the third aux‐
iliary line and to the intersection upper arm line/
panel seam. Adjust the directions. Construct a yoke
line from the front pitch as a perpendicular onto the
centre front.
Proceed in the same way for the back.

Reset the move and now move the darts by the re‐
spective dart width at waist height. Use the transfor‐
mation type move from point to point.
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3rd exercise
In the construction Bodice 20 construct two lines par‐
allel to the centre front from the neck/shoulder point

and from the front pitch to the hem. Perpendiculars
are unsuitable, here in case the hem line is altered
interactively at a later time. Separate the hem line at
both lines and raster the hem line piece in between
with 5 points. Move one of the two lines to the new
raster points using the transformation type move
from point to point with the setting +copy. Cut the
spread lines at the shoulder.
4th exercise
In the style ‘Straight skirt’ from Section 2.4 move the
dart into the panel seam. Construct a panel seam at
33.3% from the centre front and centre back, meas‐
ured along the hem. Cut the panel seams at the
waist. Move the darts with move from point to point
into the panel seams. Draw new waist curves. Note

that the waist curves are to end at the dart lines in a
right angle.
5th exercise
In the style ‘Straight skirt’ from Section 2.4 rotate the
dart into the yoke. Construct a yoke starting at

150mm on the centre front and centre back, meas‐
ured from the waist and ending at 80mm on the side
seam, measured from the waist. Lengthen the dart
to the yoke and close the dart with the transfor‐
mation type turn about a turn point from point to
point. Make a copy of the yoke curve in the process.
6th exercise
Construct a yoke in Bodice 10 which runs through the
shoulder dart apex and rotate the shoulder dart into
the yoke line. Use the transformation type turn
about a turn point from point to point.
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7th exercise
In the Bodice 10 construct a princess line and rotate
the bust dart into the panel seam. Use the transfor‐
mation type turn about a turn point from point to
point.

8th exercise
In the Bodice 10 relocate the bust dart into the side
seam and the shoulder dart into the armhole. Con‐
struct a yoke in the front from the centre front to the
armhole. Relocate the yoke to the back with the
transformation type turn and move.

9th exercise
In the Trouser 10 (with turn‐up set to 0) construct a
yoke beginning 60mm from the waist on the side
seam and ending 120mm from the waist at the cen‐
tre front. The yoke curve is to begin and end at right
angles. Attach the yoke curve to the dart apex.

Flare the side seam by 90mm at the hem and con‐
struct a new side seam. The inside leg is to be vertical
(perpendicular line). The new hem curve is to start
220mm from the hem at the side seam and end
100mm from the hem on the inside leg seam. The
curve is to begin and end at right angles. Move the
yoke upwards by 60mm. Insert the yoke into part
003 and the trouser front into part 004.
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10th exercise
In the style ‘Straight skirt’ from Section 2.4 construct
a side panel with one pleat. Construct a line from the
dart apex parallel to the centre front. A perpendicu‐

lar is unsuitable in case the hem curve is altered in‐
teractively at a later time. Then, construct a yoke line
starting 100mm from the waist on the side seam and
ending 50mm from the dart apex on the auxiliary
line. Move the pleat piece to the right by 200mm and
spread it at the auxiliary line from the centre of the
yoke. The spread amount at the yoke is 30mm and
70mm at the hem.

12th exercise
In the front of Bodice 10 construct an overlap of
50mm at the centre front and a hem of 30mm with a
mitred corner at the centre front/hem.

11th exercise
In the style ‘Straight skirt’ from Section 2.4 rotate the
dart into the hem. Delete the hip line and construct
a vertical line from the dart apex onto the hem. Close
the dart with the transformation type turn about a
turn point from point to point. You need a copy of the
perpendiculars. Close the hem.

Mirror the allowances at the respective seam lines,
construct a diagonal line and mirror the diagonal line
at the seam lines. Close the corners.
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13th exercise
In the style ‘Straight skirt’ from Section 2.4 construct
an inverted pleat with 50mm pleat content at the

centre front and a flared side seam. Mirror at the
centre front. Set the text and the displayed symbols.
14th exrcise
Open the style ‘Blouse with pin‐tucks’ from 5th ex‐
ercise in section 8.6:

15th exercise
Call Skirt 20 and construct a panel seam with vent in
the front skirt. Relocate the dart in the back into the
side seam. Use the tool Parallel 10 and the functions
60
60
100

Open two new parts 003 ‘back yoke’ and 004 ‘back’.
Insert all lines and points you need to construct a
yoke into part 003. Construct the seam allowances
and the notches, adjust the part vertically (align →
part adjust vertical) and mirror the part at the centre
back. The centre back is now doubled and one of the
lines must be deleted. Set the grain line symbol and
a text.
Create part 004 ‘back’ in the same way, adding 2
pleats spread with a pleat content of 25mm and con‐
struct the dart hoods

70

50%

60

30

70

under transformation. Detach the production pat‐
tern pieces, construct the seam allowances, set sym‐
bols and mark the seam lines as dotted lines.
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17th exercise
Construct a skirt with panel seams and a pocket in
the front skirt from Skirt 20. Activate the grown‐on
waistband in Skirt 20 and adjust it interactively. To
shape the skirt use the functions parallel, line from
point to point, new curve and transformation. Con‐
struct a vent in the centre back. Detach the produc‐
tion pattern pieces, construct the seam allowances,
set symbols and mark the seam lines as dotted lines.
50%

50%
110

140

20

50

16th exrcise
Mirror the back of Bodice 20 at the centre back. Use
the transformation type mirror at line.
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The application of the construction parameter x
value and the resulting manifold styling options is
one of the outstanding features of Grafis. The skilful

use of x values allows for creation of style variations
or trend adjustments through adjustment of the x
values, only.

152

Chapter 11 The construction parameter x value

_________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Step‐by‐step guide

11.1 The X values

 Open the x value table from the pull‐down

X values are size‐related construction parameter.
The numerical values are logged in x value tables and
can represent lengths, distances, radius or angles, for
example. X values can be altered after completion of
a style at any time. Thus, later modification of the
style is possible in a very effective manner. For exam‐
ple, in the collar construction (title picture of this
chapter) the x values ‘collar stand’ and ‘angle for col‐
lar step’ were altered.






There are three different types of x values:
 x values of non‐interactive basic blocks,
 x values of the construction record and
 x values of all parts.

menu Extras via x value table or from the
toolbox
Select the List: (global or active piece)
Select the index card (values of the part or 1st
basic block for the basic block of the part)
Adjust one of the view options Edit view, Short
view or Interpolation view
Add, edit or delete size‐related x value assign‐
ments

The x values of the basic blocks
Each basic block contains a prepared x value table.
The x values represent lengths, percent, or angles
which are variable according to the respective con‐
struction instruction, e.g. ease or position and length
of the darts. The implementation of the x value into
the basic block and pre‐assignment of an appropri‐
ate value ensued by the developer of the basic block.
The user has the option to modify the basic block to
his own requirements by altering the x values.

The difference relates to the validity of the respec‐
tive type of x value. The application of x values is
identical for all types and is elaborated on the x val‐
ues of the construction record.
The x values of the interactive constructions can
only be edited in the drag environment and are
greyed out in the x value list.

Display selections
List, part and display options

List of available measurement charts/sizes
It activates when adding a value entry.

Comment line on
the x value

X value table
value column
X value table
size column
(The standard value is
marked by _xxxxx_x.)

Picture 11‐1
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The x values of the construction record

Step‐by‐step guide for editing x values

The x values of the construction record are user de‐
fined and implemented during construction. Thus,
the respective construction step can be altered later.

 Insert new x value into the x value table:
 Extras → X Values...
 Select the List: (active part or global)
 For List: active part: select the index card

Before starting the construction consider for which
construction steps the use of x values would be ben‐
eficial for flexible pattern modification!
In the following menus the use of x values offers
great modification options:
 parallel menu: distance for parallels
 raster menu: distance values and number of
points
 lengthen menu: values for lengthen by and
lengthen to
 sub‐menu point construction: values for rela‐
tive length or partial length
 dart menu: ...% of dart to be relocated
 spread menu: distance of spread line
 curves menu: bind starting point, final point
and base points of the new curve via the point
construction sub‐menu
 transformation menu: move amount, scale fac‐
tor, rotation angle
 points and lines menu: distance values, relative
values for point construction, length of a line
The x values of all parts (global x values)
Global x values apply to all parts of the style. They
can be used for example for:
 seam allowance self / lining,
 ease,
 distances for markings,
 adaptation factors for stretch etc.
The x values of all parts are additionally indicated
with a G (for ‘global’); small and capital letters have
the same significance. Example: XG5 or xg5.
XG5 stands for the fifth x value of the x value table of
all parts whereas x5 stands for the fifth x value of the
construction record of the active part. This rule ap‐
plies to calculation with z values as well as direct en‐
try into numerical fields.
You can switch between record x value tables of dif‐
ferent parts in the ‘Grafis X Values’ window, di‐
rectly. Merely select the required part number in the
‘Part:’ field.

Values of the part
Click on Add New X Value. A maximum of 80 x
values can be opened per part.
 Double‐click the comment line and enter the
description for the new x value. Be careful to
use clear definitions!
 Double‐click on the standard value (to the right
of _xxxxx_x=), enter the value and <ENTER>
 possibly: insert size‐related x value entries
 possibly: delete the last x value with Delete
Last X Value
 Quit with
or with Close
 Continue the construction and enter an x value
(e.g.: X2 oder XG1) instead of a numerical value


The Grafis ‐ X values window
The Grafis ‐ X values window offers the following op‐
tion for display of the required x value table (Pic‐
ture 11‐1).
List and index cards:
For each part one of the following x value tables can
be displayed:
 global (the x values of all parts) or
 the x values of the active part offered on a num‐
ber of index cards. The index cards contain the
x values of the non‐interactive basic blocks and
the x values of the construction record.
Select the required list under List: and then, click on
the card tag. The x value list of the interactive con‐
structions remains greyed out.
Part:
Select the part for which the list of x values is to be
displayed.
Display options:
The x value table can be displayed in the options
 Edit view,
 Short view or
 Interpolation view.
The Edit view with all size entries is the most detailed
option.
In the Short view only the x value numbers and de‐
scription and the standard value _xxxxx_x are dis‐
played.
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Interpolated values for specific sizes can be viewed
in the Interpolation view after having clicked the size
in the Size name field.
Generate new x value and apply it to the construc‐
tion
Open the list of x values of the construction record
via Extras → X values… and select List: active part.
The file card active part is active. Switch to Edit view.
Open a number of new x values by clicking on Add
new x value and delete a few by clicking on Delete
last x value.
Name the first x value x1 ‘overlap width’ by double‐
clicking on the comment line and entering the text.
Now assign the standard value for x1 with 20 by dou‐
ble‐clicking to the right of _xxxxx_x= and entering 20.
Name the second x value x2 ‘button position from
bust point height’ and assign this standard value also
with 20 (Picture 11‐1).
Now call the construction Bodice 10 and construct a
parallel for the overlap (Picture 11‐2). In the parallel
menu, enter the distance value x1 before clicking on
the centre front. This determins that the current
value of x1 will be used for construction of the next
parallel. Now click the centre front and the overlap
appears at a distance of 20mm.
x1=20
x2=20

x1=70
x2=70

Grade the construction in the sizes N40, N36, N44.
Stack at the bust point and measure. You will see a
result according to Picture 11‐2 left. In the x value
list, alter the values of x1 and x2 to 70 respectively.
After test run and grading you will see the result ac‐
cording to Picture 11‐2 right. Enter other values.
Alterations to x values are only visible after test run
and grading.
An x value must be defined before it can be used in
a construction step. Should this not be the case,
Grafis will refuse processing.
Whether an x value is interpreted in mm, in percent
or in degrees depends on the function with which
the x value is used. When entering the x value as a
relative length, the x value is used as a percentage.
When entering the x value as a rotation angle, the x
value is an angle in degrees.
Redirecting an x value
From Version 9 recorded x values can be redirected
to global x values. The character set in the comment
line of the respective x value is supplemented with
=>{XG4}, here for the redirection to the fourth global
x value. If this character set is removed, the original
values apply. The production patterns of the pocket
modules contain x values for seam allowance. If you
control the seam allowance for your styles via the
global x value XG2 you can supplement the comment
line of the seam allowance x value in the production
pattern with the character set =>{XG2}.
Size‐related x values
Adding, editing and deleting size‐related x values can
ensue in the Edit view, only.
To add x value entries the x value or one of the cor‐
responding size‐related x value entries are to be
highlighted. The list of available measurement charts
from which measurement charts can be selected by
clicking opens to the right. Each selected measure‐
ment chart is accepted into the x value table.
A size can be assigned a value, only if it is available
as a measurement chart on the workstation!

Picture 11‐2

Construct the first button position with a distance of
x2 from the bust point on the centre front. Use the
point construction point with distance to a base
point on a line with the distance value x2. First, the
bust point is to be clicked and then, the centre front
in direction hem.

Adding new x value entries is followed by editing the
values by double‐click on the numerical value or
clicking on Edit Entry. With Edit Entry the next nu‐
merical value is offered, automatically.
To delete or edit x value entries the entry is to be
highlighted and Remove Size is to be clicked.
Opening new x values or deleting existing x values
is not possible with x values of the basic block.
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Construct a yoke in the back of Bodice 10. The start
of the yoke at the centre back is to be controlled via
x3 and the end of the yoke at the armhole via x4. En‐
ter the x values x3 (100mm) and x4 (70mm) and con‐
struct a curve starting vertically on the centre back
at a partial length with plg=x3 and ending horizon‐
tally at the armhole with plg=x4. The measurements
are taken along the curves from the neck to the hem
respectively. Grade the sizes N38 to N42 and stack at
the neck. The result is shown in Picture 11‐3 left.

Having double‐clicked on the line of size N40, enter
the value 120 and in the line for size N42 enter the
value 130. Now close the X value window, grade and
stack. You obtain a result according to Picture 11‐3
right.
Rules for size related value assignment
X values can be altered in correspondence with the
size. However, it is not necessary to assign each size
with a value. The following cases apply:
Case 1: The x value is identical for all sizes
In this case, only the standard value _xxxxx_x is to be
assigned. Further entries are not necessary.

Picture 11‐3

The start of the yoke on the centre back is to be size‐
dependent and altered by 10mm from size to size.
Select one of the lines of the respective x value x3
(Picture 11‐4). The list of existing measurement
charts/sizes opens. From this list you transfer the
sizes N40 and N42 with a simple click.

Case 2: The x value is to be identical for all sizes of
the same figure type
The standard measurement charts are organised in
figure types, depending on the measurement sys‐
tem. For example, the Optimass measurement sys‐
tem distinguishes between narrow hips/ normal
hips/ wide hips and additionally between short/ reg‐
ular/ long.
If only one size of a figure type is assigned a value this
value applies to all other sizes of this figure type, see
Picture 11‐5.

To set a size entry,
select one of the lines
of the respective x value.

The list of available measurement charts/ sizes
opens for adding a size entry.

Picture 11‐4
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You can find more information on figure types in
Chapter 2 in the section ‘Work with measurement
charts’.

sizes. The even alteration continues for the sizes be‐
fore the first and after the last entered size, but for
the respective figure type, only, see Picture 11‐7.
These rules apply to standard sizes of a figure type,
only.

value
___N38_0 = 25.0
25.0

Individual measurement charts can be assigned x
values, also. Furthermore, an individual measure‐
ment chart can be assigned the x value of a stand‐
ard size via x value references, see section 11.3.
Enter the x values absolutely necessary for the re‐
quired dependency into the x value table, only. This
makes care easier and reduces mistakes.

32

34

36

38

40

42

44

size N…

Picture 11‐5

After having altered x value entries test run should
always ensue!
Exercise

Case 3: An even alteration to the x values for the
sizes within a figure type is to ensue
value

___N40_0 = 26.0

26.0
24.0
___N38_0 = 24.0

Create a shirt with flared hem from Bodice 10 with
portions of the bust dart being relocated into side
seam and hem depending on the size. In the smaller
sizes up to size N40 the complete bust dart is to be
relocated into the hem. From size N42, 25% of the
bust dart are to be relocated into the side seam and
75% into the hem. From size N46, 50% are to remain
as bust dart and the remaining 50% are to be relo‐
cated into the hem.
Call Bodice 10 and delete auxiliary points and lines
which are not required.

32

34

36

38

40

42

44

size N…

Picture 11‐6

In this case it is sufficient to assign two sizes of the
relative figure type with the required x values. The
even alteration of the x value is continued through‐
out all sizes of the figure type, see Picture 11‐6.
Case 4: The x value is to be altered unevenly within
a figure type.
value

___N42_0 = 28.0

28.0
24.0
___N38_0 = 24.0
___N36_0 = 24.0

32

34

36

38

40

42

44

size N…

Picture 11‐7

In this case it is necessary to assign values to a num‐
ber of sizes. The following rule applies: an even alter‐
ation of the x value ensues between two adjacent

Generate two x values:
x1 portion bust dart in side seam
x2 portion bust dart in hem

25.
25.

Note: With this pre‐assignment of the x values, all
darts initially remain open so that correct dart hoods
and allowances can be constructed.
Relocate the bust dart into the side seam with the
function relocate dart, entering ‘x1’ as value for the
dart portion. Relocate additional lines and points
such as the front pitch for example. Relocate a fur‐
ther portion of ‘x2’% into the hem.
Construct a single dart hood for the bust dart and the
dart in the side seam. Link the hem as a curve. Then,
link the side seam and the shoulder as a continuous
line sequence including the dart hood lines. Then,
construct the parallels to ensure that the seam al‐
lowances are also created correctly when the dart is
closed.
Generate two global x values for the allowances:
x1 general seam allowance
10.
x2 hem allowance
20.
Construct the seam allowances at side seam, arm‐
hole etc using ‘xg1’.
The hem allowance is created with ‘xg2’. You will ob‐
tain a result according to Picture 11‐8.
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N38

N40

N42

25%

N44

N46

N48

25%
Picture 11‐8

Picture 11‐9

Only now, adjust the x values according to the in‐
structions:
x1 portion bust dart in side seam
_xxxxx_x =
25.000
___N38_0 =
0.000
___N40_0 =
0.000
___N42_0 =
25.000
___N44_0 =
25.000
___N46_0 =
0.000
___N48_0 =
0.000

Checking the calculation of x values
Checking x value calculations is made easy with the
Interpolation view option (Picture 11‐10). Highlight
the respective sizes in the Size name list. In the x
value table only the x values of the respective size
are displayed, see also Picture 11‐10. Additionally,
the sizes used for calculating the x value are stated.
The calculation variations are displayed as shown for
size N36:

x2 portion bust dart in hem
25.000
_xxxxx_x =
___N38_0 = 100.000
___N40_0 = 100.000
___N42_0 =
75.000
___N44_0 =
75.000
___N46_0 =
50.000
___N48_0 =
50.000
Sizes N38 and N48 were also assigned with a value
to ensure that the dart distribution does not change
further in the following smaller or larger sizes.
For example, if no value is assigned to size N48, the
value for size N48 would be calculated from the val‐
ues for N44 and N46 via extrapolation. In this case x1
would equal ‐25 and x2 would equal 25.
Ensure realistic values also for very small and very
large sizes when using size‐dependent x values!
With the listed x values you obtain a result according
to Picture 11‐9.

1. The standard value applies to the respective size
(_xxxxx_x), e.g.:
x1
overlap width
___N36_0: [_xxxxx_x]
2. A specific value is assigned to the respective size,
e.g.:
x1
overlap width
___N36_0: [___N36_0]
3. For the figure type of the respective size only one
size entry is available (here: size ___N40_0); it ap‐
plies to the respective size, also, e.g.:
x1
overlap width
___N36_0: [___N40_0]
4. The x value of the respective size is calculated
from two size entries (i.e.: size ___N42_0 and size
___N46_0), e.g.:
x1
overlap width
___N36_0: [___N42_0/___N46_0]
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X value for size highlighted on the right
Size entries on which the calculation is based.

Picture 11‐10

Exercise
Alter the x value table of the first construction of this
chapter as follows:
x1 overlap width
_xxxxx_x =
20.0
x2 button position on CF from bust point
_xxxxx_x =
20.0
x3 start of yoke on CB from neck
_xxxxx_x = 120.0
___N38_0 = 120.0
___N40_0 = 120.0
___N42_0 = 130.0
___N46_0 = 150.0
___N52_0 = 155.0
x4 end of yoke on armhole from shoulder
_xxxxx_x =
70.0
Reflect which value x3 has in the sizes N34, N36, N38,
N44, N46, N48 and N52. Then switch to the interpo‐
lation view and select the respective sizes one after
the other in
the
Size
name
list.
For
size
___N36_0 all
information
appears ac‐
cording to
Picture 11‐
10.

Analyse the displayed values with graphic represen‐
tation like Picture 11‐5 to Picture 11‐7.
Analyse the values for other figure types. Supple‐
ment the x value table with your own entries and
check the implications on the x values of other sizes.
Start test run, grading and measure.
Additional functions
The pin is an echo and cannot be clicked. While the
pin is visible, the x values of the selected part are
shown, even if another part has been activated by
clicking in the main window. If the pin is not visible,
the x values of the active part are indicated automat‐
ically.
In Grafis Setup advanced users can activate the op‐
tion Additional functions in the x value window, see
Picture 11‐11. These additional options help during
visual adjustment of the user's x values. With the
buttons test run and grading, the active part can
quickly be calculated after having altered the values.

Picture 11‐11
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Automatic grading with / without successors and Au‐
tomatic test run starts automatic calculation of the
construction after alteration of values. Hold value
entry activates the hold function for the altered x
value.

11.2 Size‐dependent adjustment of inter‐
active constructions
Step‐by‐step guide
 Assign size table with at least the sizes to be ad‐

justed
 Activate construction with double‐click or from

the overview with <F12>
 Select the drag area in which drag points are to

be adjusted size‐dependently
 Open the Break sizes window by clicking on break

sizes in the menu on the right
 Transfer break sizes
 Make size‐dependent adjustments to individual
drag points either
 in each size or
 in one size, maintaining the set increments.
The aids stack and ruler can be used during drag‐
ging.
How does drag work?
Each interactive construction is variably adjustable
via a multitude of x values. As opposed to the x val‐
ues of the construction record, the x values of the in‐
teractive construction are ‘visible’ through drag
points. Moving a drag point alters one or two x val‐
ues. You can see the value of the current x value and
its number in the value window (Picture 11‐13).
The construction is recalculated after each alteration
of the value. The effect on the complete construction
is immediately visible. As the logic of a construction,
for example of a bodice, can be extensive, powerful
computers should be used. Otherwise, the construc‐
tion changes in jumps. If this is the case for you check
whether a raster is active. If not, you should continue
working on a computer with higher clock speed.
Size‐dependent adjustment of an interactive con‐
struction means adjusting the x values of the con‐
struction depending on size.

Select break sizes
First, assign the
size table with at
least the sizes
you
probably
need as break
sizes. Then, acti‐
vate the con‐
struction
with
double‐click or
with <F12> and
select the drag
area in which the
Picture 11‐12
drag points are to
be adjusted size‐dependently. Click on break sizes in
the menu on the right. The Break sizes window opens
(Picture 11‐12).
The list of break sizes in Picture 11‐12 contains all
sizes which can become break sizes of the active drag
area. These are all activated sizes of the size table or
their reference size. Further information on refer‐
ence sizes can be found in section 11.3. The first po‐
sition of the list is occupied by the base size.
The base size of the interactive construction is the
size, which is adjusted interactively if no other break
sizes are activated. The size in the first position in the
size table is automatically also the base size of the
interactive construction.
Open a new style and call the basic block Skirt 20. The
skirt is to be graded in the sizes _N34 to _N46. Enter
these sizes into the size table. The first position of the
size table is still to be assigned with _N38. Grade the
construction. The width of the skirt changes across
the sizes but not its length. The skirt length is to be
adjusted to a constant 600mm for the smaller sizes
up to _N40 and 700mm from size _N42 upwards. Ac‐
tivate the construction Skirt 20 and change to the
drag area Line relocation. Click on the button break
sizes in the menu on the right. A window opens as
shown in Picture 11‐12. Activate the sizes _N40,
_N42 and _N46 and end selection of break sizes with
<OK>.
Only sizes (or their reference size – see section 11.3)
listed and activated in the size table can be adjusted
interactively.
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The value window
The break sizes activated in the drag area appear in
the value window, see Picture 11‐12 and Pic‐
ture 11‐13.
Click on the left of the two buttons
. Each size
can now be dragged individually or adjusted with
values. Use this display option while no grade has
been determined for this drag point.
Click on the right of the two buttons
. In this dis‐
play option you can
 edit the increments with numeric values or
 adjust one of the offered sizes interactively,
maintaining the increments. The other sizes are
altered respectively after release of the mouse
button.
Set the skirt length in the drag area Line relocation of
Skirt 20 as shown in Picture 11‐13. Then, quit the in‐
teractive environment and grade in the sizes _N34 to
_N46. The x value for the skirt length is calculated ac‐

The list of break
size in Picture 11‐
14 belongs to a
drag area in which
initially the nor‐
mal _N sizes
_N38,
_N40,
_N42, _N44 and
_N46 had been
adjusted.
Addi‐
tionally, the short
sizes are to be ad‐
justed. These have
already been en‐
tered in the size
table and acti‐
vated in the break
size table. If the
Grafis ‐ Break sizes
dialogue is now
closed with OK, all
Picture 11‐14
short break sizes
will be assigned the values of base size _N38.

Picture 11‐13

cording to the rules of section 11.1. Thus, the skirt is
600mm long in the smaller sizes up to N40 and
700mm long in the larger sizes from N42 upwards.
Transfer values from break size to break size
A construction prepared for normal _N sizes is now
also to be produced in short _S sizes. If you have not
been able to immerse yourself in the alternative
break size from section 11.4, simply activate the re‐
spective short sizes as break sizes and assign the val‐
ues of the normal sizes. This process is only required
in drag areas with more than one break size.

Picture 11‐15

For a suitable pre‐assignment of the short sizes, click
on Transfer values>>. The Grafis ‐ Break sizes dia‐
logue changes according to Picture 11‐15 right. Now
click in the column Values of..., select the corre‐
sponding size from the normal figure type in the col‐
umn Transfer values from... confirm with
and
continue assigning values with the next short size.
After having clicked OK all sizes of the first column
Break size will be assigned with the values from the
sizes of the column Values of....
This transfer of values is a one time operation.
There is no permanent link such as is possible with
the alternative break size from section 11.4.

Chapter 11 The construction parameter x value

161

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

11.3 The x value reference
In the size table you can find the column x reference
(Picture 11‐16), which influences the calculation of x
values.
All sizes for which an entry exists in the 'x reference'
column of the size table are calculated with the x
values of the assigned x value reference size (short:
x reference).
The measurement chart in this column...

Picture 11‐17

... is graded with the x values of the meas‐
urement chart of this column.
Picture 11‐16

With the x value reference, measurement charts/
sizes in the size list are assigned with x values of
other measurement charts/ sizes.
The x value reference is usually used to assign the x
values of a standard measurement chart to an indi‐
vidual measurement chart.
When entering an individual measurement chart
into the size table, the x value reference is assigned
by default with the standard size on which the indi‐
vidual measurement chart is based. If no x value ref‐
erence is entered the standard value applies to indi‐
vidual measurement charts. Entering, editing and de‐
leting the x value reference ensues analogous to ed‐
iting the measurement chart column.
Open a new style and call Tailored
jacket 20 from the folder Grafis Bod‐
ices | Mens bodices and load the
standard mens sizes _HN48 to _HN58
into the size table. In the interactive
environment of Tailored jacket 20 ad‐
just the option Style length based on x
value. Go to the Line relocation drag
area and open the list of break sizes. In addition to
base size _HN48 activate the size _HN58 as break
size and close the list. Activate the drag point for the
style length and adjust it to 790mm in size _HN48
and to 830mm in size _HN58. Then, grade all sizes.

Now, the jacket is to be graded with company‐spe‐
cific body measurements. Set up an individual grade
run from ’HAKA48’ to ’HAKA58’ based on the stand‐
ard figure type _HN. Alter the grade run of the bust
and lower hip circumferences. Enter the individual
sizes ’HAKA48’ to ’HAKA58’ into the size table and
grade. Through application of the x value reference
to the standard sizes _HN, the size dependent style
length of the _HN sizes is applied to the individual
’HAKA’ sizes, see Picture 11‐17. Now, remove the x
value reference in the size table and grade again. The
style length is now applied based on the settings of
the base size.

11.4 The alternative reference size
This section is for advanced users. Beginners are ad‐
vised to read through all application examples and
then, come back at a later date for a more detailed
look if required.
The alternative reference size has been developed
for Grafis Version 11. It has system‐wide effect and
should therefore, only be applied by experienced
Grafis users. The function has been developed to al‐
low users to apply changes to x values quickly from
one figure type to another figure type. The alterna‐
tive reference size is particularly interesting for
 companies, which manufacture styles for dif‐
ferent figure types and
 made‐to‐measure studios where styles are de‐
veloped in a standard size range and then, ad‐
justed to individual customers' wishes.
Please note the application examples on the follow‐
ing pages.
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Assigning an alternative reference size
Open a style and make size‐dependent adjustments
for figure type ’_N’. Switch on the alternative refer‐
ence size in the Grafis Setup. An additional column,
alt. reference appears in the size table into which
standard measurement charts can be entered. The
size in the alt. reference column acts as alternative
reference size to the size in the second column.

Priority for search of a matching size entry for grade
rules of single grade points:

1.
1.

Rules and effects of the alternative reference size

1.

The alternative reference size takes effect if no set‐
tings have been saved for the size to be graded in the
following areas
 individual x values (Chapter 11),
 individual drag areas of interactive construc‐
tions,
 individual grade points in grade rule grading
and
 curve adjustments.
The alternative reference size is a 'deviation' size if
for this size or its x value reference no settings are
entered in the above four cases.
When calculating a value in one of the above four
cases, a matching size entry is searched according to
a pre‐set priority. This priority is slightly different
during grade rule grading as no grade rules can be
saved for an individual measurement chart. The
numbers in Picture 11‐18 and Picture 11‐19 state the
priority for search of a matching size entry.
Priority for search of a matching size entry for x val‐
ues, in drag areas and for curves:

1.

1.

1.

1.

2.

2.

1.

2.

1.

1.

2.

Picture 11‐18

2.

2.

1.

1.

2.

1.

Picture 11‐19

Summary
 The application of the alternative reference size
is only useful if a style is to be manufactured in
different figure types or if a prepared style is to
be adjusted specifically for a particular person.
 The alternative reference size is a 'deviation'
size if for the size or its x value reference no set‐
tings have been saved.
 The alternative reference size effects the x val‐
ues of a construction, adjustments to interac‐
tive constructions, curve adjustments and grad‐
ing with grade rules.
 As a rule, a style should be completely adjusted
and checked for one figure type. Only then,
should the style be adjusted for further figure
types or for particular persons via the use of the
alternative reference size.
 Take notes for each style detailing exactly
which part/construction of the style has been
globally adjusted and in which parts/construc‐
tions specific adjustments have been made for
the different figure types or a particular person.
Only with good documentation can the style
development be recreated at a later date.
 During grade rule grading the grade of one fig‐
ure type can be transferred once onto another
figure type.
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1st Application example
Corporate outfit with individual adjustments
For the corporate outfit of a company, a puffball skirt
has been developed in sizes _N34 to _N44, tested
and approved by the customer. Colleague Karen re‐
quires a special fit: the skirt is to be 10cm longer than
the standard size range. Karen's body measurements
have been taken and saved as an individual measure‐
ment chart. The nearest stardard size is _N40.

Picture 11‐21
Picture 11‐20

Adjust your size table according to Picture 11‐20.
Currently, the size KAREN is graded based on body
measurements. The skirt length for this size is identi‐
cal with the skirt length in size _N40. Activate the
interactive skirt basic block, change to the drag area
Line relocation and load the size KAREN as an addi‐
tional break size, see Picture 11‐21. Ensure that size

KAREN has been pre‐assigned the values of _N40.
Now, lengthen the skirt in size KAREN to the desired
length and grade with a result according to Pic‐
ture 11‐22.
Please note that the size KAREN has otherwise been
graded according to the settings for _N40 and the set
body measurements

Picture 11‐22
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2nd Application example
Creation of a jacket style for different figure types
A jacket has been developed from the interactive
constructions Bodice 50, Front part 30, Front edge 30
and Back part 40, see Picture 11‐25. The jacket has
already been adjusted for sizes _N38 to _N42. In ad‐
dition to the normal sizes, short and long sizes are to

Picture 11‐23

be produced. The basic adjustments such as seam al‐
lowances must be the same in all figure types. Only
the position of the pocket is to be adjusted.
Picture 11‐25

Prepare your size table according to Picture 11‐23
and grade. Activate the Front part 30 tool
and change to the drag area Pocket open‐
ing. Insert two break sizes in this drag
area: _S38 for the short sizes and _L38 for
the long sizes. Adjust the pocket opening
in sizes _S38 and _L38 according to your
ideas, see Picture 11‐24.
Then, grade sizes _N38, _S38 and _L38
with a result similar to Picture 11‐25.

Picture 11‐24
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3rd Application example
Creation of an imported trouser pattern in short
sizes
A trouser pattern has been imported in sizes _36 to
_44. The imported pattern looks similar to Pic‐
ture 11‐26 in sizes 38 and 42.

Picture 11‐26

The trousers are now to be manufactured in short
sizes also. The pattern must not be altered in the hip
area. Only the grade rules at the hem are to be ad‐
justed for the short sizes.

Picture 11‐28

The hem is now 10cm shorter in the short sizes, see
Picture 11‐29.

Picture 11‐29

Picture 11‐27

Set up the size table according to Picture 11‐27. Ac‐
tivate the grade rule pattern of the trouser back and
adjust the three grade points at the hem for the
short size figure type manually by entering values ac‐
cording to Picture 11‐28

The alternative reference sizes _36 to _44 must be
referenced permanently to ensure the required
grading.
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4th Application example
Transfer of an imported grade to another figure
type
A trouser pattern has been imported in sizes _36 to
_44. The imported pattern looks similar to Pic‐
ture 11‐26 in sizes 38 and 42. The grade is to be ap‐
plied to sizes _N36 to _N44, _S36 to _S44 and _L36
to _L44 to be adjusted for other figure types at a later
date.

 quit grade rule pattern with
 save changes in record?: Yes
 activate next part
In this way, the grade rules of the sizes of figure type
_36 to _44 are transferred to the figure types _N, _S
and _L. New break sizes have been inserted in all
grade rule tables for the sizes activated in the size ta‐
ble, see Picture 11‐31.
You can now remove the alternative reference size
and adjust the grade rule patterns in the figure
types _N, _S and _L separately. In the figure types
_N, _S and _L the alternative reference size is no
longer effective as the grade rule tables of all points
now have values in all parts for these figure types.
Alter the size table according to Picture 11‐32 and
grade.

Picture 11‐30

Set up your size table according to Picture 11‐30 and
grade all sizes. Activate all parts of the imported pat‐
tern one after the other and select
 Rule pattern → Extract Grade Rule Pattern
 extract

Picture 11‐32

In case some parts are identical in the figure types
_N, _S and _L, you can continue to work with the al‐
ternative reference size in the style. These parts are
graded in the _N sizes only and then, start Extract
Grade Rule Pattern. Thus,
in these parts only grade
rules for the _N sizes are
saved. The alternative ref‐
erence size for the _S and
_L sizes must point perma‐
nently to the _N sizes. The
grading of parts with grade
rules in _N, _S and _L en‐
sues according to the set
grade rules, independent
of an alternative refer‐
ence.

Picture 11‐31
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5th Application example
Creation of a swimsuit in different cup sizes
A swimsuit has been developed from the basic block
Bodice 80, see Picture 11‐33.

Picture 11‐34

Picture 11‐33

The swimsuit has already been adjusted for cup
size A and the underbust sizes A65 to A95. In addi‐
tion to the A cup sizes, the swimsuit is to be adjusted
for B and C cup sizes.

Create your size table
according
to
Pic‐
ture 11‐35 and grade.
Activate the curve for
the cup shaping, load
additional break sizes
for the B and C cup sizes
and interactively adjust
the cup shape, Pic‐
ture 11‐34. Then, grade
all A, B and C cup sizes
with a result similar to.
Picture 11‐36.

Picture 11‐35

Picture 11‐36
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Exercises on X values
st

1 Exercise
Call the basic block Skirt 20, design a yoke and a sep‐
arate panel in the lower part of the skirt which can
be modified via x values with new curves.
X value assignment:
x1 Yoke centre front [mm]
_xxxxx_x =
150.000
x2 Yoke side seam [mm]
75.000
_xxxxx_x =
x3 Yoke centre back [mm]
_xxxxx_x =
150.000
x4 Lower skirt part centre front [%]
_xxxxx_x =
25.000
x5 Lower skirt part side seam [%]
_xxxxx_x =
15.000
x6 Lower skirt part centre back [%]
_xxxxx_x =
25.000
X1=150mm

X value assignment:
x1 first pleat from neck [mm]
_xxxxx_x =
10.000
x2 pleat content shoulder [mm]
_xxxxx_x =
40.000
x3 pleat content hem [mm]
_xxxxx_x =
40.000

X3=150mm
X2=75mm

X4=25%

nd

X5=15%

X6=25%

2 Exercise
Create a shirt blouse with three variable pleats in the
back from Bodice 10. Adjust the following options:
 centre back fold
 straight side seams
Close the shoulder dart and the waist dart. Then, de‐
lete all auxiliary lines and shorten the piece to the
waist. Link the shoulder. Construct a point on the
shoulder at a distance of x1=10mm from the neck.
The first spread line is to begin at this point. Starting
at this new point construct a point sequence of 4
equally distributed points along the shoulder. Con‐
struct three spread lines to the hem. Spread the
three pleats, controlling the pleat content at the
shoulder via x2=40mm and the pleat content at the
hem via x3=40mm. Close the pleats at the shoulder
with a single dart hood and link the hem. Link the
shoulder and dart hood lines with link single.

Alter the pleat content as displayed by altering the
values for x2 and x3. After test run the construction
is changed accordingly.
3rd Exercise
Construct a simple collar with distances variable via
x values where indicated.

X8

X4
X7

X3
X6

X2
X1

X5

The pre‐assignment for the x values is to be as fol‐
lows:
X1=150.0
X2=35.0
X3=20.0
X4=40.0
X5=40.0
X6=45.0
X7=80.0
X8=155.0
With this pre‐assignment the displayed collar is cre‐
ated.
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Mirror the collar and delete superfluous points and
lines. Alter the x values x3 and x4 to 5mm increments
per size and x6 to 10mm increments per size. Grade
the collar in the sizes N38, N40 and N42. With the x
value x1 the length of the neck seam can be adjusted.
All other x values mainly alter the shape of the collar.

4th Exercise
Construct a shirt collar with indicated measurements
variable via x values.
The pre‐assignment for x values is to be as follows:
X1=10.0
X2=5.0
X3=10.0
X4=25.0
X5=65.0
X6=20.0
X7=20.0
X8=15.0
X9=10.0
X10=10.0
X11=66.0 X12=150.0

Alter X4 and X10:
X4:
___N38_0=25.
___N40_0=15.
X10: ___N38_0=10.
___N40_0=20.
Again, grade the sizes N38 and N40.

Assign all x values as the standard value indicated.
Activate the sizes N38 and N40 in the size table. Alter
the x value x11 so that it is 66. for size N38 and 50.
for size N40. Grade the shirt collar construction.
Alter x11 so that it is 66. for all sizes.

The collar has not been aligned with the length of
the neckline. For a simple alignment, z values are
required, see Chapter 12.
X10 in °
X8
X9

X5

X4

X6
X11/100*X12 (X11 in %)

X1
X2
X12

X7

X3 in °
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5th Exercise

004
003

Create fashionable trousers with a zip in the left side
seam from Trouser 10.
Create and label the following parts in the part list:
001 basic trouser shape
002 developm. trouser
003 PP yoke ft
004 PP yoke bk left
005 PP ft left
006 PP bk left
007 PP yoke bk right
008 PP ft right
009 PP bk right

006

005

Call the basic block Trouser 10 into part 001, set the
hem turn‐up to 0. and close the second dart in the
trouser back. Insert part 001 into part 002.
Create the style development in part 002, applying
the following x values:
x1 yoke ft ss from waist [mm]
_xxxxx_x = 60.
x2 yoke ft CF from waist [mm]
_xxxxx_x = 100.
x3 yoke bk CB from waist [mm]
_xxxxx_x = 120.
x4 flare ss [mm]
_xxxxx_x = 100.
x5 cut height ss from hip line [%]
_xxxxx_x = 75.
x6 cut height inside leg [%]
_xxxxx_x = 85.
X3

X1

X2

X1

X5

6th Exercise
Call the Skirt 20, interactively adjust straight side
seams, close the second dart in the skirt front and
move the first dart to 50%. Generate an x value for
the position of a panel seam in the hem, measured
from the centre front and construct the panel seam
starting at the end point of the dart. To achieve an
optically more flattering run of the panel seam in
larger sizes, the position of the panel seam at the
hem is altered size‐dependently:
x1 position panel seam hem from CF in %
_xxxxx_x = 45.000
___N38_0 = 45.000
___N40_0 = 45.000
___N44_0 = 40.000
___N46_0 = 40.000

X5
X6
X4

X4

Derive the production patterns (PP) 003 to 009 from
part 002 and develop them to production standard.
The pleat content in parts 005, 006, 008 and 009 is
to be controlled via an x value of the part. Parts 003
to 006 are displayed.

N40
N46
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The g and z values complete the palette of construc‐
tion parameters so that basic blocks can be drafted
from scratch. The g values deliver the relationship to
the measurement chart of the measurement system.

The z values allow for calculation of construction pa‐
rameters with numerical values or values measured
in the construction.
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12.1 The G values

G1

G2
G3
G4
G5

G10
Picture 12‐1

G values are the size values of the current measure‐
ment system which are logged in the well‐known
measurement charts. g1 defines the first value of the
current measurement chart, g2 the second value and
so on. In the measurement system Optimass (Ba‐
sis_A) for example g2 is the bust and g1 the height,
see Picture 12‐1. The measurement charts can be ed‐
ited, viewed and/or printed via Extras → Measure‐
ment Charts.

G1

Always consider the selected measurement system
when working with g values!
G values are applied in the same way as x values. In
conjunction with the z values ‐ which will follow ‐
they allow for drafting basic blocks on screen.

G3

Exercises
1st exercise
Construct a rectangle with the waist as the width and
the body height as the height. Grade in sizes N38,
NS38, N42 and NS42, see Picture 12‐2.
For this construction, use the interactive tool Rectan‐
gle 10. The lower left corner is set to the zero point
(x=0 and y=0).

Picture 12‐2

Next, select the drag point top right for the height
and assign G03 for body height to this drag point in
the same way.
entry of the g value

From Version 12 onwards, x, g and z values can be
applied to selected drag points of the interactive
constructions and tools!
Activate the interactive tool Rectangle 10 and select
the drag point for the width, see Picture 12‐2. Then,
enter ‘g‘ into the value window and select G03 for
the waist girth.

width = G03
Picture 12‐3
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2nd Exercise
Construct a rectangle with the bust as width and
waist to floor as height. Grade the sizes N38, NB38,
N42 and NB42, see Picture 12‐4.

13% of
G1

G20

G9
G2

G12

G29
G3
G1
G8

G2

G5

Picture 12‐4

In the Optimass (Basis_A) measurement system,
connect the two drag points for width and height of
Rectangle 10 with width =G02 and height=G29. The
lower left corner is to be placed with point from
x=y=0. The lower left corner is to be placed with
point from x=y=0.
3rd Exercise
Construct the figure displayed in Picture 12‐5 or a
similar shape in the measurement system Optimass
(Basis_A). The circumference measurements are not
halved or quartered. The calculation of g values is
possible with the application of z values, see next
section.
In the points and lines menu construct a vertical line
with the interactive Tool Line 10 with a length=G1,
starting at the zero point. Then, carry out the length
division.

12.2 The Z values

Picture 12‐5

The first point is to be constructed at a relative
length=13. from the top. For all further points use
the function point at a distance to a base point on a
line with the distances G9, G12 and G8 respectively.
Construction of the horizontal lines ensues with
Line 10, with the lengths G20, G2, G3 and G5. Close
the shape with line from point to point. Grade the fig‐
urine.

Input assistant

What are z values?
Z values are calculated construction param‐
eters. For the calculation of z values
 all defined construction parameters (x,
xg and g values),
 previously defined z values,
 measurements from the construction,
so‐called process data (e.g. GL, AB, TL),
 numerical and mathematical functions
can be used.
From Version 12 onward, a case differenti‐
ation can be entered for z values with up to
three conditions. Use the input assistant.
Defined z values are applied in the same way as x val‐
ues.

Formula

Comment

Picture 12‐6

Entering and altering z values
Entering and altering z values is started with the
function key <F11> or via Extras → Z Values. With
few exceptions this is possible in all menus after test
run or a record function.
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Pressing the <F11>
Switch between:
View variations
Sort sizes
key opens the z value
Edit z value <=> View
entry window (Pic‐
ture 12‐6). The z
value with its calcula‐
tion formula is en‐
tered into the for‐
mula column and a
corresponding com‐
Picture 12‐7
ment is entered into
 Angles are to be entered in degrees (e.g.:
the text column. Longer comments can be entered
sin(45) for the sine of 45 degrees).
into the large edit window below the z values.
 Mathematical expressions with correct syntax
The calculated result for the style size appears in the
are accepted only.
value column. Having selected the z value, an exist‐
 Defined x and g values, mathematical functions
ing z value can be re‐assigned. After correction of the
and process data can be used to calculate z val‐
selected z value, the construction record runs to the
ues (see examples). Processing previously de‐
saved record step and re‐determines the z value.
fined z values is also possible.
Switching to long format also displays the values for
The calculation of z values is recorded. Resetting the
the other sizes in the grade table. The display can be
record resets the z values also!
switched from normal display to difference to 1st size
Permitted operators
or relative difference. The order of sizes can be ar‐
ranged according to the order in the grade table or
+
for addition
according to standard sizes (Picture 12‐7).
‐
for subtraction
*
for multiplication
In addition, the z value list can be printed or copied
/
for division
to the clipboard. The z value list displays the record
#
for exponent
step during which the z value was entered. A z value
can only be deleted if it is no longer required for a
Permitted operands
correct record run. When resetting the Grafis record
g6 g values
the z values which are part of the record step are also
g6=sixth value of the current measurement
reset.
chart
Use z values also for displaying warnings!
x3 x values
For example, if a distance may never be smaller than
x3=third value of the x value table (active
100mm, generate a z value z.=Ab, enter the value
part) of the current part
100 in the Min field and measure the distance after
xg5 x values of all parts (see Chapter 11)
having pressed <ENTER>. In case the value is actually
xg5=fifth value of the x value table of all
smaller, a warning appears ‘Warning: value fallen be‐
parts of the style
low minimum z.=Ab’. Ensure a suitable comment for
z4 z value z4
the z value!
num‐ numbers, e.g. 12; ‐12.0; 23.6, with the
ber point as decimal point
Syntax (spelling) of the z value entry
pi
the constant pi (=3.1415927)
 Each instruction is to begin with z1= or z20=. It
is recommended to enter the z values in the
Functions permitted as operands
given ascending order.
cos for cosine
 Small and capital letters have the same signifi‐
sin
for sine
cance. Spaces are ignored.
tan for tangent
 The calculation of expressions in brackets is
atn for arc‐tangent
possible.
sqr for square root
btr for absolute value
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Process data permitted as operands
gL
full length of a clicked line

Examples for correct z values
z1= 12.3‐124.3+100‐33‐.123
z2=123.4‐pi+gL+sin(Ri‐Ri)
z3=(gL+gL)*1.05+g1/100
Z4=z1+x12‐g2/3.5+Ab
z5=sqr((xK‐xK)#2+(yK‐yK)#2)
theorem of Pythagoras
z6=atn(z1/z3)

Ab

distance between two points

TL

partial length of a line

Ri

direction of a line in the ‘click
point’

WS
WP

angle at intersection point of two
lines
angle out of three points

Ax

horizontal distance

Ay

vertical distance

xK

x co‐ordinate value of a point

yK

y co‐ordinate value of a point

For the process data gL, Ri and WS existing lines of
the construction are to be clicked. Other process
data determined with the point construction sub‐
menu.

Input assistant
The input assistant facilitates the entry of calculation
instructions for the z value. To open the input assis‐
tant, click on the button
in the upper menu (Pic‐
ture 12‐7).

Picture 12‐8

The process data can be selected via the buttons. In
the Formula element area, all other permitted oper‐
ands such as mathematical functions, g values of the
measurement chart, x values of the part, global x val‐
ues or z values of the part can be selected. The selec‐
tion is automatically transferred to the z value for‐
mula (Picture 12‐8).

Exercise on entering z values
Call the Bodice 10 and define two x values. Enter the
following z values. Scroll in the list of z values and
check the calculated values on the right side of the
list, see also Picture 12‐7. The values apply to the
base size.
<F11> or Extras→| Z Values...
z1=1+2+3+4+5 <ENTER>
z2=100‐20
z3=5*5
z4=100/4
z5=Pi
the number Pi
z6=G1
body height in system Optimass
z7=G1/2
half of the bust
z8=G16/2
half of the neck
z9=G4/(2*Pi) radius of a circle with circumfer‐
ence = waist
z10=GL+GL+GL <ENTER>
Now, you are requested three times to click a line. In
Bodice 10, you can click on the three armhole lines of
front and back one after the other. In this case z10
equals the full length of the armhole curves.
z11=(Ab+Ab)/2 <ENTER>
Measure the distance between the final points of the
side seams of front and back by clicking the points of
the side seam at the armhole and at the hem of the
front and back respectively. z11 is the average value
of this distance.
z12=x2+100
z13=z2/2
z14=(Ab+Ab+Ab+Ab)*2
Measure four distances between 2 points, respec‐
tively, e.g. the waist in front and back without darts.
z15=z3+z4
z16=sqr(16)
Define your own z values and combine different
functions, process data and construction parame‐
ters.
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Case differentiation (if – elseif – else)
Case differentiations are used if constructions are to
behave differently under different conditions. Case
differentiations are entered in the input assistant.
For entry of the Conditions, the possible comparison
operators are offered for selection. (Picture 12‐9).

The waist deficit in the skirt back z03 is to behave as
follows:
if Z02>0:
Z03=(Z02*2/6)/2
else:
Z03=0.1
The waist deficit in the skirt front z04 is to behave as
follows:
if Z02>0:
Z04=(Z02*1/6)/2
else:
Z04=0.1
The side seam deficit z05 is to behave as follows:
if Z02>0:
Z05=(Z02*3/6)/2
else:
Z05=0.1
To check the construction, generate an individual
measurement chart Test38. Alter the hip girth to
950mm and the waist girth to 900mm.

Picture 12‐9

An example for multiple branching is displayed in the
following excercise. The z value z02 has been as‐
signed the difference between hip girth and waist
girth. Z value z03 now calculates the waist deficit at
the side seam. If z02 is greater than 0, i.e. the hip
girth is greater than the waist girth,
z03=(Z02*2/6)/2. Otherwise, z03=0.1.

Picture 12‐10

Enter the measurement chart in to the size table, en‐
ter size N38 for comparison and grade.

Exercise
For the skirt construction from the 1st Exercise, the
waist deficit is to behave differently if the hip girth
with ease is smaller than the waist girth with ease.
First, the z value z02 is assigned the difference be‐
tween hip girth with ease and waist girth with ease.
To enter z03, use the input assistant and activate the
case differentiation.

red contour: N38
blue contour: Test38

Picture 12‐ 11
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Exercises on the application of g values in z value
calculations
1st Exercise
Construct a ½ circular skirt with the waist being iden‐
tical to the waist in the measurement chart and a
length of 615mm from waist. Draw the hip circle at
waist to hip (G5) + 30.

z3

Exercises on the application of measurements of
the construction (process data) in z value calcula‐
tions
1st Exercise
Design a waistband with the length of the waist lines
in Skirt 20 .
Call the construction and reset the hem reduction in‐
teractively and close the second dart. Open a new
part and insert the three waist lines of front and back
skirt respectively into the new part.
z2

z1

z2

z1

z2
z1=gl+gl+gl

z2=gl+gl+gl

z1
Use the following z values:
z1=G3/(2*Pi)
z2=z1+G5+30.
z3=z1+615.
Grade the circular skirt in 5 sizes.
2nd Exercise
Construct a ½ circular skirt with g, x and z values. The
x value x1 is to be processed as an addition to the hip
circle and x2 is to define the skirt length. Draw the
hip circle again at a distance of waist to hip +x1.
From this skirt construct 1/4, 1/3 and other panel
skirts.
Generate two z values:
z1=gL+gL+gL waist lines front skirt
z2=gL+gL+gL waist lines back skirt
Generate an x value for the waistband height preset
to 40mm. Construct the waistband with z1, z2 and
x1. Set notches on the side seam positions. Mark the
centre back and centre front. Grade the skirt and
then the waistband. Check the measurements.
2nd Exercise
The steps are analogous to the 1st Exercise with
x1=30 and x2=615 and the z values
Z1=G3/(2*Pi)
Z2=Z1+G8+X1
Z3=Z1+X2
Assign the x values with different values according to
the different figure types

z1=gl+gl+gl

z2=gl+gl

Create a waistband for the construction Trouser 10.
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12.3 Complex Exercises
1st Exercise
Construct a straight skirt with g, x and z values.
X value table pre‐assignment:
x1
ease to ½ hip width in mm
(20)
x2
raise at ss in mm
(10)
x3
ease ½ waist width in mm
(10)
x4
skirt length
(600)
x5
position of skirt back dart from
ss in %
(50)
x6
dart lenth skirt back
(130)
x7
position of skrt front dart from
ss in %
(30)
x8
dart length skirt front
(90)
x9
hem decrease in mm
(15)
Z value table:

Grade in sizes N38 to N44.
Then, alter the position of the two darts by interac‐
tively moving the dart centre.
2nd Exercise
Construct a children’s hat with the values
X1 ease to head circumference (10.)
X2 hat height in mm (165.)
X3 head height in mm (80.)
X4 seam allowance in mm (40.)
Z1=(G28+X1)/4
Note: G28 is the head circumference in Optimass
(Basis_A).

X2
X3

Z1
X4

Other hats can be obtained with different curve
forms for example.

Z1=G2/2+X2
Z2 =Z1‐(G3/2+X3)
Z3=(Z2*2/6)/2
Z4=(Z2‐X4*2‐x7)/2
Z5=(Z2*3/6)/2
Z6=X3/4
Z7=X3/2
z4

G8

1/2 hip +ease
deficit
1/2 dart width bk
1/2 dart width ft
1/2 deficit side seam
bk raise dart centre
ft raise dart centre

x2
x7 z5 z5

z3
x5

x8
x6

3rd Exercise
Construct a stand‐up collar with x, g and z values.
Call a bodice block and insert the necklines of front
and back into the next part of the part organisation
with the tool insert lines
Create the following x values :
X1 shortening back in mm (2.)
X2 shortening front in mm (2.)
Create the following z values for this part:
Z01=(gl+gl)‐(x1+x2) length of front and back neck
Z02=gl+x1
length back neck

x4
20
20

10
Z1

15
z1

Z2

After the completion of the construction trace the
production patterns.
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4th Exercise
Construct a back with g, x and z values in the meas‐
urement system Mueller&Sohn Women.
X value table pre‐assignments:
x1 style length in mm (700.)
x2 addition nape to scye in mm (20.)
x3 addition nape to waist in mm (20.)
x4 addition nape to hip in mm (0.)
x5 reduction waist in mm (20.)
x6 reduction hip in mm (20.)
x7 addition ½ across back in mm (20.)
x8 raise neck at shoulder in mm (20.)
x9 ease for shoulder width in mm (15.)
x10 shoulder angle in mm (15.)
x11 armhole curve point in mm (7.)
z6

x8

x10

Z values with the value in size 38:
z01=g7+x2
nape to scye + addition
z02=g8+x3
nape to waist + addition
z03=g9+x4
nape to hip + addition
z04=g13+x7
across back + addition
z05=g14*2/3
2/3 armhole diameter
z06=g16+x9
shoulder width + ease

215.0
436.0
622.0
185.0
62.0
137.0

5th Exercise
With the Pinch 20 tool pinch the side seam of the
front of Bodice 50 at 40mm, 30mm and 35mm. The
apex of the new dart is to be positioned at start, cen‐
tre and end of the waist dart respectively. Depending
on the set pinch amount, the side seam of the front
is shortened. Therefore, measure the remaining side
seam between waist and hem in the front with
z01=gl+gl+gl+gl

x11
z1
z5

z4

z2
x5

x6

z3

x1

Lengthen the side seam of the back from the waist to
the length z01. The hem of the back must be con‐
nected with the shortened side seam. Use the func‐
tion manipulate curve and attach the end point of
the hem to the side seam. Select a suitable transition
type, here type 4 and deposit the manipulated curve.
Refine the curve run a little with the refine function
from the same menu.
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6th Exercise
Bodice 50 is to be styled with panel seams. First, con‐
struct a curve from the centre front to the waist dart
in the front. Interactively move the starting point of
the first curve along the centre front and the final
point along the line of the waist dart. A second curve
is to run from the waist dart to the side seam. Both
curves are to merge smoothly when sewing the waist
dart.
Measure the partial lenth of the waist dart to the
waist:
Z01 = TL
When constructing the second curve, start the curve
at a partial length z01 from the waist and merge
smoothly into the side seam. In the back, a third
curve is to run from the side seam to the waist dart.
The second and third curve are to merge smoothly as
well when sewing the side seam.
Measure the length of the side seam to the waist
Z02 = TL
The third curve now starts at a partial length Z02 on
the back side seam and ends at a partial length Z01
on the waist dart in the back.
Trace the production patterns using the Part assis‐
tant, see Chapter 9. Interactively, alter the final point
of the first curve and start test run all parts.

Z01=

Z02=
=Z02

=Z01
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repeated in a similar way in the other constructions.
Drag points on curves for direction and shaping
points are not explored at this point as they are iden‐
tical to adjustments in the Link 20 tool, see Chapter
5.1
Picture 13‐1 shows Bodice 50 with all its drag areas.
An overview of all options for Bodice 50 is displayed
in Picture 13‐2 with an indication of the respective
drag area (DA) for each option.

13.1 Interactive Bodice 50
Basic options and adjustment systems are explained
using Bodice 50 as an example. These principles are

Auxiliary adjustments
In the Positioning drag area, the front and the com‐
bined armhole can be moved. These adjustments
have no relevance for the construction.
Option Auxiliary measurements
This option displays important
auxiliary measurements. We rec‐
ommend having this option active.

Picture 13‐1

All drag areas:
Display measurements

DA Centre back

DA Tolerances:
waist construction

DA line reloc:
style length

DA Side seam

DA Side seam:
outline identical?

DA Waist dart:
Position waist dart

DA Bust dart

DA Hem

DA Side seam:
straight or shaped?

DA Waist dart
DA Hem

DA Side seam:
grading centred?

DA Shoulder dart

DA Armhole

DA Bust dart

DA Armhole

Picture 13‐2
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Drag area Tolerance horizontal and vertical
10

11

7
9

8

13

12

3
1
2

4

5
6
Width in torso area
1
Addition to bust girth, which is originally
added to the armhole diameter. Important,
see explanation on Bust girth.
2
Part of the tolerance added to bust girth for
front width. If this amount is increased, the
portion in the armhole diameter decreases.
3
Part of the bust girth tolerance for back
width. If this amount is increased, the portion
in the armhole diameter decreases.
4
Tolerance to waist girth; see topic Waist
construction on the next page.
5
Tolerance to hip girth
Balance between front and back
6
Shorten/lengthen the front in relation to the
back
7
Shorten/ lengthen the front
8
Shorten/ lengthen the back; see topic Style
length on the next page

Adjust basic neckline
Basic neck front
9
10 Basic neck front – shoulder
11 Basic neck back – shoulder
NB: In this area the fit specific characteris‐
tics of the neckline are adjusted. All style
specific adjustments are made in the Neck‐
line drag area.
Adjust shoulder width
12 Addition to shoulder width front and back
13 Addition to shoulder width back only
Adjustments to the shoulder slope are made
with the Shoulder drag area.

Picture 13‐3

Bust girth
In the different measurement systems, one or more
of the four body measurements bust girth, front
width, back width and arm width are available. As a
rule, the bust girth is used for construction of the
bust line.

Only in the Optimass measurement system in which
all four body measurements are available, the bust
girth remains unconsidered.
NB: In Bodice 10, the arm width remains unconsid‐
ered. It is calculated from the bust girth. Further in‐
formation can be found in the help for the basic
block.
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Waist construction
If this option is active, the drag
point 4 in Picture 13‐3 works as
tolerance to the waist girth.



If this alternative option is active,
the waist line is constructed in re‐
lation to the bust line. The side
seam can be interactively adjusted
at waist height, see Picture 13‐4.
In this case, the side seam does
not change if the dart content is al‐
tered.

Option Style length from…
The style length is adjusted in the Line relocation
drag area.
If this option is active, the style length is
constructed from the basic neck.
NB: With drag point 8 in Picture 13‐3,
the hem line moves in relation to the
given style length.

4



If this alternative option is active, the
style length is constructed from the
waist. During alteration with drag point
8 in Picture 13‐3, the hem line is not
moved.

4

Addition to waist girth; Important, see ex‐
planations on Waist construction
Picture 13‐4

Drag area Line relocation

5
1

4

1
2
3
4

9
5
6

6

7

2
10

8
9

10

3
8

Relocate armhole diameter line
Relocate waist
Relocate hip
Shorten/lengthen side seam of
the back without balancing out
the side seam length. The front
or back side seam is pinched.
Relative height for drawing the
back width
Raise waist at front and back
side seam
Adjust style length (fit), see ex‐
planations on Style length
Shorten a style in relation to the
Style length
Position auxiliary line for bust
measurement, see explanations
of Auxiliary line
Position auxiliary line for hip
measurement.

7
Picture 13‐5
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Style length

in the hem. Due to logic of construction, it must al‐
ways be positioned below the hip.

Via switching options, the style length can be con‐
structed from the neck or from the waist. It is ad‐
justed at the centre back with drag point 7 in Pic‐
ture 13‐5. The following applies to drag points 7 and
8:

Auxiliary line for bust measurement
Depending on the setting of this op‐
tion, the line is either horizontal or
transformed in relation to the bust
point. The difference is particularly
obvious with the bust dart located in
the side seam.

For pieces longer than hip depth, drag point 7 is
used and drag point 8 remains at zero. For pieces
shorter than hip depth, a company specific style
length is set and the piece is shortened with drag
point 8.
The style length with drag point 7 is required for ex‐
ample for the construction of hem widening in milli‐
metres and for spreading/overlapping the waist dart



Drag area Bust dart
First, the position of the bust dart must be adjusted via options. The bust dart can be located in the shoulder, the
side seam and the armhole, see Picture 13‐6.
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Relocate bust point
Adjust dart in %
Relocate a portion of the bust dart into the
centre front
Relocate a portion of the bust dart into the
armhole
Adjust position of the bust dart in the con‐
tour. In case the dart is positioned in the side
seam, the option bust dart centre horizontal
yes/no applies, see text.
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Shorten the dart
Pinch side seam, see text. The side seam
balance depends on the option Style length
from… Before making alterations with cur‐
sor 7, set the comparison!

Picture 13‐6

Option Bust dart centre horizontal
If the bust dart is located in the
side seam, the option bust dart
centre horizontal yes/no ap‐
plies. Depending on the setting
of this option, the position is ad‐
justed as a distance to the arm‐
hole or in relation to the hori‐
zontal.



Pinch side seam
If the bust dart is located in the side seam, it can be
increased/decreased with drag point 7 in Pic‐
ture 13‐6. As a result, the front side seam is indirectly
pinched. The front and back side seam length are
corrected depending on the Style length from... op‐
tion as follows:
 Style length from neck … by spreading/pinching
the front
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 Style length from waist … by spreading/ pinch‐
ing the back; NB: The style length from the neck
is altered!

Drag area Shoulder dart
1

Bust dart construction based on body measurement
Upper front width

3

Only the measurement system Optimass offers the
option of constructing the bust dart with the bust an‐
gle or with the upper front width:
If this option is active, the bust dart is
constructed on the basis of the bust an‐
gle from the measurement chart.

2


If this alternative option is active, the
bust dart is constructed from the body
measurement G42, upper front width.
This is only possible within the Opti‐
mass system as only Optimass contains
this measurement in the measurement
chart.
In this case, the additional drag point 8
in in Picture 13‐7, appears which can be
used for moving the construction line
for the upper front width. The bust dart
is now constructed with the dashed line
starting at drag point 8 becoming the
upper front width. This line indicates
the narrowest area above the bust and
is connected to the armhole pitch.

1
2
3

Dart content in mm
Length and direction of the dart
Position of the shoulder dart
Picture 13‐8

NB: When altering the position of the shoulder dart,
the armhole in the back is also altered.
If the shoulder dart is to be moved in a tested pat‐
tern, set the comparison and then, reinstate the orig‐
inal armhole shape via shoulder angle correction in
the Shoulder drag area.
Option Position shoulder dart
If this option is active, the
shoulder dart is positioned at
a relative length on the shoul‐
der.



If this alternative option is ac‐
tive, the zero position of the
shoulder dart is determined
by the position of the bust
dart. This option is only ap‐
propriate if the bust dart is
also located in the shoulder.

8

Option Back panel

8

Only in Optimass: Addition to
body measurement G43 dis‐
tance bust point <=> upper front
width, see text
Bust dart construction based on
body measurement Upper front
width.
Picture 13‐7

With this option, waist and
shoulder dart can be con‐
nected via an auxiliary line.
When using the Back part
tools, this option is not signif‐
icant.
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Drag area Waist dart

5
3

1
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6
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4

Dart content in the front in mm
Dart content in the back in mm


NB:
When altering the dart content, the side seam
is only altered if the waist is constructed from
the waist girth; see explanation on Waist con‐
struction, in drag area Tolerance horizontal
and vertical on previous pages.
Position for the top point of the front waist
dart in relation to the bust point
Distance of the top point of the waist dart
from the waist and horizontal position

5
6
7
8
9
10

10

Rotate/tilt the complete front dart
Rotate/tilt complete back dart
Rotate/tilt lower front dart
Rotate/tilt lower back dart
Spread/overlap front hem at style length
height
Spread/overlap back hem at style length
height


The cursors 9 and 10 are only active if the
waist dart option Open to hem has been
selected.


Depending on the option, the horizontal posi‐
tion is determined relative to the waist or to
the back width
Picture 13‐9

Position of the waist line
The position of the waist line is influenced in two
drag areas:
Drag area Line relocation
 Total waist height

 Raise waist at side seam
Drag area Side seam
 Raise waist at centre front
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Drag area Centre front and Centre back

5

3

3

4

4

3

2
1
1
2

Angle centre front at style length height
Rotate/tilt front construction about the
intersection of bust line and centre front

3
4
5

Adjust centre back at waist height
Adjust centre back at hip height
Adjust centre back at neck

3
4
5
Picture 13‐10

Drag area Neckline

1

1

5

2

1
2
3

3

4

Increase neck at shoulder
Increase neck at centre front
Increase neck at centre back

4
5

Length of straight line at centre front
Length of straight line at centre back
Picture 13‐11

NB: The fit of the neck has already been adjusted in the drag area Tolerance horizontal and vertical. In the
Neckline drag area, the neckline is shaped.
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Drag area Shoulder

5

5

1

2
3 4
4

1
2
3

3

Shoulder relocation at neck
Shoulder relocation at armhole
Shoulder angle in ft and bk

4
5

Additional shoulder angle for shoulder pad
Shoulder shaping in mm
Picture 13‐12

Should the style be produced with a relocated shoul‐
der at a later date, the shoulder should be relocated
temporarily before calling the sleeve. For a correct
distribution of notches, the natural shoulder must be
clicked, which is only visible with relocated shoulder.

NB: The fit specific shoulder angle is adjusted with
drag point 3 in Picture 13‐12. In addition and style‐
specific, you can add a further tolerance for shoul‐
der pads with drag point 4. The respective addi‐
tional length in mm is shown in brackets.
Drag area Armhole

The option
adjusts
the number of segments in the arm‐
hole.
4 segments means two segments re‐
spectively in front and back, sep‐
arated by the sleeve pitches
6/8/10 segments means 2/3/4 seg‐
ments respectively above the
sleeve pitch

3

1 and 2
3 and 4

1

2

4

Relocate front/back pitch
Relocate notch along the armhole in relation to
the front/back pitch
Picture 13‐13

The number of segments in the
armhole must be identical to the
number of segments in the sleeve. It
can be altered subsequently.

The option
appears
from 6 segments upwards. It offers
the choice of adjusting the length of
the uppermost segment as a relative
length in % or as a partial length.
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Drag area Side seam

1 3

4 2

5

1
2

Side seam relocation without armhole altera‐
tion
Relocation of lower armhole point with arm‐
hole alteration

3
4
5

Relocation of side seam up/ down to pinch
armhole, see text.
as cursor 3 but in the back
Asymmetrical correction of waist at centre
front only
Picture 13‐14

Relocate side seam up/down

With drag point 3 in Picture 13‐14, the side seam can
be moved up/ down. This drag point is used for
shortening the armhole. The bust dart is indirectly
relocated into the hem area.
Options Contour identical side seam
Front and back side seams are
contour identical. The shape
of the side seam is adjusted in
the front.

Option Side seam straigth/shaped
With this option, the side
seams are straight, see Pic‐
ture 13‐14 centre.

Option Side seam grading centred
If this option is active, the side
seam is graded proportionally
to the bust width and back
width.


Both side seams can be ad‐
justed independent of each
other, see Picture 13‐14 right.
Differences in length are ad‐
justed at the front side seam.

If this option is active, the side
seam is graded by ¼ of the
bust increment independent
of the increments of the indi‐
vidual sections.
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Option Side seam direction
If this option is active for waist
or hip, the direction of the
curves can be adjusted inde‐
pendently from each other.

If a continuous curve shape is
desired, this option should be
selected.

With the long direction handle, the curve direction of
the lower section is adjusted. Starting with this direc‐
tion, the direction of the upper section can be influ‐
enced with the short direction handle. For a continu‐
ous curve shape, set the short direction handle to 0°.
Drag area Hem

1

4

6

3

5
1
2
3
4

8

2

Rotation point for side seam angle at hem
at style length height
Side seam angle at hem
Shorten/lengthen side seam
Rotation point for centre front angle at hem

9
5
6
7
8
9

7

Centre front angle at hem
Rotation point for centre back angle at hem
Centre back angle at hem
Straight line at front hem
Straight line at back hem
Picture 13‐15

Option Hem increase in mm/°
The increase on drag point 2 ensues in
millimetres or in degrees.

Option Hem direction at side seam
The hem direction is calculated
as a right angle to the side
seam or free or linked.
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13.2 Interactive Sleeve 30

DA Curve adjustement

DA Curve adjustment
(automatic length adjustment)

DA Curve adjustement

DA Ease distribution

All drag areas:
Display measurements

DA Finished
measurements

DA Underarm

DA Elbow

DA Line relocation

DA Hem

DA Curve adjustments

Picture 13‐16

Using Sleeve 30 as an example, the principal options
and adjustment systems of all Grafis sleeves are ex‐
plained.

Calling the sleeve
All interactive Grafis sleeves are automatically ad‐
justed to the armhole of the bodice. This automatic
adjustment is possible because various information
on the bodice is transferred by clicking when calling
the sleeve:
 natural shoulder back
 armhole back
 back pitch
 lower armhole point
 front pitch
 armhole front and
 natural shoulder front.

The armhole in the front and the back must be a
continuous line sequence, respectively. If the shoul‐
der of the bodice has been relocated towards the
front or the back, the natural shoulder must be
clicked, i.e. the shoulder in its original position. The
sleeve must not be altered by shoulder relocation.
The same applies to the lower armhole point in case
of a side seam relocation.

In Grafis bodices, the natural shoulder is indicated as
a dashed line as soon as the shoulder has been relo‐
cated. We recommend relocating the shoulder be‐
fore calling the sleeve and then, reinstating the orig‐
inal shoulder position after the sleeve has been
called. From Version 10 onwards the function Reset
‘Clicks’ can be used for correction of a completely ad‐
justed sleeve, see Chapter 14. In Grafis bodices, the
front armhole is separated so that the number of ob‐
jects is correct even in the case of bust dart in arm‐
hole. Therefore, when calling the sleeve the con‐
nected armhole should be clicked, normally located
between front and back.
Picture 13‐16 shows an overview of all options for
Sleeve 30, indicating the corresponding drag areas.

Auxiliary adjustments
Auxiliary measurements option
This option displays important
auxiliary measurements. We rec‐
ommend having this option acti‐
vated.
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Drag area Curve adjustment

1

4

2

3

8

7

9

6

5

5
6

Sleeve proportions
1 Sleeve height. Important, see Automatic
length adjustment.
2 Upper arm width. Important, see Automatic
length adjustment.
3 Ease in mm or % depending on the option.
Important, see Ease.
4 Relative position of the upper sleeve point
All not specifically explained points are shaping
points for the sleeve curve.

Directions and curve adjustment
5 Length of armhole curve section which is
transferred directly.
6 Direction of sleevehead at beginning/end, if
cursor 5 is set to 0
7 Adjustment of common direction of the
sleevehead front and back in the upper
sleeve point
8 Difference direction of the back sleeve
curve. If the difference direction does not
equal zero, the sleevehead has a kink in the
upper sleeve point.
9 Length of curve adjustment at back sleeve
seam
Picture 13‐17
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Automatic length adjustment

The upperarm width is adjusted
starting with the upperarm girth
measurement.
Sleevehead
height is a result from the con‐
struction.
The upperarm width is graded proportionally
to the upperarm girth even without break
sizes.

When constructing a sleevehead, three construction
measurements are dependant on one another:
 sleevehead height
 upper arm width and
 sleevehead length.
The sleevehead length equals the length of the arm‐
hole lines plus ease. Generally, two of these con‐
struction measurements are given and the third
measurement results from these settings.



If this option is active, automatic
length adjustment is applied. The
sleevehead height or the upper‐
arm width are adjusted so that
the given sleevehead length is
achieved. Automatic length ad‐
justment can ensue in four varia‐
tions; see option Length adjust‐
ment as...
If this alternative option is active,
the automatic length adjustment
is switched off. Sleevehead
height and upperarm width are
given and the sleevehead length
is a result from the construction.
Select this option only if the
sleevehead from a digitised tem‐
plate is to be transferred. Switch
automatic length adjustment
back on after the transfer.

Option Length adjustment as …
If automatic length adjustment is active, sleevehead
height and upperarm width are automatically ad‐
justed to achieve the given sleevehead length. The
ease can be adjusted size dependantly. The length
adjustment can ensue in four variations:
Sleevehead height is set as a fin‐
ished measurement with break
sizes. Upperarm width is a result
from the construction.

The upperarm width is set as a
finished measurement with
break sizes. Sleevehead height is
a result from the construction
The sleevehead height is ad‐
justed starting from the centre
armhole height. Upperarm
width is a result from the con‐
struction.
The sleevehead height is graded proportion‐
ally to the average armhole height, even with‐
out break sizes.

Ease



The adjustable ease, adjusted
with drag point 3 in Picture 13‐17
is calculated as a percentage
value of the armhole length.
The ease is calculated as a length
in millimetres.

Option Mirror lower armhole point at angled or
straight sleeve fold line …
This option deter‐
mines whether
the lower arm‐
hole point is mir‐
rored at the
straight
break
line or the angled
break line. The
lower armhole
point can be
moved up/down
in the Line reloca‐
tion drag area.
This option has
an impact on the
adjustment
of
the elbow.



Option Mirrored curve …
With this option, the mirrored
sleevehead curve can be made vis‐
ible additionally and temporarily
in the Curve adjustment drag area.



Option Straight line front… or straight line back …
With this option, a straight line is
switched on/off between the sec‐
ond and the third shaping point.
This option is available for the
front and back sleeve.
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Drag area Ease distribution

1
1

1

1

1

Drag cursor for manual distribution of ease

2

2

1

Drag cursor for ease in the individual
segments, see Ease comb.
Picture 13‐18

Option Segment number …
With this option, the number of
segments along the sleevehead
is determined; see detailed ex‐
planation on the Armhole drag
area in Bodice 50.
The number of segments in the
armhole must be identical with
the number of segments in the
sleeve. It can be altered subse‐
quently.
Ease comb
The ease can be distributed either manually via drag‐
ging the notches at the drag points 1 in Picture 13‐18

or via adjustment of the ease comb with drag points
2. Each drag point of the ease comb corresponds
with the ease in one segment. As a rule, the ease
comb is used as it allows simultaneous visual control.
Measurement lines for ease
The small horizontal dashed lines in the centre of
each segment are also transferred into the construc‐
tion. The length of these auxiliary lines equals the
ease in the corresponding segment. The same ap‐
plies to the dashed auxiliary lines at the grain line,
which equals the total ease. These lines can be trans‐
ferred into finished measurement tables via the fin‐
ished measurement function or into text via z values.

Drag area Finished measurement
The Finished measurement drag area can only be selected if the wrist width has been set as a finished measure‐
ment.
Option Grade sleeve hem as upperarm
If this option is active, the wrist width
is calculated from the body measure‐
ment upperarm width minus the
sleeve fold adjustment at lower/front
and minus the elbow dart content.
The elbow dart is adjusted in the El‐
bow drag area with drag point 15 (Pic‐
ture 13‐19).

If this alternative option is active, the
wrist width is set as a finished meas‐
urement with break sizes. Only in this
case can the Finished measurement
drag area be activated.
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Drag areas Line relocation, Sleeve fold, Underarm, Elbow
DA Line relocation

DA Sleeve fold

DA Underarm

DA Elbow

16
1

2

9
20
13

12
3

6

7

19
17

10

14

21

21

15
4

4

5

8

DA Line relocation
1
Rotate the sleeve in the armhole via reloca‐
tion of notches
2
Move lower armhole point upwards/down‐
wards
3
Relocate elbow line
4
Adjust sleeve length, depending on the se‐
lected option either as finished measure‐
ment with break sizes or as an addition to the
arm length, see Sleeve length
5
Manual correction of the sleeve length
DA Sleeve fold
6
Adjust sleeve fold at elbow
7
Tolerance to elbow width
8
Adjust sleeve fold at wrist
DA Underarm
9
Underarm seam relocation along the sleeve‐
head. The zero position is dependant on the
Option Seam relocation front...
10 Underarm seam relocation at elbow
11 Underarm seam relocation at wrist

11
18

12
13
14

Adjust seam length difference
Move notches along the underarm seam
Length of curve smoothing section at the
underarm
DA Elbow
15 Adjust elbow dart. This drag cursor is only
active if the wrist width is calculated from
the body measurement upperarm width,
see explanation on drag area Finished
measurement.
16 Elbow seam relocation along the sleeve‐
head
17 Elbow seam relocation at elbow
18 Elbow seam relocation at wrist
19 Adjust seam length difference
20 Move notches along the elbow seam
21 Length of curve smoothing section at the
elbow seam

Picture 13‐19
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Option Set sleeve length …

After shaping the hem curve, the ac‐
tual sleeve length is automatically cor‐
rected. The hem is transformed to the
set sleeve length and the underarm
seams are lengthened or shortened
correspondingly. However, in the Hem
drag area, this correction is de‐acti‐
vated. It is carried out after changing
the drag area or after quitting the in‐
teractive menu.

If this option is active, the sleeve
length is a result of the arm length
body measurement. It can be ad‐
justed with drag point 4 (Pic‐
ture 13‐9) in the Line relocation
drag area. The elbow line does
not change during this adjust‐
ment.
If this alternative option is active,
the sleeve length is adjusted in‐
teractively with drag point 4 and
break sizes. In this case, the posi‐
tion of the elbow line is also al‐
tered.

Option Seam relocation front …

Depending on the
setting of this op‐
tion, the zero posi‐
tion for drag point 8
(Picture 13‐19) is
calculated
either
from the lower
point or from the
side seam of the
bodice or from the
underarm seam.

Option Automatic adjustment of hem position…

The length of the grain line (green line) corresponds
with the actual sleeve length. After having shaped
the hem curve, the actual length may differ from the
sleeve length set with drag point 4.

Option Elbow seam contour identical …
Depending on the
setting of this op‐
tion, an additional
drag point for
shaping of the el‐
bow seam ap‐
pears.

After shaping the hem curve, there
is no automatic adjustment of the
actual sleeve length. The sleeve
length must be adjusted with drag
point 5 if required.



Drag area Hem
After quitting this drag area, the hem curve is automatically transformed to the set sleeve length if applicable;
see explanation on the two options for sleeve length at the top of this page.

1
1

Shorten the underarm
Picture 13‐20

Option Hem as curve sequence …

If this option is active, the hem is
shaped as a curve sequence.

If this alternative option is active,
the hem of the underarm is a
straight line and only the upper‐
arm hem can be shaped.
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13.3 Additional functions for adjusting in‐
teractive constructions
The adjustment of interactive constructions has al‐
ready been explored in sections 2.4 ‘Adjust interac‐
tive construction’ and 11.2 ‘Size‐dependent adjust‐
ment of interactive constructions’. This section deals
with additional functions in the menu for interactive
constructions.

Menu for interactive constructions

load shape ▪ save shape
set break sizes

raster

+/‐magnet ▪ +/‐ruler
+/‐comments ▪ +/‐options ▪
+/‐values
+/‐measurements ▪ set measure‐
ments
+/‐compare ▪ set comparison
+/‐stack ▪ set stack

alteration steps
original state ▪ undo alteration step ▪
redo alteration step
end ▪ abort
help for construction

The value window
The value window (Picture 13‐21) contains the x
value settings for the active drag point. All activated
break sizes in the active drag area are displayed and
can be adjusted.
With the left button
individual sizes can be
dragged. Changes made to one size are not applied
to other sizes. The grade rules are altered.
With the right button
sizes of a figure
type can be adjusted
simultaneously. Alter‐
ations are automati‐
cally applied to all sizes
of the respective fig‐
ure type. The grade
rules
remain
un‐
changed.
With the button
all break sizes can be
altered
simultane‐
ously. Adjustments are
automatically applied
to all break sizes. The
grade rules remain un‐
changed.

Picture 13‐21

From Version 12 onward, selected drag points can be
assigned x, xg, z or g values. In this case, an additional
input option appears,
Assign x, xg, z or g
see Picture 13‐21. If
value
to a drag point
an x, xg, z or g value is
entered, this drag
point is connected
with this value and
can no longer be al‐
tered interactively.
Removing the entry
also removes the con‐
nection.
If a value is entered
into the input window
for x, xg, g or z values,
the buttons
and
are hidden, Pic‐
ture 13‐22. After hav‐
Picture 13‐22
ing deleted the pa‐
rameters from the input window, the buttons reap‐
pear.
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The other elements of the value window have the
following significance:
With this drag point, a single x
value is adjusted.
With this drag point exactly
two x values are adjusted, e.g.
the x and y co‐ordinate of a
free moving point. The set‐
tings for only one x value are
visible at a time.
Minimise/maximise the win‐
dow
Show all sizes.
Hide all sizes except the active
size.
Base size of the construction
This size is hidden. Clicking on
the tick box in front of the size
shows the size again.
The size is shown. Clicking the
tick hides the size.

Use of set stack
The stack function can be used for interactive adjust‐
ment of a graded nest. After clicking on set stack the
stack point and then, optionally a direction point are
determined. If no direction point is required, simply
use the right mouse button after having set the stack
point.
Clicking on +/‐stack activates or deactivates the nest.
All drag points can be adjusted on a stacked nest.
Grafis takes into account the shift caused by stack‐
ing.

Dimensioning an interactive construction
A number of dimensions are al‐
ready shown on an interactive
construction. In practice how‐
ever, other special company‐
specific dimensions are required.
Therefore, Grafis offers the op‐
tion of setting your own meas‐
urements which are altered im‐
Picture 13‐23
mediately during interactive
modification of the construction.
With the dimensioning function you can set your
own measurements which are altered immediately
during dragging.

Dimensioning ensues analogous to measuring, de‐
scribed in section 7.1. Additional options exist for
each measurement, see Picture 13‐23.
Display options:
text for measurement
show/hide text
show/hide value
show/hide left auxiliary line
show/hide right auxiliary
line
show/hide measurement
line
clicking turns measure‐
ment into ID measure‐
ment. ID measurements
are saved with the shape.
In which drag areas are the
measurements
to
be
shown?
The ID measurement button ensures that a meas‐
urement is automatically entered into the comments
of the construction and saved as a measurement ta‐
ble when saving the shape. This table appears in the
preview window when loading a shape. The ID meas‐
urement button remains inactive if the measure‐
ment has been attached to points which are not part
of the interactive construction. For example, if you
are interactively adjusting a pocket you can set
measurements for the underlying bodice construc‐
tion. These measurements for the bodice cannot be
entered as an ID measurement as they do not de‐
scribe the pocket shape and may be changed when
loading a different shape.
Measurements can also be set for a comparison part.
For example, if you want to make a modification dur‐
ing which a measurement is not to be altered, pro‐
ceed as follows: first, set a comparison and switch to
+compare. Position the comparison part suitably
with <F3> and <F5>. Set measurements for the com‐
parison part and the original part. Carry out the mod‐
ifications. Measurements for the comparison part
are reset when quitting the drag menu.
Measurements can be printed via Edit → Copy to the
clipboard.
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Use of ruler

Toggle to +ruler displays the ruler. It consists of two
lines at a right angle, one line is very long and the
other considerably shorter.
Clicking with pressed down mouse button...
 at the short line moves the ruler
 at the long line rotates the ruler.
ruler

The name of the shape is created from the date, the
time as well as the computer and user names. They
are saved as single XWF files under
\Grafis\Forms\[name of construction].
Clicking on load shape opens the list of available
shapes of the construction. All shapes stored as XWF
files under \Grafis\Forms\[name of construction] are
offered. Clicking onto a shape with the right mouse
button opens the context menu with the functions
rename and delete. Use the rename function in par‐
ticular to organise your list of shapes.

1.
Picture 13‐24

When moving and rotating the ruler it is automati‐
cally attracted by neighbouring lines and points. You
can set the ruler onto a point and adjust it along a
line.
Free moving drag points
can only be moved in
the direction of the ruler with active ruler.

In Picture 13‐24 the ruler was set onto the collar
point and adjusted. The drag point collar point can
now only be moved along the ruler. Thus, the collar
point has been lengthened by 10mm without alter‐
ing the collar angle.
Load and save shapes

The adjustments of an interactive construction are
saved in the corresponding x value list. This list is in‐
visible for the user, it is updated automatically by
Grafis. Clicking on save shape saves this x value list
together with a preview, the comments and the pre‐
viously explained ID measurements.

2.
Picture 13‐25

Shapes can be loaded for other break sizes and also
into styles of other measurement systems. The
break sizes of the shape may have to be reassigned.
If you want to load a shape, which has originally been
adjusted for sizes _38 etc. the break sizes can be re‐
assigned, see cutting in Picture 13‐25. The construc‐
tion is graded in size N42 as originally in size _42.
ID measurements set with dimensioning as well as
comments are saved with the shape. The field for en‐
try of notes opens by switching to +comments in the
menu on the right hand side.
For new developments, first load the basic construc‐
tion and then, one of your prepared shapes. This
combination of interactive construction and new
shape can be entered into the call list, see section
13.5.
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13.4 Reconstruct a digitized template
pattern with an interactive construction

For front/back constructions activate the drag area
Positioning and move the front and back towards
one another (Picture 13‐27).

Step‐by‐step guide
 Call the digitised template pattern and the inter‐

active construction into different parts
 Position the parts to one another with <F3>, e.g.








at the zero point of the interactive construction
Activate the interactive construction
Adjust the most important options
For front/ back constructions: activate the drag
area Positioning and move the front and back to
one another. Use the magnet function.
Roughly adjust the most important drag areas,
e.g. in the bodice constructions Tolerance hori‐
zontal+vertical and Line relocation. Start with the
symmetrically movable drag points.
Carry out the fine adjustment systematically and
step‐by‐step. Save significant stages as shapes
and rename the shape if required. Click on  or
 in the menu on the right to undo or redo step‐
by‐step.

Reconstruct a proven bodice construction

Load the proven bodice construction and the inter‐
active bodice construction you want to adjust into
different parts. Position the parts to one another
with <F3>, e.g. at the zero point of the interactive
construction. Activate the interactive construction
and adjust the most important options having clicked
on +options, e.g. the position of bust dart and shoul‐
der dart (Picture 13‐26).

Picture 13‐27

Use the magnet function by switching to +magnet.
The magnet function applies to move points which
will attach to existing points and lines of the con‐
struction in the background. The magnet function
does not make sense for angle or percentage alter.
First, adjust the most important drag areas. In the
bodice constructions this is first of all the area Toler‐
ance horizontal+vertical. Adjust the tolerances for
bust, waist and hip area. Then, switch to the Line re‐
location area and adjust the position of bust line,
waist line, high hip and hip line. Then, switch to the
Side seam drag area and relocate the lower armhole
point. This drag point is situated at the armhole/ side
seam corner in the back. The same point in the front
relocates the side seam.
Adjust step‐by‐step:
 in the Tolerance horizontal+vertical drag area
the neck point in front and back
 in the Bust dart drag area the position of the
bust point with +magnet, the position of the
left dart line and the suppression angle
 in the Shoulder drag area the shoulder angle in
front and back
 in the Tolerance horizontal+vertical drag area
the tolerance for shoulder width in front and
back.

Template
Picture 13‐26

... with a result according to Picture 13‐28.

202
Chapter 13 Interactive constructions
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook,Edition 2017

3

If you adjust interactive curves again first reset all
shape points (points 3 to 5 in Picture 13‐28) to 0 by
e.g. selecting Raster 10 and clicking on the points.
Then, readjust the directions at the beginning and
end of the curve, set the raster to 0, activate mag‐
net and readjust the shape points 3 to 5.

1

2

Picture 13‐28

The back dart is adjusted in the Shoulder dart drag
area (Picture 13‐28). First, move the back dart with
point ‘1’, if required using +magnet then, point ‘2’
and then the suppression angle with point ‘3’. If re‐
quired, readjust the shoulder angle in the Shoulder
drag area with a result according to Picture 13‐29.

2

Picture 13‐30

The result of these adjustments can be seen in Pic‐
ture 13‐30, where the side seam, the waist dart and
finally the armhole are still to be adjusted.
Please note that after having adjusted the base size,
the grading in the break sizes also has to be recon‐
structed from the template.
Grafis users of Versions 8 and earlier can recon‐
struct existing proven constructions in this way and
save them as shapes.

5

3

1
4

Picture 13‐29

To adjust the neckline switch to the Neckline drag
area and zoom into the back neck. In this area you
can adjust dropped and widened necklines. Adjust
the neckline shape by first adjusting the directions
with points ‘1’ and ‘2’ then, reconstruct the superior
central shape point ‘3’ with +magnet and then, ad‐
just the inferior auxiliary points ‘4’ and ‘5’.

An interactive construction can be entered into the
call list together with a new shape, see the follow‐
ing section 13.5.

Chapter 13 Interactive constructions

203

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

13.5 Designing the call list
Step‐by‐step guide
 call; the dialogue Grafis Basic blocks / Modules

opens
 Activate Edit → Edit mode
 Create folders/subfolders
 Enter construction as programming language

program, style, grade rule pattern or as an inter‐
active construction in conjunction with a shape
 Design the corresponding file card pictures and
the text. The edit functions are opened respec‐
tively via the context menu.
Create new folder/subfolder

Click on General with the right mouse button and se‐
lect Create new folder and enter ‘my skirts’.
NB: Do not create a new folder with the name
‘Grafis‐...’ and do not create entries or subfolders in
these folders. Your data may be overwritten during
a subsequent update.
Data types in the call list

The following can be entered in the call list:
 style (.MDL) = Grafis style with all parts
 program (.CPR) = Grafis programming language
program of the new programming language,
see Chapters 19 and 20. If this is an interactive
construction, a shape can be assigned for call‐
ing.
 program (.PRG) = Grafis programming language
program of the old programming language
 grade rule pattern (.SWS) = Grafis grade rule
pattern saved as a template, see Chapter 16.
From Version 10, the module combination is no
longer required. Use the option save part module,
see Chapter 14 and enter the modules as styles
(.MDL).

Now, create a new folder for your skirts by clicking
onto General with the right mouse button and then
click on Create new folder. Call the new folder ‘my
skirts’.
Now, create the new entry for Skirt 20 in conjunction
with the shape ‘SkirtStandard’. Click on ‘my skirts’
with the right mouse button and select Create new
entry. The dialogue Insert Modules opens (Pic‐
ture 13‐32). Set the button to Basic block and select
the
CPR
file
for
Skirt
20,
here
GraPrg_GK_RO_c002_03.cpr and close with OK. Call
the entry ‘SkirtStandard’.
Assign Skirt 20 with this particular shape by clicking
on the new entry with the right mouse button and
selecting Set shape. The shapes are saved centrally
under \Grafis\Forms\[name of basic block]. In this
particular
case,
select
\GRAFIS\FORMS\
GraPrg_GK_RO_x002_01\skirtstandard.xwf.
Unless you create a duplicate in the following dia‐
logue, you must never rename or delete the selected
shape. A duplicate is saved in the directory of the link
file. Enter an appropriate image and a short descrip‐
tive text for the new entry.
Insert entry as style

Entering styles into the call list is useful for basic
types, which are frequently used as basis for style de‐
velopments. Grafis transfers all parts of the style
when called and inserts them into the edited styles.
Create a Grafis style with a number of parts and en‐
ter it into the call list. The process is identical to Cre‐
ate entry from basic block and shape explained be‐
fore, only in the Insert Module dialogue the button is
to be set to Style (.MDL), see Picture 13‐32. Linking
with a shape is not required.
Entering grade rule patterns in the call list ensues in
the same way.

Create entry from basic block and shape

Save a shape ‘SkirtStandard’ for Skirt 20,
in which the side seam adjustment has
been reset and the two 2nd darts in
front and back have been closed respec‐
tively, see Picture 13‐31. Now, an entry
for Skirt 20 in conjunction with this skirt
shape is to be saved in the call list. First,
determine the name of the CPR file for
Skirt 20. Activate Edit → Edit mode in the
call list. Click on Skirt 20 with the right
mouse button and Open link file with ed‐
itor. You will find the name of the CPR
file for Skirt 20 in the first line.
Picture 13‐31
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Graphics and text for the list entry

In active Edit mode, graphics or text can
be opened for editing via the respec‐
tive context menu. The graphic must be
saved as a .bmp, .gif, .jpg, .tif or .png.
We recommend a size of 750x500 pix‐
els.
A new or edited graphic or text ap‐
pears only after new selection of the
list entry.
A quick preview can be obtained via a
print screen by pressing <Print/PrtSc>
with slightly reduced pattern. Insert
the screen print into Paint.

Picture 13‐32

Picture 13‐33

Chapter 14

Part organisation

___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Inhalt
14.1
14.2
14.3
14.4
14.5
14.6

Hereditary automatic ............................................................................................................ 206
Part organisation................................................................................................................... 209
Difference between the functions of the menus insert and
duplicate/connection part in the part organisation ............................................................. 210
Modifying mother parts ........................................................................................................ 211
Reset ‘Clicks’ ......................................................................................................................... 212
Complex exercises................................................................................................................. 219

Content of this chapter is working with parts, in par‐
ticular the hereditary automatic and the differences
between insert, duplicate and connection part. The
section ‘Modifying mother parts’ is especially im‐
portant as only certain modifications are permitted

for mother parts to protect the hereditary auto‐
matic.
A further large area is the application of ‘Reset
‘Clicks’.
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14.1 Hereditary automatic
What does hereditary automatic mean?
The different parts of a style must fit to‐
gether taking into account their interde‐
pendence. Grafis ensures this by building
an automatic heredity. If, for example, a
waistband is to be designed to fit the parts
‘skirt front’ and ‘skirt back’, the waistlines
of skirt front and skirt back can be in‐
serted into the new part ‘waistband’ and
the waistband can be constructed. When
grading the waistband in different sizes
the insertion of the waist lines is repeated
automatically. We call this heredity of the
waistlines to the part ‘waistband’.
Heredity is realised with the functions of
the insert menu.
Inserting (heredity) always ensues into
the active part out of parts with lower
part number.
Grafis records the hereditary steps and
displays the hereditary structure in the
part organisation menu. The hereditary
structure is arranged to generations.
The heredity
Picture 14‐1 elucidates the principle of
heredity using the style ‘Trouser with
flared hem’ as an example.
Part 001 contains the basic construction
Trouser 10, which has been adjusted in‐
teractively.
All lines and points of the basic block were
inserted from part 001 into part 002 ‘style
development’. Thus, part 002 has become
a part of the 1st generation. Part 001 has
become a mother part. Alterations to part
001 are automatically transferred to part
002. The style was developed in part 002
with the use of x values.
The pocket module with a number of
parts has been loaded into part 003. The
pocket programme belongs to part 003
‘back pocket‘. In this part, the postion,
size and shape of the pocket are adjusted
interactively. The parts of the 3rd genera‐
tion 008, 009, 013, 014 and 015 are de‐
pendent on the pocket in part 003 and are therefore
daughter parts of part 003. Part 003, in itself a
daughter part has now also become a mother part.
Particular rules apply for alterations to mother parts,
see Section 14.4.

0th generation
Part 001: basic block trouser

1st gneration
Part 002: style development

2nd generation:
Part 003: hip pocket
Part 004: trouser front
Part 005: fly facing right
Part 006: fly guard left
Part 007: pocket trouser front
Part 010: yoke
Part 011: waistband

3rd generation:
Part 008: trouser back
Part 009: pocket
Part 013: pocket template 1
Part 014: pocket template 2
Part 015: marking template

Picture 14‐1

In part 004 ‘trouser front’ all lines and points for the
production pattern trouser front were transferred
with insert and the trouser front was completed.
Thus, part 002 has become mother part for part 004.
Part 004 is now the daughter part of part 002 and
therefore, indirectly related to part 001.
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ancestors
active part

successors

Picture 14‐2

Alterations to part 001 are first transferred to part
002 and then further to part 004.
All other parts of the 2nd generation (Picture 14‐1)
were also derived by inserting lines and points from
the style development in part 002.
Hereditary information can only be passed on to
parts with a higher part number.
The hereditary structure
For presentation of the hereditary structure the
parts are divided into generations. The following ap‐
plies:

Picture 14‐2 shows the part organisation dialogue
for the example ‘Trouser with flared hem’. An over‐
view of interdepencies between the parts, also called
hereditary structure, appears on the file card in the
lower window . All parts of a generation are com‐
bined in a part block. Part 001 belongs to the 0 gen‐
eration (first part block). It is marked with generation
number ‘00‘ in the list of parts. Part 002 belongs to
the 1st generation with generation number ‘01‘ and
so on.

A daughter part automatically receives a genera‐
tion number at least 1 up from the mother part.

In the hereditary structure the active part is high‐
lighted. Ancestors and successors are highlighted in
grey. Parts without relation to the active part are not
highlighted.

This rule ensures that a part of the 3rd generation
can carry hereditary information of the 0th, 1st and
2nd generation, only.

Clicking a part number in the hereditary structure ac‐
tivates the part. Thus, the user gets a quick overview
of the hereditary structure of the parts.
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Grading a number of parts
The functions test run and grading in the basic menu
apply to the active part, only. Grafis also offers the
option to calculate (test run) or grade all parts of the
style or the successors of the active part, only. These
functions can be found in the Grading pull‐down
menu. In this menu you can choose between:
Test Run Active Part
Test Run Successor Parts
Test Run All Parts
and
Grade Active Part
Grade Successor Parts
Grade All Parts
Exercise
Construct the ‘Trouser with flared hem’ shown in Pic‐
ture 14‐1. Organise your part list according to Pic‐
ture 14‐2. Call Trouser 10 into part 001 and adjust
the following interactively:
 contour identical side seams
 adjust waist at side seam
 no shaped seat seam
In the Tolerances drag area:
 tolerance at waist: 15mm
 tolerance at hip: 20mm

Create the following x values in part 002 and design
the trouser, using the x values (Picture 14‐3):
x1 yoke ss from waist in mm
_xxxxx_x = 40.000
x2 yoke CB from waist in mm
_xxxxx_x = 100.000
x3 pocket position waist from ss in %
_xxxxx_x = 40.000
x4 pocket position ss from waist in mm
_xxxxx_x = 150.000
x5 pocket length in mm
_xxxxx_x = 230.000
x6 back pocket position from ss in mm
_xxxxx_x = 40.000
x7 back pocket position from waist in mm
_xxxxx_x = 65.000
x8 zip length in mm
_xxxxx_x = 140.000
x9 fly facing width
_xxxxx_x = 30.000
X3
X7

X1

X2

X6

X4
X8
X5
X9

Apart from the base size N38, also enter sizes N40
and N42 into the size table and activate them.
In the Finished measurement drag area enter the
break sizes N38 and N42 and adjust:
size
value
knee width
N38
391
N40
400
N42
409
hem width
N38
515
N40
520
N42
525
In the Line relocation drag area:
 waist relocation: ‐50mm
In the Dart front area close the dart. In the Dart back
area close the second dart and move the first dart to
50% of the waist. In the Waist and waist edge area
reduce the centre front by 30mm (to ‐30mm). In the
Hem area set the hem position to 0mm.
Insert all lines and points from part 001 into part 002.
Activate part 002, select parts in the insert menu and
click on an object from part 001. Part 001 is selected
and is inserted into part 002 after having clicked on
without transformation.

Picture 14‐3

Now, start extracting the pattern pieces from the
style development in part 002. Open a new part for
the trouser front and insert the objects of the trouser
front from the style development. Create global x
values for general seam allowance and the hem re‐
spectively:
GLOBAL x‐values
x1 seam allowances in mm
_xxxxx_x = 10.000
x2 hem in mm
_xxxxx_x = 30.000
Construct the seam allowance and the hem with xg1
and xg2. Create the mirrored hem corners with the
corner tool Corner 10.
Construct the fly facing and the fly guard in the same
way. Insert the lines of the pocket into a new part
and construct the seam allowances and the facing
(Picture 14‐4). You can also use the part assistent for
generating the procution pattern pieces.
Leave part 002 ‘style development’ visible. Call the
Grafis‐Pockets → without lining → patched → Facing
→ 001 into part 003. The first positioning point for
the pocket is the end of the auxiliary line of the trou‐
ser back in the style development. Adjust the pocket
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and its grading interactively. The pattern pieces for
the pocket (parts 009, 013, 014 in Picture 14‐5) were
generated automatically by the pocket module. After
having adjusted the pocket, start test run all parts.
Insert the lines for the yoke from the style develop‐
ment. Close the dart with insert with transformation
turn and move. Link the yoke line with the Link 10
tool.

14.2 Part organisation
The basics of part organisation were introduced al‐
ready in section 3.1. In this chapter all information
on part organisation is collated.
Part organisation menu
open new part ▪ insert part
move part up ▪ move part down

004
006

duplicate part ▪ duplicate part with
daughter parts/successors
delete ▪ remove ▪ reduce part
show all ▪ hide all ▪ show parts
insert connection ▪ update connec‐
tion ▪ +/‐part information

005

copy ▪ print part list
load module ▪ save part module

007

Picture 14‐4

Construct the waistband with the help of z values.
Create an x value for the waistband height. Then,
construct the marking template for the back pocket.
Start test run all parts and grade all parts. Modify an
x value in the style development. After test run suc‐
009
013

014

Picture 14‐5

cessors, the modification will be transferred onto all
related parts (successors).

Clicking on a part in the part rack, a part number or
a part text in the part list or clicking on a part number
in the hereditary structure activates this part. It is
highlighted with a yellow bar in the part list and
marked in yellow in the part rack. The part can be
processed after having quit part organisation. When
activating a mother part (see Section 14.4) a warning
message appears in the status bar.
Clicking on open or
in the part list creates a new
part with the name ‘NN’ and the next highest num‐
ber after the last part. The new part is active straight
away.
Clicking on insert generates a new part before the
selected part.
Duplicate or duplicate with successors creates a
copy of the active part and all daughter parts, see
section 14.3.
After delete and a security question the record steps
of the selected part are reset to 0. The last part in the
list is reset and removed.
Removes an empty part (with 0 record steps) from
the part list. The following parts move up in the list.
With reduce the active part is graded in the sizes of
the size table and ‘frozen’ in this state. Having re‐
duced a part, it no longer has any dependency to
mother parts, has no x values and no record steps.
Daughter parts remain unchanged. Uses reduce only
after speaking with a Grafis expert.
With the function hide all all parts apart from the ac‐
tive selected part are removed to the background
memory. Hidden parts are no longer visible on
screen, but are not deleted.
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It is recommended that only parts required for work
are visible on screen.
Individual parts can be called from the background
memory to the screen by clicking in the
column.
Clicking show all recalls all removed parts from the
background onto the screen. Via the button show
parts pattern development parts, construction pat‐
tern pieces, mother parts of the active parts, daugh‐
ter parts of the active part or parts of a selected ma‐
terial can be called.
With the functions insert connection and update
connection parts from a different style are inserted,
see section 14.3.
Edit → Copy (clip board) copies the part list to the
clipboard.
Clicking print starts printing the part list, provided
the printer is switched on.
Activating text and clicking a part in the list allows for
editing the part text. After <ENTER> entry can con‐
tinue with the next part text. A part text can be ed‐
ited, also with double‐click on the text. In this case,
<ENTER> does not switch to the next part text. Take
care of your part names. This makes your work easier
and avoids mistakes.
With the function save part module, the selected
parts are saved as a module. When saving a part
module, the system checks which parts must be
saved in addition to ensure a correct hereditary
structure when calling the module. Possible ‘click’
connections to mother parts are automatically reset.
Modules saved in this way can be stored in the call
list, see Section 14.5, Example 3.

14.3 Difference between the functions of
the menus insert and duplicate/con‐
nection part in the part organisation
The most important differences
Basic menu → insert... performs a hereditary step
between two parts. Grafis automatically repeats
this hereditary step when grading other sizes.
The source part becomes a mother part and the
target part becomes a daughter part.
Part organisation → duplicate ... creates a copy of a
part in the same generation. Existing relations to
mother parts remain intact. The part is gradeable
in the same way as x and z values are also dupli‐
cated. The daughter parts are not duplicated! The
part has no daughter parts after duplication. The
duplicate function can be found in the part organ‐
isation menu.
Part organisation → insert connection part(s) ...
transfers parts from another style. This function
can also be found in the part organisation menu.
When inserting a connection part, the switch in‐
sert with complete record decides whether or
not the part is inserted with its complete con‐
struction record.
If this switch is set, at least the parts of the 0th
generation can be graded unchanged, provided
the global x values of source and target style have
been aligned.
If the switch is not set, objects are only trans‐
ferred in the existing sizes. Adding new record
steps is not possible. These parts can be used for
measuring, stacking and comparison.

With call part module, the modules can be called
into new or existing styles.

Further information on connection parts can be
found in the Textbook Chapter 18 ‘Layplanning
II’, section 18.1.

piece parameter opens the the file card for piece
parameters relevant for the layplan (see Chapter 17)
text box opens the file card in which comments
on the selected part can be stored.
exchangeable parts opens the file card for deter‐
mination of permitted sizes in the part, see separate
explanation in Chapter 18.13.
opens the overview of the hereditary structure.
The number of parts per style is limited to 500. The
active part is displayed in blue on a white back‐
ground. Only this part can be edited. All other parts
remain unchanged.

Part identifiers
The first column in the part list of the style contains
an identification symbol with the following signifi‐
cance:
‘*’

The part is a mother part, other parts
depend on it.
‘ ‘ (without) No other parts depend on this part. It
can be a daughter part.

The indicators in the fifth column
of the part or‐
ganisation have the following significance:
This is a connection part.
This is a connection part. The source
style is no longer available.
This is a connection part. The part in
the source style has been changed.
The part is reduced.

Chapter 14 Part organisation
211
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

When to use which function?
Insert without transformation is the most frequently
used of the functions. It is always required when in‐
formation from one part is to be passed onto an‐
other part. Use the alternative tools Insert lines or In‐
sert points if the following construction is to be re‐
leased and saved in the call list at a later stage.
Part organisation → Duplicate is used to create a
copy of a part. The copied part serves either as a
starting point for a new development variation or
simply as a comparison for further changes. Modifi‐
cations to x values are clearly visible when original
and copy are displayed and placed on top of one an‐
other. The duplicated part can easily be deleted or
reset step‐by‐step in the record.
Part organisation → Insert connection is used if tem‐
porary templates are required or if company‐specific
standard pieces are to be loaded.

14.4 Modifying mother parts
Organisation of the heredity
Each object (point, line, text) of a part has a Grafis
internal name. When inserting objects into other
parts Grafis relates to these internal names. When
inserting a line out of part 003 into part 010 the in‐
ternal Grafis record of part 010 reads for example:
‘The 4th line out of part 003 is inserted.’ A modifica‐
tion to the mother part 003 resulting in a changed or
deleted 4th line can possibly lead to insertion of a
completely different line when running through the
record of part 010. All record steps relating to this
inserted object could now be faulty. Part 010 ap‐
pears damaged on screen. In this case the only cure
is resetting the construction record of part 003 to the
state before the modification. Therefore, the follow‐
ing applies: Modifications in mother parts must not
disturb the recorded hereditary steps.

Modifications with any other functions of the basic
menu are to be applied with care as they can lead
to errors.
After each modification in a mother part, daughter
parts have to be tested thoroughly with test run and
grading! If errors occur, the record must be reset by
the modification steps!
Typical alterations to the mother part
The style ‘trousers with flared hem’ from section
14.1 is altered as follows:
Modify interactive construction
Change the hem width
of the interactive trou‐
ser construction in
part 001 from 515mm
to 465mm in base size
N38. The grade is to re‐
main unchanged. After
test run successors this
modification has been
transferred to the re‐
lated parts ‘trouser
front’ and ‘trouser
back’.

Picture 14‐6

Curve correction
In part 002 of the style development activate the
yoke curve of the trouser back and modify it interac‐
tively according to Picture 14‐7.

As a rule, each construction step which does not de‐
lete objects can also be applied to mother parts. Af‐
ter the modification the recorded construction must
still be executable in a meaningful manner.
The following functions can be used for modifica‐
tions without problems:
 x values
 modification of curve shapes, see Chapter 9
 call
 attributes

replace curve. After setting starting point
and final point of the new curve, a green arrow ap‐
pears. The curve to be replaced must be clicked in
the direction of this arrow.

Picture 14‐7

After Grading → Test run successors the modified
curve shape has been transferred to the production
patterns ‘trouser back’ and ‘yoke’.
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before

after

Picture 14‐8

Replace curve
Change the pocket mouth of the trouser front from
a straight line to a curve. In part 002 of the style de‐
velopment construct a new curve with replace curve,
which is bound to the original pocket mouth with in‐
tersection. Having constructed the starting point and
final point of the new curve, a green arrow appears.
The currently straight pocket mouth must be clicked
in the direction of the green arrow. Shape the curve.
After Test run successors this alteration has been
transferred to the related parts ‘trouser front’, ‘trou‐
ser back’ and ‘pocket trouser front’. The global x
value xg2 ‘seam allowance2’ was used for the seam
allowance at the pocket mouth. For the new shaped
pocket mouth, adjust the seam allowance2 from
20mm to 10mm and let part
007 ‘pocket trouser front’ be
calculated again. The result
of the modification is shown
in Picture 14‐8.

14.5 Reset ‘Clicks’
From Grafis Version 10, all point, line and direction
‘clicks’ set within constructions from the call function
can be reset and re‐called. Binding the new ‘clicks’
ensues automatically during the next test run for the
respective part.
The Reset ‘Clicks’ function can be found in the List of
interactive constructions dialogue, accessible via the
<F12> key or via the Extras pull‐down menu, see Pic‐
ture 14‐9. The list in the window on the left contains
all interactive constructions of the style and all non‐
interactive ‘click’ constructions. The non‐interactive
click constructions are indicated with [ ]. The con‐
structions are organised according to part number in

Picture 14‐9
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the first column and record step in the second col‐
umn. In the right window, a preview of the construc‐
tion selected on the left appears.
Select some constructions of the list, one after the
other. The Reset ‘Clicks’ button is only active if the
construction contains clicks. When calling a bodice,
no objects had to be clicked. Therefore, the Reset
‘Clicks’ button remains inactive for these construc‐
tions.
Select a construction for which Reset ‘Clicks’ is active
and click on the Reset ‘Clicks’ button a number of
times. With each click, the mark ‘*’ changes for this
construction. The mark ‘*’ indicates that this con‐
struction is available for Reset ‘Clicks’. The clicks of
the selected construction are reset with the Accept
button. The respective parts have to be bound again
onto the construction after a subsequent test run.

Example 1:
Bind ‘click’ construction onto mother part after al‐
teration
Sleeve 70 is bound to Bodice 30. The shoulder of Bod‐
ice 30 had originally not been relocated, see Picture
14‐10. Therefore, when calling the sleeve, no differ‐
ence had been made between natural shoulder and
shoulder line of the part. This is important for correct
distribution of notches in the sleeve.
To bind the sleeve to the natural shoulder, the fol‐
lowing steps are required:
 release ‘clicks’ of the sleeve,
 relocate the shoulder of Bodice 30 towards the
front,

re‐activate the part with the sleeve and bind
the sleeve to the bodice again with test run. During
clicking, the dashed natural shoulder is to be clicked.

Call Bodice 10 into part 001 and Sleeve 30 into part
002. Adjust the bodice and the sleeve in‐
teractively. Open the List of interactive
constructions via <F12>, select Sleeve 30,
click once on Reset ‘Clicks’ and then, on
Accept. Open part organisation. Part 001
is no longer marked as mother part for
part 002 as resetting the ‘clicks’ has bro‐
ken the hereditary interdependence. Ac‐
tivate part 002 and start test run. After a
prompt, you can now bind the sleeve to
the bodice again.
Reset ‘Clicks’ offers the following applica‐
tions:
 ‘Click’ constructions can be bound
onto the mother part again after hav‐
ing been altered.
 ‘Click’ constructions can be bound to
an alternative part within the style
 chains of parts can be released and
saved as modules containing a num‐
ber of parts in the call list.
In the following, you will find four exam‐
ples for new applications of Reset ‘Clicks’.

1

2

3

4

6
5

Picture 14‐10
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It is also possible to relocate the shoulder first and
then, reset the ‘clicks’ in the sleeve.
8

8

7
7

To release the ‘clicks’, open the List of interactive
constructions with <F12>, select the sleeve (2), press
Reset ‘Clicks’ (3), Accept (4) (Picture 14‐10). Then, ac‐
tivate the bodice and relocate the shoulder towards
the front in the Shoulder drag area (5 and 6). The nat‐
ural shoulder is now visible as a dashed line. Then,
activate the sleeve and start test run. The sleeve is
now being bound again. During clicking, ensure that
for 7 and 8 (Picture 14‐11) you click the natural
shoulder displayed as a dashed line.

Picture 14‐11

Example 2:
Bind ‘click’ construction onto a
different basic block within the
style
Sleeve 70 with its dependent
parts is bound to Bodice 10. The
body measurement construction
Bodice 10 is now to be replaced
by the finished measurement
construction Bodice 30.

1

Step‐by‐step guide:
 Release the ‘clicks’ of the
sleeve
 Reset the part containing
Bodice 10
 Call Bodice 30 into this part
 Adjust Bodice 30 to be grade‐
able
 Activate the part with the
sleeve
 Bind the sleeve to the new
bodice with test run of the
sleeve
It is also possible to bind the
sleeve to the bodice, first and
then, adjust the bodice.

2

4

3

To release the ‘clicks’, open the
List of interactive constructions
with <F12>, select the sleeve (2),
press Reset ‘Clicks’ (3) and Accept
(4), see Picture 14‐12. Then, acti‐
vate part 001 and reset Bodice
10. Call the finished measure‐
ment Bodice 30 into part 001 and
adjust the construction interac‐
tively. Then, activate part 002
with Sleeve 70 and start test run.

5

Picture 14‐12
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6

Picture 14‐13

The sleeve is now being bound again (5), see Pic‐
ture 14‐12. Label part 001 in the part organisation
(6), see Picture 14‐13.
Example 3:
Release sleeve with dependent parts from a style and save in the call list

1
Save selected parts as
part module

Picture 14‐14

In a style, Sleeve 30 has been developed as a sleeve
with vent, lining, interfacing and templates.

This sleeve is now required in another style. It is to
be stored as a part module.
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Step‐by‐step‐guide:
 Activate the sleeve construction in the part or‐
ganisation.
 All parts belonging to the sleeve development
are automatically highlighted in colour.
 For a quicker control of the parts, you can have
only daughter parts displayed in the part rack
of the active part.
 Save part module
The saved part moducle can be loaded into another
style via call module

Store module in the call list
Step‐by‐step‐guide:
 Open new style.
 Open call list and activate edit mode.
 Add a new entry for the module and make the
connection to the previously saved style.
Open the style with the sleeve development (1), see
PiPicture 14‐14. Activate the basic block Sleeve 30.
Save the part module

, as ‘sleevechain01.mdl’.

Create a new style ‘test’ and open the call list. Acti‐
vate the edit mode via Edit → Edit mode (1), see Pic‐
ture 14‐15. In case your computer does not yet con‐
tain a folder for sleeve construction, click onto Gen‐
eral with the right mouse button and then, onto Cre‐
ate new folder in the context menu (2) and rename
the new folder to ‘My sleeeves’ (3)’. Avoid special
characters during naming. Click on the new folder
‘My sleeves’ with the right mouse button and select
Create new entry from the context menu (4). The In‐
sert module dialogue opens, see Picture 14‐16. Acti‐
vate Style (.MDL) (5) and select the recently saved
style ‘sleevechain01.mdl’ from (6). A copy of the
style is saved in the central folder \Grafis\Prog.
Assign a unique name according to the naming con‐
vention. We recommend a 9‐digit abbreviation of
your name or company name (7). After having as‐
signed the name, close the dialogue with OK.
Also, assign a name for the style in the call list (8).

.

1

2

3

4

Picture 14‐15

6

5

7

8

Picture 14‐16
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Example 4:
Application of the insert tool for development of a
shaped waistband
A shaped waistband for trousers and skirts with one
dart in the front and back respectively is to be devel‐
oped and saved in the call list.
Step‐by‐step guide:
 Generate a skirt basic block with one dart respec‐
tively in part 001
 Insert all required lines of the skirt front and back
into part 002 with the Insert lines tool. From ver‐
sion 11 onwards when calling the insert lines
tool, the click situation is photographed auto‐
matically, marked by a photo frame. Ensure that
the required objects are visible within the frame.
Shrink the view if required.
 Construct a shaped waistband with variable
width from the lines inserted into part 002. Use
either the Parallel 10 tool or the new curve tool.
Complete the shaped waistband with seam al‐
lowances, grain line, symbols and text. Set the
part parameter.
 Activate the shaped waist‐
band in the part organisation
and save the part as a part

clicked one after the other (2). Develop a systemati‐
sation in which order the lines are to be clicked. For
example, according to Picture 14‐17 all lines were
clicked from the outside. Click in the following order:
 centre back
 waist back 1
 dart back towards apex
 dart back away from apex
 waist back 2
 waist back 3
 side seam back downwards
 side seam front upwards
 waist 1 front
 waist 2 front
 dart front towards apex
 dart front away from apex
 waist 3 front
 centre front

module
.
 Open a new style, open the
call list and activate the edit
mode
 Create a new entry for the
shaped waistband and link it
with the recently saved style.

2

This shaped waistband can only
be used for skirts and trousers
with exactly one dart in the
front and the back. In the same
way, construct shaped waist‐
bands for two darts in front and
back respectively and for two
darts in the back and one dart in
the front.
Open a new style and call Skirt
20 into part 001. Interactively,
close the second dart in the front
and back skirt, respectively. Link
the waistline across the closed
second dart with link single.
Open a new part 002 and acti‐
vate it. Quit part organisation. In
the insert function from the
basic menu, click onto the tools
button and select Insert lines (1),
see Picture 14‐17. Now, all lines
required for development of a
shaped waistband must be

1

3

4

5
6

Picture 14‐17
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Transform the waist lines with side seam, centre
front and centre back towards one another in part
002. Construct a parallel to the waistline with Paral‐
lel 10 or new curve. Carry out the corner treatment
and complete the shaped waistband with seam al‐
lowances, grain line, symbols and text (3).
Open the part organisation and save the style as part
module ‘shapedwaistband.mdl’ (4)

. Create a

new entry in the call list as described in the step‐by‐

step‐guide in 14.5 example No.3 and link it with the
recently saved style ‘shapedwaistband.mdl’.
To test the shaped waistband, open a new style, call
Trouser 10 into part 001, close the second darts and
link the waist lines across the closed second darts.
Call the shaped waistband from the call list into part
002. Note the click situation in click window (5) pho‐
tographed by you. The trouser back is situated to the
left of the trouser front. If you have clicked all lines
correctly, the shaped waistband to fit the trousers
appears (6).

Example 5: Use of the Insert part tool for development of construction sets

Bodice 10

Front part30

Back part 40

Collar 40

Insert part

Insert part

Front component

Insert part
Back component

Picture 14‐18

The Insert part tool (also called ‘part click‘) allows for
insertion of all objects of a part with one single click.
This click connection can be released and reinstated
with one single click. Please note that the part click
requires an exact object structure of lines and
points. If Bodice 30 is clicked when calling Insert part,

after releasing the part click, only Bodice 30 can be
clicked again.
In Picture 14‐18 shows a front component and a back
component. The front component is based on Bodice
30 and Collar 40, both clicked with the Insert part
tool and thus, transferred into the development part
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for the front component. From this development
part, three production parts for main fabric and six
production parts for fusing were developed.
For a construction set, a number of components
based on the same or different constructions are de‐
veloped and stored in the call list. Additional infor‐
mation such as text, dimensions and part parameter
can also be stored at this point. This way, component
sets enable a standardisation of processes. At the
same time, company‐specific knowledge is saved.
Through the use of part click, the parts remain con‐
nected to the basic block so that alterations are au‐
tomatically transferred through the development
parts onto the production parts.
When calling the Insert part tool, the click situation
is automatically photographed, marked by a photo
frame. Please ensure that all required objects are vis‐
ible inside the frame. If required, zoom out the view.
Before building a construction set, we recommend
that you seek advise as further styling possibilities
are available.

14.6 Complex exercises
1st Exercise ‘Skirt with yoke’

Design specification:
From Skirt 20 a skirt with yoke in front and back, a
waistband and a zip in the centre back is to be con‐
structed.
Part list:
001 basic block Skirt 20
002 style development
003 PP yoke ft
004 PP yoke bk
005 PP skirt ft
006 PP skirt bk
007 waistband
Call the Skirt 20 into part 001 and interactively close
the second dart and set the hem reduction to 0.
Open part 002 ‘style development’ and insert all ob‐
jects from part 001.
Z01

Z01

+

X1

002

Construct the yoke in the front with the interactive
curve. The yoke curve in the back is to be constructed
at the side seam with z01= TL (yoke width front skirt
side seam).
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For the end of the zip, construct a point on the centre
back with the x value of part 002 ‘style develop‐
ment‘:
x1

2nd Exercise ‘Skirt with separate box pleat’

zip length from waist in mm (180)

Open parts 003 to 006 and insert all required lines
and points from part 002. Lengthen the darts to the
yoke line in part ‘yoke ft’ and ‘yoke bk’ and close the
darts. Link the yoke curves, construct the seam al‐
lowance, the notches and set the text. Use the follo‐
wing global x values:
Global x values:
xg1 seam allowance in mm (10.)
xg2 overlap width zip in mm (25)
xg3 hem in mm (20.)

Design specification:
From Skirt 20 a straight skirt is to be constructed with
separate box pleat in the centre front and flared side
seam. A vent and a zip are to be constructed at the
centre back.
Use the following global x values:
x1 seam allowance 1 (10.)
x2 seam allowance hem (20.)

003

List of parts:
001 basic block Skirt 20
002 style development
003 skirt front
004 pleat
005 skirt back
006 waistband

004

40

005

006

To conclude, open part 007 and transfer all waist
lines of the front and back skirt from part 002. Use z
values to construct the waistband.
Construct the waistband height with a continuous in‐
teractive parallel.

5

Call the Grafis Skirt 20 into part 001 and interactively
close the second dart. Adjust the following interac‐
tively:
Drag area Hem:
 flare side seam by 20mm
 rotation point side seam: 60mm

007

Drag area Dart front:
 close 2nd dart
 position for 1st dart: 66%
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Drag area Dart back:
 close 2nd dart
 position for 1st dart: 33%

Open part 006 and construct the waistband using z
values and Parallel 10 for the waistband height.

Open the part 002 ‘style development’ and insert all
objects from part 001. Construct the box pleat in the
front skirt with Parallel 10 and shorten the pleat and
the pleat back by 5mm with Line 20.

006

Open the part 003 ‘skirt front’ and insert all required
lines and points from part 002. Construct the dart
hood, the seam allowance and set the symbols and
the text.
Close the hem corner with Hem corner 80.
Create part 004 in the same way.
Now, open part 005 ‘skirt back’ and insert all re‐
quired lines and points from part 002. Finish the skirt
back according to part 003. Use Vent corner 30 for
the zip facing and the vent facing.

004

003

005

3rd Exercise ‘Shirt blouse with pin‐tucks in the front and various back variations’

Design specification:
From the basic block Bodice 10 a blouse with front,
yoke and four different back variations is to be de‐
signed. The front is to have 3 pin‐tucks, a button‐
stand and an overlap. The back is to have four varia‐
tions:
 back with pleats from yoke,
 back with flared hem,
 back with gathering at the yoke,
 back with different spread amount in yoke and
hem.

Part list:
001 Bodice 10 shirt blouse
002 style developement
003 PP ft
004 PP bk yoke
005 SD bk
006 PP bk with flared hem
007 PP bk with pleats
008 PP bk with gathering
009 PP bk with variable pleats
Call the Bodice 10 into part 001 and load the shape
‘shirt blouse’, see section 2.5.
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50 50

Open part 003 and insert all required lines and points
from part 002. Construct the position for the first
pin‐tuck, the further pin‐tucks and the overlap with
Front edge 30 and then, the facing. Spread the pin‐
tucks after having constructed the facing.
For the seam allowance use a global x value:
Global x values:
xg1 seam allowance in mm (10.)
Open part 004 ‘PP bk yoke’ and insert all required
lines and points from part 002. Construct the seam
allowance with the global x value and mirror the
piece. Set the symbols and the text.

004

Open part 002 and insert all objects from part 001.
Construct the yoke and the spread lines for the
pleats in the back with Line 10. For the curved hem,
use Co‐ordinated corner 50.

Open part 005 and insert all lines and points required
for the back construction from part 002. Raster the
yoke line equally and construct the spread lines.
Spread the back using the following x values for the
pleat content:
X values of part 005 ‘SD bk’:
x1 pleat content yoke (40.)
x2 pleat content hem (40.)

12

Duplicate part 005 four times. The two x values for
the pleat content are also duplicated. Adjust the part
name and the value of the x values as follows:
X values of part 006 ‘PP bk with flared hem’:
x1 pleat content yoke (0.)
x2 pleat content hem (40.)
X values of part 007 ‘PP bk with pleats’:
x1 pleat content yoke (50.)
x2 pleat content hem (50.)
X values of part 008 ‘PP bk with gathering’:
x1 pleat content yoke (40.)
x2 pleat content hem (0.)

20

60

X values of part 009 ‘PP bk with variable pleats’
x1 pleat content yoke (30.)
x2 pleat content hem (70.)
Develop production patterns for the backs in parts
006 to 009. Construct dart hoods, link if necessary,
set symbols and text.

Chapter 14 Part organisation
223
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook Edition 2017

4th Exercise ‘Flared skirt’

005

Design specification:

006

From the basic block Skirt 20 a paneled skirt with
flared hem, concealed zip in the side seam and vari‐
able seam allowance is to be constructed.
Use global x values for the seam allowance, the hem
and for the spread amount of the pleats.

007

008

Part list:
001 basic block Skirt 20
002 style development
003 PP skirt ft left
004 PP skirt ft right
005 PP skirt ft centre
006 PP skirt bk left
007 PP skirt bk right
008 PP skirt bk centre
009 waistband
Call the Skirt 20 into part 001, close the second dart,
reset the hem reduction and position the darts in
front and back at 40% respectively.
Open part 002 and insert all objects from part 001.
Construct a panel seam, using Line 10 parallel to the
centre front and centre back.
Construct the curve in the front with 250 mm from
the dart at the panel seam and with 250 mm from
the hem.
The curve in the back is to be constructed with
Z01 = AB
Z02 = AB

distance from dart end at panel seam
dinstance from hem at side seam

Raster the hem of front and back from the side seam
to the panel seam respectively with number of points
on line section into 5 points. Construct vertical lines
upwards from this points and ‘cut on‘ the lines to the
curves.

009
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004

003

z01

z01
z02

z02
002

005

Open part 003 and transfer all required lines and
points from part 002. Then, duplicate part 003, cre‐
ating part 004. Continue with parts 005 to 008. Use
the following x values for construction of the pleats:
X values of part 005 ‘PP skirt ft centre’:
x1 spread amount top (0.)
x2 spread amount hem (40.)

006

007

Finally, open part 009 and transfer all waist lines of
front and back skirt from part 002. Use z values to
construct the waistband.
Construct the waistband width with the interactive
parallel and the raised centre front with interactive
Line 10.

009

008
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5th Exercise ‘Culottes with pleats’

Drag area Hem:
 hem line: 0mm
 shape hem line as curve
Open part 002 ‘style development’ and insert all ob‐
jects from part 001. Construct the yokes in the front
and back trouser and the points for the zip length,
applying the following x values:
100

x1

x1
120

+ x2

+ x2

Design specification:
From the basic block Trouser 10 culottes with pleats
in the front, a yoke, raised hem and concealed zip in
the side seam are to be developed.
Use the following global x values:
x1 seam allowance 1 (10.)
x2 hem (20.)
Part list:
001 Basic block Trouser 10
002 style development
003 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
004 ‐‐‐ PATTERN PIECES
005 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
006 yoke front
007 trouser front left
008 trouser front right
009 yoke back left
010 yoke back right
011 trouser back left
012 trouser back right
Call the Trouser 10 into part 001 and adjust the fol‐
lowing interactively:
Options:
 display measurements: yes
 side seam countour identical: yes
 side seam as curve
 adjustment waist at side seam: yes
 adjustment curve at crotch seam: yes
Drag area Finished measurements:
 knee width 650mm
 hem width 700mm
Drag area Line relocation:
 position hem line for shorts: 600mm
 inclination of hem line at side seam/front:
70mm
Drag area Dart back:
 2nd dart: 0mm

x values part 002 ‘style development’:
x1 yoke ft ss from waist in mm (80.)
x2 zip ss from waist in mm (160.)
Raster the yoke line in the front trouser to draw the
spread lines. Construct the spread lines and cut them
at the hem line.
Open part 006 ‘yoke front’ and insert all required
lines and points from part 002. Note that a zip is to
be inserted into the left side. Rotate the dart closed
and construct the seam allowances.
Open part 007 and insert all required lines and points
from part 002. Spread the pleats with the following x
values:
x values part 007 ‘trouser front left’:
x1 pleat content top in mm (40.)
x2 pleat content bottom in mm (40.)
Construct the pleat hoods and seam allowances. Du‐
plicate part 007 before constructing the zip facing
with Vent corner 30.
Part 008 ‘trouser front right’ simply has to be mir‐
rored at the grainline.
Generate parts 009 to 012 in the same way.
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6th Exercice ‘Dress with panel seams’
006
008

010

012

007

009
011

Design specification:
From Bodice 10 a dress with panel seams and con‐
cealed zip in the centre back is to be developed.
Use the following global x values:
x1 seam allowance 1 (10.)
x2 seam allowance centre back (20.)
x3 hem (40.)
Part list:
001 Basic block Bodice 10
002 FP‐Tool 20
003 BP‐Tool 20
004 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
005 style development
006 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
007 ‐‐‐ PATTERN PIECES
008 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
009 bk centre panel
010 bk side panel
011 ft side panel
012 ft centre panel
013 ft facing
014 bk facing
015 armhole facing
Call the Bodice 10 into part 001 and adjust the fol‐
lowing options interactively:
 CB shaped
 CB length measured from waist
 side seam contour identical
 position waist dart relative to waist
 length waist dart to hem
 bust dart into armhole
 armhole direction linked at shoulder
 hem direction linked at side seam
 panel seam in the back: yes
 4 segments
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Drag area Tolerances:
 tolerance at bust: 50mm
 tolerance at waist: 50mm
 tolerance at hip: 50mm
 tolerance at across bust: 10mm
 tolerance at across back: 5mm

Drag area Panel seam from shoulder
 move bust point by 5mm in positive x‐direction
 base point hip curve in mm: 120

Drag area Line relocation:
 length: 500mm
Drag area Bust dart:
 position from front pitch: 50mm
Drag area Shoulder dart:
 position at 60 %
Drag area Waist dart:
 relocate towards side seam by 10mm
Drag area Neckline:
 drop neckline bk: 30mm
 increase neckline at shoulder: 50mm
 drop neckline CF: 150mm
013

012

Adjust the neckline to your preference.
Drag area Hem:
 side seam reduction at hem 15mm
In the part organisation, open two further parts and
call tool Front part 20 and tool Back part 20. Set the
following options and drag areas interactively:
Front part 20
Options
 princess seam
 panel seam 2 visible: no
 base point hip curve in mm

011

015

X1
014
X1

010

009

Back part 20
Options
 panel seam from shoulder
 panel seam visible: no
 base point hip curve in mm
Drag area Panel seam from shoulder
 base point hip curve in mm: 140
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Open part 005 ‘style development’ and insert all ob‐
jects from part 002 and part 003. Create the follow‐
ing x values:
X values of part 005 ‘style development’:
x1 facing width neck (30.)
Extract the pattern pieces as displayed. Create global
x values and construct the seam allowances, set sym‐
bols and texts.
Structure the part organisation.
Name part 009 ‘back centre panel’ and insert all re‐
quired lines and points from part 005.
X values of part 009 ‘bk centre panel’:
x1 zip length (530.)
Continue with part 010, 012 and 013 in the same
way.
In part 012 ‘front centre panel’, construct the seam
allowances and mirror the part. Use corner tools Cor‐
ner 60 (angle) and Corner 70 (angle coordinated) for
the construction of the angled corner at the princess
seam/armhole. For the hem, use Corner 80 (hem cor‐
ner).
For part 015 ‘armhole facing’ insert the lines of the
armhole step‐by‐step from part 005, starting with
the shoulder, upper armhole front, princess line.
Transfer the further armhole lines with insert with
transformation. Alternatively, transformation can
ensue after all required lines and points have been
inserted
7th Exercise ‘Long dress with godets’

x2
x3

seam allowance centre back (20.)
hem (40.)

Part list:
001 Basic block Bodice 10
002 front part tool 20
003 back part tool 20
004 style development
005 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
006 ‐‐‐PATTERN PIECES
007 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
008 bk centre panel
009 bk side panel 1
010 bk side panel 2
011 ft centre panel
012 ft side panel 1
013 ft side panel 2
014 bk neck band
015 ft neck band
016 strap
Call the Bodice 10 into part 001 and adjust the fol‐
lowing options interactively:
 CB seam shaped
 CB length measured from waist
 side seam not contour identical
 position waist dart relative to waist
 length waist dart to hem
 bust dart in shoulder
 armhole direction linked at shoulder
 hem direction linked at side seam
 4 segments
Adjust the following in the drag areas:
Drag area Tolerance:
 tolerance at bust: 30mm
 tolerance at waist: 30mm
 tolerance at hip: 30mm
 tolerance at across bust: 10mm
 tolerance at across back: 5mm
 ss/waist ft 12.5mm (half dart suppression ft)
 ss/waist bk 15mm (half dart suppression bk)
Drag area Line relocation:
 length: 950mm
 armhole relocation: ‐15mm
Drag area Bust dart:
 position from neck: 40%

Design specification:
From Bodice 10 a long dress with straps, band and
godets is to be developed.
Use the following global x values:
x1 seam allowance 1 (10.)

Drag area Waist dart:
 reduce waist darts in ft + bk by half (ft: 12.5, bk:
15mm)
Call Front part 20 and Back part 20 into parts 002 and
003, respectively. Design and modify the panel
seams in the interactive area.
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Front part 20
Options
 panel seam from shoulder
 panel seam 2 visible: yes
 panel seam at waist in: %
Drag area 2nd side panel seam
 position panel seam at 50%
 contour identical adjustment in facing area
Back part 20
Options
 panel seam from shoulder
 panel seam visible: yes
 panel seam at waist in: %
Drag area Panel seam from shoulder
 shorten upper dart point interactively to facing
Drag area Side panel seam
 position panel seam at 50%
 contour identical adjustment in facing area
Open part 004 ‘style development’ and insert all ob‐
jects from part 002 and part 003. Create the follow‐
ing x values:
X values of part 004 ‘style development’:
x1 band width
(50.)
x2 godet position from hem (400.)
x3 godet width
(25)

140

Then, transform the panel seams back to their origi‐
nal position with reverse transformation.
Construct the godets at all panel seams, CF, CB and
side seam with the interactive Circle 20. Set the cir‐
cle arc to 0 at one side and use x3 for the other circle
arc side. Mirror the circle arc at the panel seams.
Open part 008 ‘bk centre panel’ and insert all re‐
quired lines and points from part 004. Create an X‐
value:
X values of part 008 ‘bk centre panel’:
x1 zip length (500.)
Construct the seam allowances and the hem. Set the
symbols and the text.
Open the next part 009 ‘bk side panel 1’ and insert
all required lines and points from part 004. Construct
the seam allowances and the hem. In the area of the
zip at the centre back use the X‐value XG2. Set the
symbols and text.
Construct parts 009 ‘bk side panel 1’, 010 ‘bk side
panel 2’, 011 ‘ft centre panel’, 012 ‘ft side panel 1’
und 013 ‘ft side panel 2’ in the same way.
For part 014 ‘bk neck band’ and 015 ‘ft neck band’,
insert the lines for the neckband step‐by‐step from

250
X1

011

010

012

009

013

008
016

015
X2

mirror

X3

Transform the panel seams together at facing level
and construct the facing line with curve and the fac‐
ing width with parallel and x1.

014

part 004. The individual parts of the facing are trans‐
formed toward each other. Construc the seam allow‐
ances and symbols and mirror the ‘ft facing‘ at the
centre front.
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To construct the strap transfer the lines in the bust
dart area, the shoulder, armhole ft and bk. Trans‐

011
012
013
014
015
016
017
018
019

yoke facing
trouser bk part 1
trouser bk part 2
trouser bk part 3
pocket 2
pocket 3
flap pocket 3
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
waistband
55

50
35

60
180

100
x3

form the back shoulder onto the front shoulder and
construct a curve for the strap shape.
Construct the strap width with the interactive Paral‐
lel 10..

x3

220

70
X2

90

x1

50

80

8th Exercise ‘Casual trouser with two zips in the legs
and patch pockets ‘

220

X2
X4

Call the Trouser 10 into part 001 and adjust the fol‐
lowing options interactively:
 side seam contour identical: yes
 adjustment waist at side seam: yes
 adjustment curve at crotch seam: yes
 waistband pleats: no
Adjust the following in the drag areas:
Design specification:
From Trouser 10 new trousers are to be designed
with two zip detachments and patch pockets.

Drag area Tolerances:
 tolerance at waist: 10mm
 tolerance at hip: 20mm

Use the following global x values:
x1 seam allowance 1 (10.)
x2 seam allowance 2 (5.)
x3 hem allowance (30)

Drag area Finished measurements:
 knee width: 540mm
 instep width: 480mm

Part list:
001 basic block Trouser 10
002 style development
003 ‐‐‐‐‐PATTERN PIECES‐‐‐‐‐‐
004 trouser ft part 1
005 trouser ft part 2
006 trouser ft part 3
007 pocket 1
008 decorative flap
009 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
010 yoke trouser bk

Assign the finished measurements with one or more
break sizes and adjust a suitable grade, see Chapter
11.2.
Drag area Line relocation:
 waist: ‐40mm
Drag area Dart back:
 2nd dart: 0mm
Drag area Hem:
 hem line: 0mm
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9th Exercise ‘Fitted jacket with panel seams’
019

007
011
008
010

Design specification:

017
015

Part list:
001 basic block Bodice 50
002 front part tool 20
003 back part tool 10
004 style development
005 basic block Sleeve
006 basic block Flap

016

004

From the basic block Bodice 50 a fitted jacket with
panel seams and pocket is to be developed.

012

005

013

006

014

Open part 002 ‘style development’ and insert all ob‐
jects from part 001. Create the following x values:
X values of part 002 ‘style development’:
x1 separation for zip at thigh at ss (400.)
x2 overlap width for zip at thigh (40.)
x3 pocket position ss from waist in mm (240.)
x4 separation for 7/8 length from hem in mm
(200.)
Construct the style development using the interac‐
tive functions and the x values. Then, develop the
completed production pattern pieces.

Call the Bodice 50 and adjust the following options:
 display measurements:
yes
 CB seam:
shaped
yes
 ss contour identical:
 ss straight:
no
 ss grading centred:
no
 preset ss shaping at waist: yes
 ss direction at waist:
linked
 ss direction at hip:
linked
 position waist dart in bk:
relative to waist
 dart length to hem:
no
 position shoulder dart
yes
as bust dart:
 dart with bust angle
 bust dart in shoulder
 armhole direction at shoulder: linked
 armhole direction at ss:
right angle
 armhole direction at
front pitch:
free
 hem direction at ss:
linked
 hem extension in:
mm
no
 panel in back:
 bust line:
transformed
 number of segments:
8 segments
Adjust the following in the drag areas:
Drag area Tolerance:
 tolerance at bust:
 tolerance at waist:
 tolerance at hip:
 tolerance at across bust:
 tolerance at across back:
 tolerance at shoulder width:

80mm
80mm
80mm
15mm
10mm
10mm
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Drag area Line relocation:
 drop armhole:
 style length:

‐20mm
720mm

Drag area Bust dart:
 loosen armhole:
5mm
 position bust dart at 50% of shoulder
Drag area Waist dart:
 move back dart to
 shape waist curves
Drag area Shoulder dart:
 reduce dart suppression to

60 %
004
15mm

Drag area Shoulder:
 move shoulder by 10mm at neckline and arm‐
hole.

When extracting the pattern pieces, ensure that the
new neckline is inserted. This had been altered by
shoulder relocation and created as a new object.

Open part 002 ‘front 20’ and call Front part 20. Acti‐
vate Front part 20 and adjust it according to your
ideas.
Then, open part 003 ‘back 20’, call Back part 20 and
adjust it interactively.

Open part 005 ‘basic block sleeve‘ and leave part 001
visible. Call Grafis sleeve 30 into part 005, clicking the
corresponding lines and points of the relocated arm‐
hole from part 001. Adjust the sleeve interactively
according to your ideas. Adjust the wrist width using
break sizes.
Call the Grafis‐Pocket → with lining → cut → single
jet → 001 into the style development and adjust it.
Alternatively, you can open a separate part for the
collar and the pocket and attach it to the style devel‐
opment when clicking. The corresponding pattern
pieces are automatically loaded into the part organi‐
sation when calling the pocket.

Open part 004 ‘style development’ and insert all lines
and points from part 002 and part 003.
Construct the overlap, position the 1st button and
the curved hem with the tool Front edge 30. Adjust
as follows:
Options
 lapel (revers)
 front point as curve
 direction linked
no
 resulting button distance:
 place buttons from CF
 single‐breasted (1 button line)
Drag area Overlap:
 overlap width:
 revers from waist:

25mm
130mm

Drag area Front point:
 curved hem at CF:
 curved hem at hem:

200mm
100mm

005

006

Drag area Buttons:
4
 number of buttons:
 distance 1st button to revers: 20mm
 distance between buttons: 70mm
Call the interactive Collar 40 into the style develop‐
ment. Adjust the collar interactively according to
your ideas.

Open a further part 006 ‘basic block flap’ and keep
part 004 with the basic pocket shape visible. Call the
Grafis‐Pocket 60 (Pocket flap) and adjust it interac‐
tively.
Now open further positions for the other pattern
pieces. Create global x values for seam allowance
and hem and construct.
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Global x values:
x1 seam allowance 1 (10.)
x2 seam allowance 2 (20.)
x3 seam allowance 3 (5.)
x4 hem (40.)
Use the following interactive
corners when closing the cor‐
ners:
Hem corner
Vent corner
Angle corner
Angle corner coordinated
Part list:
001 basic block bodice 50
002 front part tool 20
003 back part tool 10
004 style development
005 basic block sleeve
006 basic block flap

Main fabric parts 008‐021

Interfacing parts 022‐029

Lining parts 030‐037

007
008
009
010
011
012
013
014
015
016
017
018
019
020
021

==MAIN FABRIC=
back
back side panel
front side panel
front
undersleeve
top sleeve
facing
under collar stand
under collar
top collar
top collar stand
pocket flap
jet
facing

022
023
024
025
026
027
028
029
030
031
032
033
034
035
036
037

==INTERFACING=
interfacing front
interfacing facing
interf. u collar stand
interfacing under collar
interfacing top collar
interf. top collar stand
interfacing jet
==LINING==
flap lining
pocket bag lin. bottom
pocket bag lining top
bk lining
ft lining
top sleeve lining
undersleeve lining
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All Grafis users who deal with production abroad or
provide pattern services for companies will have to
deal with export and import. As a rule, during data
exchange between CAD systems a loss of infor‐
mation occurs as the patterns are reduced to an
agreed data format.
During export, the interactively adjustable patterns
in Grafis are converted to a contour with grade rules
plus additional information on grain line, notches,
text and symbols. The exported patterns contain no

information on x values, body measurements and
piece interdependency.
Patterns from foreign systems can be imported into
Grafis only as grade rule patterns. Grade rule pat‐
terns consist of a pattern perimeter with grade
points. Each grade point is assigned a grade rule ta‐
ble with size dependant point movement in x and y
direction.
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15.1 Preparation for export in the Grafis
Patternmaking program
Step‐by‐step‐guide
 Generate production patterns with closed perim‐

eter
 Set grain line as symbol or as attribute line
 Set piece parameter production piece for all pro‐

duction pieces
 Enter all sizes to be exported in the size table and

grade all pieces.
Construct production pieces with closed perimeter
During pattern development draft patterns are cre‐
ated from which the actual production patterns are
derived, see Chapter 14 Part organisation. Only
pieces with closed perimeter can be exported.
Production pieces:

Picture 15‐2

With the button
the piece parameters of the se‐
lected piece are transferred to the next piece. This
relates to the attribute Production piece, the mate‐
rial type and the amount per style in normal/ mir‐
rored position. These parameters are required for
marker making, see Chapter 17.
Grafis checks for closed perimeter of the pieces
when setting the piece parameter production piece
and again during export. If Grafis finds gaps
(>0.5mm) in the perimeter or protruding lines, an er‐
ror message appears. Gaps can usually be found at
corners, joints of lines or at symbols.
notch in the perimeter

Draft patterns:
correct

 false (gap)

Picture 15‐3

Line symbols such as notches are ignored during
checking of the perimeter (Picture 15‐3).
To avoid problems, the slit notch should be used.
Picture 15‐1

Set grain line
The Grafis symbol grain line or the interactive Grain
line 10 should be set in the pattern pieces. Alterna‐
tively, an internal line can be declared as grain line in
the attributes menu. If no grain line has been set, the
negative y direction (direction downwards) is as‐
sumed as the grain direction as standard.
Assign piece parameter
In the part organisation dialogue open the file card
Piece paremter (Picture 15‐2). For export, all produc‐
tion pattern pieces must be declared as Production
piece. Only these pieces are captured during auto‐
matic export.

To learn about the export function, prepare a simple
style with pattern pieces, for example a skirt as
shown in Picture 15‐1.
Grade production pieces
All sizes to be exported must be entered in the size
table. One entry per size is sufficient. Grade all pro‐
duction patterns with Grade all Parts.
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15.2 Export formats and their particulari‐
ties

For transfer to a Gerber Accumark system database
a conversion is required.

Grafis can export in the following formats:
1. AAMA/DXF
2. ASTM/DXF
3. DXF
4. ExtendedPN
5. Grafis export format
With the exception of the Grafis and DXF export for‐
mats, during export, all pattern stacks are reduced to
a base size with grade rules. As all sizes are con‐
structed individually in Grafis, this leads to a loss of
information. The target system calculates the con‐
tours of the different sizes from these reduced data
with its own mathematical algorithms. Therefore,
the shape can differ from the original shape in Grafis,
particularly in extreme sizes.

4. DXF

1. AAMA
The AAMA format, also called AAMA/DXF format, is
currently the most widely used format. It is based on
the DXF data format used by the AutoCAD software
for transfer of vector graphics. The AAMA standardi‐
sation determines which content is to be deposited
in which DXF data structure (contour, internal lines,
notches, drillholes etc.). The contour of the base size
is normally written into the .DXF file and the graded
sizes are written into a separate .RUL file. Unfortu‐
nately, the AAMA format is not clearly defined in all
points so that significant differences may occur dur‐
ing interpretation by different CAD systems.
Grafis has accommodated this particularity. During
export in AAMA/DXF format you can chose between
different Export configurations. The correct Export
configuration for a particular case has to be tested.
The addition ’noRUL’ means that all sizes are con‐
tained in the DXF file as perimeters. No separate
.RUL file is created.
2. ASTM
The ASTM format, also called ASTM/DXF format, is
the further development of AAMA format. It is more
standardised but not available in all CAD systems.
Furthermore, ASTM contains a number of new notch
types and supports descriptive text. The Export con‐
figuration ‘GradedNest‘ generates a .DXF file and no
separate .RUL file, analogous to ‘noRUL‘. All sizes are
contained as perimeter in the DXF file.
3. Extended PN (EPN)
EPN is an interim format determined by Gerber Gar‐
ment Technologies (GGT). Exactly one pattern piece
with all grade rules is captured per file.

The DXF format is used for export of data to engi‐
neering CAD e.g. AutoCAD or drawing programs e.g.
Corel Draw. The DXF format exported by Grafis uses
a small amount of the standardized data types only.
Thus, the exported data will be readable in many sys‐
tems. The single sizes are exported to consecutive
layers
5. Grafis format
The Grafis format is a format for transfer of pattern
pieces determined and published by Grafis. This data
format is currently supported by only one foreign
system.
NB: Data exchange with other Grafis users should
ensue via: Grafis styles, Grafis styles with reduced
pieces, Grafis production styles, Grafis grade rule
patterns or Grafis markers!
6. Other data formats
There is no alternative to the above formats for
transfer of pattern pieces in a number of graded
sizes.
Individual pieces can be output in HP/GL vector
graphic format, see explanation on ‘output to file’ in
section 3.3.2.
With the Grafis Marker making, data can be output
in ISO format to drive cutters. This interface is re‐
leased for particular cutters as part of a maintenance
contract.

15.3 The export dialogues
The Grafis export parts dialogue
The Grafis Export parts dialogue (Picture 15‐5) opens
via File → Export parts. This dialogue controls which
parts, in which data format and with which specific
settings are to be exported.
Settings opens the Export parameter dialogue with
the selection of Export configuration, among others.
Check in this dialogue whether the parameters for
the envisaged export are set correctly.
The switch Hide seam allowances can temporarily
hide seam allowances of the patterns. The pre‐req‐
uisite is that the net perimeter of the pattern has
been assigned the attribute seam line. Having quit
the export function, the seam allowances are re‐in‐
stated.

238
Chapter 15 Export/ Import and Pixel images
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

any particular line attribute. Al‐
ternatively, you can use the
global switches all internal lines
with attribute for all lines with
special attribute or all internal
lines. If one of the global switches
is set, specific line types can no
longer be selected.
Symbols for output

Output selection initiates the export of all currently
selected parts. Output all starts the export of all
parts in the list. If the switch overwrite without
warning is set, existing files with the same name will
be overwritten without notification.
With the buttons Copy and Print the list of export
parts with details of export type and time of last ex‐
port is copied to the clipboard or printed directly.
The output file field indicates the name of the export
file during the export process.
The Export parameter dialogue
The Grafis‐Export parameter dialogue (Picture 15‐5)
opens via the button Settings in the Grafis‐Export
part dialogue.

Picture 15‐5

Lines for output
The section lines for output controls which lines are
to be written into the export file. You can select the
line attributes grain line, annotation line, cut internal
line, split line and seam lines, which have been as‐
signed with the attribute function. The selection all
continuous internal lines captures all lines without

The section symbols for output
controls which symbols are to be
written into the export file. This
section captures all point and line
symbols which have been set
Picture 15‐4
with the symbols function. The
grain line and line symbols are not captured, here.
Symbols which are known in the target data format,
such as the drillhole, are written as symbols into the
export file. All other symbols are transferred as con‐
tinuous lines. If the switch all symbols is set, all point
symbols are exported. Alternatively, the symbols to
be exported can be selected individually in the list.
The switch interactive symbol lines and marking lines
controls the export of the interactive seam symbols.
Division of curves with additional grade points
To ensure accurate curve representation in all sizes
in the target system, additional grade points are set
automatically along the curve during Export parts.
The options under edit parameter for lines influence
this automatism. The switch create additional grade
points should only be deactivated in exceptional cir‐
cumstances as it switches off the above automatism.
The additional grade points are set at the following
points of the perimeter:
1. at real corner points,
2. always at notches even if create additional
grade points is switched off and
3. at turning points of the curve.
4. All remaining curve sections are divided accord‐
ing to the parameters min number of base
points and max number of curve segments.
The parameter min number of base points indicates
the minimum number of base points to be contained
in a curve section between two grade points. Nor‐
mally, Grafis generates an appropriate number of
base points automatically. In tight curvatures the
points are denser and in long stretched curve sec‐
tions, they are placed further apart. The smaller the
min number of base points, the closer the grade
points on the curves. A value between 4 and 8 has
proven to be successful. A value below 3 is not mean‐
ingful. The parameter max number of curve seg‐
ments limits the division of curves through grade
points. The last division step creates no more than
the stated number of curve sections. If this parame‐
ter is to be void, a high value, e.g. 99 can be entered.
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A value between 8 to 12 has proven to be successful.
A value below 2 is not meaningful.
Export configuration
Depending on the selected export format, different
options are displayed in the export configuration
section. For AAMA and ASTM, the export configura‐
tion can be chosen. Thus, the export is adjusted to
the different requirements of the target system. For
export of Gerber EPN (ExtendedPN), further conver‐
sion and possibly the export target can be selected,
see section 15.5.
Additional settings
Experienced users can further control the export
with the following switches of the Grafis.ini, section
[INTERFACE]:
DXFEXP_NAMEMODE controls the allocation of the
file name for Autocad‐DXF files.
DXFEXP_STARTLAYER determines start layer for out‐
put in Autocad‐DXF. The layers for the specific sizes
are then counted upward by 1.
Mit OPTNSALWY=1 automatically opens the export
parameter dialogue for each export.
AAMASAVEAS permits saving DXF files with the ’Save
as…’ dialogue.

15.4 Step‐by‐step guide for export in
AAMA/ASTM/DXF format
This step sequence applies to export in
AAMA/ASTM/DXF format and in Grafis export for‐
mat. The analogous step‐by‐step guide for export in
Gerber EPN format can be found in section 15.5.
1. Every part of the style to be exported need to be
marked as Production piece at file card Part pa‐
rameter. It is possible that a number of parts are
marked as production pieces as the parts will be
chosen for export, later.
2. The parts must be available and graded in all sizes
to be exported. Select all sizes to be exported in
the Size table and then start Grade All Parts or
Grade Production Pieces.
3. Open the export dialogue via File | Export Pattern
Pieces. All productions pieces will be automati‐
cally prepared and displayed in all available sizes,
see Picture 15‐4.

4. Choose export type AAMA/DXF, ASTM/DXF or in
exceptional cases DXF or Grafis. Please take note
of the information on export data formats in sec‐
tion 15.2.
5. Clicking on the Settings button opens the Export
parameter dialogue (Picture 15‐5). Depending on
the selected format AAMA/ ASTM/ DXF/ Grafis,
this dialogue differs only in the export configura‐
tions available. You must test which export con‐
figuration is suitable for which CAD system.
Choose the required export configuration and
close the Export parameter dialogue.
6. In the cases AAMA/DXF and ASTM/DXF:
In dialogue Grafis Export Parts check if Collating
AAMA files is active and enter an appropriate
name. Only if Collating AAMA files is checked
then all selected parts will be combined into one
*.DXF file and one *.RUL file. It is important that
the name has no more than 8 characters and
does not contain any spaces or special charac‐
ters. Otherwise the file name of the exported files
might be changed during transfer by email.
7. Now choose the parts to be exported in the list of
parts. Mark an area of parts by clicking the part
at the end of the required area with pressed
<Shift> key. Pressing the <Ctrl> key marks or un‐
marks single parts.
8. Then all selected parts will be exported with Out‐
put Selection. According to the settings under Ex‐
port Parameter the grain line, the symbols and
the inner lines are included, also. Alternatively all
parts can be exported with Output All.
9. The export files are stored in the directory
\Grafis\Basis_A\Interfac\Alpha\. The following
applies: ‘Basis_A’ is the current measurement
system and ‘Alpha’ the current collection. During
output this path is displayed at Output file lower
left of the window.
10. The *.DXF file as well as the *.RUL file of the same
name have to be passed on together ideally
packed into a *.ZIP file. Both files are comple‐
mentary. The *.DXF file contains the contour data
and the *.RUL file the grade rules of the sizes.
File names must not be changed after export as they
are synchronised!
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15.5 Step‐by‐step guide for export in EPN
format and transfer to Gerber
The step‐by‐step guide for generation of EPN files is
identical to the step‐by‐step guide in section 15.4
where the export data type ExtendedPN is selected.
The transfer to Gerber can ensue with the following
variations:
A) transfer of EPN files without conversion
B) direct access to Gerber Accumark via a network
C) transfer via USERROOT
D) single Gerber export files *.TMP
Check with the recipient in which form the data is to
be supplied.
Please note! We can take no responsibility for error‐
free data acquisition in Gerber or any mistakes or
conflicts arising from the import into Gerber.
The configuration ensues in the EPN conversion dia‐
logue which is opened from the Export parts dia‐
logue via Settings  EPN conversion, see Picture 15‐
6. The above transfer variations are adjusted as fol‐
lows:
A) Select no conversion of EPN files in the EPN con‐
version dialogue.
B) In the EPN conversion dialogue, select conversion
in data area (USERROOT). Select the target area
on your Accumark system.
C) Now, prepare the data base for Gerber with Win‐
dows Explorer. Rename an already existing area
C:\USERROOT\STORAGE\FLOPPY\...
to
C:\USERROOT\STORAGE\YOUR_NAME\... if re‐
quired.

Copy the file \Grafis\Hilfen\floppy0.exe to the
root of your drive, here C:\ and start it there.
Floppy0.exe
creates
a
new
area
C:\USERROOT\STORAGE\FLOPPY\... An already
existing area 'FLOPPY' will be overwritten! Ide‐
ally, rename this area ‘FLOPPY‘ immediately to
'YOUR_NAME'.
In the EPN conversion dialogue, select conversion
in data area (USERROOT). Select the target drive
and the data area you have just created.
D) In the EPN conversion dialogue, select conversion
to TMP files.
After export, the converted data is available as fol‐
lows:
A) The EPN data is saved under
\Grafis\Basis_A\Interfac\Alpha\, where Basis_A
is the measurement system and ‘Alpha‘ is the
name of the collection. The EPN files are con‐
structed from the style name and the part num‐
ber. Thus, the file trouser.002 contains the data
from the second part of the style ‘trouser‘.
B) With direct access to Gerber Accumark via a net‐
work, the parts are immediately visible.
C) The data is to be sent via email/ internet. The
complete data area from \USERROOT must be
placed into a zip file.
NB: There may be more than one data area
stored under /USERROOT which may relate to
more than one customer or stem from different
days. Always ensure that you send only the
area(s) required by the recipient. Otherwise, data
for other customers may be included.
Each export writes to the selected data area of
the USERROOT. The old data is not overwritten,
the data area grows. To ensure before export

Picture 15‐6
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that the data area contains no other data,
floppy0.exe must be called. This creates the
empty ‘FLOPPY‘ area. You can write more than
one style to an area..
D) As a rule, the Gerber export files are written to
the directory
\Grafis\Basis_A\Interfac\Alpha\Skirt\ where ‘Ba‐
sis_A‘ is the measurement system, ‘Alpha‘ is the
name of the collection and Skirt is the style name.
This path appears in the output file field at the
bottom left during output. A separate file is cre‐
ated for each part during export, e.g. ‘a1A.tmp‘
etc. All files in this folder (folder name = style
name) must be placed into a zip file and then,
transferred.
Experienced users can adjust the Gerber export indi‐
vidually. This concerns the transfer of notation and
symbols amongst others. Further information can be
found in the appendix.

15.6 Special settings and errors during ex‐
port
Grade points
Grafis interprets each start and end point of a line as
a grade point. These points will appear correctly in
the target systems throughout the graded size range.
Therefore, it is important that the perimeter of the
Grafis pattern is separated at all significant corner
points and base points. Internal objects which con‐
tain corners or kinks should also be separated at
these points. The only exceptions are points with at‐
tached notches. All base points of notches are auto‐
matically translated into grade points so that their
position can be described accurately.
Perimeter
In addition to the separated points mentioned
above, the perimeter of the piece must be properly
closed. The export function tolerates gaps or over‐
laps of a max of 0.5mm. Therefore, it is recom‐
mended to close all corners properly with the cor‐
ners function before export. But the perimeter
should not be linked completely! More difficult to
find are areas with blunt overlaps. Such sources of
error should be avoided during pattern development
if possible. They are difficult to rectify using construc‐
tion methods at a later date. Especially in the graded
sizes, blunt overlaps can arise after link: single and
parallel or after transformation and parallel.

Curves
At Export pattern pieces Grafis automatically inserts
additional grade points onto the curves so that the
curve shapes in all sizes appear largely unchanged in
the other systems. It is not necessary to separate the
curve manually like in earlier Grafis versions.
Notches and drillholes
During export there is a differentiation between two
types of symbols, line symbols and point symbols.
Line symbols as for instance the notch are consid‐
ered in connection with the perimeter or with an‐
other base line. Point symbols, however, can be
placed in any position inside a pattern piece. The
drillhole is an example for a point symbol. Point sym‐
bols are divided into directional symbols (grain line,
centre back, arrows etc.) and non‐directional sym‐
bols (drillholes).
Of the different notch types the slit notch is most
suitable for export. It can be located accurately on
the perimeter as the base point is part of the notch
line. It can also be used as cutting line for separating
curves. When using point symbols it should be con‐
sidered that not all symbols are supported in the in‐
dividual data formats. For example, AAMA recog‐
nises only one drillhole.
Text
Free text is directly supported by ASTM format, only,
exceptionally also in the AAMA format. In general,
only the transfer of part name and style name can be
controlled. In addition, the size designation is usually
transferred. However, the size does not have to be
identical with the original Grafis size designation.
Grafis uses the Grafis style name and the part text to
determine these designations. Therefore, these des‐
ignations should have a connection to the designa‐
tion to be used later in the target system.
Possible sources for errors
For export of individual sizes there are no further
sources for errors other than the points mentioned
above.
For exporting graded nests the fact that most target
systems expect a clear succession of grade points
and notches within the perimeter is to be considered
in addition to the points mentioned above. It is not
acceptable for a notch to be placed exactly on a
grade point in one size and slightly off to the side of
the grade point in another size.
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Also, the succession of the points in the perimeter
must always be identical. A notch must not move
across a grade point throughout the size range! Such
errors are reported in Grafis during export (Error
404) and the process is aborted.
Another possible source for errors are points posi‐
tioned too closely. Gerber cutters often encounter
problems if notches are placed closer together than
the minimum distance allows. In other cases the im‐
port only succeeds if the base points of the perime‐
ter have a minimum distance. If the distance falls be‐
low the minimum required relevant messages will
appear during export. The limits should be tested be‐
fore going into production.

15.7 Import of grade rule patterns
All patterns prepared in one of the export formats
listed below can be imported into Grafis. They are
imported as grade rule patterns into Grafis. Working
with grade rule patterns forms the content of Chap‐
ter 16.
Overview of the import data formats:
Data formats with grading information
AAMA
DXF and RUL
or
DXF without RUL with all sizes in
the DXF file
ASTM
as AAMA
ExtendedPN
EPN
IBA/VET
IBA and VET
Grafis
001, 002, 003 etc.
Data formats without grading information
DXF
DXF without RUL
(AutoCAD‐
DXF)
HPGL
PLO, PLT, HGL and others
ISO
CUT, ISO and others
Data can be imported into Grafis Patternmaking and
into Grafis Marker making. As opposed to Grafis Pat‐
ternmaking, in Grafis Marker making the size range
cannot not be rebuilt. Only contours contained com‐
plete in the file are displayed in Grafis Marker mak‐
ing. Therefore, import from data formats with grad‐
ing information must always ensue into the Grafis
Patternmaking program first. Import into the Grafis
Marker making program can only serve as a control
measure. One exception is ‘DXF without RUL with all
sizes in the DXF file’.

Unfortunately, a completely automatic import is not
possible. The main reason is that the definition of the
AAMA format is not clear and is interpreted differ‐
ently by different CAD suppliers, see more detailed
explanation in section 15.2. In addition, in Grafis the
size range must be checked during import.
Step‐by‐step guide
 Create a new style as the size table is usually al‐
tered during import
 Pull‐down menu File → Import grade rule pattern
 Select file to be imported
 A size table appears in which you can assign the
sizes in the file with the usual standard sizes in
Grafis.
 During import of DXF files, a further dialogue ap‐
pears with the option to select AAMA‐DXF or Au‐
toCAD DXF as well as other options. If the file
comes from a clothing CAD system, select AAMA
DXF. Otherwise select AutoCAD DXF. For your
first import attempt leave the options in the dia‐
logue unchanged.
 Grade and check the imported patterns.
 If one of the following discrepancies occurs, re‐
peat import with changed options. Import again
into an empty style.
Possible discrepancies in the case of AAMA DXF:
 Curves are kinked, not smooth/ soft.
 The piece description in Grafis‐ Part organisa‐
tion is missing or too short.
 Import of an ASTM file has not worked.
 The perimeter seems to have been imported
twice. The lines of the contour are not visible.
 All notches point in the same direction, e.g. all
to the right or all upward.
 Patterns appear in the wrong scale.
Possible discrepancies in the case of AutoCAD
DXF:
 Not all parts are visible
 If error messages appear during import or noth‐
ing is imported, import with File → Import (re‐
duced). Import (reduced) does not transform the
data into a gradeable pattern but shows exactly
the content of the file.
Import of HPGL, ISO and DXF data without RUL en‐
sues always into the first size. The size table remains
unaltered.
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Check size range
To ensure that the imported pattern can be graded
in Grafis as a grade rule pattern, the sizes in the file
must be assigned to the Grafis standard sizes of a fig‐
ure type.
A dialogue according to Picture 15‐7 opens. A suita‐
ble base size must be entered into the first position
of the size table. Enter all other sizes in the desired
order. The section discarded import sizes contains
the sizes existent in the import file but not assigned
with a size. If you continue import with close, the dis‐
carded import sizes are not imported.
Individual sizes can also be entered into the size ta‐
ble. In this case, a correct reference size must be en‐
tered in the x reference column as the grade rules
are associated with these reference sizes. A shift of
the size run during import also is possible, see Pic‐
ture 15‐8.

Picture 15‐8

If the AAMA format button is greyed out, no data in
AAMA or ASTM format is present. In this case only
the AutoCAD DXF format option can be selected.
Simultaneous with the Grafis‐Import dialogue, the
Grafis DXF/AAMA/ASTM import information window
appears, containing information from the file.
If the data comes from a clothing CAD system, select
‘AAMA‐DXF’. Otherwise, select ‘AutoCAD‐ DXF’.
Before starting the import process, you can select
different options. For
a first import attempt,
leave the options un‐
changed as Grafis has
already preset them
based on information
from the file.
Measurement unit

In the AAMA/ASTM
format, normally only
metric or inch is per‐
mitted as measuring
units. Depending on
the CAD system, met‐
ric could be inter‐
preted in millimetres,
centimetres or me‐
Memory function for size allocation
tres. Therefore, the
Picture 15‐7 Measurement unit is
preset based on information in the file. The user can
The memory function for size allocation in Pic‐
alter these settings. Entry of a user‐defined unit in
ture 15‐7 is only visible if this option has been acti‐
millimetres is possible. For metres, the value 1000.
vated at the index card Options for experts in the
should be entered.
setup. Before quitting the size table with close you
Interpolate curve points [only AAMA/ASTM]
can enter a suitable name for this allocation, e.g.
‘women‘ or ‘men‘. You can then select one of the
Depending on the CAD system, sufficient or relatively
memorised allocations for your next import.
few curve points are delivered for a curve. Set this
option if the curves appear to have been imported
The Grafis Import dialogue
slightly kinked during the first import attempt. Addi‐
The Grafis‐ Import dialogue (Picture 15‐9) appears
tional curve points will be interpolated so that the
only for import of ASTM/AAMA/DXF files. It is re‐
curve appears softer/ smoother.
quired as data could be presented in AAMA or ASTM
or AutoCAD DXF format.

244
Chapter 15 Export/ Import and Pixel images
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Us Annotation as piece name [only
AAMA/ ASTM]
In the AAMA format, two text entries
are available: PIECENAME for the identi‐
fication of the piece and ANNOTATION
for a description. This switch determines
whether the text in PIECENAME or in
ANNOTATION is used for the part de‐
scription in part organisation. Normally,
this switch is not set. However, some
CAD systems assign PIECENAME with
very short and not very informative text.
In this case, it is advisable to activate the
switch.
Ignore Quality‐Layer [only ASTM]
Only ASTM files contain an additional
quality layer. This layer contains the con‐
tour with individual auxiliary points and
had been introduced as an aid for com‐
parison in the target systems. If a quality
layer is available, Grafis uses this more accurate data.
In case the import with ASTM does not work, activate
the option Ignore Quality Layer.
Ignore seam lines [only AAMA/ASTM]
Some CAD systems export the seam line as well as
the contour. If the seam allowance has been set to
0mm, the contour and the seam allowance are dou‐
bled up and leave each other invisible. In this case or
if too many auxiliary lines have been imported, acti‐
vate Ignore seam lines.
Notch angles relative [only AAMA/ ASTM]
Normally, the notch direction is calculated absolute
in relation to the co‐ordinate system. Some versions
of CAD systems interpret this setting as relative to
the base line of the notch. Therefore, the following
applies: If all notches point in the same direction at
the first import attempt, e.g. all to the right or all up‐
ward, activate Notch angles relative.
Automatic notch repetition
This option serves only as a display for treatment of
notches during import of AAMA /ASTM data from
Lectra. Here, it may be necessary to transfer the
notch position from the base size automatically to
the graded sizes. The pre‐selection of this switch en‐
sues via the GRAFIS.INI [INTERFACE]/IMPNONLEC‐
TRA.
Use ATTDEF [ASTM only]
The new data type ATTDEF is not fully implemented
in Grafis. If errors occur during reading of ASTM files
or if elements such as notches are missing, this op‐
tion can be selected.

Picture 15‐9

Ignore BLOCKS etc. [only AutoCAD DXF]
In DXF files, lines and points are combined to
BLOCKS. Furthermore, there is an ENTITIES area in
which the individual BLOCKS areas are activated and
other objects may be stored. Unlike in AAMA and
ASTM files where a part is always combined in a
BLOCKS area which is activated in the ENTITIES. This
organisation is not always clear in other DXF files.
Therefore, the following option for this import are
available:
 Ignore BLOCKS hides everything defined in
BLOCKS and shows only the objects from the
ENTITIES area.
 BLOCKS  pieces behaves like import of an
AAMA/ASTM file and imports each BLOCK into
a separate part. The ENTITIES area is also im‐
ported into a separate part.
 BLOCKS  sizes imports everything into one
part but stores the different BLOCK areas in dif‐
ferent sizes.
 All objects into one piece ignores the organisa‐
tion into BLOCKS or ENTITIES and saves all lines
and points in one part.
If you are unsure how the different BLOCKS are inter‐
preted, first select all objects into one piece. This
shows everything contained in the file. Then, test the
AutoCAD DXF import with all other options one after
the other and check with which option all infor‐
mation appears in the desired order.
All grade rules universally valid
If the perimeter or internal lines of the piece in an
import file are not continues lines, different grade
rules may be calculated at points of contact with the
perimeter during conversion to a grade rule pattern.
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During grading, gaps may therefore appear in the pe‐
rimeter. In this case, the option all grade rules uni‐
versally valid may assist. It ensures that one grade
rule only is permitted for each position. On the other
hand, new problems may occur if internal lines touch
the perimeter but are to be graded differently from
the perimeter.
Additional options
AAMA/ASTM]

in

the

Grafis.ini

[only

Experienced users can control the import via the fol‐
lowing switches in the Grafis.ini section [INTERFACE]:
MIN_SLITNOTCH and MIN_VNOTCH controls the
minimum length of notches.
IGN_GRADE_REF ignores grading reference line
IGN_PLAID_REF ignores repeat markings for check
material

IGN_STRIPE_REF ignores repeat markings for stripes
DUPL_PCE_MODE controls the treatment of double
piece names
AAMA_CHK_DOUBLE_RULES checks for double
grade rules on a point
AAMA_ACCEPT_FFPTS accepts free function points
Direct import of data
From version 11 onwards, importable files can be
opened with double‐click in Grafis. The file exten‐
sions, e.g. DXF for AAMA/ASTM/DXF files, are linked
with the Grafis.exe. Double‐clicking on a DXF file
starts Grafis, requests the desired measurement sys‐
tem and begins direct import of the file.

15.8 Load and manage Pixel images
Pixel images can be loaded into
a Grafis Patternmaking or into
a Grafis Marker making. When
saving the style file or the
marker file, the images are
saved with this file. Loading
and managing pixel images is
identical in both applications
and is explained in the follow‐
ing.

Manage pixel image menu
load image ▪ delete image ▪ +/‐ show image list

Image selected in the list of images...
vertical ▪ mirror horizontal ▪ nil
rotate +90° ▪ rotate ‐90° ▪ fine turning

Using pixel images in Grafis is
optional. It is enabled and set
up by the Grafis Team.

width/height of image in pixel

Load pixel images

target width/height in Grafis in mm

Pixel images in bmp, gif, jpg, tif
and png can be loaded in to
Grafis.

reference point (X/Y) in Grafis in mm

Step‐by‐step guide
 Open a style or marker file
 Extras or Marker informa‐
tion → Manage pixel
images
 Load image in the menu

reference point (X/Y) in image in pixel
solution in dpi

visibility ▪ greyscale ▪ invert image
gamma correction

Grafis‐Patternmaking
Grafis‐Marker making

select type of use

select symbol/logo ID
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 Select the pixel image file
 possibly, assign the image to a part
 select type of use for the pixel image
Select in Grafis Patternmaking:
 Background image
 Symbol/ Logo
Select in Grafis Marker making:
 Material background
 Transparent material background
 Fill/ brush
 Symbol/ Logo
 possibly, assign ID for symbol/ logo
 possibly, flip or rotate pixel image
 possibly, determine reference point in pixel im‐
age
 possibly, determine image size in Grafis
 possibly, determine reference point in Grafis
 possibly, adjust visibility, greyscale, transparency
or invert image
 End with

Offset point
Picture 15‐10

For size/ scale in Grafis, the dpi
value in the third row is critical. It determines the cal‐
culation from pixel to inches and thus, indirectly into
mm. If the dpi value of the pixel image is not known,
it can be established in its own dialogue via the but‐
ton
to the left of the dpi value, see Picture 15‐11.
In this dialogue, the start and end point of a line is
placed in the pixel image and the known target
length of this line is entered. You can select if the
scale is to be applied proportionally in x and y direc‐
tion or in one direction only. If
is active in the

 With the functions
pixel im‐
ages are loaded into the image list or removed
from this list and the list is opened and folded. All
further functions on the right of the menu relate
to the image selected in the image list.
Functions of the image list
Clicking on the last column in the image list opens a
context menu with further functions for the pixel im‐
age. The pixel image can be assigned to a part or
moved up/ down in the image list. With save image
file as… it is sorted from the style/ marker file and
saved outside of Grafis. The function duplicate im‐
age... is needed if the image in the current style/
marker is also required in other parts or as a dupli‐
cate with other settings.

Place line
Edit target length

Flip/ rotate image
With this block of functions, the
selected pixel image can be
flipped, rotated or returned to
its original state.
Image size and image position
With the following functions in the menu, the target
size in Grafis and the position of the image in Grafis
are determined. The value in the
first row shows the actual size of
the pixel image. For transfor‐
mation in Grafis, the offset point in the image can be
selected specifically with
in the second row (Pic‐
ture 15‐10).

Picture 15‐11

menu, the scaling is carried out proportionally.
accepts the scaling. The dpi value results from
these data.
The size of image in Grafis in mm,
shown in the fourth row, results
from the dpi value.
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The target position of the offset point can be deter‐
mined through value entry in the fifth row or through
clicking and constructing the target point in Grafis
(Picture 15‐12).

Picture 15‐13
Picture 15‐12

Visibility, colour values, greyscale, transparency, re‐
peat
Activating
determines that the pixel image is
visible in the style/ marker. The tick
only controls
visibility of the image and the corresponding part
during work in the Manage pixel image menu.

Background image for derivation of body measure‐
ments from photographed persons
The person in Picture 15‐14 has been photographed.
Here also, the lens distortion and perspective have

converts the image into greyscale. Clicking on
inverts the colour values of the image.
is
for gamma correction. Clicking again on the respec‐
tive icon reverses the correction. Further settings for
background images are available in Grafis Marker
making, which are explained in Section 15.10.

15.9 Pixel images in Grafis Patternmaking
Pixel images can be used in Grafis Patternmaking as
 background images or
 symbol/ logo.
Background image for digitizing and tracing
This option is required for tracing photographed or
scanned pattern templates. It is important that the
pixel image is free of distortion through optical lens
or perspective and that the image contains mark‐
ings/ lines from which the actual size in mm can be
determined.
The pattern pieces in Picture 15‐13 have been pho‐
tographed. Then, the lens distortion and the per‐
spective have been recalculated with the PFP Photo
add‐on. These processed photos can be loaded into
Grafis as pixel images. They are then used as tem‐
plates for digitizing of the background image or as
templates for tracing an interactive construction, see
Section 13.4.

Picture 15‐14

been recalculated with the PFP Photo add‐on. This
pixel image is now used as a template for the inter‐
active add‐on construction PFP Profile 10 for deter‐
mination of body measurements of specific individu‐
als from photos.
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Pixel image as symbol/ logo
With the symbol/ logo type, a pixel image is placed
onto a number of parts of a style in various positions.

The ID assigned to the text label symbol can be al‐
tered subsequently. Activate the expert switch ma‐
nipulate symbols in the Setup. Open the dialogue for
editing non‐interactive symbols via Extras → Change
Symbols. Select the required symbol from the list,
enter the new ID and/or the new offset point. Accept
the changes for the selected symbol with

.

With
the changes are applied to all affected
symbols in the style.

15.10 Pixel images in Grafis Marker ma‐
king
Pixel images can be used in Grafis Marker making as

Picture 15‐15

First, load a logo similar to Picture 15‐15, in the Man‐
age pixel image menu, set the type symbol/ logo and
assign ID 200. Set the width of the logo to 80mm. For
the sleeve in Picture 15‐15, the logo is required to be
a little smaller. Duplicate the logo with
and du‐
plicate image, assign ID 201 to the duplicate and set
the width to 40mm; treat the logo for the collar in
the same with ID 202 and a width of 10 mm.
Then, the symbol text label must be set in the differ‐
ent parts with
the
symbol
menu. The posi‐
tion of the text
label is con‐
structed
with
the point con‐
struction sub‐
menu and the
direction is con‐
Picture 15‐16
structed
with
the direction construction sub‐menu. When setting
the symbol, the dialogue according to Picture 15‐16
opens. Select the ID of the loaded logo, the offset po‐
sition bottom/ left or centred and confirm the set‐
tings. For the back and the sleeve in Picture 15‐15,
select ID 200 and for the collar select ID 202. The
logos now appear in the construction (Picture 15‐15).
A pixel image is to be loaded once only in the Man‐
age pixel image menu if it is to be placed in various
parts in the same size. The pixel image must be
loaded a number of times or duplicated, if it is to be
used in different sizes. A symbol/ logo is not assigned
to a part. A logo is assigned exclusively via the logo
ID.

 Material background without transparency
 Material background with transparency
 Fill/ Brush
 Symbol/ Logo
In Grafis Marker making, pixel images have many ap‐
plications. Images of patterned fabrics can be posi‐
tioned in the background of the material to enable
material matching of pattern pieces. Outline images
of leather skins (Picture 15‐17) or particularly shaped
material as material background facilitate the appro‐

Picture 15‐17

priate positioning of pattern pieces. Digital print
adapted to pattern pieces can be prepared and cor‐
rect positioning of logos is easily implemented.
Material background without transparency is useful
for matching patterned fabric with the marker and
for positioning pattern pieces on particular cutting
material. Material background with transparency is
equally used for matching patterned fabric with the
marker. Fill/ brush is especially suitable for digital
print as a pixel image is directly assigned to a pattern
pieces and the fill can be moved within the pattern
piece. With symbol/ logo pixel logos are output at
various positions previously prepared in Grafis Pat‐
ternmaking.
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Material background without transparency

Material background with transparency

One or more images can be loaded into a marker as
background without transparency. They appear on
the material in the position assigned as offset point
in the Manage pixel image menu. These can be
marker templates or images of cutting material such
as truck tarpaulin or leather skins.

The pixel image type
Material background
with transparency
offers an additional
switch on the back‐
ground and a slider for the gamma value. The switch
on the background determines whether the pixel im‐
age appears on the pattern pieces or only on the

Picture 15‐20
Picture 15‐18

During output of the marker, the switch Material
background determines whether the background is
printed or not, see Picture 15‐18.
Material background without transparency with re‐
peat
The pixel image type
Material
back‐
ground
without
transparency offers
the
additional
switch repeat x and
repeat y. This switch activates the repeat of the im‐
age at the repeat lines of the marker. NB: the image
is not repeated on the basis of its own size but at the
repeat lines of the marker. Prerequisite is a set re‐
peat in the marker and the option repeat x and/ or

background, see Picture 15‐20. The gamma value
determines the transparency in the area of the pat‐
tern pieces.
Fill/ brush
For the pixel image
type fill/ brush (Pic‐
ture 15‐21) an addi‐
tional function is
available in the list of
images
for display im‐
ages in piece. With this func‐
tion, one or more pattern
pieces can be selected to be
filled with this fill/ brush in
the marker.
A further button in the menu
sets whether the fill is to be
mirrored in mirrored pattern
pieces.
The offset for the fill is set to
the bottom left corner of the
pattern pieces as standard.

Picture 15‐19

repeat y is activated for the background material
(Picture 15‐19).

Picture 15‐21
In the
Marker making mode, the off‐
set for the fill can be moved in‐
teractively or via value entry for
each pattern piece separately.
Switch to Marker making mode
and open Marker information
Picture 15‐22 → Move fill. The Offset value di‐
alogue opens, see Picture 15‐22. Now click on the fill.
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The offset values can be altered by dragging the fill
with the mouse or by entering new offset values.
With
and
the offset values can be trans‐
ferred from one fill to another fill. Click the source fill
and then on the button
in the dialogue. Then,

During output of the marker, the switch logos deter‐
mines whether the logos are printed or not, see Pic‐
ture 15‐23.

click on the target fill and on
in the dialogue.
During output of the marker, the switch fill /brush
determines whether the fill is printed or not, see Pic‐
ture 15‐21.
Symbol/ logo
The logo position and their direction and logo IDs
must already be constructed or assigned with the
text label in Grafis Patternmaking. In Grafis Marker
making, pattern pieces cannot be assigned new logo
positions or new logo IDs. During transfer of data
from Grafis Patternmaking to Grafis Marker making,
pixel images are not transferred. The pixel images for
logos must be loaded in Grafis Marker making in the
Manage pixel images menu and assigned an ID.

Picture 15‐23
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Construction patterns as well as grade rule patterns
(Rule Patterns) can be used for pattern develop‐
ment.
Construction patterns are generated on the basis of
body measurements. Grade rules are not required
for grading, see Chapter 12.
A grade rule pattern consists of a pattern perimeter
with grade points. Each grade point is linked to a

grade rule table with size‐related point movement in
x and y direction.
Grade rule patterns can be accepted into the record
to form the basis of style development just like con‐
struction patterns. As opposed to construction pat‐
terns, grade rule patterns cannot be graded made‐
to‐measure.
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16.1 Digitizing the pattern perimeter
For many years, paper patterns could only be digit‐
ized with the help of a digitizer tablet. A digitizer tab‐
let with a 16‐button digitizer mouse and a WinTab
driver matching the operating system were required.
The new, alternative method is digitizing of photo‐
graphed pattern pieces within Grafis without a digi‐
tizer tablet. Pattern pieces are photographed with a
standard digital camera, processed with an add‐on
software and then loaded into Grafis as a back‐
ground image and digitized or traced.
Digitizing with a digitizer tablet has a theoretical ac‐
curacy of 1 mm and is only dependent on the wavi‐
ness of the template. However, a digitzer requires a
lot of space, has high investment cost and is heavy
and bulky. Big problems occur when switching to a
new operating system, as normally a new driver for
the digitizer tablet is required from the manufac‐
turer.
When digitizing photographed pattern pieces the
accuracy depends on how the photo was taken and
how well it was reworked. First, the pattern pieces
are placed on a rectangle of known measurements
(Picture 16‐1). The pattern pieces are photographed
with a digital camera with a good lens. Reworking the

Prerequisites for digitizing with a digitizer tablet
Prerequisite for digitizing is a digitizer with a 16‐but‐
ton mouse, connected and switched on. The respec‐
tive Windows driver must be installed. If these con‐
ditions are fulfilled, the test programme
\Grafis\Hilfen\Tabtest.exe displays the current pixel
position of the digitizer cursor in x and y direction
when moving the digitizer mouse across the active
area.
Have the overview of the digitizer key assignment
and the menu template for the digitizer ready. Both
can be found in the <F1> help.
Position the menu template at any position within
the active area of the digitizer tablet. The position
must be determined only at the beginning or after
each change of position as follows: start the set up in
the digitizing menu with the <TAB> key. Then, points
P1 and P2 must be digitized.
Prerequisites for digitizing photographed pattern
pieces
Prerequisites for digitizing photographed pattern
pieces, ‘with mouse’ in the following, is a standard
digital camera with minimum 7 mega pixels, a rec‐
tangular underlay of known measurements and an
add‐on software for image processing, e.g. PFP
Photo. The rectangular underlay is fixed, one or more
pattern pieces are placed on top; a photo is taken of
the pattern pieces with the underlay (Picture 16‐1).
This photo is reworked with the add‐on programme
and then loaded into Grafis as a background image,
see also Section 15.9.
Preparation

Picture 16‐1

photo with the add‐on programme is necessary to
subtract out the lens distortion through the camera
lens and the perspective and to enter the correct dpi
value for the pixel image. This process is not one hun‐
dred percent exact. The higher the lens distortion,
the higher the risk of discrepancy. Lines on a pixel im‐
age no longer have the accuracy of a pencil stroke.
Therefore, digitizing on‐screen is slightly less accu‐
rate than digitizing with a digitizer tablet. As a rule,
the accuracy is sufficient and the advantages out‐
weigh the disadvantages, in particular the location‐
independence when photographing the pattern
pieces, the low investment and space requirement.
The add‐on programmes PFP Photo and digitizing
background images are optional and are enabled
and set up by the Grafis Team.

Digitizing is easier if the required grade points are
marked on the pattern. This could be done by hand,
also.
With Rule Pattern → Digi ze Grade Rule Pa ern dig‐
itizing ensues into an empty part. Therefore, activate
a part with ‘0’ record steps. The digitized pattern can
be inserted into the record or the call list or can be
saved as a template, later.
With Rule Pattern → Edit Grade Rule Pa ern subse‐
quent digitizing of points, lines or grade rules into
non‐edited or edited grade rule patterns or even into
constructed patterns is possible. This option is not
explained in detail.
Before digitizing, Grafis is to be told the size of the
pattern to be digitized. The base size is to be entered
into the first position of the size table. In the example
blazer side panel (Picture 16‐7) this is size 38.
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The control ensues exclusively via the menu tem‐
plate on the digitizer tablet. In the digitizing menu,
the current state is displayed. The top four rows from
Picture 16‐2 are situated on the 16‐key digitizer
mouse. All other functions can be found on the digi‐
tizer template to be positioned in a corner of the ac‐
tive area of the digitizer tablet. The digitizer mouse
key configuration and the digitizer template can be
found in the appendix to the Grafis Help.

After these preparations,
continue with Rule Pattern →
Digitize Grade Rule Pattern.
The menu for editing grade
rule patterns is opened. First,
open the digitize menu
shown via the digitize func‐
tion in the menu.
To digitize photographed
pattern pieces click on the
menu item digitizing back‐
ground image
. The dis‐
played digitizing menu opens
with all necessary functions.
The often used functions of
the first two rows are availa‐
ble as shortcuts on the key‐
board key <1> to <8>.

Prepare digitizer

Picture 16‐2

To digitize with digitizer tablet click on the menu
item digitize with digitizer
. The displayed digit‐
izing menu opens. You cannot click inside this menu.
Digitize menu
[with tablet]
adjust pad
entry transformation:
P+Px => (0,0) ▪ P+Py => (0,0)
P+Px => P ▪ P+Py => P ▪
P+P => P+P
scale factor

points ▪ lines/curves

increments

 Prepare the pattern to be digitized, mark missing
notches etc., decide whether to digitize with or
without seam allowance
 [with tablet] prepare the digitizer and place the
pattern pieces onto the digitizer
 [with mouse] place the pattern pieces inside the
reference rectangle and photograph
 [with mouse] process the photos
 [with mouse] load the processed photos into
GRAFIS as a background image., see section
15.10, align the image and check or adjust the im‐
age size.
 Activate and annotate an empty part in the part
list (possibly prepare the part list with annota‐
tions for all parts to be digitized)
 Enter the base size of the pattern to be digitized
into the first position in the size table
 rule pattern→ digitize grade rule pattern
 click rule pattern: digitize

[with tablet] or

[with mouse].
 [with tablet and at the beginning only] Set up
menu pad
 [with tablet] Determine entry transformation
and define scale Fa=... (e.g. 2 for patterns in half
scale)
 Digitize lines and points
 possibly: Save digitized patterns and digitize an‐
other pattern
 Terminate with [Quit Digitizing]
 Edit (subsequent digitize / replace) and save the
grade rule pattern (see sections 16.4 and 16.5)
 Quit with
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Transformation P+P => P+P

Entry transformation [only: with tablet]
For digitizing with digitizer tablet five input trans‐
formations are available for the data transfer digi‐
tizer tablet → Grafis.
p+px
=>0,0
p+py
=>0,0
p+px
=>p
p+py
=>p
p+p
=>p+p
The entry transformation determines the data trans‐
fer digitizer → Grafis. It is to be updated a er repo‐
sitioning the pattern on the digitizer. The entry trans‐
formations are called via the menu template. They
have the following significance.

digitizer
Y
Pa

X

Pa

GRAFIS
Pc

Pb

Pd
Picture 16‐5

The first digitizer point Pa is set on position Pc in
Grafis. The second point Pb is set on Pd in Grafis. The
scale and co‐ordinate rotation is calculated accord‐
ing to these settings (Picture 16‐5). Use this transfor‐
mation for inserting/replacing curves for example.

Transformations p+px => 0,0 and p+px =>p

Pb

digitizer

GRAFIS
Y

Scale factor
X

0,0 or Pc

Picture 16‐3

These transformations align the pattern horizontally.
With p+px => 0,0 the first digitizer point Pa is set onto
the zero point in Grafis. The second digitizer point Pb
defines the x axis of the digitizer template (Pic‐
ture 16‐3).
As opposed to p+px => 0,0 the first digitizer point Pa
is positioned on a point to be constructed in Grafis
with p+px =>p.

For all transformations other than p+p=> p+p the
scale factor is to be set. The digitized point co‐ordi‐
nates are multiplied with this factor. A pattern with
scale 1:2, digitized with scale factor 2.00 appears full
size in Grafis.
The digitizer mouse key functions [with tablet]
For digitizing, a 16‐button mouse is required. The
keys are assigned the following functions (Pic‐
ture 16‐6). All other functions can be found on the

Transformations p+py => 0,0 and p+py =>p
digitizer
Y
Pb
GRAFIS
X
Y
Pa
X
0,0 or Pc

Picture 16‐4

These transformations align the pattern vertically.
They differ from p+px => 0,0 and p+px =>p only in the
second digitizer point Pb defining the y axis of the
digitizer template (Picture 16‐4).

Picture 16‐6

digitizing template, which is found in the appendix of
Grafis Help.
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Overview of digitizer functions
Digitizer mouse functions
1: <digitize>
Set digi point.
2: <deposit+continue> The active line/curve (red) or active points (black, round)
are deposited. The next line/curve is linked, directly.
Starting point of the next line/curve is identical to the fi‐
nal point of the last line/curve. It is not digitized again.
The active line/curve or active points are deposited. A
3: <deposit+start>
new object with a new starting point is digitized.
4: <delete nearest
digi point>
The point closest to the cursor and active (digi point or
grade point) is deleted.
5:<digitize with grade point>
A digi point is digitized as a grade point.
6: <click p>
Set digi point onto a point.
Set digi point onto a line/curve.
7: <click l>
Set digi point onto the fulcrum of a line/curve.
8: <click pl>
<zoom digi area>
<zoom all>

The screen display is zoomed so that it contains all ac‐
tive digi objects not yet deposited.
The screen display is zoomed so that it contains all
screen objects; as the function ‘centre picture’ with
<F6>.

<move points>
Move grade points.
<re‐digitize lines/curves> Replace lines/curves. The starting and final point of the
line/curve cannot be changed.
Menu pad functions
<points>
<line/curve>

Digitize single points (applies to all active digi points).
Digitize line/curve (applies to all active digi points). For
a line select <line/curve>, digitize the starting and final
point and deposit the object.
<grade rules ON/OFF> Start/end digitizing grade rules from a graded nest, see
section 16.6.
<set attributes>
Set attributes for the active type of object <points> or
<line/curve> Click the required attribute number 1, 2 or
3.
<delete objects>

Delete points with <delete points> or lines with <delete
lines>. Quit deleting with <delete objects OFF>.

<save to part>

Save the digitized patterns to an empty part to be se‐
lected from the part list.

<part up↑> <part down↓>

Scroll in the list of parts

<save> or <abort>

Confirm selection in the part list or abort saving.

<quit digitizing>

Quit digitize mode.
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Picture 16‐7
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1: <digitize>
Set digi point.
2: <deposit+continue>
The active line/curve (red) or active points (black,
round) are deposited. The next line/curve is
linked, directly. Starting point of the next
line/curve is identical to the final point of the last
line/curve. It is not digitized again.
3: <deposit+start>
The active line/curve or active points are depos‐
ited. A new object with a new starting point is dig‐
itized.
4: <delete nearest digi point>
The point closest to the cursor and active (digi
point or grade point) is deleted.
5: <digitize with grade point>
A digi point is digitized as a grade point.
6: <click p>
Set digi point onto a point.
7: <click l>
Set digi point onto a line/curve.
8: <click pl>
Set digi point onto the fulcrum of a line/curve.
9: <zoom digi area>
The screen display is zoomed so that it contains
all active digi objects not yet deposited.
10: <zoom all>
The screen display is zoomed so that it contains
all screen objects; as the function ‘centre picture’
with <F6>.
11: <zoom +>
Increase screen display.
12: <zoom ‐>
Reduce screen display.
15: <move points>
Move grade points.
16: <re‐digitize lines/curves>
Replace lines/curves. The starting and final point
of the line/curve cannot be changed.
The functions <move points> and <re‐digitize
lines/curves> are particularly useful for editing grade
rule patterns which are already incorporated in style
developments.
The functions of the menu template will be ex‐
plained after the exercises.

Digitizing points and lines/curves
In the digitizing mode all deposited lines appear in
blue and all active lines in red. Active points are
round and red filled. Deposited points are black
crosses. Switching between [points] and [line/curve]
(on the menu template) effects all active objects.
Each digitized line or point sequence must be depos‐
ited with <deposit+continue> or <deposit+start>.
Starting and final point of a line/curve are automati‐
cally converted into grade points. It is resumed with
a new object.
Check before each deposit that the digitized contour
equals the template with <zoom digi area>.
Step‐by‐step guide
 Select object type [points] or [line/curve]
 if [line/curve]; at the beginning and after <de‐
posit+start>:
 digitize starting point of the line,
Option 1 ‘form with intermediate points’:
 digitize final point of the line,
 <zoom digi area>,
 digitize intermediate points
Option 2 ‘digitize in sequence’:
 digitize line in sequence,
 <zoom digi area>,
 if <points>:
 digitize all points
 Correction with <delete nearest digi point>
 Deposit the digitized line or points with
 <deposit+continue>, if the final point of the
digitized object is to be the starting point of
the next object or
 <deposit+start>, if the next object starts at
a new position.
 Correction with <move points> and <re‐digitize
line/curve>
Digitize the objects of the template. The perimeter
should have no gaps. It can be closed by binding the
final point of the last line onto the existing objects
with <click p>, <click l> or <click pl>.
Points on lines (e.g. notch positions) should be
bound onto previously digitized lines with <click l>.
Exercise
Digitizing is explained using the blazer side panel de‐
picted in scale 1:2 as an example (Picture 16‐7). Note
that the smaller the scale of the template, the less
accurate the digitized pattern.
Fix a copy of the blazer side panel to the digitizer. Ac‐
tivate an empty part in the part list, annotate the
part and set the base size (here: ____38_0) onto po‐
sition 01 in the size table. The following steps relate
to Picture 16‐8.
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4

Should P14 not be at the required position delete
P14 with <delete nearest digi point>
P14 with <digitize>
P15 with <digitize>
P16 with <digitize>
<deposit +continue>

5

6

P5 with <digitize>
<zoom all>
<deposit +continue>

10

16

17

3

7

15
14

P7 with <digitize>
<zoom digi area>
P6 with <digitize with grade point>
P17 with <digitize>
possibly additional intermediate points
<deposit +continue>

13

11
12

18
8
2

1

Now, the second option follows. First, the final point
is digitized and then, the intermediate points. We
recommend this option as the rule ‘the less points
the smoother the curve’ applies to digitizing, also.

19

9
Picture 16‐8

Rule Pattern → Digitize Grade Rule Pattern
digitize
<TAB>
digitize points P1 and P2 of the
menu template
p+py=>0,0 click point 11 and then point 10
Fa=2
for templates in scale 1:2
[line/curve]
P1 with <digitize>
P2 with <digitize with grade point>
P3 with <digitize with grade point>
P4 with <digitize>
<zoom digi area>
This curve was digitized ‘in sequence’. The other op‐
tion follows when digitizing the armhole curve.
Before deposit, shape the curve with points P14,
P15, P16.
P14 with <digitize>

P9 with <digitize>
<zoom digi area>
P8 with <digitize>
The function <digitize with grade point> is not used,
here as digitizing points is to be covered.
P18 with <digitize>
P19 with <digitize>
possibly additional intermediate points
<deposit +continue>
Digitize the notch P8 as a grade point.
[points]
click P8 with <click l>
<deposit + start>
[line/curve]
<zoom all>
click P9 with <click pl>
click P1 with <click pl>
<deposit + start>
The contour is closed. All notch positions are marked
with grade points. Digitize the grain line, also.
P10 with <digitize>
<deposit+continue>
P11 with <digitize>
<deposit+continue>
P12 with <digitize>
<deposit+continue>
P13 with <digitize>
<deposit+start>
The pattern is digitized in base size 38. Carry out a
final check. The function keys <F2> (zoom with digi‐
tizer mouse) and <F6> works in digitizer mode, also.
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Deleting objects is possible in the Rule Pattern →
Digitize Grade Rule Pattern mode, only, not in the
Rule Pattern → Edit Grade Rule Pattern mode. To de‐
lete points select [delete objects p] from the menu
template. To delete lines/curves select [delete ob‐
jects l] (echo  right menu strip). Delete all respec‐
tive objects with the digitizer mouse. Deleting is ter‐
minated with [delete objects OFF].
Replacing objects is possible in the Rule Pattern →
Edit Grade Rule Pattern mode, also. Thus, grade rule
patterns which are the basis for style developments
can be altered, subsequently. To move a point click
on it with the digitizer mouse key <move points> and
digitize it again. With <re‐digitize line/curve> you can
replace a line/curve. Starting and final point of the
line/curve remain unchanged. <deposit+start> de‐
posits the new line/curve.
Should grade rules be digitized from a graded nest
continue according to section 16.6. Otherwise, you
can choose between
 digitizing all patterns and apply grade rules,
later or
 entering the grade rules for the pattern, di‐
rectly and then, digitizing the pattern.
The function [save to part] of the menu pad allows
for saving the digitized pattern in the record. Grafis
opens a window for display of part numbers and
names. Select an empty part with the template func‐
tions [] and [] and save with [YES]. This saving
from the digitizing mode allows for digitizing of a
number of patterns without having to change be‐
tween digitizer mouse and keyboard. The names for
the parts to be digitized can be entered into the part
list prior to digitizing.
Terminate digitizing with [quit digitizing] from the
menu template. If you do not wish to continue to
proceed with the next section of this chapter, imme‐
diately deposit the digitized pattern into the active
part with save → in record. It can be processed fur‐
ther via Rule Pattern → Edit Grade Rule Pattern.
The functions of the menu pad
When digitizing with digitizing tablet the menu pad
is to be positioned on the active area of the digitizer.
The position of the menu pad is defined with <Tab>
and digitizing points P1 and P2. The fields of the
menu pad can, then, be activated by clicking. They
have the following significance:
[ P+Px => 0,0 ] only with tablet
[ P+Px => P ]
only with tablet
[ P+Py => 0,0 ] only with tablet

[ P+Py => P ]
only with tablet
[ P+P => P+P ] only with tablet
Activate one of the five described entry transfor‐
mations.
[ Fa= ... ]
only with tablet
Enter the scale factor (except for ‘p+p => p+p’).
[ points ]
Digitize single points (applies to all active digi
points).
[ line/curve ]
Digitize line/curve (applies to all active digi
points). For a line select [line/curve], digitize the
starting and final point and deposit the object.
[ grade rules ON/OFF]
Start/end digitizing grade rules from a graded
nest, see section 16.6.
[ set attributes ]
Set attributes for the active type of object
[points] or [line/curve]. Click the required attrib‐
ute number 1, 2 or 3. As an echo, the new attrib‐
ute number appears in brackets in the menu strip
on the right behind the object type, e.g.
lin/cur (3) means the digitized line/curve is
given line attribute no. 3.
[ delete objects ]
Delete points with [delete objects p] or lines with
[delete objects l]. Quit deleting with [delete ob‐
jects OFF].
[ save to part ]
Save the digitized patterns to an empty part to be
selected from the part list. With [  ] or [  ] you
can scroll in the part list. The selection is to be
confirmed with [ YES ].
[  ] or. [  ]
Scroll in the part list.
[ save ] or [ abort ]
Confirm selection in the part list or abort saving.
[ quit digitizing ]
Quit digitize mode. The dialogue resumes at the
computer.
The following functions were not used in the Exer‐
cise:
 delete objects
 set attributes and
 saving from the digitizing mode.
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16.2 Overview of assigning grade rules
Grade rules should be assigned to break sizes, only.
All other sizes are calculated by Grafis by interpola‐
tion or extrapolation analogous to calculation of x
values.
Overview of options for grade rule assignment
 The option enter absolute grade rules (sec‐
tion 16.3) is the most common way of assign‐
ment. Grade rules can be entered in mm or
1/10mm.
 The option enter grade rule differences (sec‐
tion 16.3) is also used.
 The option digitize grade rules (section 16.6) is
required if grade rules are not available as nu‐
meric values but indirect as graded nest or sets
of sizes.
 The option transfer grade rules with copy or
proportional (section 16. 5) is use for additional
grade points for example.
 With the option drag grade rules (section 16.5)
grade rules can be altered ‘by eye’ or with ras‐
ter values.
 The option apply grade rule library (section
16.9) is interesting for companies who have
many years of experience of grading and work
with their own libraries.
 For the option transfer grade rules from a tem‐
plate pattern (section 16.7) proven gradeable
templates have to be saved for the respective
style types. Digitized first patterns without
grading information can transfer grade rules
from these templates.
 The import of grade rule patterns from other
CAD systems has already been explored in
Chapter 15.

In Grafis, grade rules are saved in grade rule tables.
The window for editing grade rule tables (Pic‐
ture 16‐9) opens after having clicked on a grade
point. A red arrow indicates the grade point for
which the grade rule table is displayed. The most im‐
portant elements of this window are explained in Pic‐
ture 16‐9.
View
Display the grade rules in millimetres or 1/10 mil‐
limetre. The active option is indicated with a tick.
In the industry, the display option 1/10 mm is
common.
Enter values in the line highlighted with a bar.
The interpretation of the values in x and y direc‐
tion depends on the display option selected un‐
der View. The values are accepted with
or
<ENTER>.
accepts values in fields ‘X’ and ‘Y’. The marked
size becomes break sizes.
deletes marked size as break size. The values for
this size are interpolated.
Selection of a different figure type
Display of the current rotation angle for grade
rules. Rotation of grade rules is activated via
Edit → Rotate/ mirror grade rules permitted
Further explanation follows in the text.
Entry of own number for grade rule (0 to 999),
see also section 16.9.

16.3 Edit grade rules
Grade points are marked with a red or green circle.
A red circle indicates that the grade point has not
been assigned a grade rule.
The different options for assigning grade rules were
mentioned briefly in section 16.2. Topic of this sec‐
tion is editing grade rules in the options normal and
difference display.

The cards norm and diff contain different view
options fort he current grade rule table (Pictures
16‐9 and 16.10). Changes to the view alter the
contents of the other displays, also.
grey edit window at the lower window edge
In this edit field you can enter your own com‐
ments on the grade rule. It is opened with a dou‐
ble‐click, clicking another function closes the
field. Grafis automatically enters information on
source of the rule and dragging the grade point
into this field.
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Grade rules for grade point

Toggle between display
in mm and 1/10 mm

Base size

Delete grade rule
as break size
Accept grade rule
as break siz

Enter grade rule
for x or y

Display options

Label for
break size

Label for
base size

Dialogue field for com‐
ments; Open with dou‐
ble‐click.

Size column

Difference to base size in y direction
Difference to base size in x direction
in mm or 1/10 mm
Picture 16‐9

Topic of the following exercise is entry of grade
rules in the normal view. Then, explanations on the
display option ‘diff’ follow.
Exercise: Enter grade rules for blazer side panel
For the blazer side panel digitized in section 16.1
grade rules are to be entered for grading in a size
range from 34 to 46. The following grade rules be‐
long to the grade points numbered according to Pic‐
ture 16‐8 (values in mm). They may not correspond
with common grade rules. Practise entry of grade
rules. Later, you can determine your own values:
Point 01:
____34_0
36.2
5.6
*____38_0
.0
.0
____46_0 -72.4 -11.2

Point 02:
____34_0
*____38_0
____46_0
Point 03:
____34_0
*____38_0
____46_0
Point 04:
____34_0
*____38_0
____46_0
Point 05:
____34_0
*____38_0
____46_0

36.1
.0
-72.1

5.6
.0
-11.1

35.9
.0
-71.9

5.3
.0
-11.2

24.1
.0
-41.3

-5.1
.0
5.0

25.7
.0
-43.9

-4.7
.0
5.5
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Point 06:
____34_0
28.1
1.8
*____38_0
.0
.0
____46_0 -47.8
-7.0
Point 07:
____34_0
22.1
7.7
*____38_0
.0
.0
____46_0 -40.1 -15.2
Point 08:
____34_0
22.2
4.7
*____38_0
.0
.0
____46_0 -40.4
-9.7
Point 09:
____34_0
23.1
4.5
*____38_0
.0
.0
____46_0 -42.4
-8.6
Points 10 to 13:
____34_0
33.7
2.1
*____38_0
.0
.0
____46_0 -62.4
-6.9
If you have quit the Grade Rule Pattern menu in the
exercise in section 16.1 and deposited the contour
with save => in record you have to activate the re‐
spective part, first and, then, re‐open the menu via
Rule Pattern → Edit Grade Rule Pattern.

Move between the two fields with the <Tab> key.
or <ENTER>.
Accept the values with
Continue with the values for size ___46_0 by mark‐
ing this size and entering ‐72.4 into the ‘x’ edit field
and ‐11.2 into the ‘y’ field and accept. The grade rule
table is assigned in the normal view according Pic‐
ture 16‐11.
Open the grade rule table for grade point 02 by click‐
ing this point. Enter the grade rules and continue
with the other grade points. Test the grading directly
from the Grade Rule Pattern menu with grading with
the result shown in Picture 16‐10.
Normal view ‘norm’
The normal view of grade point 01 from Picture 16‐8
is shown in Picture 16‐11.

Click on Point 01. The grade rule table analogous to
Picture 16‐9 opens. The grade rules are assigned
with ‘0’ originally. Set the display to mm by selecting
Display | mm. Mark size ____34_0 and enter the val‐
ues 36.2 into the edit field
value 5.6 into the ‘y’ edit field.

and the

Picture 16‐11

The columns of this view contain:
1: indication of base and break sizes. The sign >>
indicates the base size to which the grade rules
relate. > indicates the break sizes.
2: the size name,
3: the grade rule of the size in x direction, as differ‐
ence to the base size. Display is in mm or 1/10
mm depending on the setting in View.
4: the grade rule of the size in y direction.
For all non‐break sizes the grade rules are interpo‐
lated or extrapolated from adjacent break sizes.
A size becomes a break size by marking the size, ed‐
iting the setting if required and accepting with
Difference view ‘diff’
Regard the grade rule for point 01 in the difference
view (Picture 16‐12).

Picture 16‐10
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In this view, in addition to the values of the break
sizes, the difference per size is displayed and can be
edited. In Picture 16‐12 these are sizes 34, 38 and 46.

A grade rule for a slit notch must be a global grade
rule as the notch is otherwise detached from the
base line, see Picture 16‐13.

Picture 16‐13

Picture 16‐12

The base size 38 is marked with >>. The line with the
size name in the second column contains the grade
rule for this size as difference to the base size. The
respectively following line with a value in the ddx or
ddy column indicates the difference value per size.
Difference values should be edited in the difference
view diff.
If you have the difference values per size proceed as
follows with entry of grade rules:
 Mark all break sizes in the normal view by mark‐
ing the respective size and accepting the value
with
.
 View | Show break sizes only
 Then, change to difference view diff and enter

the grade rule differences in x and y.
Note: If the increments are identical for all sizes ac‐
cept one size larger than the base size as a break size.
If 38 is the base size accept size 40 with
and en‐
ter the grade rule for size 40 in the difference or nor‐
mal view.
Global grade rule
If the switch Global grade rule is set, this grade rule
applies to all lines within the search environment. If
two lines meet in a corner, this switch must be set
The switch must not be set if a grade rule is to apply
to one line/ one point only. If for example the grain
line touches the contour by accident in the base size,
the grade rule at the grain line must not be a general
grade rule. Otherwise, the contour ‘hangs on’ the
grain lines for grading.

If the switch ‘global grade rule’ is removed, Grafis
expects the user to click the base line for the grade
rule.
Additional Functions
The functions in the grade rule window in Pic‐
ture 16‐9 have the following significance:
File → Save in Library...
saves the grade rule table in a library, provided a
library is available (section 16.9).
File → Delete from Library...
deletes the grade rule table from the library (sec‐
tion 16.9).
File → Print
prints the single grade rule table in the active dis‐
play option. An overview of all grade rule tables
can be output via the print menu function.
File → Close or
closes the window.
Edit → Grade point becomes new stack point
changes the marked grade point into the new
stack point of the grade rule pattern.
Edit → Reduce break sizes (all grade points)
automatically removes the mark for break sizes
from all sizes which can be calculated by interpo‐
lation from adjacent sizes without alteration. In
an interim step, the user can mark the preferred
break sizes, see Picture 16‐14.
The selected sizes remain break sizes if the
grades are constant. Only break sizes actually not
required for grading are deleted. Grading re‐
mains unchanged after calling this function.
Edit → Reduce break sizes (this grade point)
as before but for the marked grade point, only.
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Edit →Set x and y to 0 (this grade point)
deletes all grade rule settings. After calling this
function the grade point is not graded, it remains
unchanged during grading.

Grade rule pattern menu
digitize ▪ digitize background
image ▪ extract
grade points…
set ▪ drag ▪ group
+/‐display number
grade rule…
edit ▪ transfer ▪ drag
+/‐measurement ▪ set
measurement

delet ▪ print
Picture 16‐14

Edit → Set x to 0 (this grade point)
Edit → Set y to 0 (this grade point)
deletes the x or y component of the grade rule.
After calling this function the grade point is
graded with one component, only.
Edit → Rotate/mirror grade rules permi ed
If this option is ticked grade rules of the marked
point can be mirrored and rotated. A crosshair
appears with the functions analogous <F3>. Ro‐
tate and mirror grade rules should be used by ex‐
perienced users, only. The rotation angle and
mirror are indicated in the grade rule table. The
grade of the pattern is changed.
Edit → Rotate/mirror complete grade rule pattern
permitted
If this option is checked, the pattern can be ro‐
tated. The grade rule tables are updated, so that
the grade of the pattern remains unchanged.
Edit → Move grade one size up
The base size and the grades move one size up.
The contour of the larger size becomes the basis
for the grade point calculation. The graded stack
changes for uneven grade runs.
View → mm or View → 1/10mm
Display of values in mm or tenth of a millimetre.
View → Show break sizes only
Only the break sizes are displayed.
View → Show individual sizes
The individual sizes entered in the size table are
displayed in the position of their corresponding
standard size.

save:
in call list ▪ as template ▪
in record

test run ▪ grading ▪ stack

16.4 Save Grade Rule Pattern
Before quitting the Grade Rule Pattern menu the
grade rule pattern is to be saved. The following three
options are available.
Save => in record
The grade rule pattern is accepted into the active
part. Thus, depositing this pattern is a construction
step in the part and corresponds to call grade rule
construction. Select this option if you digitize a num‐
ber of new patterns. In this case, open a new style in
Grafis, prepare the part list with the names of the
pattern pieces to be digitized at the beginning and
then, digitize the patterns. This way all pattern
pieces are saved in one Grafis style. After testing
each part can be saved as a template or in the call list
via Rule Pattern → Edit Grade Rule Pattern.
If more than one grade rule pattern has been called
into a part, a list of buttons appears at the bottom of
the menu. Clicking these buttons switches between
the grade rule patterns in the part.
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Save => as template
The grade rule pattern is saved in the directory for
template patterns \Grafis\[current measurement
system]\SWERT or in another directory. Grade rule
pattern files have the extension *.SWS. The grade
rules of these template patterns can be transferred
to other grade rule patterns (see section 16.7).
Save the blazer side panel from section 16.3 as a
template under \Grafis\[current measurement sys‐
tem]\SWERT\JACKET.SWS.
Save => in call list
The grade rule pattern is saved as a grade rule con‐
struction in the call list.
Save a pattern in the call list, only after is has been
tested and released.
Step‐by‐step guide
 Open the Grade Rule Pattern menu for the grade
rule pattern to be saved via Rule Pattern → Edit
Grade Rule Pattern for example
 save → in call list
 Click on
or
and enter a suitable name
 later: edit the call list, design a graphic for the
construction and store text information
Save the blazer side panel from section 16.3 in the
call list. After having clicked save => in call list the di‐
alogue Insert modules opens (Picture 16‐15).

16.5 Edit grade rule patterns, drag and
transfer grade rules
The Grade Rule Pattern menu (see previous page)
opens for Rule Pattern →
Edit Grade Rule Pattern
Extract Grade Rule Pattern
Digitize Grade Rule Pattern
Depending on the selection certain functions are
greyed out. The individual menu functions have the
following significance.
Digitize and extract
Depending on the selection one or more of these
functions are available. Digitize starts digitizing of
contours or grade rules, see sections 16.1 or 16.6.
Extract starts extracting a grade rule pattern from
the active part. The active part can be
 a constructed pattern based on body measure‐
ments or
 a grade rule pattern with or without modifica‐
tions.
The possibilities of this function are topic of section
16.8.
Grade points
The grade points section contains all functions for
editing grade points.
Place grade points opens the depicted menu.
With automatical grade points are set automatically.
Set grade points menu
automatical
constructive

Picture 16‐15

For entry of a name for the grade rule pattern file
click on
and you can enter the file name in the
Save as field. Alternatively, a prepared mask can be
called by clicking
. This interface is explained in
more detail in section 14.5.
After OK the file is created in the directory
\Grafis\[directory of measurement system]\Prog. In
the call list you can find a New entry in the area of
constructions of the measurement system. The entry
can be renamed and designed.

Existing grade points are not overwritten or deleted.
With constructive individual grade points can be set
with the known point construction functions.
The new grade points are marked in red as their
grade rule tables are still empty. With the functions
under grade rule… grade rules can be assigned to
grade points.
Set additional grade points onto curves, especially if
the curve shape has not been graded as required.
With drag grade points the contour of the base size
can be altered. Activate drag. The Grafis Raster tool
window opens (Picture 16‐16). If the Raster value
button is pushed in, the grade points are dragged in
the set raster steps.
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Activate Raster value and drag a grade point with left
mouse button pushed down. You are altering the
shape ‘by eye’. Grafis displays the movement of the
grade point in x and y direction in the Grafis‐Raster
tool window. Terminate dragging with . Only after

Copy allows for transfer of grade rules from one or
two grade points to another grade point with the op‐
tions:
 1=>1 ,
 [special] and
 2=>1 .
The options ‘1=>1’ differ as follows:
1=>1(XY) the complete grade rule table is
copied
1=>1(X)
only the x component value is cop‐
ied
1=>1(Y)
only the y component value is cop‐
ied

Picture 16‐16

having confirmed the security question are the alter‐
ations accepted. For your information, Grafis regis‐
ters the move values in the dialogue window of the
grade rule table with code % and the alteration date,
see Picture 16‐16.
With group grade points grade associations can be
formed. This special grading option is topic of section
16.10.
Switch to +display to show the grade point number.
The screen image can be output via Edit→ Copy (Clip‐
board) or with the functions of the print menu.
Grade rules
Edit grade rules opens the menu for editing grade
rule tables with the following options:
Edit grade rules menu
grade rules...
edit ▪ drag
Copy grade rules...
1=>1 (XY) ▪ 1=>1 (X) ▪ 1=>1 (Y)
[special 1] ▪ set special 1
[special 2] ▪ set special 2
copy grade rules...
2=>2 (linear) ▪ 2=>2 (curved)

With edit grade rules and clicking a grade point its
grade rule table opens, see section 16.3.

For ‘1=>1’‐copying activate one of the three copy
options and click the grade point from which grade
rules are to be copied. Move the cursor. An arrow
appears with which you define onto which grade
point the grade rules are to be copied. Quit copying
with .
With the options ‘[special]’ grade rules are copied
from one grade point to another. When copying, the
x component can be mirrored for example
([Xspg Y]). In the other case the grade rules are
not overwritten but added. Double‐click on set spe‐
cial allows for selection of other special options
which should be used by experienced operators,
only.
The options ‘2=>1’ transfer the grade rules of two
points onto a third. They differ as follows:
2=>1(lin) The new grade rules are calcu‐
lated linear in relation to the di‐
rect connection between the two
points. Use this option when the
points lie on a long (imaginary)
connecting line.
2=>1(cur) The new grade rules are calcu‐
lated as components. Use this op‐
tion when the points lie on a
shaped (imaginary) line.
For ‘2=>1’‐copying activate one of the two copy op‐
tions and click the grade points from which the grade
rules are to be copied. Define the grade points to ob‐
tain new grade rules with the arrow (Picture 16‐17).
Quit with .
Note the exercise in this section.
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The grade rules
of these points ...

Print
Print opens the sub‐menu with the following func‐
tions:
Print menu
print grade rule table
copy grade rule table

print grade rule pattern
... are transferred to
this point.

Picture 16‐17

Transfer grade rules opens the menu for transferring
grade rules from template patterns, see section 16.7.
Drag grade rules and clicking on a grade point opens
the Grafis‐Raster tool window. At the same time, all
sizes in the size table are graded. The contour of the
different sizes can now be dragged directly with or
without raster. NB: These alterations are directly
transferred to the grade rule table of the active
grade point! A different grade point can be activated
at any point by clicking. Dragging grade rules can be
quit with .
Set measurements
With set measurements you can include specific
measurements on a grade rule pattern. When drag‐
ging grade points or dragging grade rules, the meas‐
urements are altered immediately. Setting measure‐
ments ensues in the same way as temporary meas‐
uring in Chapter 7. The switch +/‐measurements
shows or hides the measurements.
Delete
Delete opens a sub‐menu. It allows for deletion of
single or all points or lines of the contour. Grade
points are deleted individually with single grade
points or all grade points.
Deleting points and lines of the contour during alter‐
ation of a grade rule is not permitted as subsequent
construction steps could relate to these objects.
Delete menu
Single lines ▪ single points ▪ all
points and lines
single grade points ▪ all grade
points

Print grade rule table starts output of the grade rule
table for all grade points. The table contains the
grade point numbers and their absolute grade rules
in the break sizes.
Copy grade rule table copies the table to the clip‐
board. For a formatted view select a proportion
typeface, e.g. CourierNew.
Print grade rule pattern starts output of the grade
rule pattern with marked grade points. Should the
grade point numbers be visible (Grade Rule Pattern
menu: +display) these are plotted, also.
Test run / grading / stack / save
These functions are already known. Grading in this
menu starts grading with grade rules. Saving was
topic in section 16.4.
Exercise
Activate the gradeable blazer side panel from section
16.3. Set an additional grade point onto the armhole
curve. Copy the grade rules of the adjacent grade
points with ‘2=>1’‐copy onto the new grade point
(Picture 16‐17).
part organisation
Rule Pattern → Edit Grade Rule Pattern
place grade points
click l
Place grade point onto the armhole
curve
edit grade rules
copy 2=>1(linear)
Assign grade rule according to Pic‐
ture 16‐17. First, click on the front
pitch then, the point on the side
seam and then, the new grade
point.
Terminates copying
The grade is shown in the right nest
grading
in Picture 16‐18. The curve shape is
slightly flatter.
edit grade rules
copy 2=>1(curved)
Steps as above
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left:
2=>1(prop) copied
Centre:
grading before insert‐
ing the grade point
right:
2=>1(lin) copied

38

By dragging the grade point you have altered the
contour of the pattern in the base size. Grafis regis‐
tered the move values of the grade point in the dia‐
logue window of the grade rule table with code %
and date of alteration (e.g. %31‐07‐98 = ‐2.0 0.0).
Drag the grade rules of this grade point. Note! These
alterations are accepted without confirmation.
Grade Rule: drag
Click on the grade point of
which you want to drag the grade rule.
Drag the pointer according to Picture 16‐
20 with pressed left mouse button. The
move value is indicated in the dialogue
window.

34

46
Picture 16‐18

grading

The grade is shown in the left
nest in Picture 16‐18. The curve
shape is slightly rounder
terminates copying

With this pointer
the grade rules
for sizes 34 or 46
can be dragged.

Drag the grade point in the base size 38 by approx.
2mm ‘to the left’, i.e. 2mm in negative
X‐direction (Picture 16‐19).

38
Drag grade point by
2mm in negative x di‐
rection:

34

46
Picture 16‐20

before
after

16.6 Digitize grade rules
If the pattern is available as a graded nest, i.e. all re‐
quired sizes stacked, the grade rules can be digitized.
38

34

46
Picture 16‐19

Drag grade point Drag the grade point with
pressed left mouse button. The
move amount is shown in the di‐
alogue window.

The nest has to contain the base size and the break
sizes, only. Further sizes do not have to be digitized,
they are interpolated by Grafis, automatically. Why
work harder than necessary!
Step‐by‐step guide
 Digitize the pattern perimeter of the base size
(see section 16.1)
 Open the size table via Extras → Size table and
enter and activate the sizes of the nest in sys‐
tematically order.
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The size in position 01 is the size of the digitized

34
38
46

Picture 16‐21
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The size in position 01 is the size of the digitized
contour. The grade rules of all further activated
sizes are digitized in this order.
 if the Grade Rule Pattern menu had been quit:
 Rule Pattern → Edit Grade Rule Pa ern
 Digitize
 Determine entry transformation and scale
factor
 Click [Grade Rules ON/OFF] on the menu tem‐
plate
 Digitize the grade rules of all grade points, re‐
spectively with:
 Click grade point, possibly adjust on screen; it
is sufficient to click near the point.
 Digitize position of the point in other sizes;
the size to be digitized is displayed on the
menu strip. The displayed order is to be fol‐
lowed, exactly.
 After having digitized the last size the com‐
puter gives an acoustic
signal.
 Quit with [Grade Rules
ON/OFF] on the menu tem‐
plate.
 possibly: re‐digitize lines,
points or grade rules
 Quit with [Quit digitizing] on
the template or
 Edit the grade rule pattern
 Save the grade rule pattern
in the record, as a template
or in the call list.
After having quit the digitize
mode test the state or work with
test run and grading from the
Grade Rule Pattern menu.
Should errors occur lines, points
and grade rules can be re‐digit‐
ized.

Exercise
Picture 16‐21 shows a graded nest of the blazer side
panel (Exercise in section 16.1) in sizes 34, 38 and 46.
For more clarity the sizes are not stacked as usual but
displayed shifted. The grade rules of the blazer side
panel are to be digitized.
Fix a copy of the nest to the digitizer table. First, dig‐
itize the contour in size 38, see section 16.1. After
having digitized the contour the grade rules are to be
digitized.
The following steps relate to Picture 16‐22.
<zoom all>
[Grade Rules ON/OFF]
Sizes 38, 34 and 46 appear below Grade Rules in the
menu. If other sizes or a different order appear, the
entries in the size table have to be altered. In this
case, quit the digitizing mode but not the Grade Rule
Pattern menu and edit the size table via Extras → Size
Table. After digitize you are back in the digitize
mode. If the pattern on the digitizer table was not
changed resume digitizing the grade rules, immedi‐
ately.

6

3

46

4

5

1

2

38

34

Picture 16‐22
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Point P1 in size 38 corresponds with point P2 in size
34 and P3 in size 46. The grade rules for this point are
digitized as follows:
P1 with <digitize> digitize approximately
P2 with <digitize> digitize exact
P3 with <digitize> digitize exact
After P3 the computer gave an acoustic signal. It
means: grade rule digitizing for this point is com‐
pleted. The grade point is now marked in green and
assigned with a grade rule.
You can resume with another grade point. Continue
with grade point P4, still marked in red.
P4 with <digitize> digitize approximately
P5 with <digitize> digitize exact
P6 with <digitize> digitize exact

2

1

3

5

4

6

If an error occurs during those steps continue digit‐
izing to the signal (or press digitizer mouse button
no. 4) and digitize the grade rule again.
Digitize the grade rules for the grade points until all
points are marked in green. Quit the digitizing mode
with [Quit Digitizing] on the menu template and test
the grade with test run and grading.
If grade rules were digitized incorrectly the graded
nest can look bad. First, analyse which points were
not graded correctly. If necessary deactivate size 46
in the size table so that sizes 34 and 38 are displayed,
only. Re‐digitize the grade rules. During digitizing
grade rules, sizes 38, 34 and 46 must be active, again.
In the next step the curve shape in the graded sizes
is to be checked. The shape of the panel seam in size
46 is not yet identical with the template.
To correct curve shapes set one or more additional
grade points and digitize the relevant grade rules.
place grade point
click l
first, set the additional grade
points P1 and P4 (Pic‐
ture 16‐23)

46

38

34

Picture 16‐23

Mark the additional grade points on the template in
the sizes of the nest, also.
Digitize the grade rules of the new grade points.
P1 with <digitize> digitize approximately
P2 with <digitize> digitize exact
P3 with <digitize> digitize exact
After P3 the computer gives an acoustic signal. Con‐
tinue with P4, then, quit the digitizing mode with
[ Quit Digitizing ] on the menu template and test
again.
Set additional grade points until you agree with the
grade result and then, deposit the grade rule pattern
(see section 16.4).
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16.7 Transfer grade rules

Transfer grade rules menu

Transfer grade rules from another Grafis part
Grade rules can be transferred from another part of
the Grafis style onto the active grade rule pattern in
a very user‐friendly manner. The required part must
be graded and visible in the background, see Pic‐
ture 16‐24.
graded
Grafis part

active
grade rule pattern

edit grade rules
template...
call ▪ hide ▪ coordinate
move
turn angle
copy grade rules...
1=>1(XY) ▪ 1=>1(X) ▪ 1=>1(Y)
single ▪ guided
grade rules...
+/‐ display identical ▪
+/‐ x component ▪ +/‐ y compon‐
ent

Edit grade rules opens the grade rule table of a grade
point to be clicked, see section 16.3.
Function group template
Picture 16‐24

In the grade rule pattern menu directly, move the
cursor over the graded Grafis part. The grade rules
are visualised in form of small points. Click on a point
or a line in the graded Grafis part and then move the
cursor to the active grade rule pattern. Click the cor‐
responding grade point in the active grade rule pat‐
tern. The grade rules are now assigned to this grade
point. Visualise the current state with grading in the
menu.
Transfer grade rules from a saved template pattern
With the function transfer grade rules in the Grade
Rule Pattern menu grade rules can be transferred
from a saved template pattern. Use this option when
a pattern is available in the base size, only. Digitize
the pattern in the base size and then, transfer the
grade rules from an available tested grade rule pat‐
tern.
After Installation of Grafis no template patterns are
available. Template patterns are generated via save
=> as template from the Grade Rule Pattern menu.
Saving a grade rule pattern as a template is possible
via Rule Pattern → Edit Grade Rule Pa ern or Rule
Pattern → Extract Grade Rule Pa ern (see section
16.8). Clicking on transfer in the Grade Rule Pattern
menu opens the sub‐menu shown on the right with
the following functions:

The functions below template help with preparation
of the template for transfering grade rules.
First, call the template. Select a tested grade rule
pattern saved as a template (*.SWS). The template
appears with dashed lines. At the same time, Grafis
asks you to co‐ordinate both patterns to one an‐
other. Co‐ordinate (explained in the following) is al‐
ready active.
To call another template you have to hide the active
template, first. Then, a new template can be called.
It is possible to transfer grade rules from more than
one template.
With co‐ordinate you define which grade points
have identical grade rules. First, the point of the tem‐
plate is to be defined then, the point in the active
grade rule pattern.
Move allows for the template to the moved, rotated
or mirrored. Functionality corresponds to the <F3>
function. During rotation or mirror of the template
the grade rules are updated, also. Therefore, rotate
and mirror before copying the grade rules. The rota‐
tion angle of the template is displayed in the menu.
For very small rotation drag further away from the
centre of the circle. Moving the template does not
affect the grade rules.
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After having adjusted and positioned the template,
effectively copying grade rules begins with the func‐
tions below copy.

active grade rule
pattern

template

Function group copy
With the functions below copy transferring grade
rules from the template and copying onto the active
grade rule pattern begins.
The copy options were explained in section 16.5, al‐
ready. For the copy option ‘1=>1’ copying can ensue
either single or guided. With guided the grade points
of the active grade rule pattern one after the other
are the beginning of a thread which is to be con‐
nected with the corresponding grade point of the
template. The grade points are processed in order of
their numbers. Assigning can be skipped with . Ac‐
tivating single terminates guided transfering.
Display options
In the option +display identical grade points with
identical grade rules are connected with dashed
lines. The following are connected:
+x components and +y components:
identical grade rule tables
+x components and ‐y components:
grade rule tables with identical x components
‐x components and +y components:
grade rule tables with identical y components

Pciture 16‐25

grading

the grade corresponds with the
nest in Picture 16‐26 (sizes 34,
38 and 46).

Exercise
Generate a blazer side panel similar to Pciture 16‐25,
for example by drawing and digitizing the contour.
Transfer the grade rules from the template saved in
section 16.4 as JACKET.SWS.
Edit the digitized pattern with the Grade Rule Pattern
menu as follows:
transfer grade rules
call
open JACKET.SWS
The prepared blazer side panel appears dashed.
co‐ordinate click in both patterns the corner
points armhole/ side seam
move
move and rotate the template;
reset rotation to 0
guided
copy 1=>1 (XY)
transfer all grade points guided;
if necessary skip a point with
and re‐process with single

Picture 16‐26
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If a grade point is graded incorrectly select Grade
Rule: transfer again. The settings for transfer remain
existent when quitting the Grade Rule Pattern menu.
If necessary the pattern can be edited further with
the functions explained in section 16.5.

These differences between construction pattern and
grade rule pattern are corrected with additional grade
points.

16.8 Extract grade rule pattern
Each Grafis part can be extracted to a grade rule pat‐
tern. This applies to pure construction patterns as
well as grade rule patterns which were edited with
the Grafis construction functions.
Changing a part into a grade rule pattern or ‘extract‐
ing’ a grade rule pattern is interesting for example
for:
 releasing one or more parts form a hereditary
line for use in a different style or
 transferring a tested, constructed grade onto a
pattern available in the base size, only.
Step‐by‐step guide
Activate the part to be changed into a grade rule
pattern;
 Enter the base size into position 01 in the size
table; in the following positions of the size table
enter and activate all sizes from which you want
to extract the grade rules;
 Rule Pattern → Extract Grade Rule Pattern
 extract, First, set the grade points automatically.
Grafis takes off the grade rules for these grade
points for all sizes active in the size table.
 grading, the pattern is now graded as a grade
rule pattern. The pattern must be identical with
the original construction pattern. Especially on
curves differences occur which can be rectified
by setting additional grade points with place
grade point and repeated extract. The grade
points do not have to be set again. Click alter‐
nately on extract grade rules and grading. When
no differences are visible the grade rule pattern
can be saved.
 Possibly, edit the grade rule pattern according to
section 16.5
 Save the pattern according to section 16.4
 Quit with .


Picture 16‐27

additional grade
points

Test extracting by saving production patterns or cer‐
tain development stages of a style as grade rule pat‐
terns. From the constructed blazer side panel in Pic‐
ture 16‐28 the grade rules for the break sizes 34, 38
and 46 were extracted with automatically set grade
points. In Picture 16‐27 the nest of the constructed
pattern and the extracted pattern are displayed on
top of one another. On the marked lines differences
can be found.
After having set additional grade points with place
grade points and constructive according to Pic‐
Picture 16‐28
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ture 16‐28 and repeated extract the nests of the con‐
structed pattern and the grade rule pattern are
identical (Picture 16‐29).
Construction pattern and grade rule pattern after cor‐
rection:

16.9 Create, use and edit a grade rule li‐
brary
A grade rule library is a collection of grade rule ta‐
bles. Use of a number of libraries is possible. The in‐
dividual grade rule tables can obtain their own des‐
ignation. A library is saved in the grade rule pattern
data format (*.SWS).
This section is divided in the topics:
 create a grade rule library
 assign grade rules from the library and
 edit a grade rule library.
Create a grade rule library
A grade rule library can be extracted from existing
patterns or created by entering the values. The for‐
mer option is explained, first.
Step‐by‐step guide
Prepare a pattern with all gradeable pattern
pieces,
 Enter and activate the break sizes in the size ta‐
ble,
 Rule Pattern | Extract Grade Rule Pattern
 Place grade points from which grade rule tables
are to be inserted into the library, manually
 extract
 Possibly, set further grade points and extract
 with
return to the Grade Rule Pattern menu
 Label the grade rule table with a number be‐
tween 1 and 999 in the No. Field. This number
subsequently appears in the library.
 Save grade rule pattern with save => as template
under \Grafis\[measurement system]\ SWERT\
LIBRARY\[library name].SWS
Generate a Grafis pattern with all corresponding pat‐
tern pieces (see Picture 16‐31). Activate the break
sizes in the size table (here: 38, 34, 46) and start
Grading → Grade All Parts. Then, open the Grade
Rule Pattern menu via Rule Pattern → Extract Grade
Rule Pattern and set the grade points from which
grade rules are to be inserted into the library with
place grade point. Not all grade points have to be set!
Then, click on extract. The grade rule tables for the
grade points were calculated.


Picture 16‐29

Prior to extracting, check if notches or other symbols
should be replaced by points. A notch for example
consists of two grade points. The base size and all
break sizes must be entered in the size table and
must be active. Proceed according to the step‐by‐
step guide and save the patterns in the call list and
as template grade rule patterns.
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If you require an empty grade rule library in which
grade rules are to be saved, later the following step‐
by‐step guide applies:
Step‐by‐step guide for an empty library









Activate empty part,
Enter base size into the size table,
Rule Pattern → Digitize Grade Rule Pattern
place grade points
construct
p on x&y with x=y=0
with return to Grade Rule Pattern menu
Save grade rule pattern with save => as template
under \Grafis\[measurement system]\ SWERT\
LIBRARY\[library name].SWS

Use grade rule library

Picture 16‐30

Click on a grade point; the grade rule table window
opens (Picture 16‐31). Double‐click on the dialogue
window at the lower edge of the table. Enter a num‐
ber between 0 and 999 into the No. field as a name
for the grade rule. This number appears marked with
‚#’ as a number at the point (with +display), in the
comment window and later in the grade rule library.
Introduce your own system when naming the grade
rules. Note that the grade rules are listed in alpha‐
betical order. Enter a name for each grade point.
Then, save the grade rule pattern with save => as
template under \Grafis\ [measurement sys‐
tem]\SWERT\LIBRARY\BLAZER.SWS. The grade rule
library is created.

Entry

Picture 16‐31

Grade rule libraries are opened from the Grade Rule
Pattern menu via edit grade rules and used as fol‐
lows:
Step‐by‐step guide
 Click edit grade rules in the Grade Rule Pattern
menu
 Select required grade rule library (Picture 16‐
32),
 click required grade rule once and then, click the
grade point to which the grade rule is to be as‐
signed;
Digitize a pattern without grade rules. Edit the pat‐
tern in the Grade Rule Pattern menu (possibly: Rule
Pattern → Edit Grade Rule Pattern). Open the Grade
Rule: edit menu (Picture 16‐32). All functions intro‐
duced in section 16.5 are available. Select the re‐
quired grade rule library under drag by clicking this
field and selecting one of the available libraries from
the list below. The selected library is entered into the
field below drag. The list below the field with the
name of the library now contains the grade rules.
Scroll in this list. Click on the first grade rule and
move the cursor to the pattern without pressed
mouse button. For your support an arrow to the re‐
spective nearest grade point appears. Click on the
grade point to which you want to assign this grade
rule.
Assigning can ensue with the three copy options
1=>1 where 1=>1 (xy) is the default.
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Edit grade rule library
Grade rules can be added
to an open grade rule li‐
brary as follows.

Selected grade rule library
Click here to select a different library.

Step‐by‐step guide
 Click edit grade rules
Selection list
Here, select the required library or grade rule.
in the Grade Rule Pat‐
tern menu
 Select the required
grade rule library
 Edit a grade rule: dou‐
ble‐click on the grade
rule in the right menu
strip, edit the grade
rule and quit with
 Add a grade rule: acti‐
vate edit and double‐
click on a similar grade
rule in the right menu,
edit the grade rule, la‐
bel it in the No. field
and save it in the li‐
brary with File → Save
to library. Close the
Scroll the list
grade rule table with
without accepting
the alteration again,
as otherwise the
Picture 16‐32
grade rule selected as
template is overwritten.
A grade point can be assigned with a number of
 Delete a grade rule: double‐click on the grade
grade points.
rule in the right menu strip and File → Delete
The grade point which has grade points assigned to
from Library.
it is marked with a dashed circle.
Edit the library according to the step‐by‐step guide.
A grade point which already has grade points as‐
The alterations are saved in the library, immediately.
signed to it can be associated with another grade
point (chain of grade associations).

16.10 Group grade points

Grouping grade points is a powerful and sophisti‐
cated function. It is explained briefly in this section
using a simple example. It can be used far more ex‐
tensively than described, here.
With the function group a grade point can be graded
in relation to another grade point. The grade rule ta‐
bles discussed so far relate to the pattern contour in
the base size. With group and assign this relation is
released and grading can be related to a grade point.

Group grade points menu
edit grade rules

grade point…
assign neutral
release neutral
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The options Group neutral or additive
Grade points can be grouped neutral or additive:

The option grade point additive should be used if a
grade rule is to be adjusted for a new point in rela‐
tion to an existing point.
Example
Picture 16‐33 shows a front with drillholes for a welt
pocket. The welt has the same dimensions for all
sizes. The nest in Picture 16‐33 is stacked at P1. The
grade rule table for P2 is shown in Picture 16‐34. The
grade point P2 is associated with grade point P1 with
the following steps and graded in relation to P1.
Rule Pattern → Edit Grade Rule Pattern
group grade points
assign grade points neutral
P2 is to be allocated to P1 according to
Picture 16‐35.

drillhole

P1
P2

P1
Picture 16‐33

In the case of grade point neutral the grade rules of
the grade point are calculated so that it continues to
be graded as before without alteration.
In the case of grade point additive the grade rule ta‐
ble remains unchanged. The target to which the
grade rule refers is changed. This option is originally
not visible as it is rarely required. The option additive
can be made available in the Grafis.ini under [OP‐
TIONS] with the switch GRD_GRP_ADD=1.
Assign grade point neutral and subsequent Release
grade point neutral restores the original state. The
same applies to the additive option.

P2

Picture 16‐35

edit
The grade rule table for P2 after allocation
is shown in Picture 16‐36. The position of
P2 does not change in relation to P1 in all
sizes. All grade rules are zero.

Picture 16‐36

Picture 16‐34

The option grade point neutral should be used if a
grade point has already been graded correctly and
now, its grading is to be checked/ adjusted in relation
to another point. See also the following example
with Picture 16‐33 and Picture 16‐38.

Now, the grade rules for drillhole P2 are to be
changed so that the pocket is 5mm narrower in both
sizes 34 and 36 and 10 mm wider from size 44. In
sizes 38 to 42 the grade for the pocket is to remain
unchanged. The grade rule table for P2 is to be al‐
tered according to Picture 16‐37.
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Picture 16‐37

The result after grading and stacking of the pattern
at P1 is shown in Picture 16‐38.

P1
P2

Picture 16‐38

Now, remove the grade association with
Grade Rule Pattern → edit grade rules
group grade points
release grade points neutral
To remove click the point to which an‐
other point was assigned; in this case
click P2.
edit
The grade rule table was calculated for the relation
to the pattern contour (Picture 16‐39). The grade of
the pattern corresponds with Picture 16‐38.

Picture 16‐39

Use additive if you have set a new grade point and
want to grade it in relation to an existing grade point.
If no grade point has been set at drillhole P2 you can
obtain the result in Picture 16‐38 with the following
steps.
Grade Rule Pattern.→ Edit Grade Rule
place grade point
constructive the centre of the drillhole
group grade points
assign grade points additive
P2 is to be associated wit P1 according
to Picture 16‐33.
edit
The grade rules for P2 remain zero af‐
ter allocation (Picture 16‐36). Alter the
grade rules according to Picture 16‐37.
grading
For result see Picture 16‐38.
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Grafis Marker making is started as a separate appli‐
cation and can be open at the same time as Grafis
Patternmaking.
The Grafis Marker making can be used at different
levels in industry, trade and education. It allows
amongst other:
 marker making of all production patterns of the
current style,
 combining patterns from different styles within
one marker, also across different measurement
systems,
 grouping of pieces,

 open and folded markers,
 transfer of optimised markers onto new mark‐
ers to be generated,
 creation of fusing group and much more.
Technical parameters such as material type, grain,
number of pieces per style and repeats are consid‐
ered as well as planning parameters for buffer
(global, piece‐specific, direction‐specific), shrinkage
and material faults. Pieces can be rotated and flipped
during marker making.
Content of this chapter are the basic functions for
creating a marker from one or more styles. All other
application options follow in Chapter 18.
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17.1 The fastest way to a marker
For industrial application, the marker making soft‐
ware offers an abundance of planning and organisa‐
tional options which have to be entered before the
actual marker making process. Not every user, how‐
ever, requires all options. Therefore, the steps for
minimum requirement are to be explained, first.
Note:
If you have no suitable style with production pat‐
terns available you can prepare the following: Open
a new style in the measurement system Optimass
(BASIS_A). Call the ‘Unisex Basic Block’ into parts 001
and 002, respectively. In part 001 delete and points
and lines of the back and call the part front. Part 002
becomes the back by deleting all points and lines of
the front. Now, two parts with closed perimeter are
available. Continue with the step ‘Set part parame‐
ter’.
Steps in Grafis Patternmaking
 Create the production pieces with closed perim‐
eter, if necessary set the grain line
 Set part parameter; minimum: Attribute produc‐
tion piece, material type (e.g. ‘O upper fabric’),
number of pieces per style (e.g. 1x normal, 1x
mirrored)
 Enter all sizes to be layed into the size table and
grade all parts.
 Save the style
 Start marker making via File → Start Marker mak‐
ing or via the ‘Marker making’ icon on the desk‐
top.

 Button Lay opens the user interface for laying the
pattern pieces.
 Lay the pieces according to section 17.6

17.2 Preparations in Grafis Patternmak‐
ing
Step‐by‐step guide
 Create production pieces with closed perimeter
 Set grain line
 Enter part parameter (material type, amount of
pieces per style)
 Enter all sizes to be layed in the size table and
grade all pieces.
Construct production pieces with closed perimeter
During pattern development draft patterns are cre‐
ated from which the actual production patterns are
derived, see Chapter 14. Pieces can only be layed in
the marker if they have a closed perimeter. The pe‐
rimeter corresponds with the cutting line on the fab‐
ric. It can be adjusted to the fabric by entering shrink‐
age values and buffer within the marker.
Production pieces:

Steps in Grafis Marker making
 Open the prepared style (of Version 8 or higher)
via Production Style → Open. Grafis suggests con‐
verting the style into a production style. This
should be confirmed. Explanations can be found
in section 17.4.
 If necessary, check or edit the part parameter via
Production Style → Part Organisation
 Open the Material index card via Marker Infor‐
mation → Material
 Enter the material width, e.g. 1500 (entry in mm)
 Select material type, e.g. ‘O upper fabric ‘
 Button Next to index card Parts
 Optional: Select one or more pieces and enter
buffer (buffer column) and allow rotate/flip (al‐
lowance column).
 Button Next to index card Sizes
 Click a size and set the amount of this size for the
marker via Edit Amount. Dragging with pressed
left mouse button allows for selection of a num‐
ber of sizes and changing the amount to be layed
in one operation.

Draft patterns:

Picture 17‐1

Grafis checks whether the perimeter is closed when
setting the part parameter Production Piece (in the
part organisation menu) and again when transfer‐
ring all sizes into the marker. If Grafis finds gaps
(>0.5mm) in the perimeter or protruding lines, an er‐
ror message appears. Gaps can usually be found at
corners, joints of lines or at symbols.
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notch in the perimeter

 right
false (gap)

Picture 17‐2

Line symbols such as notches are ignored during
checking of the perimeter (Picture 17‐2). For the first
steps in the marker, please prepare a simple style
with production pieces, e.g. a skirt as shown in Pic‐
ture 17‐1.
Set grain line
In the production pieces the Grafis symbol ‘grain
line’ should be set at least.
If no grain line is set, the negative y axis (direction
downwards) is utilised as the direction of the grain,
however, this can be changed subsequently (see
18.10). Also, an internal line can be declared as the
grain line (see 18.11).
The following symbols and attributes must already
be set in the style if they are required in the marker:
 grain line
 annotation line (see 18.11)
 split line (see 18.11)
 internal line to be cut (see 18.11)
Assign piece parameter
After having finished the production patterns the
piece parameter for the production pieces should be
assigned, already on the file card Piece Parameter in
the Part organization menu.

These are:
 Set piece type to Production piece
 Determine the Material for the production
pieces;
If the required material type is not listed, it has to
be entered in the file \Grafis\MATERIAL.DAT. This
file contains the code for the material type in the
first column. Each code can be assigned only
once. For the code one capital letter or one num‐
ber can be used. Use of special characters or um‐
laut is not permitted. The material name follows
from the third column onwards.
 Enter the amount of this piece per style;
For right/left‐symmetrical pieces (pairs) the piece
is required ‘1x normal’ and ‘1x mirrored’. Please
note that here, not the total number of pieces to
be placed is to be entered but the amount for
normal and mirrored position per style.
With the button
the piece parameters of the se‐
lected piece are transferred to the next piece. This
relates to the attribute Production piece, the mate‐
rial type and the amount per style in normal/mir‐
rored position.
Optionally, each piece can be assigned a category for
which the buffer at top/bottom/left/right and the
settings for rotate and flip during marker making are
prepared. Details on work with categories can be
found in section 18.7.
Grade production patterns
All sizes to be layed must be entered in the size table.
One entry per size is sufficient. Grade all production
patterns with Grade all Parts and save the style.

17.3 Structure of the Grafis Marker
The Grafis Marker making is started via the icon
‘Marker making’ or from Grafis Patternmaking via
File → Start Marker making. Grafis Patternmaking
and Grafis Marker making can be open at the same
time.
Data structure of the Grafis Marker
The data of a marker is divided into production style,
marker information and marker. In this order, the in‐
formation for the marker is assembled. The overview
in Picture 17‐4 indicates the structure. The interme‐
diate steps (production style, marker information
and empty marker) can be saved, separately.
Picture 17‐3

284

Chapter 17 Marker making

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Construction style with
• construction record
• part interdependencies
• x value list
• part parameter (e.g. code produc‐
tion pattern/draft pattern)

Produktion style
• pieces from different styles
• piece perimeter in different sizes
• part parameter
• match relations
• path to the source style
• without: construction record, part
interdependencies, x value lists

Structure of Grafis Marker
First, a production style is created from one or more styles.
Then, the marker information for material, pieces and
sizes is to be entered. Marker making can then, ensue.

Marker information

Marker

•

• laying data for each
piece (position on the
material, rotation angle,
active flip,...)

•

•

material data
(material
width, repeat, shrinkage...)
laying options for each piece
(buffer, allowance for rota‐
tion/flip)
size list (bundles)

Picture 17‐4

Production Style
... is the assembly of pattern pieces from different
styles and different measurement systems to be
layed in a marker. It contains
 all required pieces as perimeter in all required
sizes,
 the part parameter for the pattern pieces,
 match relations if required and
 a connection to the source of the respective
pieces.
As opposed to the styles in the Grafis Patternmaking,
the construction record with x value lists and the in‐
terdependence of the parts no longer exists.
Marker information
... are the data of the production style and addition‐
ally
 all information about the material (width, re‐
peat, shrinkage, ...)
 laying options for each piece (buffer, allowance
for rotation/flip),
 sizes to be placed (bundle) and the name of the
marker.
Marker
... contains the data of the marker information with
the data of the production style and additionally
 the laying data for each piece (current position
in the marker, rotated, flipped,...)
The data of every placed marker are saved as marker
files with the extension *.scb.

Prepare marker
Step‐by‐step guide
 Prepare the style according to section 17.2 and
start Grafis Marker making
 Load or assemble the production style
 Assign marker information
 Lay the marker
For each of the highlighted steps, there is a pull‐
down menu with all relevant functions.
Load or assemble production style:
 Pull‐down menu Production Style
Assign marker information:
 Pull‐down menu Marker information
Lay marker:
 Pull‐down menu Marker
To create a marker these steps are to be processed
one after another. The individual steps are explained
in sections 17.4 to 17.7.
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17.4 Create production style
Load production style
If only pieces of one style are to be placed, the fol‐
lowing steps are sufficient:
Step‐by‐step guide
 Pull down menu Production Style → Open Style.
Open a prepared style. Grafis suggests automati‐
cally converting the style into a production style.
This should be confirmed. Thus, all production
pieces are transferred and the alteration service
is activated for each piece. Refuse this conversion
only if not all required patterns have been de‐
clared as production pieces. In this case, all parts
including empty parts and development parts will
be transferred. However, this means that any al‐
teration to the source style leads to updating of
all pieces in the marker.
 If necessary, check or edit part parameter via Pro‐
duction Style → Part Organisation, open file card
Part parameter and check the material type and
the required amount for each part.
The production style is now prepared. You can con‐
tinue immediately with the marker information
NB: The alteration service (section 18.1) can work
only if the source style and the complete path to the
source style (drive, collection, sub‐collection) have
not been renamed, moved or deleted.
Assemble production style
Step‐by‐step guide
 Open part organisation via Production Style →
New style
 Click Insert connection part
 Select a style from any measurement system
 The dialogue Grafis‐ Part Connection appears
 Select the sizes required for the production style
or click on all sizes. The order of the sizes remains
intact in the marker when creating the bundles.
 Click the button Create connection for all pieces
required in the production style or click on all
parts
 Select the next style with the button Back or close
the Grafis‐ Part Connection dialogue with the
button Close
 Open file card Part parameter and check the ma‐
terial type and the required amount per style for
each piece
 End with right mouse button
When assembling production styles from styles of
different measurement systems, ensure identical
size names. If the size names are not identical, indi‐
vidual measurement charts with identical names
may have to be created. Ensure correct settings for
the alias in the size table.

The production style is assembled with the function
or the part organisation menu which are largely
identical with the ones in the Grafis Patternmaking.
All changes apply to the new production style, only.
The source style remains unchanged.
Start Grafis Marker making and select Production
Style → New Style. Assemble the new production
style by clicking on Insert Connection and selecting
the required style.
Select style
In the dialogue Open Style for Insert select the drive
on which the required style is saved under Look in:.
In the window below, all measurement systems ap‐
pear, indicated as folders with the icon
. Double‐
click changes to the required measurement system.
All available collections of the selected measure‐
ment system appear, also indicated by the icon
.
Double‐click on the required collection opens the list
of all available styles of the collection. Styles are in‐
dicated by the icon . If a padlock appears at the
icon , the style is currently being processed and is
therefore, write‐protected. Parts from a write‐pro‐
tected style are transferred in the state of the last
save. Move up one level of folder/ collection with the
button
. Table 17‐1 contains an overview of the
icons used in Grafis and their significance.
Icon
Significance
folder (measurement system), collec‐
tion
style (Grafis Patternmaking)
write‐protected style
production style
marker
marker information
Table 17‐1
The content of the window can be arranged with the
buttons according to Table 17‐2.
Button
Significance
List without details
List with details
Show/hide text preview
Show/hide preview of the first piece
Table 17‐2
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Picture 17‐5

Create connection
After having selected the required style, the window
Part Connection appears (Picture 17‐5).
Step‐by‐step guide





Select all sizes to be transferred to the produc‐
tion style
Transfer pieces with: select piece and click but‐
ton Create connection or double‐click on the
piece
Button Back to select another style
End with button Close

Select sizes
All sizes positioned to the left of the arrow ‘<=‘ in the
section Sizes of the style will be available in the
marker. Double‐click on the respective line transfers
the size to the left or excludes it again. Selecting a
number of sizes in one operation is also possible with
pressed left mouse button. The bundles will be cre‐
ated in the order of the sizes to the left of the ‘<=‘.
Transfer pieces
The check mark Display production patterns only can
be set if all pieces to be layed have been assigned
with the Production piece attribute. If the check mark
is set, all draft patterns are hidden. After having
clicked a piece its perimeter appears in the Preview
area and the content of the text box ‐ if applicable ‐
appears under Part description. Clicking the button
Create connection or double‐click on the piece trans‐
fers the piece. The following piece is selected, auto‐
matically. A different insert position in the produc‐
tion style can be selected with the buttons
.

After having transferred all required pieces, another
style can be selected with the <<Back button or the
assembly of the production style can be ended with
Close.
Edit production style
The current list of parts can be opened via Production
style → Part Organisation. On the Part parameter file
card the date of the last edit of the piece, the name
and the path of the source style are now shown for
each piece. This information is used to ensure that
any alteration of the source style will automatically
be updated in the marker. Further information on
updating pieces can be found in section 18.1.
If necessary, check that
 no pieces have been transferred, twice by acci‐
dent,
 the material type of the piece is correct,
 the required amount per style is correct and
 if applicable, the part category is correct.
Corrections can be made immediately with the
known function from the part organisation, see
Chapter 14. Adding further pieces is started by click‐
ing insert connection part. The part organisation is
closed with the right mouse button.
In the style view, the function keys <F2>, <F3>, <F4>
and <F6> are assigned as in the Grafis Patternmak‐
ing. Pressing <F5> arranges all transferred pieces in
all transferred sizes. The functions Copy, Measure,
Stack and Move/Zoom are also active (pull‐down
menu Edit or toolbox).
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Save production style
The production style can be saved at this stage via
Production Style → Save Style As... Finished styles
should be sent to the customer or the production
unit in the form of production styles. Alteration
through application of other body measurements or
x values are no longer possible.
For saving of production styles no fixed directory
structure is given as the production styles are no
longer attached to a measurement system. As the
target, we recommend the folder \Grafis\SB\ and its
subfolders. With the button
New Folder a new
folder/directory can be created.

17.5 Edit marker information
Step‐by‐step guide
 Create or open a production style
 Pull down menu Marker Information → New
Now, three file cards are to be filled in.
 Fill in file card Material (enter material width and
material type minimum)
 Fill in file card Pieces
 Fill in file card Sizes

 Save empty marker or lay the pieces in the
marker
After preparation of the production style and before
laying the pieces in the marker, all information about
the marker must be entered into the file cards Mate‐
rial, Pieces and Sizes. As a rule, each of these file
cards are indicated by one icon in the toolbox.
File card Material
On this file card, enter at least the material width
and the material type. All other fields can be edited
if required. Some of the other options are explained
in the following. Further information about pre‐se‐
lection of material, repeat, shrinkage values (global),
fault areas and spreading types follow in Chapter 18.
Buffer (global)
The global buffer applies to all pieces in the marker.
Grafis calculates a new perimeter for each piece with
half of the buffer distance. Thus, the set safety mar‐
gin between two pieces is ensured. If pieces are to
be touching in the marker, the global buffer must be
0. A piece‐specific buffer can then be entered on the
next file card.

Picture 17‐6
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Maximum material length
In this field, the maximum length for the marker in
metres or a minimum efficiency in % is entered. A
default setting for the maximum length is entered in
the Grafis.INI file and can be altered at any time.
When entering a minimum efficiency in %, the maxi‐
mum material length is calculated, automatically
from the area of all pieces and the width of the ma‐
terial.

With every…mm the distance between vertical or
horizontal anchor lines can be randomly selected.
For vertical anchor lines, the distance between the
lines can correspond with the page size of the active
plotter. This setting is useful for single sheet plotter
where the pattern pieces are not to protrude over
the edge of the page.
Button Next
Clicking the Next>> button opens the Pieces file card.

Anchor lines

File card Pieces

Anchor lines are laying aids which function like a bor‐
der. Pattern pieces can be attached from left/ right
or up/ down. Placing a piece on top of an anchor line
is only permitted if the check mark use as auxiliary
line only is set. Anchor lines can also be plotted.

On the Pieces file card, settings regarding additional
direction‐specific buffer, flip and rotate allowance
and special settings for shrinkage value can be en‐
tered for each piece.

Picture 17‐7
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In the part list (left on the file card) the following is
stated next to the piece name:
Column
Piece
Amount

Buffer

Category
Material

Content
Piece name
Amount of the piece per style; first
number indicates normal and second
number flipped position
The character ‘x’ indicates that a
piece and direction‐specific buffer
has been entered for this piece.
Small ‘x’: original perimeter is cutting
line; capital ‘X’: buffer line becomes
cutting line;
character ‘‐’: the piece will be re‐
duced.
Display of category number and
name assigned to this piece.
Code for the material type

If only pieces of the selected material type are to be
displayed, check Show pieces for selected material
only. Thus, only pieces which will be layed out can be
seen. The material type is selected on the previous
file card Material.
The values in the entry fields Fixed settings, Allow‐
ance, Buffer and Shrinkage values for the piece apply
to the selected piece(s), respectively. To select a
number of pieces at the same time, press the <Ctrl>
or the <Shift> key when clicking on the pieces.
Fixed settings
For each piece the following can be set:
 fixed rotation angle
The piece is rotated through this angle before
entering in the marker.
 flip about x or y
The piece is flipped before laying.

Allowance
Additionally, the following rotate/flip allowances can
be set:
 tolerance angle
The piece may be rotated freehand about a
maximum of this angle in the marker.
 flip about x (grain line)
 flip about y
 rotate through 180°
 rotate through +/‐90°
 rotate through +/‐45°
The piece may be rotated/ flipped according to these
settings
Buffer
The piece and direction‐specific buffers are added to
the global buffer from the previous file card Mate‐
rial. The settings apply to the selected piece(s). A
buffer can be entered into the fields top, bottom, left
and right in mm or in %. When using percentage,
only the character ‘%’ is to be entered. Move be‐
tween entry fields with the <Tab> key. All settings re‐
late to the first piece in the first bundle in unflipped
position.
The check mark at cut buffer line results in the piece
being increased by the global and piece‐specific
buffer and cut at the buffer line. Complex pieces or
pieces which the cutter may not be able to cut, accu‐
rately can be cut roughly and can then be cut, accu‐
rately by hand.
If the check mark at cut buffer line is not set, the
buffer is an invisible distance between the pieces.

Picture 17‐8
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A check mark at reduce piece results in the piece be‐
ing reduced by the global and piece‐specific buffer
and cut reduced. Interlining can be reduced by 2mm
all around for example, to prevent the fusing press
from being soiled with glue.
In the part list (left on the file card) the current set‐
tings are indicated as follows:
Character Significance
x
 cut buffer line
(original perimeter is cut line)
X
 cut buffer line
(buffer line is cut line)
‐
 reduce piece
(piece is cut reduced)
All further options are explored in Chapter 18. These
are
 shrinkage values for the piece
 pre‐set buffer
 pre‐set (all)
 replace style/add style
File card Sizes
The file card Sizes determines which sizes are placed
and how often. This information is displayed in the
size list (Picture 17‐8, left window). From this data,
the bundles are created, automatically in the right
window. Only the sizes set up in the production style
can be placed. Adding unlisted sizes is only possible
through reprocessing the production style. To edit
the amount of the size, select one or more sizes in
the window on the left. Pressing a number on the
keyboard or the arrow keys next to the dialogue Al‐
ter amount changes the amount of the selected
size(s). A number of sizes can be selected with the
<Shift> and <Ctrl> keys, analogous to the handling in
the part list.
In the field Article/Marker code a short description
of the marker can be entered which can be plotted
at the material edge.
Further information about Article/Marker code and
Step lay follow in Chapter 18.
Save empty marker
As soon as all settings for the Marker Information are
dealt with, this intermediate stage can be saved as
an ‘empty marker’. Often, a number of markers are
required for the same style due to marker optimisa‐
tion.

The first marker contains sizes 36 and 42, the second
marker sizes 38 and 40 and so on. After having saved
the ‘empty marker’ for the sizes 36 and 42, the sizes
38 and 40 have to be entered, only in the required
amount on the Sizes file card. Then, the marker for
sizes 38 and 40 is prepared, also.
Later, the first marker is opened with Marker →
Open Marker…. If consecutive names have been
given when saving the markers, the next marker can
be loaded, immediately with Marker → Open Next
Marker.
Option Maintain bundle position
If the size list for an already placed marker is altered,
the option Maintain bundle position appears. It con‐
trols the transfer of placement positions of already
placed pieces.
If this option is active, the bundles remain at their
original position. During alteration of the size run, al‐
ready placed pieces may overlap. The basic structure
of the marker is retained. Use this option if the basic
structure of the marker must not be altered but var‐
ious sizes will be changed.
If this option is inactive, the sizes remain at their orig‐
inal position. Use this option if single sizes are to be
changed with the other sizes remaining at their orig‐
inal positions, even if the bundle number is changed.
Example for the marker scheme all bundles same di‐
rection (one way):
before
after
1. bundle
38
40
2. bundle
40
42
If the option Maintain bundle position is active, size
40 will be placed where size 38 had been and size 42
is placed in size 40’s position. If the option is not ac‐
tive, size 40 remains in its position and size 42 is un‐
placed in the rack.
Marker making opens the marker interface, imme‐
diately.
Edit the marker information
Via the pull‐down‐menu Marker Information the file
cards Material, Pieces and Sizes can be opened, di‐
rectly. Alterations to the file cards are possible at any
time. They are automatically applied to the marker.
If overlapping or gaps occur, the marker must be re‐
processed.

Chapter 17 Marker making

291

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

The number of pieces in normal and flipped position
and the bundle name result from the settings on the
file cards in the marker information. If necessary, a
scroll bar appears for scrolling to the left/right.
Below the boxes of the rack, the sizes to be placed
and a capital letter for the bundle appear in the first
column. The numbers in the following columns rep‐
resent the amount of pieces in normal position (left)
and in flipped position (right). A clicked number is
highlighted in white and the respective piece of the
relevant bundle in the respective position hangs on
the cursor.

17.6 Marker making
Step‐by‐step guide
 Create or open the production style
 Enter the marker information
 Marker→ Marker making
First, prepare the production style and enter the
marker information. From the last file card Sizes the
button Marker making leads to the marker. If this file
card is already closed, the marker is opened via
Marker → Marker making.
Marker user interface

The material is situated at the base of the screen.
The width of the material was determined on the
Material file card. At the end of the material (right) a
marking for the efficiency in percent can be found.

The marker user interface (Picture 17‐9) is divided
into four areas:
 the rack,
 the pre‐lay area,
 the material and
 the status line.

The pre‐lay area is the area between the rack and
the material. It serves as a temporary store and can
be increased in size by folding the rack. Click the but‐
ton at the upper right end of the rack. Clicking
unfolds the rack.

The rack is situated at the top of the screen. It con‐
tains all pieces to be placed in all sizes or bundles.
The order of the pieces corresponds with the order
in the part list of the production style.

Rack
Pre‐lay area

actual end of marker

material

Display in the status line:
‐ marker length
‐ efficiency
‐ material usage
‐ material width
‐ pieces placed/total

Picture 17‐9
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The status line with information about the marker is
situated at the lower edge of the screen. The individ‐
ual fields show (from left to right):
 part number and name of the piece on or below
the cursor
 size and a capital letter for the bundle
 current length of the marker in m
 current efficiency in %
 usage per bundle (average) in m
 material width in m
 placed pieces/total number of pieces to be
placed
 placed production style

Sliding pieces
Click the piece for sliding so that it hangs on the cur‐
sor. Drag the piece with the left mouse button
pressed. A red thread appears, indicating the direc‐
tion of the slide (Picture 17‐10).

Call and place pieces from the rack
A piece is called from the rack by clicking the respec‐
tive number below the box with the left mouse but‐
ton. The piece hangs on the cursor and can be
dropped in the pre‐lay area or on the material with
another short click of the left mouse button.
Only pattern pieces on the material placed without
overlapping are displayed with colour fill.
A piece hanging on the cursor will cease to follow the
cursor as soon as it touches another piece on the ma‐
terial, the selvedge or an anchor line. At the same
time, a red thread appears between the piece and
the cursor. If the thread exceeds a certain length, the
piece will follow the cursor, even across the edge of
the material or already placed pieces. The length of
this so‐called search area can be altered via View →
Marker options.
To reposition already placed pattern pieces move
the free cursor (without pieces attached) over the
pattern pieces. In the status line at the lower edge of
the screen, the piece number and name, the size and
the bundle appear. The size and the bundle name are
also stated directly at the piece if this option is acti‐
vated under Marker → Options. Clicking on a piece
with the left mouse button picks up the piece.
All pieces of one size appear in one of seven colours.
Three different shades of a colour differentiate be‐
tween the bundles of one size.
A number of pieces can be called from the rack at the
same time by moving the cursor over the numbers of
the required pieces with the right mouse button
pressed. The right mouse button must be released
when still in the area of the rack. Thus, all selected
pieces hang on the cursor. With the left mouse but‐
ton the pieces are dropped in the pre‐lay area or on
the material, slightly removed. Sliding the stack is
also possible.

Picture 17‐10

As soon as the mouse button is released, the piece
slides against already placed pieces or into the near‐
est gap Picture 17‐11.

Picture 17‐11

The piece does not have to be picked up, first. The
mouse button may remain pressed, immediately.
Moving the mouse pulls the red thread. Releasing
the mouse slides the piece onto already placed
pieces.
Move a number of pieces
Click on a number of pieces with the <Ctrl> key
pressed down, let go of the <Ctrl> key, click quickly
on one of the selected pieces and move them.
Free anchor lines
In the area of the lower or left material edge the sym‐
bols
or
appear at the cursor. Having
clicked and dragged, a free moving anchor line ap‐
pears which can be positioned as required. The line
can be placed exactly at full cm values with pressed
<Shift> key. Already placed pieces in the area of the
line are switched to ‘unplaced‘.
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The free anchor lines behave in the same way as an‐
chor lines with regular distance, see section 17.5. De‐
pending on the setting of the switch use as auxiliary
lines only, the lines are simple docking lines or mag‐
netic lines.
To delete an anchor line, drag it to the edge. The
symbol
or
appears at the cursor. After
releasing the mouse button the anchor line is re‐
moved.
Zoom/refresh
<F6> toggles between
 zoom to optimum marker length and
 zoom to optimum marker width.
At the same time, the pieces in the pre‐lay area are
rearranged according to bundles and the screen is re‐
freshed. <F6> only changes the view if you have

zoomed into a detail or if the marker is not com‐
pletely visible at full marker width.
With <F4> or moving the marker to the left/right, the
screen is refreshed.
To reduce/increase the size of the marker, the al‐
ready known function move/zoom is available. It can
be called from the toolbox or from the pull‐down
menu Edit. Maximum scale is 1:1.
Undo or redo laying operations
While the marker user interface has not been closed,
any number of laying operations can be reset via
Edit → Undo (keyboard <Ctrl> + <Z>). Reset laying
operations can be reprocessed with Edit → Redo
(keyboard <Ctrl> + <Y>) as long as no new operation
has been performed.

17.7 Functions of Marker making menu
Constant functions
Almost all functions of the menu
strip are constant functions
indicated by
in the lower left
area of the button. For these
functions the following rule
applies:
If a constant function is active
and the mouse hovers over a
piece, a symbol at the cursor
indicates which function is
active. If the selected function
may not be applied to the piece
(e.g. rotation not permitted),
the icon
appears at the
piece. The active function is trig‐
gered with the right mouse but‐
ton.
Example: The function flip about
x axis is active. The icon
ap‐
pears at the cursor. After having
clicked a piece with the right
mouse button, it is flipped about
the x axis (if permitted for this
piece).

Marker making menu
properties
flip about X ▪ flip about Y ▪ rotate through 180°
rotate through +90° ▪ rotate through +45° ▪ rotate
through +1°
rotate through –90° ▪ rotate through –45° ▪ rotate
through –1°
nil piece ▪ all unplace
place automatically…
single pieces ▪ active unplaced pieces ▪ unplaced pieces
return…
single pieces bundles ▪ pieces
buffer on/off ▪ +/‐magnet
group ▪ fuse ▪ ungroup

split piece ▪ place piece in piece ▪ place piece with overlap

294
Chapter 17 Marker making
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

Overview of all functions in the menu strip
Function
properties

Icon

Flip:
about x

Description
Edit the piece properties
on the Pieces file card

about y

Flip about x axis (grain
line)
Flip about y axis

Rotate through….
180°

1/2 turn

+90°

1/4 turn to the left

–90°

1/4 turn to the right

+45°/+1°

45°/1° turn to the left

–45°/–1°

45°/1° turn to the right

buffer+/‐

Switch buffer (global +
piece‐specific) on/off
Activate magnet
function
Reset flip and rotation;
piece appears unplaced
(no colour fill)
All pieces are immedi‐
ately marked as un‐
placed.

+/‐magnet
nil piece

all unplaced

none

Automatic lay:
single
unplaced
active

none

unplaced

none

Return
single

The clicked piece is
placed, automatically.
All unplaced active
pieces are immediately
placed, automatically.
All unplaced pieces, also
from the rack, are imme‐
diately placed, automati‐
cally.

fuse

Return single piece to
the rack
Return all pieces of the
bundle to the rack
Return all pieces with
the same part number to
the rack
Group the hatched
pieces.
Fuse the hatched pieces.

ungroup

ungroup

split piece

Split piece with seam al‐
lowance.
place
piece
inside
another piece
place piece with overlap

bundle
pieces

group

piece in piece
overlap

Almost all functions can also be activated via the
keyboard.
Flip/Rotate
If the icon
for ‘function not permitted’ appears at
the cursor for one of the flip/rotate functions, it indi‐
cates that flip/rotate is not permitted for this piece.
To permit flip/rotate
 select properties from the right menu,
 click the piece with the right mouse button,
 check allowance for flip/rotate on the open
Pieces file card,
 return to the marker with the button Close,
 reactivate the function for flip/rotate and
 click the piece to be flipped/rotated with the
right mouse button.
Nil piece
All flip and rotate operations are reset. The piece ap‐
pears in the original orientation and is unplaced (no
colour fill). The fixed settings remain intact.
Laying with magnet function
The magnet function +/‐magnet is used for aligning
pieces. The surrounding rectangle of the selected
piece(s) serves as the magnet. First, activate the
magnet function in the menu. Then, select the
piece(s) to which other pieces are to be aligned with
pressed down <Ctrl> key. Now, let go of the <Ctrl>
key, pick up another piece and move it to the
selected piece(s). The magnetic lines appear as an
echo in the vicinity of the selected piece(s). The piece
catches at the magnetic lines.
Automatic laying
The automatic laying function is not an automatic
nesting. The piece or the group is placed in the first
permitted position in the marker (from the left). An
optimisation considering perimeter or efficiency
does not ensue!
Automatic laying with the function single is useful for
placing lots of small pieces into gaps. The piece
clicked with the right mouse button is placed as far
to the left as possible.
This also applies to the functions unplaced active (for
unplaced pieces in the pre‐lay area and on the mate‐
rial) and unplaced (all unplaced pieces). Further op‐
tions for automatic laying can be found in the pull‐
down menu Marker.
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Trigger the active function with the right mouse button
Picture 17‐12

Group/fuse pieces
Only pieces placed on the material without overlap‐
ping (with colour fill) can be grouped. To create a
group, click the pieces once with the left mouse but‐
ton while keeping the <Ctrl> key pressed. The pieces
will be hatched. Then, activate the function group
and click one of the hatched pieces with the right
mouse button. The group can then be moved as one
piece. The functions from the menu can also be ap‐
plied to the group.
Only the allowances flip/rotate given to all pieces in
the group apply. If one piece may be rotated through
up to 15° and another up to 10°, the group consisting
of these two pieces may be rotated through a maxi‐
mum of 10°. The buffer apply to each piece of a
group, individually even after grouping.
To ungroup pieces, activate the function ungroup.
Clicking the group with the right mouse button dis‐
solves the group. To release individual pieces from a
group, the group must first be dissolved and then
grouped again.
To create a fusing group, all relevant pieces are to be
clicked with pressed <Ctrl> key, also. Then, activate
the function fuse and click one of the pieces of the
group with the right mouse button.
A window with the following options for the fusing
group appears (Picture 17‐13):
 method for creating contour (rectangle or sil‐
houette),
 addition in mm or % around the fusing group in
addition to the buffer of the fused pieces,
 maximum size of the fusing group, depending
on the size of the fusing press and
 a name for the fusing group.

The fusing group is
saved under the en‐
tered name as a new
piece in the produc‐
tion style. When lay‐
ing the interlining
marker, the shape of
the fusing group can
be transferred from
the
main
fabric
marker with this
piece.

Picture 17‐13

Split piece
Pieces can still be split
or duplicated in any
number in the Marker
making mode.
To split or duplicate a
piece, the function
split piece from the
right menu must be
activated first. Then,
the piece is to be
clicked with the right
mouse button. A win‐
dow with the follow‐
ing entry options ap‐
pears (Picture 17‐14):
To duplicate, enter
the required amount
in the field times and
click on the button
Duplicate.

Picture 17‐14
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To split a piece first, you have to select where the
piece is to be split. A piece can be split
 at a distance of xx millimetres from the top/
bottom/ left/ right,
 vertical/ horizontal in the middle or
 at the split line.
Then, the seam allowance to be added to both edges
is to be entered. Clicking the button Split splits the
piece.

17.8 Additional functions in the Marker
and View pull‐down menus
Some of the functions from the pull‐down menu
Marker are only available when the marker is open
or closed.

Place piece inside piece
When activating the function place piece inside
piece, the symbol
or the symbol
normal ap‐
pears at the cursor during marker making. The sym‐
bol indicates the set parameters for the piece. With
the parameter normal, the piece is placed normally,
without overlapping with other pieces. With the pa‐
rameter piece in piece, the piece can only be placed
fully inside another already placed piece.
This laying option is useful for multi‐layer cutting if
for example a piece is required only once. Thus, a dif‐
ferent smaller piece can be cut from a different layer
in the same position. Pieces placed with piece in
piece count as ‘placed‘ pieces. They are filled with a
background pattern on the material.
Place with overlap
Pieces can be placed with a small overlap. First, the
‘normal‘ pieces are placed. Then, the piece to be
overlapped is placed with pressed <Shift> key. Origi‐
nally the piece is shown without fill colour. Activate
the function place overlapped and click the piece
with the right mouse button. The piece now counts
as placed and is displayed with fill colour. The over‐
lap area is marked in colour on the material. The area
content of the overlap is limited to 50cm². Therefore,
it is not possible to create large overlaps.
End
With End or with the right mouse button in the menu
area, the marker making function is quit after a secu‐
rity question. The marker user interface can be reo‐
pened at the last stage of work via Marker → Marker
making

Picture 17‐15

Open Marker to open a previously saved marker.
Open Next Marker to open the next marker. Markers
are alphabetically ordered and the marker following
the active marker will be opened.
Save Marker saves the marker, immediately under
the name given.
Save Marker As... save the marker in a directory to
be selected and under a name to be entered.
Remove superfluous data should be used when a
marker has been layed and Always remove superflu‐
ous data during saving has been switched off. The
perimeters of the unplaced pieces and unplaced
sizes are removed from the marker. The marker file
becomes smaller. Always remove superfluous data
during saving can be switched on via Edit | Settings.
The two remaining options Save marker with preview
and More columns in detail view should be set only if
not working within a network. Otherwise, the win‐
dow for the Open Marker dialogue would build very
slowly. The option Save marker with preview also re‐
quires sufficient memory.
Marker making opens the marker user interface.
Replace layout transfers the layout of a previously
saved marker to be selected with identical amount
of pieces and bundles. A preview and/or a detail in‐
formation about the marker appears via the buttons
(list, details, preview).
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Delete layout data resets all layout data. Only the
marker information settings on the file cards remain
existent.
Automatic laying (as described two pages previ‐
ously)
 all pieces
 all active pieces from the pre‐lay area or the
material
 all pieces on the material
 all unplaced pieces*
 all unplaced, active pieces*
* These functions can also be found in the right menu
in the marker user interface.
Return (as described two pages previously)
 all pieces
 all unplaced pieces.
View → Marker options offer a window (Pic‐
ture 17‐15) with various display options in the
marker and settings for handling during laying. The
Search area for layout relates to the length of the red
thread during laying.

17.9 Plot marker
Output of a marker is started via File → Plot/Print...
The plot dialogue according to Picture 17‐16 opens.
In the section output to, select the plotter/ printer
for output. With the button Settings further settings
are offered.
If Plot with frame is selected, the frame of the plot
image is plotted. The frame is required, only when
plotting onto a number of pages which are to be
joined, subsequently frame by frame; or for output
in full scale to small scale printers/plotters.
If Stop before output is selected, the prepared plot
image is displayed. Output can still be aborted at this
stage.
A margin can be added to the left edge. This is useful
if a safety margin is required between the end of one
plot and the beginning of the next for output to a
number of pages, e.g. for output on a roll if the plot
is not cut off at the end.

Picture 17‐16

In the section Plot information the following can be
set:
The entry fields Scale factor and corresponds to 1:
are aligned. If the marker is to be plotted in original
size, the Scale factor must be set to 1 or corresponds
to 1: must be set to 1. For reduced output in scale
1:2 the Scale factor must be set to 0.5 or corre‐
sponds to 1: must be set to 2.
If adapt to page size is set the scale and page orien‐
tation are optimised by Grafis, automatically.
The digit for first bundle determines the number for
the first bundle in this marker.
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Marker Annotation determines if the marker is an‐
notated and how. The position of the marker anno‐
tation, start or end, orientation and whether the an‐
notation is to be plotted inside or outside the marker
can be selected. With the button Edit
the con‐
tent of the marker annotation can be edited. The
button
creates a new file. The marker annota‐
tion Marker all contains all codes which are replaced
with the respective text, automatically during plot:
Date:
{Sdt}
Time:
{Szt}
Efficiency:
{Sef}%
Usage per bundle:
{Svb}m
Length:
{Sln}m {Slc}cm
{Slm}mm
Marker width:
{Sbc}cm
{Sbm}mm {Sbr}m
No. of bundles:
{Sbz}
Size list:
{Sgl...............}
{Smd}
Production style:
Marker (File name):
{Ssb}
Article /marker code:
{Sar}
Material code:
{Smk}
Material:
{Smt}
Perimeter lengths:
{Sum} m
Shrinkage:
{Sdx} {Sdy}
Number of pieces:
{Snt}
Number of placed pieces:
{Sng}
Text for area weights, see section 18.15 and Marker
→ Characteristics:
Absolute weight:
Effective weight:
Waste weight:
Absolute weight per bundle:
Effective weight per bundle:

{Stw} kg
{Sew} kg
{Sww} kg
{Sbw} kg
{Seb} kg

The marker annotation is saved as a *.stx file in the
directory \Grafis\TEXTE.

Piece Annotation determines whether and how each
piece is annotated with a standard text. The content
of the piece annotation can be edited via the button
Edit. The button
creates a new file. The piece
annotation Pieces all contains all codes which are re‐
placed with the relevant content, automatically:
Date:
{Sdt}
Time:
{Szt}
Piece text:
{Stl}
Piece text area:
{Stb0106}
Size:
{Sgr}
Bundle as letter:
{Sbd}
{Sbn}
Bundle as number:
Source style:
{Sqm}
Source collection:
{Sqk}
Material code:
{Smk}
Material:
{Smt}
Amount per style (normal+ flipped):
{Snz}
Piece category:
{Skt}
Perimeter lengths:
{Sum} m
The piece annotation is saved as a *.ttx file in the di‐
rectory \Grafis\TEXTE.
Additionally, you can adjust if further information,
such as
 the grain line,
 other text,
 repeat lines,
 marking lines,
 auxiliary lines,
 the marker edge or
 anchor lines
is to be included in the output.
Plot starts the actual output.
The output of cutter data is started via File → Gener‐
ate cutter data see section 18.16.
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Not every user will require all the options available
for application during Marker making. The special
application options are summed up in this chapter.
The optimum way of working is often found, only in
a direct dialogue between the expert in the company

or the user and a Grafis expert, as company‐specific
requirements can often be fulfilled with a number of
functions and procedures. The aim is to find the fast‐
est and safest method of working.
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18.1 Alterations to the production style
Alteration service for production styles
When opening a marker which has been created
from a production style without connection parts,
i.e. created directly from a style of the Grafis Pattern‐
making, Grafis checks whether the original style has
been altered and offers updating of the style, if nec‐
essary.
Alteration service for production styles of connec‐
tion parts
When opening a marker which has been created
from a production style of connection parts, Grafis
checks for each connection part whether the source
style is still available and the piece in the source style
is unchanged. If this is not the case, the user is in‐
formed and asked whether the altered pieces are to
be updated, if necessary.
Alteration service for connection parts
Connection parts are parts inserted into the style in
the part organisation menu via insert connection
part. They are marked with the icon
in the part
list (Picture 18‐ 1). The part parameter of the se‐
lected piece appear on the respective file card

Picture 18‐ 1

. For each connection part, date/ time of last
edit and the source style and path are saved (Pic‐
ture 18‐2).
When loading a production style, marker and open‐
ing the part organisation, Grafis checks for each con‐
nection part whether the source style is still available
and whether the source part is unchanged. If a ques‐
tion mark
appears in addition to the connection
part mark, it indicates that the source style or the
source part are no longer available. The exclamation
mark
indicates that the source part has been al‐
tered. A marker can continue to be layed with the al‐
ready loaded pieces and sizes, irrespective of this.
This also applies if the construction style is no longer
available.

Picture 18‐2

A new connection can be set by clicking the button
on the right of the path to the source style in the
part parameter window. Select the new source style
and the new connection part.
Update single part/ all parts (for connection parts,
only)
To update single connection parts, open the Part Or‐
ganisation via: part rack → button
or Part Organ‐
isation from the pull‐down menu Production Style,
select the respective part and click on connection:
update
. With the button
the part parame‐
ters are also updated. The text box is always up‐
dated. The function connection: update should be
applied, especially if only individual pieces of the part
organisation are marked with
or if some parts
are to remain in their unchanged state.
Updating all connection parts of the production style
is started from the pull‐down menu Production Style
with Update All Parts or Update All Parts (with part
information).
After having updated the pieces, the already placed
marker remains existent. If overlapping or gaps oc‐
cur, the marker must be reprocessed.
NB: The alteration service can work only if the
source style and the complete path to the source
style (drive, collection, sub‐collection) have not
been renamed, moved or deleted.
Add sizes
Before adding one or more sizes, check in Grafis Pat‐
ternmaking that the parts have been graded in the
respective sizes in the source style. If not, grade all
parts in all sizes of the marker and re‐save the con‐
struction style under the same name.
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In Grafis Marker making, click on Size Table in the
pull‐down menu Production Style and add the miss‐
ing sizes. However, the size table can only be altered
without restriction if no marker information has
been entered and no marker is available. The perim‐
eters of the added sizes are only transferred after
having updated the pieces with Production Style →
Update All Parts.
Add pieces
Individual pieces can be added in Production Style →
Part Organisation as follows. First, a new empty part
is created with open or insert. The piece is inserted
with insert connection part, provided all required
sizes are available.
Replace style

Potentially new loaded sizes are added to the size list
of the style. Alternatively to Add style you can use
the options of Production style → Organise styles,
see section 18.2.

18.2 Organise styles
A marker can be compiled from different production
styles with the Organise styles dialogue from the Pro‐
duction style pull‐down menu. As opposed to Insert
connection (via part organisation → insert connec‐
tion part) all sizes of the loaded styles are organised
separately. The sizes appear organised according to
the loaded style on the Sizes file card. The amount of
sizes to be layed is stated per style even if the size
areas are identical in parts.

Production Style → Re‐
place Style replaces the
complete
production
style with a new produc‐
tion style to be selected.
The part parameter and
the content of the text
box are replaced, also.
The marker information
and the layout data of the
marker remain intact.
Prerequisite for replacing
a style is that all required
sizes are available and
the assignment of the
pieces is identical.
Add style
With Production Style →
Add Style the part list is
extended by the parts of
a complete style. All parts
of the selected style are
added to the end of the
part list. Prerequisite for adding a style is that all re‐
quired sizes are available in the style.

Picture 18‐3

The compilation in Picture 18‐3 consists of styles
‘Style_A’ with sizes ____36_0 to ____48_0 and
‘Style_B’ with sizes ____40_0 to ____46_0. Although
sizes ____40_0 to ____46_0 appear in both styles,
they are organised separately.

Picture 18‐4
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Therefore, the following can be determined:

The Set match relation dialogue

1x size ____42_0 from Style _A and
1x size ____42_0 from Style _B
2x size ____44_0 from Style _A and
1x size ____44_0 from Style _B

The match relations are set in the prepared produc‐
tion style with the Production style → Matching...
menu. They are initially assigned specific to the style
and independent from the fabric. Clicking Production
style → Matching... opens the dialogue according to
Picture 18‐5.

The corresponding view in marker mode is displayed
in Picture 18‐4.
As a result, identical sizes from different styles are
given different bundle names.
When generating style combinations via Insert con‐
nection part only the following would be possible:
1x size ____42_0 from Style _A and Style _B
2x size ____44_0 from Style _A and Style _B
The button Merge all styles combines all sizes and
creates the same status as with Insert connection
part.

18.3 Repeat
Step‐by‐step guide
 If required: construction of additional points and
lines as auxiliary objects for defining match rela‐
tions
 Compile production style
 Set style specific match relations between
pieces, independent of the fabric
 If required: set a match point on one piece of the
match group
 If required: set match relations for left and right
piece for one piece of the match group
 Save production style for further markers
 Enter the actual repeat information for a marker
on the Material card
 Layout the pieces.
Set points/lines in the construction style
If a style is to be used for layout with fabric repeat
(warp and/or weft), suitable points and lines must be
constructed in the relevant pieces within the style.
The actual match relations are set in the marker mak‐
ing software and attached to points or the begin‐
ning/ end of lines. Attaching to symbols is also possi‐
ble. In this case, the base point of the symbol applies.
The symbols ‘RP warp’ and ‘RP weft’ from the sym‐
bols menu are invalid for repeat but can continue to
be used as points for setting match relations.
The symbols ’RP warp’ and ’RP weft’ from the sym‐
bols menu are invalid for repeat from Version 9 but
can continue to be used as points for setting match
relations.

Picture 18‐5

The pieces can be moved freely by dragging with
pressed down left mouse button and should be suit‐
ably positioned first. All pieces with set match rela‐
tion are basically visible or can be made visible with
<F6>. Further pieces without match relation appear
once they have been made visible in part organisa‐
tion, also in the Set match relation dialogue. If re‐
quired, press <F6>.
The View size area allows selection of the currently
displayed size. Only one size is visible at one time.
The match relations apply equally for all other sizes.
Check whether the match relations have been set
correctly by displaying other sizes.
The Delete all button deletes all available match re‐
lations.
Set match relations between different pieces
’Match point’ creates a connection between differ‐
ent pieces. This match relation can apply to match

Picture 18‐6
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direction warp (repeat lines in grain direction)
and/or weft (repeat lines 90 degrees to the grain).
First, click a point at the beginning/ end of a line and
then, click the corresponding point in the other
piece.
In Picture 18‐6 the pieces ‘ft facing’, ‘front’ and ‘ft
side panel’ were matched in warp and weft. Thus,
they belong to a match group. Another match group
consists of ‘back’ and ‘bk side panel’. When placing
the pieces in the marker, the first piece can be
placed anywhere. All other pieces are matched cor‐
respondingly, see Picture 18‐7. The first three pieces
from Picture 18‐6were matched for fabric repeat in
warp and weft in Picture 18‐7.

Display and edit set match relations, context menu
Existing match relations are indicated with a green
line. Check whether the beginning and end points of
the match relation have been suitably selected by
displaying other sizes with View size and if necessary,
move the pieces freely with pressed left mouse but‐
ton. When clicking on a point of the match relation
with the right mouse button a context menu accord‐
ing to Picture 18‐8 appears.

Picture 18‐8

Picture 18‐7

In a similar production style, open the Set match re‐
lation dialogue, position the pieces and activate
Match point and Weft and Warp. Now click on the
corner point centre front/ hem in the facing. The cur‐
sor indicates either P or PL. P clicks on a point, PL
clicks on the beginning/ end of a line. It is recom‐
mended to click on the sewing line rather than the
cut line as the repeat applies to the sewn garment.
Then, click the corresponding point in the ‘front’
piece. The match relation is set and indicated by a
green line. If no suitable points are available, they
have to be constructed subsequently in the style.
When setting match relations, all possible style spe‐
cific relations should be set in warp and weft direc‐
tion. If a specific fabric has only one repeat, only this
repeat will be utilised during marker making. If a
fabric has no repeat, the style can be laid out with‐
out repeat.

The first section and the line Symmetrical optic... in‐
dicate the type of point. These settings cannot be al‐
tered here.
The lines ...warp and ...weft indicate the match direc‐
tion(s) set for this match relation. The match direc‐
tions can be altered in the context menu directly by
clicking.
Clicking Delete entry deletes the match relation.
To close the context menu click on ‘Cancel’. Clicking
outside the context menu sets a new relation!
In the Set match relation... dialogue the following
symbols apply:
Marking on the
Significance
piece
match relation with the two
match points
placement point
match point right – left piece

Cursor

Significance
relation applies to warp and
weft
Relation applies to warp
Relation applies to weft
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Match point right – left piece
The match relations with Match point apply to both
mirrored and unmirrored pieces in the same way.
The mirrored, matched pieces form one group and
the unmirrored, matched pieces form another
group. With ‘match right and left piece’ a piece is
matched with the mirrored piece, see example in
Picture 18‐9.

Symmetrical optic
The fabric pattern is repeated symmetrically to the
centre front.

Picture 18‐10
Continuous optic
The fabric pattern continues evenly across the centre front.

Picture 18‐9

When setting a Match point right – left piece you can
select between symmetrical or continuous optic.
Symmetrical optic is used for most styles. For exam‐
ple for jackets or blouses where the fabric should be
repeated symmetrically to the centre front or centre
back.
Continuous optic is useful for panel skirts for exam‐
ple where the fabric pattern is continued across the
centre front or centre back.
For the example from Picture 18‐9 both options are
indicated in Picture 18‐10 and Picture 18‐11.

Picture 18‐11

The Match point right – left piece is relevant for both
warp and weft direction. In warp direction, the
pieces are matched symmetrically or continuously to
the warp pattern. If the weft direction is also active,
the mirrored pieces are also matched to one another
in the weft, see Picture 18‐10 and Picture 18‐11.
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Placement point

Summary and tips for setting match relations

’Placement point’ creates a direct link between the
piece and the fabric. It is required when a fabric pat‐
tern is to be position in a particular place of the piece
such as for appliqué or distinctive stripes. The place‐
ment point is mirrored with the mirrored piece. It
will point to the same place in the repeat.
Either one ‘match point right – left piece’ or one
placement point can be set per group.

1.

Placement point at the marked position

2.

3.
4.

5.
B

6.

A

7.

Match relations should be set style specifically
and independent from the fabric considering all
possible match directions in warp and weft.
First, set the match points. All pieces, which are
connected through match points, form a match
group. The piece placed first determines the po‐
sition of the other pieces in the match group.
Either one placement point or one match point
right – left piece can be set per match group.
Use the sew line for setting the match relations
rather than the cut line as the repeat applies to
the sewn piece and the seam allowance could
vary in width.
Construct sufficient auxiliary lines and points for
setting match relations before starting marker
making. Match relations can also be attached to
dashed lines and symbols. When attaching to
symbols, the base point of the symbol is utilised
automatically.
ATTENTION! Matching right ‐ left (unmirrored –
mirrored) pieces is often forgotten!
Check whether the match relations have been
set correctly by displaying other sizes.

Repeat settings on the Material card

Picture 18‐12

Picture 18‐12 shows a front with appliqué and a
placement point in two different positions. Pic‐
ture 18‐13 shows the layout for Picture 18‐12.

Placement point A

Placement point B

In the file card Material under Marker information, it
is determined whether the concrete material has a
repeat in warp (repeat lines in direction grain line)
or/and in weft (repeat lines vertical to the grain). The
fields for Distance and Offset of the repeat are only
active when the check mark for warp and/or weft has
been set. Distance gives the distance between the
repeat lines. From version 11 onwards these values
can be entered with decimal places. This enables lay‐
ing on pin‐stripe repeats. Offset shows the distance
of the first repeat line from the edge of the material
(from the left or bottom).
The match relations must be set for all pieces to be
placed in a repeat!

Picture 18‐13

In the Grafis Setup, Further repeat options can be en‐
abled, see Picture 18‐14. Sub repeats displays addi‐
tional auxiliary lines which have no further function
and which cannot be placed against. Use the sub re‐
peat as orientation for placing the first piece. The
permitted repeat deviation is the tolerance about
which a piece is permitted to be moved outside the
repeat. The option end with full repeat ensures that
the marker always ends with a multiple of the re‐
peat. The switch minus offset forms part of this op‐
tion. If this switch is set, the marker ends exactly with
the repeat line.
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Shrinkage values for the piece
Also during fusing with interlining the material may
undergo changes. As not all pieces are fused, shrink‐
age must also be adjustable for individual pieces.
If the values for shrinkage have been set on the Ma‐
terial file card, one of the following piece‐specific op‐
tions can be selected on the Pieces file card:
Picture 18‐14

During marker making, the repeat lines are only dis‐
played if they have been switched on under Marker
→ Options. Output of repeat lines for plot/ print is
set in the Plot marker dialogue (Picture 17‐16). For
plot output, the repeat lines can be set to appear as
short lines, only at the edge of the material with Edit
→ Settings.
The switch match only (placement point not active)
means that the placement points are not considered
for the layout. This switch is useful for example for a
very small check while the match relations have been
prepared for a distinctive fabric pattern.
With Match pieces without repeat matched pieces
are matched at the same height. This option is re‐
quired when the fabric has no obvious measurable
pattern but for example a colour gradation or irreg‐
ular repeat caused by distortion of the material.
Attention! When rotating or mirroring in Marker
making mode, match points are also rotated and
mirrored!

18.4 Shrinkage
Shrinkage values (global)
Many materials shrinks after being steamed or
washed. As the patterns are developed for the fin‐
ished garment, the shrinkage of the material must be
considered before cutting.
Enter the shrinkage values in warp or weft in the
marker information on the Material file card in the
Shrinkage values area after having set the respective
check mark. Negative values are permitted, also if
the material is stretched during processing. The
pieces are placed in stretched/ shrunk form. Chang‐
ing the shrinkage values for already placed pieces re‐
sults in overlapping/ gaps. Placed pieces have to be
repositioned.

 for piece and buffer
The shrinkage values relate to the piece perim‐
eter and the buffer line.
 for buffer line, only
The shrinkage values apply to the buffer line,
only. In this case, the original perimeter re‐
mains unchanged.
 do not apply
The shrinkage values are not applied to this
piece.
Shrinkage value assistant
Via the menu option Marker → Shrinkage value as‐
sistant, an already completed marker can be in‐
creased as a whole by a given percentage value. This
is only useful if the material width is big enough or
if there is a width reserve. The assistant (Picture 18‐
15) carries out the following steps:
 Alteration of shrinkage values on the Material
file card
 Increase of marker width by the % value in weft
direction
 Moving all pieces according to the shrinkage
values
Small overlaps of in‐
dividual pieces may
occur which usually
can be fixed rapidly.
As opposed to the
percentage increase
of a marker during
plot output with ad‐
ditional stretching,
in this case, all an‐
notation text is up‐
Picture 18‐15
dated. This includes
length and width of the marker as well as perimeter
lengths and area contents of the pieces.
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18.5 Spreading type
In the file card Material in section Spreading type,
the spread type for the material and the bundle di‐
rection is selected.

Folded laying up means a material of 1.50m
width is folded along its length (Picture 18‐19).
The marker is only 0.75m wide and has a fold.

Spreading types
The following spreading types are available for the
material:
 right‐left or ‘open’ is used for single‐ply and mul‐
tiple‐ply cutting. This is the most common spread
type (Picture 18‐16). The individual layers of fab‐
ric lie in the same direction with the same side

Picture 18‐16

facing upwards. Automatic spreaders lay one ply,
cut off at the end, return to the beginning and lay
the next ply in the same way on top. Patterns or
a possible pile face upwards in all layers.
 right‐right is used for multiple‐ply cutting (Pic‐
ture 18‐17). The individual layers of fabric all face
the same direction but with the other side up‐
wards. Automatic spreaders lay one ply, cut off at
the end, return to the beginning and lay the next

Picture 18‐19

Symmetrical pieces can be placed at the fold.
Symmetrical pieces must be marked with a check
mark on the Pieces file card in the Marker infor‐
mation. This check mark can only be set for
pieces which are not flipped.
In Grafis, the material appears unfolded but the
pieces can only be placed on the lower half of the
material. Flipped pieces automatically appear in
the upper half of the material. Symmetrical
pieces have to be dragged to the fold, only. They
will then appear placed on the fold.
 Tubular fabric is material in tubular form of half
width (Picture 18‐20). As opposed to the spread‐

Picture 18‐20

ing type folded, the marker has two folds. Every‐
thing else is identical.
Bundle direction
Picture 18‐17

ply turned over (with the right side facing down).
Patterns or possible pile face alternatively up or
down (see sketch).
The pieces are placed unflipped as the flipped
piece is taken from the turned ply.
With the spreading type right‐right, markers can
be created for zig‐zag lays, also (Picture 18‐18).
As opposed to the spreading type right‐right, the
ply is not cut off at the end. A right‐right layer is

Picture 18‐18

followed by a left‐left layer. Zig‐zag laying is un‐
suitable for materials with a sheen or pile.

For each of the spread‐
ing types mentioned,
three bundle directions
can be selected. The in‐
dividual sizes, which may
appear more than once,
Picture 18‐21
are arranged in bundles.
All pattern pieces of one garment are given one bun‐
dle letter (Picture 18‐21). The options for the bundle
direction relate to the question ‘Where does the
hem of the bundle lie?’.
 different bundles ‐ different direction (two‐way)
is used for material without sheen/pile, without
check and without a directional pattern. Bundle
A has the hem on the left, bundle B on the right,
bundle C has the hem on the left and so on.
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 all bundles – same direction (one‐way) is used
for directional patterns (e.g. a face) which cannot
be rotated.
 same sizes – same direction is used for material
with sheen/pile but without directional pattern.
This option ensures that pieces, accidentally
picked from another bundle of the same size still
have identical sheen direction. All bundles of size
38 would have the hem on the left, for example;
all sizes 40 would have the hem on the right etc.
 same sizes – same direction (compensational) As
opposed to the previous option, here, the bundle
direction is not categorically alternated from size
to size. An internal logic ensures that the number
of bundles in both lay directions is largely bal‐
anced. This option is particularly useful if the
quantity per size varies significantly
If the expert mode Swap bundle direction enabled is
activated in the Grafis setup, an additional button
Swap direction is visible on the Sizes file card. With
this button, the bundle direction can be specifically
set for each bundle. Select the bundle and switch the
bundle direction with Swap direction. If the bundle
direction is altered manually, none of the available
options for bundle direction will be activated on the
Material file card.

18.6 Fault areas
For faulty material, up to three (also regular) fault ar‐
eas can be defined and considered during marker
making. The respective settings are made in the
marker information on the Material file card. After
having checked Consider material faults, the button
Set values is active and can be clicked. The following
is to be entered in the next window for each fault
area (Picture 18‐22):






at warp (y)
width (dy)
at weft (x)
length (dx)
repeat (in x)

start from lower edge
width of fault area
start from left edge
length of fault area
distance between the starting
points of regular fault areas
The entered fault areas are indicated. With the check
mark Show fault areas only determines whether
pieces can be placed in the fault areas (check mark
set) or whether they are excluded from marker mak‐
ing (check mark not set).
The width of the Selvedge can also be entered in this
window. It appears as a dashed line in the marker
and serves as an additional anchor line.

Picture 18‐22

The settings for fault areas and selvedge remain in‐
effective, if the check mark for Consider material
faults on the Material file card is not set.

18.7 Categories
With categories, piece‐specific layout parameters,
especially buffer can be categorised. Prerequisite for
the use of categories is the existence of company‐
specific rules for buffers, e.g. in particular for sleeves,
collars, cuffs, loops etc. For each category, the pa‐
rameter on the Pieces file card of the marker infor‐
mation can be set. These are:
 fixed settings: rotation angle, flip about x, flip
about y
 allowances during marker making: tolerance
angle, flip about x or y, rotate through
180°/±90°/±45°
 buffer at top/ bottom/ right/ left
 application of the buffer: as invisible safety
margin, buffer line as cut line or reduce piece
by the buffer amount
 apply shrinkage values of the material to the
piece and the material, to the buffer, only or
not at all
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Set up categories
The category names are saved as measure group 999
in the file MASSCODE.DAT (directory \Grafis). Open
this file with an editor, e.g. Notepad. First, the name
for group ‘999.000.044’must be assigned.
The name of the category can contain letters and
numbers. Below, an extract from a MASSCODE.DAT
as example:
!----------------------- Group 999
999.000.044 Category
999.001.044 -- none/none
999.002.044 -D no turn/buffer
999.003.044 -B no turn/block
999.004.044 –S no turn/reduction
999.005.044 ID turn 180°/distance
999.006.044 IB turn 180°/block
999.007.044 IS turn 180°/reduction
999.008.044 XD turn 90°/distance
999.009.044 XB turn 90°/block
999.010.044 XS turn 90°/reduction
999.011.044 OD turn by 45°/distance
999.012.044 OB turn by 45°/block
999.013.044 OS turn 45°/reduction
999.014.044 I- turn 180°/none
999.015.044 X- turn 90°/none
999.016.044 O- turn by 45°/none

After having saved the MassCode.dat, the categories
can be assigned to pieces. Assigning ensues in the
part organisation in the piece parameter window
(Picture 18‐23), in construction style or in the pro‐
duction style.
Assign categories with piece‐specific parameters

 Duplicate part 001 until the part number is iden‐
tical with the required number of categories.
 Set the attribute Production piece for each part in
the part organisation and assign consecutive
piece categories (part 001 becomes the first cat‐
egory, part 002 the second category etc.).
 Save the style.
Now, the steps in Grafis Marker follow:
 Open the new style.
 Marker Information → Pieces
 Set all parameters to apply to the first category
for part 001. For part 002, set all parameters to
apply to the second category etc. until the last
part.
 Button Next, button Close
 Save this link between piece‐specific parameters
and the categories as a *.sbi file with Marker In‐
formation → Save As ....
 If the parameters are also dependant on the ma‐
terial type, a number of these files can be set up.
In the *.sbi files, not all categories must be assigned.
Later, the pieces are assigned with only the catego‐
ries which have been set up in the *.sbi file. A *.sbi
file is basically an empty marker with an empty part
list, similar to a format template for word‐pro‐
cessing.
Load piece‐specific parameter from a *.sbi file
To use pre‐set marker information/ categories, the
file card Pieces is to be opened for a loaded produc‐
tion style. The parameters can be transferred from
the *.sbi file in two different variations:
A) All pieces of a production style which are as‐
signed a category, are assigned with the parame‐
ters in the Buffer section, only (buffer at
ri/le/top/bottom with two options). In this case,
select the *.sbi file in the list or with the button
from file directly below Pre‐set buffer.
B) All pieces of a production style which are as‐
signed with a category, are assigned with all pa‐
rameters in the sections Buffer, Fixed settings, Al‐
lowance and Shrinkage values for the piece. In
this case, select the *.sbi file in the list or with the
button from file directly below Pre‐set (all).
Edit *.sbi file

Picture 18‐23

The procedure for assigning categories, for in Grafis
Patternmaking:
 Open new style.
 Construct a rectangle of any length in part 001.

To edit a *.sbi file, load the file via Marker Infor‐
mation → Open and save after editing with Marker
Information → Save. Alterations only become effec‐
tive after re‐loading the piece‐specific parameter of
the edited *.sbi file.
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18.8 Step lay (free mode)
The marker type Step lay is selected under Marker
Information → Sizes. In a step lay with two materials
(Picture 18‐24), the following sizes are to be layed:
1st step

2nd step

B
A
Picture 18‐24

Material A
Material B
size 38
1x
size 40
2x
1x
size 42
2x
1x
size 44
1x
The distribution of the sizes onto the different steps
is to be optimised by the user. The example plan can
be realised as follows:

1st step
2nd step
size 38
1x
size 40
1x
1x
size 42
1x
1x
size 44
1x
After having checked Step lay (free mode) on the
Sizes file card, additional buttons appear (Picture 18‐
26).
After Remove all, first transfer the sizes for the first
step and then, the sizes for the second step with dou‐
ble‐click from the size list in the middle of the win‐
dow. Then, select the first size of the second step

Picture 18‐25

Picture 18‐26
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(here: 38) and click on Start new step. After entry of
the required amount, the bundles appear on the
right. A continuous line in the left and right window
marks the start of the new step. All pieces of bundles
A and B belong to the first step, all other pieces to
the second.
During marker making, the sizes are offered, sepa‐
rately for the different steps in the rack (Picture 18‐
25).
The end of the first step is marked, automatically in
the marker. It is situated at the right edge of the
piece furthestmost to the right of the first step (Pic‐
ture 18‐27). The marker can be interlocked. The end
of the step(s) is marked at the edge when plotting.
end of 1st step
x: pieces of 1st step
x
x
x
x
x

x
x
x
Picture 18‐27

18.9 Marker sequence
A number of markers can be plotted in sequence.
This function is required for plotting multiple size
markers as a marker sequence, but also for quick
output of ‘mini markers’ for control purposes. The in‐
dividual markers are to be prepared in Grafis and are

to be saved as marker. Then, the marker sequence is
assembled via File → Plot Marker Sequence and can
be output, immediately if required. The function File
→ Plot Marker Sequence is only active if no marker
and no production style are open. If File → Plot
Marker Sequence is inactive, the production style or
the marker must be closed via File → Close.
The individual markers are loaded and arranged in
the Plot marker sequence window (Picture 18‐28).
For each marker, the number of the first bundle is to
be determined. An optional distance between the in‐
dividual markers can also be entered.
If required, a marker sequence can be saved, tempo‐
rarily with Save list and send for plotting, later.

18.10 Hem position
In the Grafis Setup, the hem
position can be aligned be‐
tween patternmaking and
marker making. Click on Hem
position on the Other file
card in Grafis Setup. The win‐
dow shown in Picture 18‐29
is opened.
Picture 18‐29
The piece is aligned accord‐
ing to the setting under Hem position in the construc‐
tion, only if no grain line symbol or grain line indi‐
cates the grain. The Hem position in the marker al‐
ways applies.

Picture 18‐28

312
Chapter 18 Marker making 2
___________________________________________________________________________________________
©Friedrich: Grafis – Textbook, Edition 2017

The hem direction is saved in the marker. When
opening a marker, the hem direction is checked. If
the hem direction in the marker is different from the
hem direction in the settings in the Grafis Setup, a
query appears. You can decide to retain the hem di‐
rection of the marker or rotate all pieces according
to the hem direction pre‐set in the Grafis Setup.

18.11 Line types
With the construction function
attributes individual lines can be
assigned particular significance,
which are interpreted in the
marker.
The optional annotation line is
used to attach and centre the
piece text, align it and ‐ if neces‐
sary ‐ reduce to the length of the
line.

Picture 18‐31

A line of the part can be assigned as grain line. How‐
ever, the grain line symbol (set by function symbols)
takes priority. If the grain line is to apply for a piece,
no grain line symbol must be set.
The optional split line
can be used to split a
piece in the marker.
During marker making,
activate split piece from
the right menu and click
the piece with the right
mouse button. In the
following dialogue (Pic‐
ture 18‐30) the split line
can be selected as the
cut line. The seam al‐
lowance can also be set.

In the Line types dialogue, the grain line, annotation
line etc should not be assigned. Only if the user has
worked with particular settings in this area with Ver‐
sion 9 or earlier, should these settings remain in
place.

18.12 Material catalogue/ material pre‐
selection
A material catalogue for use in the Material file card
of the marker information can be set up. Material
data saved in the material catalogue, such as mate‐
rial width, repeat information or material type is ac‐
tivated via selection in the combo box. Alteration to
the material data can be transferred to the material
catalogue with the button Save. After entry of a new
catalogue designation and activating the Save but‐
ton, a new entry is added to the material catalogue.
With the Delete button, the selected entry is deleted.
Use the material catalogue to quickly load frequently
required materials.

The optional cut inter‐
nal lines are cut during
cutting and are always
plotted.
Picture 18‐30

The seam line is inter‐
preted only during export in ASTM format. It has no
significance for the marker.
During plot/print from the marker, marking lines
and/or auxiliary lines can be selected, additionally
for output. Which line types are to be interpreted as
marking lines or auxiliary lines have to be deter‐
mined in the Line type dialogue (Picture 18‐31). This
dialogue is opened via the Grafis Setup on the file
card Marker with the Line type button. Line type 1 is
the continuous line, Line type 2 is the dotted line etc.

The material catalogue is saved as Material.dba un‐
der \Grafis. The file can be edited with the editor
Notepad according to the following principle: In each
line, the following information is to be entered, sep‐
arated by <Tab>:
 consecutive number
 name of the material
 width in mm
 material type code
 repeat in warp in mm
 repeat in weft in mm
 offset for warp in mm
 offset for weft in mm
If the value for repeat in warp or weft is 0, no repeat
is applied. In the future, the shrinkage values will also
be included in the material catalogue.
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18.13 Overlap areas
Via the Overlap area dialogue, areas in the marker
can be indicated where material can be restarted.
This option is required for using up material rem‐
nants or if material has to be cut and restarted due
to material flaws, see Picture 18‐32.

Overlap areas activated in the dialogue are shown as
hatched areas in the marker. To ensure that each
pattern piece is cut correctly once, the previous layer
(material end) has to be layed at least to the right line
and the following layer (material start) must be con‐
tinued from the left line, see Picture 18‐33.
In the plot picture, the overlap areas are indicated
with a marking at the top edge of the marker. These
markings appear at the bottom edge of the marker
as well if the option display marking also at bottom
edge of plot picture is selected in the Overlap area
dialogue.
Even after having activated overlap areas, pieces can
still be placed or positions can be changed. If how‐
ever the position of a piece which defines the over‐
lap area is changed, this overlap area is no longer
valid and is removed. Replacing the piece does not
re‐activate the area. Open the Overlap area dialogue
and re‐activate the selected area.

Picture 18‐32

A list of possible overlap areas appears in the Overlap
area dialogue. You can select which overlap areas
are to be shown in the marker. Initially, only the ar‐
eas with the shortest overlap lengths are selected.
With All you select all areas, with None all areas are
switched off. Typical activates all areas with an over‐
lap length of up to 30cm.

18.14 Exchangeable pieces
The Exchangeable pieces dialogue allows for exam‐
ple the production of the side panel of a jacket as a
two‐piece in the smaller sizes and a straighter cut
one‐piece for the larger sizes, seePicture 18‐34 with
parts 013, 014 and 015.
If no other selections have been made in the Ex‐
changeable pieces dialogue, the three pieces appear
in the marker in all sizes. The Exchangeable pieces di‐
alogue appears in part organisation on the respec‐
tive file card. First, all sizes are marked and thus, ac‐
tive for marker making. By clicking the sizes or an
area of sizes, the selection can be changed. For the
two‐piece side panel in Picture 18‐34, parts 013 and
014 must be selected one after the other and the
sizes N34 to N42 must be activated in the Exchange‐
able pieces dialogue. Then, activate sizes N44 to N48
for part 015, see Picture 18‐34.
During grading of the style, all parts are calculated
in all sizes and exported during ’Export pattern
pieces’.

Picture 18‐33

The settings in the Exchangeable pieces dialogue are
taken into account in the Grafis Marker, Picture 18‐
35. The settings are not significant for grading or ex‐
port.
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Picture 18‐34

Picture 18‐35
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18.15 Additional options
Dialogue Marker Characteristics
Via Marker → Characteristics... the dialogue shown
in Picture 18‐36 opens. In the simple variation, this
dialogue shows some basic information about the
marker: width, length, efficiency, name of the pro‐
duction style and the number of pieces and bundles.
With the button
Extended>> the di‐
alogue switches to
a more detailed
version. It allows
for indication and
calculation
of
weights and costs.
The entry field for
area weight and
price per meter
are saved with the
marker. A number
of values are cal‐
culated on the ba‐
sis of the entered
data, such as total
cost or the effec‐
tive weight per bundle.

Picture 18‐37

General options
In the lower part of the dialogue, you can find gen‐
eral settings. If fusing blocks are contained in a
marker, their content can be saved as a separate cut
file: set the option generate separate file for fusing
blocks. These separate files are required for subse‐
quent cutting of the small pieces.
Picture 18‐36

Toolbox
The toolbox contains the most commonly used func‐
tions. It can be turned on/off in the View pull‐down
menu. The content of the toolbox is determined via
the Grafis Setup.

18.16 Cutter output
The output of cutter data is optional. It is enabled
and set up by the Grafis Team.
Control data for a cutter can be created directly from
a placed marker. File→ Generate Cutter data opens
a dialogue in which you can select the cutter and de‐
termine some options, see Picture 18‐37.
Cutter‐specific options
The options cut notches and set drillholes control the
output of the respective symbols. The option rotate
notches inside/outside rotates V notches and rectan‐
gle notches by 180. If the cutter can also plot, fur‐
ther options are available. In this case, annotation,
text and internal lines can be output as drawn ob‐
jects. Adjustment of the annotation can only be
made in the plot dialogue.

The option divide into file segments at split line is
useful for large marker files, longer than the length
of the cutter table. To consider a cutter table length
of 10m, set the display of anchor lines to every 10m
on the Material file card. Considering the anchor
line, you can create a marker of 12m length for ex‐
ample. With the set option, two cutter files are out‐
put, one with 10m length and one with 2m length.
The option generate info file creates a text file con‐
taining information about the marker. This includes
data such as length, width and name of the marker.
Additionally, each part of the cutter file is assigned
the original Grafis part name.
With the option show summary, after creation of the
cutter file, a summary is displayed containing infor‐
mation about length, width, cut path length, free
travel, amount of drillholes and amount of notches
amongst others.
If the option initial cut point, direction and cut se‐
quence manually is set, a further dialogue opens
where cutting settings can be controlled and altered
specifically for each piece.
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The Cutter menu
The Cutter menu opens during generation of cutter
data if the switch initial cut point, direction and cut
sequence manually is set.

If the function initial cut point is active, the initial cut
point for each piece can be dragged with the mouse
to a different point of the perimeter. With reset the
original initial cut point is reinstated.

Cutter menu

18.17 Autonester

determine cut sequence ▪
reset

The control of Autonester is optional and is enabled
and set up by the Grafis Team.

cutting direction...
invert ▪ all clockwise ▪ all
counter clockwise
reset
initial cut point ▪ reset

start output

If the Cutter menu is active, the number in the cut
sequence, the cutting direction and the initial cut
point are indicated for each piece, see Picture 18‐38.
These current settings can still be altered at this
stage.

The Grafis Autonester is an optional additional soft‐
ware package for automatic nesting. The marker is
prepared as usual. On the Material file card, enter
the material width, the fabric type and the spreading
type. On the Pieces file card permission for rotation
or mirroring in the marker can be given. The last step
is setting the desired size run. Having opened the
marker making mode, the marker is sent to Auton‐
ester via Marker → Send to Autonester.
The Grafis Autonester is a separate program with its
own user interface. During calculation of a marker,
the interim results appear in a control window. The
length and efficiency of the current interim result is
shown in the title bar of the control window and in
the Autonester window, see Picture 18‐39. A refer‐
ence to the interim result of the respective marker
appears in the Grafis Marker.

initial cut point

cut sequence

33

cutting direction
Picture 18‐38

With the function determine cut sequence, the se‐
quence in which the pieces are cut can be re‐deter‐
mined. Activate determine cut sequence and then
click on the piece to be cut first with the left mouse
button, then the second and so on. With reset the
original sequence is reinstated. If you now want to
determine the first piece to be cut again, de‐activate
determine cut sequence and then re‐activate the
function.
The following three functions influence the cutting
direction. The functions all clockwise and all counter
clockwise set the cutting direction of all pieces to
clockwise or counter clockwise. With the function in‐
vert cutting direction the cutting direction can be
changed for individual pieces by clicking on the
piece. With reset the original cutting direction is re‐
instated.

Picture 18‐39

As Autonester works independently of the marker
making program, you can continue working parallel
to the automatic nesting. As soon as the Autonester
has been processed the marker, a reference appears
in the marker making program and the calculated
marker can be transferred, see Picture 18‐40.
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Often,
several
markers are to be
created for an or‐
der. From the Size
file card, the differ‐
ent size range
markers can be
transferred rapidly
to Autonester. Se‐
lect the desired size
combinations and
save an empty, un‐
placed marker. If
the option Create
Autonester order
during save is ac‐
tive, the marker is
sent automatically
to
Autonester
when saving the marker.

Picture 18‐40
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The Grafis Programming Language is used for devel‐
opment of basic blocks and construction compo‐
nents. The individual steps for generation of a basic
block are entered as text.
'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar rWi3,rWi7
pVar p1,p2,p3,p4,p5,p6,p7
sVar
qVar q1,q2,q3
tVar
cVar
'------------------------------------lCon
nCon
rCon rRi=0,rLe=180,rUp=90,rDo=270
rCon rClLng=150
tCon
'------------------- x value definitions
XTitel("collar band")
Defx(1,"raise CB",35)
Defx(2,"collar fall width",20)
Defx(3,"collar width CB",40)
Defx(4,"collar point(x) to p3",40)
Defx(5,"collar point(y) to p3",45)
Defx(6,"ang neck+foldline in p3",90)
Defx(7,"ang collar edge in p7",80)

Basic blocks should be developed in the program‐
ming language if a company‐specific fit or a complete
component solution is to be developed.

'--------------------------- points at CB
p1 = pXY(0,0)
p2 = pXY(0,rX(1))
p4 = pPRiLng(p2,rUp,rX(2))
p5 = pPRiLng(p4,rUp,rX(3))
'--------------------corner point p3 (CF)
p3 = pXY(rClLng,0)
p6 = pPRiLng(p3,rRi,rX(4))
p7 = pPRiLng(p6,rUp,rX(5))
'------------------------------ neck line
rWi3 = rWiPPP(p6,p3,p7)
rWi3 = rWi3+rX(6)
q1 = qSpline(p3,rWi3,p2,rLe)
q2 = qSpline(p3,rWi3,p4,rLe)
'---------------------------- collar edge
rWi7 = rRiPP(p7,p3)-rX(7)
q3 = qSpline(p7,rWi7,p5,rLe)
'------------------ output points + lines
AusP(p1,p2,p3,p4,p5,p6,p7)
AusQ(p2+p5)
AusQ(p3+p7)
AusQ(q1,q2,q3)
'------------------------------------End Program
'*************************************

p5

p4

p7
X7

p2
X6
p1

p3

p6
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It is to be considered that the programming language
is an abstract form of pattern development. Apart
from excellent pattern construction knowledge and
experience in the application of Grafis, considerable
familiarisation time is required. For development of
production patterns from prepared, adjusted basic
shapes, the functions of the Grafis dialogue are the
more appropriate tools.

 Project name: square
 enter 9‐digit code for your name (according to
Picture 19‐4)
 enter 2‐digit code for the product group, e.g.
“TB“ for Textbook exercises
 With <OK>, the project is created.

19.1 A simple program: square

'*************************************
Program Main()
'- Program: square
'- Declaration lines
lVar
nVar
rVar
pVar
sVar
qVar
tVar
cVar
'- Constants
lCon
nCon
rCon
tCon
'- Allocations / Instructions
'- Program end
End Program
'*************************************

Introductory notes
From version 8 onwards, the new programming lan‐
guage is part of the Grafis package. It is a compiler‐
oriented programming language. The programs are
no longer processed, interpretively but in machine‐
similar code. The processing of the programming lan‐
guage program is therefore, significantly faster. The
new programming language contains many tools
common in other programming languages; adapted
to the requirements of pattern construction. The use
of sub‐programs is also possible, so that repeated
calculations can be saved as sub‐programs. The clar‐
ity, in particular for the text display and the syntax
check have become better and more accurate com‐
pared with the previous programming language. Us‐
ers who have worked with the previous program‐
ming language will, at first, find the current language
more complex. With further observation, it will be‐
come clear that the new techniques allow for a
shorter and more transparent programming.
Square
In the first project a square (Picture 19‐1) is to be
constructed which will later be transformed into the
shape of a house as in Picture 19‐2.
Start the new project “square“ as follows:
 Extras → Programming language
 Project → New...
p02

p03

100 mm

100mm
p00

p01
Picture 19‐1

The structure of the program Main() has been set
up in the edit window (Picture 19‐5). Edit the pro‐
gram as follows:

After a first compilation with the button
or <F4>,
the program thus far has been automatically format‐
ted:
'*************************************
Program Main()
'--------------------- Program: square
'------------------- Declaration lines
lVar
nVar
rVar
pVar
sVar
qVar
tVar
cVar
'--------------------------- Constants
lCon
nCon
rCon
tCon
'---------- Allocations / Instructions
'------------------------- Program end
End Program
'*************************************

The construction of a square can be carried out as
follows:
 assign points p00 to p03
 output points p00 to p03
 output connecting lines between the points
The following allocations/instructions lead to the re‐
sult:
'--------- Allocations / Instructions
p00= pXY(0,0)
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p01= pXY(100,0)
p02= pXY(100,100)
p03= pXY(0,100)

p04

The function pXY() constructs a point from the x
and y co‐ordinates to be entered. The x co‐ordinate
of point p01 has the value 100 and the y co‐ordinate
the value 0.
AusP(p00,p01,p02,p03)

With the instruction AusP the listed points are out‐
put to the screen. Without this instruction line, the
points are assigned in the program but are not dis‐
played on the screen.
After entry of the five lines, compile the program
with

and then test it in the test run with

p02

p03

.

Clicking
switches to the Grafis screen and the
points of the square appear. The Grafis screen can be
closed with the right mouse button.
With the instruction AusQ, individual lines, curves
or polygons are output. Select Inner Fcn in the varia‐
ble list and click on AusQ. A help text for the se‐
lected function appears below the edit window. The
connecting lines are output as one line, linked across
the corners with
p01

p00

AusQ(p00+p01+p02+p03+p00)

with the lines
Picture 19‐2

AusQ(p00+p01,p01+p02)
AusQ(p02+p03,p03+p00)

the connecting lines are output as individual lines
from corner to corner. The line does not have to be
created as a variable, first. The calculation can ensue
directly in the function. The lines
s1=sPP(p00,p01)
AusQ(s1)

lead to the same result as the line
AusQ(sPP(p00,p01))
AusQ(p00+p01)

or as

In the first option, the line is created as variable s1,
first and then output. In the second option, the line
is created directly in the instruction. The function
sPP(p00,p01) creates a line variable as a connec‐
tion between two points to be entered.
Variation “house“
The square can be transformed into a house (Picture
19‐2). An additional point p04 is to be created as the
apex of the roof. The lines are to be output, continu‐
ously.
The following allocations/instructions lead to the re‐
sult:
'------------ Allocations / Instruction
p00= pXY(0,0)
p01= pXY(100,0)
p02= pXY(100,100)
p03= pXY(0,100)
p04= pXY(50,150)
AusP(p00,p01,p02,p03,p04)
AusQ(p00+p02+p01+p00+p03+p04+p02+p03+p0
1)

Save the project via Project → Save and quit the pro‐
ject user interface via Project → End.

19.2 Data basis and user interface
Data basis
The development of a basic block ensues in a so‐
called project. A project consists of
 the modules in clear text,
 the object code for the project and
 the program in the processable programming
language as the result.
The project itself is saved as a directory. This direc‐
tory contains the modules in clear text and the object
code. The processable programming language pro‐
gram is saved directly in the \PROG directory of the
respective measurement system. Picture 19‐3 con‐
tains a detailed overview.
To copy or duplicate, it is sufficient to copy the com‐
plete directory \Grafis\Module\[meas‐system]\[Pro‐
ject name]. All data belonging to the project are in‐
cluded. To pass on a tested and released program‐
ming language program, it is sufficient to copy the
*.cpr file from the directory \Grafis\[meas‐sys‐
tem]\PROG.
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Grafis
|--Basis_A
|
|--PROG
|
|
|
|

*.cpr files (example: KFriedric_LA_c001_00.cpr)
These processable programming language programs contain all infor‐
mation required for processing of the module. To be able to run
styles in which this module was used on other computers, this file
must be also be transferred.

|-- ...
|--Module
|--Basis_A
|--\[Project name] Each project obtains its own directory under \Grafis\Module\[meas‐
system]\ in which all files of the project are saved. The project “Bod‐
ice 01“ in the Optimass measuerement system is saved as directory
“\Grafis\Module\Basis_A\Bodice 01“.
The project directory contains the following files:
 Modul.ini Initialisation file for the project
 Main.qpr Source code of the main program « Main » in RTF for‐
mat
 Main.qpt Source code of the main program « Main » as ASCI file
 Main.opr Object code of the main program « Main »
… and further files *.qpr, *.qpt and *.opr of possible sub‐programs.
Picture 19‐3

Start new project
List of recent program names
To develop a new
To pre‐set the entry fields, one of the recent
basic shape, start
names can be selected.
Grafis with the re‐
quired measurement
system.
Program‐
Code for the developer (9 digits)
ming with the pro‐
gramming language
Code for the product group (2 digits))
should ensue in a
new style so that im‐
Consecutive number (3 digits)
portant styles are not
accidentally reset or
Alteration code (2 digits)
overwritten.
A new project is
started via the pull‐
down menu Extras
Picture 19‐4
→ Programming lan‐
Name of the program file
guage and then, Project → New.... The project name
The name of the program file has a given, pre‐set
must not contain special characters (e.g. “!+‐ßäöü).
length of 20 characters. It has been lengthened by 12
A suitable name would be for example “Bodice 01“.
characters from version 7 or earlier. Thus, program
In addition to the project name (= directory for de‐
can be differentiated, more easily and use of the
velopment files, Picture 19‐3), a name for the pro‐
same name can be prevented.
cessable programming language program is to be
given. The window Grafis‐ Generate program file
name (Picture 19‐4) opens.
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Variable list
for display of
modules, func‐
tions...

Edit window
(editing the programs)

Help text for the selected inner function

Picture 19‐5

The name consists of the following codes:
KFriedric_LA_c000_00
|-- 9‐digit code for the developer
Examples:
KFriedric for Kerstin Friedrich
BBachmann for Betty Bachmann
FSBeautyW for Fred Smith, employee at the
company BeautyWear
RWRollerD for Roland Williams, working for
the company Roller Design
KFriedric_LA_c000_00
|-- 2‐digit code for the product
group
Examples:
LA
for ladies wear
ME
for menswear
CH
for childrenswear
KFriedric_LA_c000_00
|
3‐digit consecutive number
KFriedric_LA_c000_00
|
2‐digit alteration code
Only for the first project of a developer, the window
is to be filled in, completely. This includes in particu‐
lar the developer code and the code for the product

group. The consecutive number is suggested by
Grafis, automatically and should only be changed if
necessary.
The alteration code must be increased, if an already
delivered/ applied program is to be edited. The al‐
teration code can be increased in the project user in‐
terface with Extras | Option.
For further projects, a relevant name can be selected
from the list of recent project names and then,
adapted if necessary.
The project user interface
The three largest areas of the project user interface
(Picture 19‐5) are
 the edit window for entry of the programs,
 the variable list for display of available mod‐
ules, functions, ... and
 a window with help texts about the selected in‐
ner function.
The program Main is started, immediately as an
“empty“ program in the required structure, see Pic‐
ture 19‐5. All keyboard entries and the buttons
above the edit window apply only to the program
text. The variable list and the window with help texts
are display areas without entry option.

324

Chapter 19 Programming Language I

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis ‐ Textbook, Edition 2017

Edit functions
The following can be used for edit:
move cursor left, right, up, down

next line
 (Enter)
Home
cursor at beginning of line
End
cursor at end of line
Delete
delete next/selected character
Ctrl+Home
cursor at beginning of program
Ctrl+End
cursor at end of program
right mouse open the context menu = pull‐
button
down menu Edit
Analogous to other editors, selecting one or more
lines is possible by clicking at the edge of the line. Se‐
lected lines are moved with the left mouse button
pressed or copied with additional pressed Ctrl key.
Further edit functions can be found in the Edit pull‐
down menu which can also be opened as context
menu with the right mouse button.
Buttons compile and test
The functions most commonly used during program
development can be found on the buttons above the
edit window.
The fist block of buttons contains functions for com‐
piling and testing of programs:
compile (syntax check and first transla‐
tion)
create & test the program in test run
create & test the program with grading
show / hide VList entries;
If the VList() button is switched on, the
program is stopped at the VList stops
during create & test. The values of the
entered variable appear in the variable
list.
Display of the result of the last create &
test of the program
Buttons search and replace
The second block of buttons contains functions to
search and replace characters:
select all characters in the
program identical to the
characters in the field on
the right
search the characters in
the right field
replace the selected char‐
acters with the term to the
right of
Select the search term, e.g. p01 in the program. It au‐
tomatically appears in the search field to the right of
, in which the term could also be entered. Clicking

on
or
selects the next character string
found.
To replace e.g. p01 with p02, the following proce‐
dure is recommended:
 Select the search term in the program,
 enter the replace term (here: p02) to the right of
,
 Click on

if the selected term is to be replaced
with the replace term.

Button Comment out/ Uncomment program lines
Comment out selected lines
Uncomment selected lines
Select the program lines to be comment out and
then, click the button
. To uncomment selected
program lines click the button
.
The variable list
The buttons Module, Inner Fcn etc. above the varia‐
ble list work like file card tags. After having clicked
one of these buttons, the following is displayed in
the variable list:
Button
Content of the variable list
Module
all program modules (*.qpt files)
for the current project
Inner Fcn.
all inner functions
External Fcn.
all external functions of the cur‐
rent project (of all program mod‐
ules)
Objects
the output objects (points + lines)
with the data (o‐object number,
ty‐object type, po‐pos‐number)
Automatic formatting
Each compiling started with
or <F4>, automati‐
cally formats the program text as well as checking
the syntax. During automatic formatting of the pro‐
gram text, instructions are highlighted in blue, com‐
ments in green.
As a rule, instructions are indented by two charac‐
ters; in loops by another two characters. The first let‐
ter of the variable name must be in lower case and
the second letter must be in upper case.
To simplify entry of comment lines, the following
rules apply:
1. If a single inverted comma is entered in the first
column, the character following the inverted
comma will fill the whole line.
- becomes...
----------------------------------* becomes...
***********************************
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2. If a single inverted comma is entered in the sec‐
Type Explanation
Example
lXxx logical variable, which can lQuery
adapt the value True or False
nXxx number (whole number) with a nNum
value between ‐2*109 and
+2*109 (2.000.000.000)
ond or a following column, the text is aligned
right.
---Initialisation becomes...
---Initialisation
output points
becomes...
output points
3. One single inverted comma followed by a space
result in the text being unchanged.
 ---Initialisation
remains...
 ---Initialisation
 output points
remains...
 output points
Comments can also be entered in a program line to
the right of the instruction. Here, the second and
third rule apply.
Note: Test the automatic formatting and the rules
for comments with the still “empty“ program
Main().

19.3 Rules for programming
Ground rules













A program is set up in lines.
Each line contains an allocation or an instruction.
The line width should not exceed 64 characters.
Upper/lower case, spacing and possible indents
at the beginning of the line are formatted by
Grafis, automatically during compiling.
The inverted comma  indicates that the following
text is a comment which is not processed.
The character “&“ in the first column indicates
that the line is a continuation line.
The module Main() must be contained in each
project and contain the program Main().
Each project contains exactly one program with
the name Main(). This program is processed, first
after calling.
Each project can contain any number of inner
functions and any number of external functions.
The inner functions are part of the Grafis pack‐
age. External functions are programmed by the
user.
Each program begins with “Program Main()“
and ends with “End Program“.
Each function begins with “Function
xXxx()“ and ends with “End Function“.

Variables
In Grafis, variables of different types are used. The
variable name can consist of up to 64 characters,
where the first character indicates the variable type.
Variables can only be used after they have been de‐
clared at the beginning of the program or the func‐
tion. During declaration of variables memory is re‐
served and set to nil. The variable is then, available
until the end or the function or program.
The following variable types are available:
rXxx real number, accurate to 6 deci‐
mals
pXxx point with x and y co‐ordinates
sXxx line with start and end point
qXxx polygon / curve / line sequence
(q stands for queue)
tXxx text with up to 10.000 charac‐
ters
cXxx container

r01
pSln
sHem
qArm
tHelp
cBox

All variables used must be declared in the program/
function header. The declaration lines begin with
lVar for logical variables, with nVar for whole
number variables etc. For each variable type, a num‐
ber of declaration lines may be entered.
Example:
nVar nIs1,nIs2,nIndex
The values of the variables are set via allocation
lines.
The variable types l (logical), n (whole number), r
(real) and t (text) can also be defined as constants at
the beginning of the program/function. The defini‐
tion lines for constants start with lCon for logical
variables, with nCon for whole number variables
etc.
Example:
nCon nIs1=1,nIs2=2
Constants may not be declared as variables at the
same time.
Variables and constants apply only within the pro‐
gram or function in which they were declared.
All new variables used during programming, are au‐
tomatically entered into the declaration lines dur‐
ing compiling, provided a minimum of one (also
empty) declaration line is available for this variable
type.
Allocation
The character “=“ stands for allocation in all pro‐
gramming languages. As opposed to an equation in
mathematics, here it means:
The value of the term to the right of “=“ is assigned
with the variable to the left of “=“. Therefore, to the
left of “=“ must be a variable.
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The following line would be incorrect as a mathemat‐
ical equation. As an allocation for programming it has
the following meaning:
nNumber=nNumber+2
The variable nNumber must first be declared in the
program header. When processing this line, the term
to the right of “=“ is calculated, first and then, as‐
signed to the variable on the left of “=“. If nNumber
has the value 5 before processing the line, the result
of the term to the right of “=“ has the value 7. After
processing the line, the value of nNumber has been
increased by 2.
Instructions
With instructions, operations are carried out during
programming which can effect one or more objects.
In Grafis, instructions for move, rotate, flip or screen
output are available for one or more objects. Instruc‐
tions begin with a command word as opposed to al‐
locations.
Inner functions
Inner functions are prepared functions which are
part of the Grafis package. Inner functions which de‐
liver a value are used in calculations. Inner functions
which carry out an operation are used in instruction
lines. The range of inner functions is sufficient to pro‐
gram all steps common in pattern construction.
After having opened a project and having clicked the
button Inner Fcn. (above the variable list), all inner
functions are displayed in the variable list. Clicking
on a function highlights it. At the same time, a help
text on the selected function appears below the edit
window. Double‐click on the function inserts it into
the program.
The first character of the name of an inner function
which delivers a value, is a code for the type of the
delivered value. The types are identical to the varia‐
ble types. The function rG() delivers a real value.
The function pPRiLng() delivers a point.
Allocation of values
Declared variables are allocated a value with the fol‐
lowing instructions:
Logical variable
lQuery1=False
lQuery2=True
Number / whole number variable
nIndex=1
Mathematical calculations (addition, subtraction,
multiplication, division) of numbers, whole num‐
ber/real variables and whole number/real func‐
tions are possible. If the term on the right of the
“=“ does not deliver a whole number value, it is
rounded to the nearest whole number.

Real variable
rDistance=920*2/3+14
Here, analogous to whole number variables, math‐
ematical calculations are also possible. However,
the result is not rounded.
Point
p00=pXY(0,0)
Points are set with the use of the inner functions.
Copying a point with p31=p30 is also possible.
Line
sHem=sPP(p31,p42)
... analogous point
In addition, with sHem=-sHem the orientation of
the line can be altered.
Curve
qArm=qSpline(p01,r01,p02,r02)
... analogous line
Text
tInfo=“My first program.“
The text must always be placed between quotation
marks.

19.4 Program: Gradeable rectangle
Gradeable rectangle
A gradeable rectangle (width: bust girth, height:
body height) is to be constructed (Picture 19‐6). The
following lines generate the result:
'****************************************
Program Main()

'-------- Program: gradeable rectangle
'------------------- declaration lines
lVar
nVar
rVar rWidth,rHeight
pVar p00,p01,p02,p03
sVar
qVar
tVar
cVar
'--------------------------- constants
lCon
nCon
rCon rRi=0,rLe=180,rUp=90,rDo=270
tCon
'-----------allocations / instructions
p00= pXY(0,0)
rWidth = rG(2)
rHeight= rG(1)
p01= pPRiLng(p00,rRi,rWidth)
p02= pPRiLng(p01,rUp,rHeight)
p03= pPRiLng(p02,rLe,rWidth)
AusP(p00,p01,p02,p03)
AusQ(p00+p01,p01+p02)
AusQ(p02+p03,p03+p00)
' ------------------------ Program end
End Program
'*************************************

Chapter 19 Programming Language I

327

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis ‐ Textbook, Edition 2017

p03

Y

p02

130°

90°
X

180°
Height=g1

270°
Picture 19‐7

Width=g2
p00

p01
Picture 19‐6

The declaration of the new variables rWidth and
rHeight is carried out, automatically during first
compiling. It is not necessary to enter the variables
in the declaration lines, yourself.
Directions
Directions are given in angle degrees. A point is set
to the left if the value of the direction is 180. All angle
entries relate to the positive x axis and are anti‐clock‐
wise (Picture 19‐7). If you find it difficult to imagine
a direction in angle degrees, you should work with
direction constants, e.g. rRi=0, rLe=180,
rUp=90, rDo=270; see also program example
”gradeable rectangle”.
The functions pXY(), rG(), pRiLng()
The lines in the block ”allocations/instructions“ have
the following significance:
p00= pXY(0,0)
The variable p00 is allocated with the inner function
pXY(). The parameters after the open bracket
state the x and y co‐ordinates of the point. In this

case both co‐ordinates are 0. Thus, p00 is the zero
point.
rWidth = rG(2)
rHeight= rG(1)
The new variables rWidth and rHeight are allo‐
cated with values which are calculated with the inner
function rG(n). The function rG(n) calculates
the nth size value of the measurement chart. With
rG(1) the first value of the measurement chart (in
Basis_A: body height) and with rG(2) the second
value of the measurement chart (Basis_A: bust girth)
are transferred.
p01= pPRiLng(p00,rRi,rWidth)
The new point p01 is allocated with the result of
pPRiLng(p00,rRi,rWidth). pPRiLng()
calculates a new point which is to be positioned in
direction rRi and at distance rWidth from point
p00.
Instead of variables, functions of the same type and
for real/whole number parameter, numbers can be
entered in the parameter list of inner functions.
Thus, the following lines have the same meaning:
p01= pPRiLng(p00,rRi,rWidth)
p01= pPRiLng(pXY(0,0),rRi,rG(2))
p01= pPRiLng(p00,0,rWidth)
In the lines
p02= pPRiLng(p01,rUp,rHeight)
p03= pPRiLng(p02,rLe,rWidth)
point p02 is calculated from p01, upwards with the
distance of the rectangle height. The same applies to
p03.
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Output of objects, test program

Application of x values

AusP(p00,p01,p02,p03)
outputs the corner points of the rectangle to the
screen.
AusQ(p00+p01,p01+p02)
AusQ(p02+p03,p03+p00)
outputs the connecting lines between the corner
points to the screen as individual lines.
After having entered the program lines and having

x values must be defined in the program header, im‐
mediately after the declaration lines for variables
and constants. For definition of x values, the follow‐
ing applies
 With the line
XTitel(".............")
a program name is transferred which will later
appear in the x value list of the basic block. With
this, the user can recognise to which basic block
these x values belong. The title may have a max‐
imum of 50 characters.
 The x values must be defined at the beginning of
the program with the following instruction struc‐
ture:
Defx(1,".....",10.0)
Defx(2,".....",12.5)
| |
|
| |
|_
standard value
| |_______________ comment text
|_________________ consecutive number
 The standard values must only have one decimal
and must be between the values of
‐3200. <= value <= 3200.
 The consecutive numbers must begin with 1 and
ascend in numerical order (no gaps).
 Each x value can be assigned with size‐specific
values. The definition line of the x values is ex‐
tended as follows:
Defx(3,"addition to napewaist",0,
&
"_36",3,"_46",4,"_036",1,"_046",2)
| |
size value
(_ stands for standard measurement chart!)

compiled the program

, the program is to be cre‐

. The
ated & tested
. The result appears after
programming user interface reopens with the right
mouse button. With
instead of
, the program
is tested not just in the base size but in all sizes in the
size table and displayed after clicking
. For the
height of the rectangle to change, short/ long sizes
or individual sizes must be entered in the size table.

19.5 Program: Collar band
A collar band according to Picture 19‐8 with the ap‐
plication of the following x values is to be pro‐
grammed:
X Definition
Step
Value
1 raise CB
35mm
p1p2
2 collar fall width
20mm
p2p4
3 collar width CB
40mm
p4p5
4 collar point (x) to p3
40mm
p3p6
5 collar point (y) to p3
45mm
p6p7
6 angle fold + neck line
in p3
90°
7 angle collar edge
in p7
80°

p5

p4

p7
X7

p2
X6
p1

p3

p6
Picture 19‐8
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The sign & stands for a continuation line. The x
value definition line can have more than one con‐
tinuation lines.
The code ”Defx“ with consecutive number, name
and standard value can also be followed with
size‐specific x value allocations. In definition
blocks, a size is allocated with a value which the x
value is to apply for this size. The size names for
standard measurement charts must start with
"_" !
Programming of the points
As a rule, a program is developed in steps and tested
after each step. Only when the first step has been
successful, should the second step be commenced.
The first step for programming of the collar band is
the programming of the points at the centre back,
followed by the points at the collar point.
'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar
pVar p1,p2,p4,p5
sVar
qVar
tVar
cVar
'------------------------------------lCon
nCon
rCon rRi=0,rLe=180,rUp=90,rDo=270
rCon
tCon
'----------------- x value definitions
XTitel("collar band")
Defx(1,"raise CB",35)
Defx(2,"collar fold width",20)
Defx(3,"collar width CB",40)
Defx(4,"collar point(x) to p3",40)
Defx(5,"collar point(y) to p3",45)
Defx(6,"ang neck+foldline in p3",90)
Defx(7,"ang collar edge in p7",80)
'------------------------ points at CB
p1 = pXY(0,0)
p2 = pXY(0,rX(1))
p4 = pPRiLng(p2,rUp,rX(2))
p5 = pPRiLng(p4,rUp,rX(3))
'----------------------- output points
AusP(p1,p2,p4,p5)
'------------------------------------End Program
'*************************************

The entries in the line pVar are entered by Grafis,
automatically after compiling. The line rCon, how‐
ever, contains the assignment for the main direc‐
tions. A block with definition of the x values follows.
For the first comment line, it is sufficient to enter
'- x value definitions
The remaining characters are entered by Grafis dur‐
ing automatic formatting. The x values are defined,
consecutively in the following lines and contain no
size‐specific x values.

After having defined the x values, the first points are
constructed.
p1 = pXY(0,0)
... defines point p1 with the co‐ordinates (0,0). Thus,
p1 is the zero of the construction.
p2 = pXY(0,rX(1))
... defines point p2 with the co‐ordinates
(0,rX(1)), where rX(1) applies the value of the
first x value. Thus, p1 is positioned upwards by ”raise
CB”.
p4 = pPRiLng(p2,rUp,rX(2))
… defines point p4, positioned upwards from p2
with the distance rX(2) –the second x value.
p5 = pPRiLng(p4,rUp,rX(3))
… defines point p5, positioned upwards from p4
with the distance rX(3) –the third x value.
Thus, the points at the CB are available within the
program. They now have to be output to the screen.
The following lines apply
'-------------------- output points
AusP(p1,p2,p4,p5)
This first step should be tested, thoroughly with
,
and
. Only the points of the centre back will
appear on the screen. Measure the distances be‐
tween the points and also their co‐ordinates, if nec‐
essary. With the right button, you return to the pro‐
gramming user interface. Save the project via Project
→ Save.
In the next step, the points of the collar point are
constructed. It is recommended to instruct the
screen output in a block at the end of the program.
Therefore, the next program lines are inserted di‐
rectly above ”output points“. All additions are
highlighted.
'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar
pVar p1,p2,p3,p4,p5,p6,p7
sVar
qVar
tVar
cVar
'------------------------------------lCon
nCon
rCon rRi=0,rLe=180,rUp=90,rDo=270
rCon rClLng=150
tCon
'----------------- x value definitions
XTitel("collar band")
Defx(1,"raise CB",35)
Defx(2,"collar fold width",20)
Defx(3,"collar width CB",40)
Defx(4,"collar point(x) to p3",40)
Defx(5,"collar point(y) to p3",45)
Defx(6,"ang neck+foldline in p3",90)
Defx(7,"ang collar edge in p7",80)
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'-------------------- --- points at CB
p1 = pXY(0,0)
p2 = pXY(0,rX(1))
p4 = pPRiLng(p2,rUp,rX(2))
p5 = pPRiLng(p4,rUp,rX(3))
'---------------- corner point p3 (CF)
p3 = pXY(rClLng,0)
p6 = pPRiLng(p3,rRi,rX(4))
p7 = pPRiLng(p6,rUp,rX(5))
'------------ -- output points + lines
AusP(p1,p2,p3,p4,p5,p6,p7)
AusQ(p2+p5)
AusQ(p3+p7)
'------------------------------------End Program
'*************************************

In this example, the collar width is to be fixed. In sec‐
tion 20.2, the instructions required for automatic
length adjustment of a collar to the neck are ex‐
plained. The collar length rClLng is defined as a
constant of 150 mm in line
rCon rClLng=150
Directly above the output of points and lines the fol‐
lowing block was added:
'------------- corner point p3 (CB)

p3 = pXY(rClLng,0)
... defines point p3 with the co‐ordinates
(rClLng,0). p3 is positioned to the right of the
zero point at a distance of the collar length.
p6 = pPRiLng(p3,rRi,rX(4))
… defines point p6, positioned to the right of p3 at a
distance of rX(4) –the fourth x value.
p7 = pPRiLng(p6,rUp,rX(5))
… defines point p7, positioned upwards from p6 at
a distance of rX(5) –the fifth x value.
In the line for output of the points, the new points
p3, p6 and p7 were added.
AusP(p1,p2,p3,p4,p5,p6,p7)
With the lines
AusQ(p2+p5)
AusQ(p3+p7)
the centre back is output as a connection between
points p2 and p5 as well as the line at the corner
points between points p3 and p7. With the output
instruction AusQ(), lines and curves can be allo‐
cated for screen output. Instead of variables, the en‐
try of line or curve functions is also permitted.
Test and check this step with
the project.

,

and

. Save

Calculate directions and angles
Direction and angle definitions
Directions are required for positioning of points in a
direction and for construction of curves, etc. In the
new programming language, directions are always
defined as real numbers in degrees.
Y
pC (90°)
pB (30°)
pD (165°)
pA (0°)
p0

pA
pB
pC
pD
pE

=
=
=
=
=

pPRiLng(p0,0,100)
pPRiLng(p0,30,100)
pPRiLng(p0,90,100)
pPRiLng(p0,165,100)
pPRiLng(p0,-60,100)

X

pE (-60° | 300°)

Picture 19‐9

The points pA to pE from Picture 19‐9 can be pro‐
grammed as follows, where the distance to p0 is to
be 100 mm, respectively:
pA = pPRiLng(p0,0,100)
pB = pPRiLng(p0,30,100)
pC = pPRiLng(p0,90,100)
pD = pPRiLng(p0,165,100)
pE = pPRiLng(p0,-60,100)
Instead, a numbers in degrees, real variables can be
entered as parameters.
Calculate directions
A direction can be defined as
 direction from first to second point with
rRiPP(p,p),
 direction of a line rRiS(s),
 direction of a curve in starting or final point
rRiQanf(q) or rRiQend(q) or
 direction of a curve in a curve point
rRiQP(q,p).
From a mathematical point of view, the direction is
identical with a vector. Only when the vector is
linked with a point, a straight line is created.
The direction of a point pB in relation to p0 (Picture
19‐9) can be calculated as follows:
rB = rRiPP(p0,pB)
After processing this line, rB has the value 30.
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Calculate angles
An angle is calculated as
 angle defined by three points with
rWiPPP(p,p,p) (starting, pivot and end
point) or
 angle between two lines rWiSS(s,s).
For the points in Picture 19‐9, the functions in the left
column result in the values of the right column.
Function
Result
rWiPPP(pA,p0,pB)
+30
rWiPPP(pB,p0,pA)
‐30
rWiPPP(pD,p0,pE)
+135
rWiPPP(pD,p0,pC)
‐75
rWiPPP(pE,p0,pA)
+60
The first parameter in rWiPPP(p,p,p) defines
the first side of the angle. The rotation direction re‐
lates to this side (positive or negative rotation angle).
The same applies to the function rWiSS(s,s),
where the sides of the angle must first be defined as
lines.
The curve variation spline

Construct neck line and collar fold line as spline
with defined directions
The neck line and the collar fold line should be con‐
structed as splines. The starting point for both curves
is p3. Both curves should start at the angle x6, relat‐
ing to the connection of points p3 to p7. First, calcu‐
late the direction from p3 to p7 (Picture 19‐11).

p7

rRiPP(p3,p7)
p3
Picture 19‐11

The calculated direction is still to be rotated about
the given angle (Picture 19‐12).

A curve of the spline variation can run through any
number of fulcrums (base points). In these fulcrums,
directions can be defined for the curve. As on a steel
ruler, the curve is bent so that all conditions can be
fulfilled with as little bending force as possible.
For definition of a spline, a minimum of starting point
and final point must be entered. The simplest varia‐
tion with
q1=qSpline(pA,pE)
pA

qSpline(pA,0,pE,0)

X6

p3
qSpline(pA,pE)
pE

pM

p7

qSpline(pA,pM,pE)

Picture 19‐10

defines a spline from pA to pE. The spline can take on
any direction in these points and will therefore, ap‐
pear as a line (Picture 19‐10).
With the instruction line
q2 = qSpline(pA,0,pE,0)
the curve is also forced to run horizontally to the
right in points pA and pE with direction 0°. For a re‐
versed curve direction the instruction should be
q2 = qSpline(pE,180,pA,180)
Each curve has a direction!
With the instruction line
q3 = qSpline(pA,pM,pE)
a curve through three points is created, where the
directions in the points are not assigned.

p6
Picture 19‐12

The following lines generate the result:
rWi3 = rRiPP(p3,p7)
rWi3 = rWi3+rX(6)
q1 = qSpline(p3,rWi3,p2,rLe)
q2 = qSpline(p3,rWi3,p4,rLe)
For the collar edge, it is to be considered that the an‐
gle in p7 is entered as inside the collar. The direction
of the curve in p7 can be calculated either with
rWi7 = rRiPP(p7,p3)-rX(7)
or with
rWi7 = rRiPP(p3,p7)-180-rX(7)
After
q3 = qSpline(p7,rWi7,p5,rLe)
the collar edge is created but not yet, output to the
screen. The output instruction for the three curves
should read
AusQ(q1,q2,q3)
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The program for the collar band with (as yet) pre‐set
collar length is ready:
'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar rWi3,rWi7
pVar p1,p2,p3,p4,p5,p6,p7
sVar
qVar q1,q2,q3
tVar
cVar
'------------------------------------lCon
nCon
rCon rRi=0,rLe=180,rUp=90,rDo=270
rCon rClLng=150
tCon
'----------------- x value definitions
XTitel("collar band")
Defx(1,"raise CB",35)
Defx(2,"collar fold width",20)
Defx(3,"collar width CB",40)
Defx(4,"collar point(x) to p3",40)
Defx(5,"collar point(y) to p3",45)
Defx(6,"ang neck+foldline in p3",90)
Defx(7,"ang collar edge in p7",80)
'----------------------- points at CB
p1 = pXY(0,0)
p2 = pXY(0,rX(1))
p4 = pPRiLng(p2,rUp,rX(2))
p5 = pPRiLng(p4,rUp,rX(3))
'---------------- corner point p3 (CF)
p3 = pXY(rClLng,0)
p6 = pPRiLng(p3,rRi,rX(4))
p7 = pPRiLng(p6,rUp,rX(5))
'--------------------------- neck line
rWi3 = rWiPPP(p6,p3,p7)
rWi3 = rWi3+rX(6)
q1 = qSpline(p3,rWi3,p2,rLe)
q2 = qSpline(p3,rWi3,p4,rLe)
'------------------------- collar edge
rWi7 = rRiPP(p7,p3)-rX(7)
q3 = qSpline(p7,rWi7,p5,rLe)
'---------- ---- output points + lines
AusP(p1,p2,p3,p4,p5,p6,p7)
AusQ(sPP(p2,p5))
AusQ(sPP(p3,p7))
AusQ(q1,q2,q3)
'------------------------------------End Program
'*************************************

19.6 Program: Skirt
The basic block skirt according to Picture 19‐13 is to
be programmed with the application of the given x
values. The generation of the program ensues in four
steps. In each step, there are construction steps (ta‐
ble), a picture, and the program up to the stage dis‐
played. The steps should initially be developed by
yourself and then, compared with the prepared pro‐
gram text.
When creating the skirt, you may have the following
questions:

What do I do if an error message appears?
How can I find the relevant function ?
What is to be considered for release of a program ?
What is to be considered for alterations / correc‐
tions of a program ?
The answers to those questions can be found in the
last section 19.7 of this chapter.
X
1
2
3
4
5
6
7

Definition
skirt length from waist
addition to half hip girth
addition to half waist girth
relocate sided seam to front
raise side seam
dart length front
dart point from hip line in bk

Value
600mm
10mm
10mm
0mm
10mm
90mm
35mm

Picture 19‐13
st

1 step: construct points of the centre back, centre
front and side seam (Picture 19‐14)
from to direc‐ distance
tion
01
02
G8 (waist to hip)

01
03
x1 (skirt length from waist)

01
05
G5/2+X2 (half hip girth + ease)

02
04
G5/2+X2

03
06
G5/2+X2

02
07
½ distance p02p04 + X4

01
08
½ distance p02p04 + X4

03
09
½ distance p02p04 + X4

'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar rZ
pVar p01,p02,p03,p04,p05,p06,p07,
&
p08,p09
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05

08

01

04

07

02

06

09

03

2nd step: calculate & distribute ease (Pict. 19‐15)
ease
Ea=(G2/2+X2)‐(G4/2+X4)
portion side seam 3/6 ease
portion skirt back 2/6 ease
portion skirt front 1/6 ease
from
to direction distance
08
08
X5 (raise side seam)

08
10
½ * 3/6 * ease

08
11
½ * 3/6 * ease

01
12
½ distance p01p10

12
12
¼*X5 (raise waist)

12
13
½ * 2/6 * ease

12
14
½ * 2/6 * ease

05
15
2/3 distance p05p11

15
15
½ *X5 (raise waist)

15
16
½
* 1/6 * ease

15
17
½ * 1/6 * ease

17 16

Picture 19‐14

sVar
qVar
tVar
'------------------------------------lCon
nCon
rCon rRi=0,rUp=90,rLe=180,rDo=270
tCon
'----------------- x value definitions
XTitel("skirt")
Defx(1,"skirt length f. waist",600)
Defx(2,"addition 1/2 hip girth",10)
Defx(3,"addition ½ waist girth",10)
Defx(4,"relocate side seam to ft",0)
Defx(5,"raise side seam",10)
Defx(6,"dart length front",90)
Defx(7,"dart p. f. hip line bk",35)
'------------------------ points at CB
p01 = pXY(0,0)
p02 = pXY(0,-rG(8))
p03 = pXY(0,-rX(1))
'------------------------ points at CF
rZ = rG(5)/2+rX(2)
p05 = pPRiLng(p01,rLe,rZ)
p04 = pPRiLng(p02,rLe,rZ)
p06 = pPRiLng(p03,rLe,rZ)
'----------------- points at side seam
rZ = rAbstPP(p02,p04)/2+rX(4)
p07 = pPRiLng(p02,rLe,rZ)
p08 = pPRiLng(p01,rLe,rZ)
p09 = pPRiLng(p03,rLe,rZ)
'----------------------- output points
AusP(p01,p02,p03,p04,p05,p06,p07,
&
p08,p09)
'------------------------ output lines
AusQ(p01+p03)
AusQ(p03+p06)
AusQ(p06+p05)
AusQ(p04+p02)
AusQ(p05+p01)
AusQ(p08+p09)
'------------------------------------End Program
'*************************************

05

15

11

10
08

14 13
12

01

04

07

02

06

09

03

Picture 19‐15
'*************************************
Program Main()
lVar
nVar
rVar rZ,rEa,rSs,rBk,rFt
pVar p01,p02,p03,p04,p05,p06,p07,
&
p08,p09,p10,p11,p12,p13,p14,
&
p15,p16,p17
sVar
qVar
tVar
cVar
'-------------------------------------
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lCon
nCon
rCon rRi=0,rUp=90,rLe=180,rDo=270
tCon
'----------------- x value definitions
XTitel("skirt")
Defx(1,"skirt length f. waist",600)
Defx(2,"addition 1/2 hip girth",10)
Defx(3,"addition ½ waist girth",10)
Defx(4,"relocate side seam to ft",0)
Defx(5,"raise side seam",10)
Defx(6,"dart length front",90)
Defx(7,"dart p. f. hip line bk",35)
'------------------------ points at CB
p01 = pXY(0,0)
p02 = pXY(0,-rG(8))
p03 = pXY(0,-rX(1))
'------------------------ points at CF
rZ = rG(5)/2+rX(2)
p05 = pPRiLng(p01,rLe,rZ)
p04 = pPRiLng(p02,rLe,rZ)
p06 = pPRiLng(p03,rLe,rZ)
'----------------- points at side seam
rZ = rAbstPP(p02,p04)/2+rX(4)
p07 = pPRiLng(p02,rLe,rZ)
p08 = pPRiLng(p01,rLe,rZ)
p09 = pPRiLng(p03,rLe,rZ)
'--------------------- distribute ease
rEa = (rG(5)/2+rX(2))
&
-(rG(3)/2+rX(3))
'on half skirt
rSs = 3/6*rEa ‘portion in side seam
rBk = 2/6*rEa
'portion in Bk
rFt = 1/6*rEa
'portion in Ft
'-------==-- reduce side seam at waist
p08 = pPRiLng(p08,rUp,rX(5))
p10 = pPRiLng(p08,rRi,rSs/2)
p11 = pPRiLng(p08,rLe,rSs/2)
'------------------------- darts in Bk
rZ = rAbstPP(p01,p10)/2
p12 = pPRiLng(p01,rLe,rZ)
p12 = pPRiLng(p12,rUp,rX(5)/4)
p13 = pPRiLng(p12,rRi,rBk/2)
p14 = pPRiLng(p12,rLe,rBk/2)
'------------------------- darts in Ft
rZ = rAbstPP(p11,p05)*2/3
p15 = pPRiLng(p05,rRi,rZ)
p15 = pPRiLng(p15,rUp,rX(5)/2)
p16 = pPRiLng(p15,rRi,rFt/2)
p17 = pPRiLng(p15,rLe,rFt/2)
'----------------------- output points
AusP(p01,p02,p03,p04,p05,p06,p07,
&
p08,p09,p10,p11,p12,p13,p14,
&
p15,p16,p17)
'------------------------ output lines
AusQ(p01+p03)
AusQ(p03+p06)
AusQ(p06+p05)
AusQ(p04+p02)
AusQ(p05+p01)
AusQ(p08+p09)
End Program
'*************************************

3rd step: draw dart lines (Picture 19‐16)
fro to
direc‐ distance
m
tion
12 12a perp. perpendicular from p12 onto
line p02p07
12a 12b
X7

15 15a
X6

draw dart lines
17 16
05

15

11

10
08

14 13
12

01

15a
12b
04

07

06

09

12a

02

03

Picture 19‐16
'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar rZ,rEa,rSs,rBk,rFt
pVar p01,p02,p03,p04,p05,p06,p07,
&
p08,p09,p10,p11,p12,p13,p14,
&
p15,p16,p17,p12a,p12b,p15a
sVar sZ
qVar
tVar
cVar
'------------------------------------lCon
nCon
rCon rRi=0,rUp=90,rLe=180,rDo=270
tCon
'----------------- x value definitions
... as before ...
'------------------------- darts in Ft
rZ = rAbstPP(p11,p05)*2/3
p15 = pPRiLng(p05,rRi,rZ)
p15 = pPRiLng(p15,rUp,rX(5)/2)
p16 = pPRiLng(p15,rRi,rFt/2)
p17 = pPRiLng(p15,rLe,rFt/2)
'----------------------- dart point Bk
sZ = sPP(p02,p07)
p12a= pLotPS(p12,sZ)
p12b= pPRiLng(p12a,rUp,rX(7))
'----------------------- dart point Ft
p15a= pPRiLng(p15,rDo,rX(6))
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'----------------------- output points
AusP(p01,p02,p03,p04,p05,p06,p07,
&
p08,p09,p10,p11,p12,p13,p14,
&
p15,p16,p17,p12a,p12b,p15a)
'-------------------------output lines
AusQ(p01+p03)
AusQ(p03+p06)
AusQ(p06+p05)
AusQ(p04+p02)
AusQ(p05+p01)
AusQ(p08+p09)
AusQ(p12b+p13)
AusQ(p12b+p14)
AusQ(p15a+p16)
AusQ(p15a+p17)
'------------------------------------End Program
'*************************************

The curve variation circle arc
The curve type circle arc curve is based on distorted,
degenerate circle arcs. One of the main differences
to the curve type spline is that a circle arc curve has
no turning points (Picture 19‐17). A curve shape ac‐
cording to Picture 19‐17 can only be constructed
with the curve type spline.
Turning point for
curve curvature

Picture 19‐17

For the curve type circle arc curve, three definition
options are available which deliver the same curve
shape if comparable parameters are entered. Circle
arc curves give relatively shallow curves. They are
especially suitable for hip and waist curves. If the
curve shape with one of the circle arc options is not
satisfactory, the only alternative is a curve of the
spline type. The curve in Picture 19‐18 was con‐
structed with one of the three definition options, re‐
spectively.
r0= -50°
p0

qKurve1(pS,pD,pE)
The curve is created from pS to pE. The parameters
 starting point pS,
 direction point pD and
 end point pE are to be entered.
The direction point pD determines the direction of
the curve in pS and pE. In pS the curve has the di‐
rection pSpD and in pE the direction pDpE.
Thus, the curve nestles against the lines pSpD and
pDpE.
qKurve2(pS,rS,pE,rE)
The curve is created from pS to pE. The parameters
 starting point pS,
 direction in the starting point rS,
 end point pE and
 the direction in the end point rE are to be en‐
tered.
The directions in starting and end point, create the
direction point of the first definition option.
qKurve3(pS,rS,pE,rRel[,rE])
The curve is created from pS to pE. The parame‐
ters
 starting point pS,
 direction in the starting point rS,
 the end point pE,
 a relative value for the curve shape rRel and
 optional, as result value the direction in end
point rE are to be entered.
The direction of the curve in the end point is calcu‐
lated from the relative value with the following rule:
From the end point, a perpendicular is dropped onto
the line starting point with starting direction. The dis‐
tance pSdirection point (analogous curve type1)
is calculated from rRel/100*distance pSper‐
pendicular point.
The value rRel, indirectly adjusts the direction in
the end point. The curve shape can thus be altered
very delicately. However, it is unsuitable if particular
directions must be considered in the starting point
and end point.
4th step: draw side seam and waist lines

qKurve1(p0,p1,p2)
qKurve2(p0,r0,p2,r2)
qKurve3(p0,r0,p2,rRel)

here: rRel=66.7
r2=20°
p2

p1
pLot (perpendicular point from
p2 onto p0p1)

Picture 19‐18

For the construction of the side seam, the construc‐
tion option “qKurve3“ is applied as the direction of
the side seam at waist is still free. Thus, the hip curve
can be adjusted to the optimum shape with the pa‐
rameter rRel. The hip curve in the front skirt is cre‐
ated with
qSs_ft = qKurve3(p07,rUp,p11,60)
Alter the numeric value 60 in steps of 5 and after
followed by

(also

with a number of sizes) and

adjust a nice hip curve.
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With mirror at p07p08, the hip curve in the skirt
back is created.
qSs_bk = qSs_ft
Spgl(sPP(p07,p08):qSs_bk)
Before mirroring, it is first switched to the new curve
variable qSs_bk. With
Spgl(sPP(p07,p08):qSs_bk=qSs_ft)
the switch would ensue directly in the mirror func‐
tion.
The waist lines are to run at right angle to the side
seam, the darts and the centre front and centre back,
respectively. Before the individual sections of the
waist can be created, the direction of the waist line
in starting and final point must be calculated.
17 16

11

10

14 13

05

01

15a
12b
07

Picture 19‐19

The waist line from centre back starts at point p01
in horizontal direction to the left (180°) and ends in
p13 at right angle to the direction p12bp13 (Pic‐
ture 19‐19). The direction is calculated with
rRiPP(p12b,p13) and rotated through 90° in a
mathematically positive direction with +90.
rRi13 = rRiPP(p12b,p13)+90
Then, the waist section from the centre back can be
constructed with
qWa_bk1= qKurve2(p01,rLe,p13,rRi13)
The waist line is to be at right angle to the side seam.
With rRiQend(qSs_bk), the direction in the end
point of the side seam is calculated. +90 rotates the
direction again through 90° in mathematically posi‐
tive direction. The result is the required direction of
the waist rRi10 in the end point.
The waist section from the dart in the skirt back to
the side seam can then, be constructed with
qWa bk2=qKurve2(p14,rRi14,p10,rRi10)

Analogous, the construction of the waist sections in
the front skirt follows.

'*************************************
Program Main()
'------------------------------------lVar
nVar
rVar rZ,rMw,rSn,rHr,rVr,
&
rRi13,rRi14,rRi10,
&
rRi17,rRi16,rRi11
pVar p01,p02,p03,p04,p05,p06,p07,
&
p08,p09,p10,p11,p12,p13,p14,
&
p15,p16,p17,p12a,p12b,p15a
sVar sZ
qVar qSs_ft,qSs_bk,
&
qWa_bk1,qWa_bk2,
&
qWa_ft1,qWa_ft2
tVar
cVar
'------------------------------------lCon
nCon
rCon rRi=0,rUp=90,rLe=180,rDo=270
tCon
'----------------- x value definitions
... as before ...
'----------------------- dart point Ft
p15a= pPRiLng(p15,rDo,rX(6))
'----------- draw and mirror side seam
qSs_ft = qKurve3(p07,rUp,p11,60)
qSs_bk = qSs_ft
Spgl(sPP(p07,p08):qSs_bk)
'--------- draw waist line in skirt bk
rRi13 = rRiPP(p12b,p13)+90
qWa_bk1= qKurve2(p01,rLe,p13,rRi13)
rRi14 = rRiPP(p12b,p14)+90
rRi10 = rRiQend(qSs_bk)+90
qWa_bk2=qKurve2(p14,rRi14,p10,rRi10)
'--------- draw waist line in skirt ft
rRi17 = rRiPP(p15a,p17)+90
qWa_ft1= qKurve2(p05,rRi,p17,rRi17)
rRi16 = rRiPP(p15a,p16)+90
rRi11 = rRiQend(qSs_ft)+90
qWa_ft2=qKurve2(p16,rRi16,p11,rRi11)
'----------------------- output points
AusP(p01,p02,p03,p04,p05,p06,p07,
&
p08,p09,p10,p11,p12,p13,p14,
&
p15,p16,p17,p12a,p12b,p15a)
'------------------------ output lines
AusQ(p01+p03)
AusQ(p03+p06)
AusQ(p06+p05)
AusQ(p04+p02)
AusQ(p05+p01)
AusQ(p08+p09)
AusQ(p12b+p13)
AusQ(p12b+p14)
AusQ(p15a+p16)
AusQ(p15a+p17)
AusQ(qSs_ft,qSs_bk,qWa_ft1,qWa_ft2,
&
qWa_bk1,qWa_bk2)
'------------------------------------End Program
'*************************************
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the value of the variable rRi11 is displayed in

19.7 General guidelines
With the instructions and functions introduced so
far, the majority of basic blocks can be translated
into programming language programs. An overview
of all available functions can be found in the Grafis
Help.
How can I find the relevant function?
First, establish the variable type for the result. If a
point is required, only functions beginning with “p“
are relevant, for lines, only the functions with “s“ etc.
As a rule, a code for the result type appears in the
name of the function
Code
Wi
Ri
Lng
Tlng
Rlng
Lot
Tang
…

Result type
angle
direction
total length
partial length
relative length
perpendicular
tangent
…

Example
rWiSS(s,s)
rRiPP(p,p)
rLngQ(q)
rTlngSP(s,p)
rRlngSP(s,p)
pLotPS(p,s)
pTangPQ(p,q)
…

followed by the required parameters in capital letter.
What do I do if an error message appears?
There are two types of errors:
 syntax error = error in the writing convention
(“spelling error“) and
 logical error, which appears during processing
of the program.
Syntax errors are reported during compiling. The re‐
spective line is highlighted and a suggestion is made.
Syntax errors are for example missing opening / clos‐
ing brackets, unknown functions or incorrect param‐
eter types in the functions. Syntax errors can usually
be rectified, quickly.
A logical error occurs, when the program does not
deliver the expected result. Logical errors are easier
to be found, if the program is developed in small
steps and each step is tested, thoroughly (also in
small/large sizes). In this case, the error is to be
found in the last step. For long programs, it is defi‐
nitely useful to print and annotate the points, lines
and curves at a particular interval, analogous to Pic‐
tures 19‐14, 19‐15, 19‐16 and 19‐19.
A few tips for identifying errors:
 The value of a variable of any type can be
checked with the instruction VList(). With
the instruction line
rRi11 = rRiQend(qSs_ft)+90
VList(rRi11)

the variable list after
or
.
 The line in which a variable has been allocated
with the current value can be found by select‐
ing the variable in the current line and then
searching for it with
.
 To identify a searched point pW, output a line
from the zero point to the searched point:
AusQ(pXY(0,0)+pW)
 If a point is generated as an intersection be‐
tween a circle and a line, output the circle and
the line, temporarily and observe the result,
also in small/large sizes. With a “ ’ “ in front of
this temporary output, the line becomes a com‐
ment line.
 During compiling, a message appears querying
whether undeclared variables are to be de‐
clared. Check for each query whether the vari‐
able has actually been used or whether is has
been “created“ through a typing error.
 After successful compiling, unused variables
will be stated in the message window. In tidy
programming, unused variables are often an in‐
dication of a mix‐up.
What is to be considered for release of a program?
Before releasing a program, it should be checked
whether
 the program runs in all sizes, also extremely
small/ large/ individual sizes without errors,
 all x values are set up, calculated and com‐
mented, correctly. An “addition to the waist
girth“ must not operate as “addition to the half
waist girth“. A positive value for “increase side
seam“ must not lead to the side seam being re‐
duced,
 only necessary objects (points, lines, curves)
are output. Objects which are not required by
the user should not be output,
 all line lengths are correct. In the skirt construc‐
tion of the previous section, for example the
lengths of the side seams in skirt front and back
should be compared and the sum of the waist
lines should be measured, also in other sizes.
After releasing the program, the program file *.cpr is
to be entered into the call list and an info mask is to
be generated.
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Furthermore, generate a documentation of the fol‐
lowing content:
 a print‐out of the construction in which all ob‐
jects are annotated. All used objects should be
output, including auxiliary points and lines not
appearing in the released construction.
 a print‐out of the program,
 the program as file and
 a copy of the construction instructions.
What is to be considered for alterations/ correc‐
tions of a program ?
Corrections in released programs must be carried
out very circumspect manner, as styles developed
from this program will always fall back on it.
Before any alteration of released programs, the al‐
teration code must be increased in the project user
interface via Extras → Options! This applies, espe‐
cially to alterations for object output.
For explanation, the record principle of Grafis is to be
described at this stage. Each output instruction of a
programming language program transfers objects
(points, lines) to the Grafis record. The objects obtain
Pos‐numbers in order of their transfer. The Pos‐num‐
ber is an identification for the objects in the Grafis
record.

The output instruction
AusQ(qHem,qInsideleg,qCrotch)
transfers the hem, the inside leg and the crotch seam
to the Grafis record which will allocate these lines
with the consecutive Pos‐Numbers 1, 2 and 3. If now,
a parallel is created to the inside leg seam, this rec‐
ord step relates to the object with Pos‐Number 2.
If later on, the instruction is altered in the program‐
ming language program to
AusQ(qInsideleg,qHem,qCrotch)
and a test run is carried out in the style, the parallel
appears at the hem instead of the inside leg. This al‐
teration will result in errors only in styles which have
been developed from the programming language
program before the alteration.
The objects must always be output in the same or‐
der for identical object types, irrespective of sizes
and x values. Therefore, output instructions within
IF‐ENDIF structures should be avoided.
The alteration code should also be increased before
correcting any numbers or formulae. A user of your
program may have already corrected the basic shape
with construction steps. These construction steps
are also carried out in the altered program.
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With the instructions and functions introduced in
Chapter 19, the majority of basic blocks can be trans‐
lated into programming language programs. In the
first section of this chapter, a number of special pro‐
gramming structures and functions are explored.

Content of the second section is the automatic
length adjustment using a collar as an example; fol‐
lowed by the application of external functions and
the generation of construction components.

'***************************************************************
Program Main()
'--------------------------------------------------------------' Collar construction with automatic length adjustment
.
'--------------------------------------------------------------nVar n,nNextPos,nT
rVar rZl,rA,rL,rA1,rL1,rA2,rL2
pVar p0,p1,p2,p3,p4,p5
qVar q1,q2,q3,qF,qB,qQqq
cVar cF,cB
'------------------------------------------- x value definitions
XTitel("x values for shirt collar construction")
Defx(1,"direction for collar neck",-45)
Defx(2,"direction for collar stand",-55)
Defx(3,"raise collar",35)
Defx(4,"stand width",15)
Defx(5,"collar width back",45)
Defx(6,"point length",60)
Defx(7,"point height",60)
Defx(8,"direction collar edge curve",-30)
'-------------------------------------- query length of neckline
qF = qKop(pXY(0,0)+pXY(100,0))
' allocate qF
qB = qKop(pXY(0,0)+pXY(50,0))
' allocate qB
cF = cPick(1,4,"Click FRONT neckline !","collar","!",nT)
qF = qCo(cF,"qq")
cB = cPick(2,4,"Click BACK neckline !","collar","!",nT)
qB = qCo(cB,"qq")
'--------------------------------------- calculate target length
rZl= rLngQ(qF)+rLngQ(qB)
'----------------------------------------- task cannot be solved
If(rZl<=rX(3)) Then
n = nIBox("The collar cannot be constructed !")
Exit Program
End If
'---------------------------- starting adjustment P0 => P1 (=rA)
rA = rZl
'-------------- 0.approximation with construction of collar edge
p0 = pXY(0,0)
p1 = pXY(rA,0)
p2 = pXY(0,rX(3))
q1 = qSpline(p2,0,p1,rX(1))
rL = rLngQ(q1)
! curve length calculation
'-------------------------- automatic length adjustment in cycle
rA1= 0
' allocate function values for 1st approx.
rL1= rX(3)
rA2= rA
rL2= rL
For n = 1,10,1
' maximum 10 approximation steps
rA = rNahInt(rA1,rL1,rA2,rL2,rZl)
' next approximation
p1 = pXY(rA,0)
q1 = qSpline(p2,0,p1,rX(1))
rL = rLngQ(q1)
! curve length calculation
If(rAbs(rL-rZl)<<0.01) Then
! achieved accuracy ?
Exit For
! if YES => quit loop
End If
rA1= rA2 !re-allocate function values for next approximation
rL1= rL2
rA2= rA
rL2= rL
End For
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20.1 Subjects for advanced users
IF‐THEN structure
The IF‐THEN structure is a control structure which
carries out calculations or construction steps only, if
a certain condition is fulfilled.
The simple structure is
If (logical term) Then
[instruction]
End If
Only if the logical term is true (has the value True),
are the instructions processed.
The logical term can either be a direct logical variable
lSwitch=true
If(lSwitch) Then
[instruction]
End If

or the result of a comparison operation between
whole / real numbers or variables.
If(rEa<<0) Then
rSs = rEa
rBk = 0
rFt = 0
End If

The following comparison operators are permitted
for whole number / real variables:
Character
Significance
<<
smaller than
>>
greater than
==
equal
<=
smaller or equal
>=
greater or equal
<>
not equal
For connection of logical variables the following is
permitted:
Character
NOT
AND
OR

Significance
“not“
“and“
“or“

If (logical term 1) Then
[instruction 1]
Else If (logical term 2) Then
[instruction 2]
Else
[instruction 3]
End If

The operations “==“ and “<>“ are only suitable for
whole numbers as the numbers are compared up to
the 6th decimal, inclusive.
Example:
For extreme individual sizes, the waist girth may be
greater than the hip girth. In this case, the negative
ease must be added, completely to the side seam.
This case is considered in the program as follows:
'--------------------- distribute ease
rSs = 3/6*rEa 'portion in side seam
rBk = 2/6*rEa
'portion in Bk
rFt = 1/6*rEa
'portion in Ft
If(rEa<<0) Then
rSs = rEa
rBk = 0
rFt = 0
End If

Within IF‐THEN structures, no objects may be out‐
put, as the number of objects, the object type or the
order of the objects may change. Changes in the ob‐
ject output may lead to errors during style develop‐
ment. The notes on linking programming language
 construction record in the previous chapter ap‐
ply.
The detailed structure is
If (logical term 1) Then
[instruction 1]
Else If (logical term 2) Then
[instruction 2]
Else If (logical term 3) Then
[instruction 3]
Else
[instruction 4]
End if
Explanations can be found in Picture 20‐1. The
“Else If() Then“ queries can follow “If()
Then“ a number of times. “Else“ is only permitted
once before “End If“.

If (logical expression 1) Then
The instruction 1 is only processed if “logical term
1“ is true. The IF‐ENDIF structure is quit.
Or If (logical term 2) Then
The instruction 2 is only processed if “logical term
2“ is true and “logical term 1“ was false. The IF‐
ENDIF structure is quit.
Otherwise
The instruction 3 is only processed if the previous
queries were false.
End If
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Example:
In a skirt block for individual sizes, the ease is to be
distributed differently, if the ease for half of the skirt
is greater than 40mm. Enter the following in the pro‐
gram:
'--------------------- distribute ease
'
rSs portion in side seam
'
rBk portion in Bk
'
rFt portion in Ft
'-------------------------- case rEa<0
If(rEa<<0) Then
rSs = rEa
rBk = 0
rFt = 0
'------------------------- case rEa<40
Else If(rEa<<40) Then
rSs = 1/6*rEa
rBk = 3/6*rEa
rFt = 2/6*rEa
'------------------------ case rEa>=40
Else
rSs = 1/4*rEa
rBk = 2/4*rEa
rFt = 1/4*rEa
End If

FOR‐NEXT structure
With the FOR‐NEXT structure, loops can be created.
The loops begins with
For nLauf = nA,nE,nStep
and ends with
End For
nLauf is the loop variable. During the first run, it
has the value nA. After each run, nLauf is automat‐
ically raised by nStep or reduced if nStep is nega‐
tive. The instructions between For and End For
are processed, repeatedly during each run of the
loop.
The loop is only quit when the loop variable has ex‐
ceeded the end value or Exit For has been in‐
structed. The variables nLauf, nA, nE and nStep
must be whole number variables.
The complete structure in an overview is shown in
Picture 20‐2.
For nLauf = nA,nE,nStep
[instruction]
[Next For]
(next loop run)
[instruction]
[Exit For]
(quit loop, immediately)
[instruction]
End For
Picture 20‐2

Example:
'-----------check if x1 to x5 negative
nA=1
nE=5
For nLauf=nA,nE,1
If(rX(nLauf)<<0) Then
t1="The x value x"+tFormat(nLauf)
&
+" is negative !"+tc(13,10)+
&
"The collar cannot be
&
constructed."

nBox= nIBox(t1,31)
Exit Program
End If
End For

These program lines check whether one of the x val‐
ues x1 to x5 is negative. If one of the values is nega‐
tive, the program is immediately aborted with a mes‐
sage.
Size interpolation
The function rGroInt() carries out a size‐related
interpolation. In the previous programming lan‐
guage, y values were defined for this process. Size‐
related interpolation is useful, if a value is to be al‐
tered depending on the current measurement chart.
The same result is achieved through use of size‐re‐
lated x values. As opposed to the x values, values cal‐
culated with rGroInt() can only be adjusted in
the programming language program. The user of the
released program has no access to these values.
(S)he cannot alter them.
A size‐related value of the real number type can be
defined at any point in the program with the follow‐
ing instruction:
rCorr1=rGroInt("Size",value
&
[,"Size“,value,])
As parameters, any number of pairs made up from
size and the relevant value can be entered. The func‐
tion calculates the value for the current measure‐
ment chart from the value pairs size/value. Size
names must be entered in inverted commas, where
the underscore “_“ indicates a standard size. It is rec‐
ommended to enter the sizes in ascending order. If
no value pair is entered for a figure type, the value of
the first entered value pair is applied to all sizes of
the figure type. Please note the following example:
Value
20
18
16
14
12
10

38

40

42

44

538 540

542

544

Size

Picture 20‐3

A correction value for the figure types normal and
broad hip is to be defined according to Picture 20‐3.
The following instruction defines the value r1 as re‐
quired:
r1
&
&

= rGroInt("_38",10,"_40",12,
"_42",16,"_44",18,"_538",12,
"_540",14,"_542",17,"_544",19)
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The following overview shows which value the varia‐
ble r1 takes on for the respective measurement
chart:
r1
r1
r1
Size
Size
Size
36
8
036
10
536
12
38
10
038
10
538
14
40
12
040
10
540
17
42
16
042
10
542
19
44
18
044
10
544
21
46
20
046
10
546
23
For the figure type narrow hips (pre‐fix “0“), no value
was defined. Thus, the variable obtain the value 10
for all sizes of this figure type.

If an x value is assigned with an extreme value, the
user can be warned. The infobox appears also dur‐
ing grading! As a rule, use nIBox for error mes‐
sages for extreme construction entries from your
program.
The infobox can appear in different display options.
The display option is determined with the optional
whole number parameter nD. The first digit of this 2‐
digit parameter controls which button is displayed.
The second digit determines the icon in the window.
Picture 20‐4 contains an overview of the display op‐
tions.
The function value of nIBox indicates the clicked
button. The values of nIBox stand for the following
buttons:
1 ‐ Button “OK“
2 ‐ Button “Yes“
3 ‐ Button “Non“
4 ‐ Button “Ignore“
5 ‐ Button “Repeat“
6 ‐ Button “Quit“
Clicking the button “Abort“ always leads to immedi‐
ate abort of the program. It is identical with Exit
Program.

For individual measurement charts, the value of the
respective reference size (column x value reference
in the size table) is entered. If no reference is entered
in this column, again, the value of the first value pair
applies.
Dialogue functions
In basic blocks or construction components, infor‐
mation from the Grafis record are often required.
This information can be process parameters
(lengths, distances,...), but also objects (points,
lines). For example, for the collar, information about
the neckline is required; for a sleeve, information
about the armhole. In the new programming lan‐
guage, a dialogue can be created which instructs the
user of the program to click the required objects.
For the dialogue with the user, the functions
nIBox()
cPick()
are available.

Example:
Before the construction steps for a mitred corner are
carried out in the programming language, it is tested,
whether the requested lines are suitable for creation
of a corner and are not parallel.
'-------------------- Lines parallel ?
rWi = rWiSS(s1,s2)
t1 ="Lines for corner are almost "+
& "parallel (angle<5°)!"+tC(13,10)+
& "The mitred corner cannot be "+
& "constructed."
t2 = "Error – Construction mitred "+
& "corner"
If(rAbs(rWi)<<5) Then
nMsg= nIBox(t1,t2,21)
Exit Program
Else If(rAbs((rAbs(rWi)-180))<<5) Then
nMsg= nIBox(t1,t2,21)
Exit Program
End If

nIBox()
Infobox builds a window with a note for the user or
which the user can close with Yes/No. In this win‐
dow, for example, the user can be told the reason
why a construction cannot run under the particular
conditions.

Icon:

Buttons:
End/Repeat/Ignore
OK
OK/Abort
Repeat/Abort
Yes/No
Yes/No/Abort

10+
20+
30+
40+
50+
60+

No Icon

+0
10
20
30
40
50
60

Exclamation Info Icon
mark

+1
11
21
31
41
51
61

+2
12
22
32
42
52
62

Question
mark

+3
13
23
33
43
53
63

Cross as Warning
sign

+4
14
24
34
44
54
64
Picture 20‐4
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If the angle between the lines s1 and s2 is almost 0°
or almost 180° (between –5°/5°, 175°/180° or –
175°/‐180°), the message according to Picture 20‐5
appears and the program is aborted.
The parameters for calling
nMsg= nIBox(t1,t2,21)
are:
t1 message text; here: “Lines for corner are al‐
most parallel ...“
t2 title of the infobox; here: “Error – Construc‐
tion mitred corner“
21 the number for the display option; here: 21
for the icon exclamation mark and the button
“OK“.
cPick()
With cPick(), analogous to nIBox, a message
appears on the screen which asks the user to click a
point or a line. All information about the clicked ob‐
ject are gathered in a container and can be taken out
of the container as required.

Picture 20‐5

For collar and sleeve programs, dialogues can be de‐
veloped with cPick() in which the user is guided
through clicking the required lines. The use of z val‐
ues for transfer of lengths and distances to the pro‐
gramming language program is not longer necessary.
Example:
For the calculation of the total length of the neck‐
lines in front and back, the following program lines
are to be entered:
'-------------------- allocate qF, qB
qF = qKop(pXY(0,0)+pXY(100,0))
qB = qKop(pXY(0,0)+pXY(50,0))
'----------------------- click qF, qB
tF ="Click neckline FRONT !"
cF = cPick(1,4,tF,"Collar",nT)
qF = qCo(cF,"qq")
tB ="Click neckline BACK !"
cB = cPick(2,4,tB,"Collar",nT)
qB = qCo(cB,"qq")
'------------- calculate target length
rZl= rLngQ(qF)+rLngQ(qB)

Calling cPick, first fills a container; here: cF and
cB. From this container, the required information is
then, taken with the function qCo.

The parameters of the function cPick() have the
following significance:
cPick(nI,nV,tC,tT,tP,nT)
nI unambiguous identifier; this identifier must
be different for each call of cPick().
Thus, the different click instructions can be
identified during test run and grading.
nV click variation
1
click point
2
click line/ curve fulcrum
4
click line/ curve
8
“freehand“ click permitted
The individual variations can be combined
by adding. Thus, nV=3 means clicking of
points and line/ curve fulcrums.
tC comment text; With this text, the user is re‐
quested to click.
tT title text for the dialogue box
tP picture/ symbol text; permitted are, “!“,
“+“, “i“, “g“ or the complete path to a bit‐
map.
nT during call: number of the part in which
clicking is permitted. nT=0 permits clicking
in all parts with a part number <= the active
part.
after call: number of the part which was
clicked.
The following information can be called from the click
container with the following functions. The first parameter is the variable name of the respective click
container.
nCo(c,"tl")
Number of the piece which was
clicked
nCo(c,"nr")
Pos‐Number of the clicked object
nCo(c,"ty")
Type of the clicked object
(‐1: error, 0‐ digi point, 1‐ point,
2‐ line/curve)
lCo(c,"rl")
line/curve was clicked on the
right (YES/NO)
lCo(c,"st")
click point is line/ curve fulcrum
(YES/NO)
lCo(c,"ri")
curve direction in the click point
in degrees
rCo(c,"rln")
relative length of the curve in the
click point in %
pCo(c,"pp")
click point
qCo(c,"qq")
clicked line/curve
Proportion classes
The ease in a basic block can be adjusted via propor‐
tion classes or via x values. Which of the two options
is used or whether both options are mixed, is de‐
cided by the programmer.
If proportion classes are used, the programmer de‐
fines the ease at waist, hip, bust, drop armhole... per
proportion class in the program. If proportion classes
are not used, the user adjusts the ease, later with x
values.
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The applicable proportion class is determined in the
size table and transferred as a whole number value
with the function nZKlasse().
In a programming language program with the in‐
struction nZkl=nZKlasse(), the variable nZkl
has the following value for the respective measure‐
ment chart during processing:
Size table
value for
nZKlasse()
> 01 e04 ____40_0
4
> 02 e04 ____42_0
4
> 03 e04 ____44_0
4
> 04 c02 ____40_0
2
> 05 g06 ____40_0
6
> 06 i08 ____40_0
8
The programmer determines the amount of ease to
be added to bust, waist ... with the calculation of
nZKlasse. With the instructions
'-------------------------- Bust width
rBu = rG(1)+10*nZKlasse()
'------------------------- Waist width
rWa = rG(4)+13*nZKlasse()
'--------------------------- Hip width
rHi = rG(2)+15*nZKlasse()
'------------------------ Drop armhole
rAh = 2*nZKlasse()

the bust width rBu for half of the garment is calcu‐
lated as follows:
Size table
value of
ease
rBu
> 01 e04 ____40_0 920+10*4
+40
> 02 e04 ____42_0 960+10*4
+40
> 03 e04 ____44_0 1000+10*4
+40
> 04 c02 ____40_0 920+10*2
+20
> 05 g06 ____40_0 920+10*6
+60
> 06 i08 ____40_0 920+10*8
+80
Per proportion class, 10mm ease are added to the
bust, 13mm ease at the waist, 15mm ease at the hip.
At the same time, the armhole is dropped by 2mm
per proportion class. With the factors before
nZKlasse(), the programmer determines the
ease per proportion class. If the change of ease is to
be irregular in the different proportion classes, the
IF‐ENDIF structure is to be used.
For tight‐fitting garments, e.g. swimwear or sports‐
wear,
the
calculation
can
also
be
10*nZKlasse()–40. Thus, the measurement in
proportion class a00 is 4cm smaller than the body
measurement.

Circle functions
Circles are treated like curves in the new program‐
ming language. All curve functions can also be ap‐
plied to circles. A circle can be created with the func‐
tions
qTeilKr()
qHalbKr()
qVollKr()
As parameters, the centre point of the circle (point
variable) and the radius of the circle (real variable)
are to be entered. Depending on the circle type, di‐
rection assignments follow.
If the circle is required to create an intersection with
a line or another curve, the function qVollKr()
(full circle) should always be used. For creation of in‐
tersections, a direction point must be entered which
points to the required intersection if more than one
option are available. The circle centre is unsuitable
as a direction point.
Example:
In the following example program, each circle varia‐
tion is defined and then, output (Picture 20‐6).
q3
q1
q2

Picture 20‐6

The parameter 45 in the instruction
q1 = qVollKr(p0,rRad1,45)
determines that the symmetry axis of the full circle
(start and end) is the 45° direction.
The parameter –45 in the instruction
q2 = qHalbKr(p0,rRad2,-45)
determines that the symmetry axis of the semicircle
is the –45° direction.
The parameter 60 and –90 in the instruction
q3 = qTeilKr(p0,rRad3,60,-90)
determine that the partial circle starts at 60° and
ends at –90°. The circle is created in a mathemati‐
cally positive direction.
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'*************************************
Program Main()
' Circle variations
'------------------------------------rVar rRad1,rRad2,rRad3
qVar q1,q2,q3
pVar p0
'------------------------ Centre point
p0 = pXY(0,0)
'------------------------------ Radius
rRad1 = 100
rRad2 = 140
rRad3 = 180
'---------------------- define circles
q1 = qVollKr(p0,rRad1,45)
q2 = qHalbKr(p0,rRad2,-45)
q3 = qTeilKr(p0,rRad3,60,-90)
'------------------------------ Output
AusP(p0)
AusQ(q1,q2,q3)
End Program
'*************************************

External functions
For more transparency, often required programming
steps can be saved as external functions. An external
function (here: type n) begins with
Function nXxx([parameter list])
and ends with
End Function
The function name is to be created analogous to a
variable name and is to be assigned with a variable
type. Within the function, the function name is a var‐
iable which can be assigned with a value. This value
is returned after processing of the function. When
calling the function, any number of variables of dif‐
ferent types can be transferred to the function. The
amount of parameters and the parameter type must
be identical in the call of the function and the func‐
tion definition. The parameters in the function call
are also returned. External functions can be saved in
their own modules. In the future, special modules for
curves, corners etc. can be developed which will be
made available to other Grafis programmers as li‐
braries. The structures Program Main()/ End
Program and Function xXxx()/ End Function must not be interlocked with one another.
Example:
'*************************************
Program Main()
[instructions]
lIo=lEck(p20,p21,p27,p28,p31)
[instructions]
lIo=lEck(p31,p37,p56,p57,p57a)
[instructions]
End Program
'*************************************

'*************************************
Function lEck(p1,p2,p3,p4,pEck)
' Calculation of the intersection
' of two lines
' The points p1 and p2 create the
' first line,
' the points p3 and p4 create the
' second line.
' The corner point pEck is returned
' as fifth parameter.
' If both lines are almost parallel
' the program is aborted with
' a warning.
' Generated: 10-09-2000 KF
'*************************************
pVar
sVar s1,s2
rVar rWi
tVar t1,t2
nVar nMsg
'------------------------------------lEck= False
s1 = sPP(p1,p2)
s2 = sPP(p3,p4)
'-------------------- lines parallel ?
rWi = rWiSS(s1,s2)
t1 = "Lines for corner are almost "+
& "parallel (angle<5deg) !"+tC(13,10)+
& "The corner cannot be constructed."
t2 = "Error - Construction corner"
If(rAbs(rWi)<<5) Then
nMsg= nIBox(t1,t2,21)
Exit Function
Else If(rAbs((rAbs(rWi)-180))<<5) Then
nMsg= nIBox(t1,t2,21)
Exit Function
End If
pEck= pSchnSS(s1,s2)
lEck= True
End Function
'*************************************

The external function lEck() constructs a corner
point which is defined by four points. The four points
are transferred in the parameter list. The first and
second point and the third and fourth point create a
line, respectively. If the angle between the two lines
smaller than 5°, the program is aborted with a mes‐
sage. Otherwise, the corner point pEck is calculated
and returned as fifth parameter of the parameter list
of the function. The function can be called a number
of times (here: twice) with different points each
time.
Often, logical functions are programmed which only
end with the value True, if the function has been
processed, correctly. To relocate the shoulder seam
by x6 at the neck and x7 at the armhole, the function
lTranslShoulder() must have the following
structure:
'*************************************
Program Main()
[instructions]
lIs=lTranslShoulder(qNeckF,qNeckB,
&
qArmF,qArmB,rX(6),rX(7))
[instructions]
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End Program
'*************************************
'*************************************
Function lTranslShoulder(q1,q2,
&
q3,q4,r1,r2)
' Transformation of q2 to q1 and
' q4 to q3
' relocate end point of q1 by r1
' relocate end point of q3 by r2
' create new curves
' reverse transform new q2 and new q4
'*************************************
lTranslShoulder=False
[instructions]
q1=...
q2=...
q3=...
q4=...
lTranslShoulder=True
End Function
'*************************************

The new curves of the neck and armhole are trans‐
ferred in the parameter list. Before processing the in‐
struction line
&

lIs=lTranslShoulder(qNeckF,qNeckB,
qArmF,qArmB,rX(6),rX(7))

in Main(), the shoulder seam of the curves qNeckF,
qNeckB, qArmF, qArmB has not been relo‐
cated. After processing the line, the curves are re‐al‐
located and the shoulder is relocated.

20.2 Automatic length adjustment
rNahInt(rA1,rIs1,rA2,rIs2,rTarg)
The approximation interpolation rNahInt()is re‐
quired for automatic length adjustment, e.g. for col‐
lars and sleeves. The collar is to be adjusted to the
neck, the sleeve to the armhole.
For application of length adjustments, the following
procedure applies:
1. Formulate a new, unambiguous construction in‐
struction with a target length depending on an‐
other construction parameter.
2. Determine a variable construction parameter rA,
which can be altered for adjustment of the target
length rTarg.
3. Allocate a zero approximation. Example: For
rA1=0, the result would be rIs1=0.
4. First development of the construction with a suit‐
able starting value rA2 for the variable construc‐
tion parameter up to actual length rIs2 and cal‐
culation of actual length rIs2. Depending on the
extent, the development steps can be pro‐
grammed as a external function.
5. Calculate the new starting value rA with the
function rNahInt().

6. Repeated development of the construction with
the new starting value rA and calculation of the
actual length rIs.
7. Query, whether the target length has been
achieved.
If yes, the construction is continued according to
point 8.
If no, the values of rA2 and rIs2 are switched
to the variables rA1 and rIs1. The variables
rA2 and rIs2 then, obtain the values of rA and
rIs which were last calculated. Then, a new
value is calculated for rA according to point 5.
8. Finish the construction.
The function
rNahInt(rA1,rIs1,rA2,rIs2,rTarg)
The
function
rNahInt(rA1,rIs1,rA2,
rIs2,rTarg)calculates the probable starting
value from two starting values rA1 and rA2, and the
corresponding result values rIs1 and rIs2, with the re‐
sult rTarg.
A mainly linear interdependence between starting
value and result value is assumed (Picture 20‐7).

rIs
rIs1
rTarget
rIs2

?
rA
rA2

rA1
Picture 20‐7

In the following collar band construction, the varia‐
ble construction parameter is the distance between
p1 and p3.
Example:
For a distance p1p3 of 160mm, the collar neck is
165.8mm long and for 200mm the collar neck is
204.7mm long.
With the allocation
rA1 =160
rIs1 =165.8
rA2 =200
rIs2 =204.7
the required distance p1p3 can be calculated for a
target length of the collar neck of 183mm as follows:
rTarg=183
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rA
=rNahInt(rA1,rIs1,rA2,
&
rIs2,rTarg)
This calculation results in a value of 177.6mm for the
distance p1p3. With this value, a collar neck of
182.9mm is obtained. A further calculation with the
values
rA1 =200
rIs1 =204.7
rA2 =177.6
rIs2 =182.9
results in a value of 177.7mm for the distance p1
p3. With this value, the collar neck has the required
length of 183.0mm.
Construction: collar band with automatic length
adjustment
A collar band according to Picture 20‐8 is to be pro‐
grammed with application of the following x values:
X Definition
Step
Value
1 addition collar length
0mm
2 raise CB
p1p2 35mm
3 collar fall width
p2p4 20mm
4 collar width CB
p4p5 40mm
5 collar point (x) to p3
p3p6 40mm
6 collar point (y) to p3
p6p7 45mm
7 factor for the direction p. p1p9 2.6
collar neck dep. on x2
8 direction p. f. collar edge p1p8 155mm

Construction steps:
from to direction
1
2

2
4

4
5

1
8

1
9

1
3


distance
x2 (raise CB)
x3 (collar fall width)
x4 (collar width)
x8 (dir. p. collar edge)
x2*x7
variable distance, so
that «collar neck» =
«neck meas. +x1»
construct and optimise
collar neck
3
6
x5

6
7
x6

construct collar fold and
collar edge
All curves are to run into the CB at right angle. The
collar fold and the collar neck have the direction p3
p9 in p3. The collar edge has the direction p7p8
in p7.

p8

p5
p9

p4

p7

p2

p1

p3

p6
Picture 20‐8
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The program: collar band with automatic length adjustment
'***********************************************************************
Program Main()
' Construction of a collar band after instructions by
' Mrs. Prof. H.Brückner, Berlin
' The user has to click the necklines in the front and back
' The collar is automatically constructed, so that the length of the collar
' neck equals the length of both necklines plus addition x1.
'----------------------------------------------------------------------lVar
nVar n
rVar rWi3,rWi7,rA,rA1,rA2,rIs,rIs1,rIs2,rClLng,rTarg
pVar p1,p2,p3,p4,p5,p6,p7,p8,p9
sVar
qVar q1,q2,q3,qF,qB
tVar
cVar cF,cB
'----------------------------------------------------------------------lCon
nCon
rCon rRi=0,rLe=180,rUp=90,rDo=270
rCon
tCon
'--------------------------------------------------- x value definitions
XTitel("collar band")
Defx(1,"addition collar length",0)
Defx(2,"raise CB",35)
Defx(3,"collar fold width",20)
Defx(4,"collar width CB",40)
Defx(5,"collar point (x) in relation to p3",40)
Defx(6,"collar point (y) in relation to p3",45)
Defx(7,"factor for direction point neck relating to x2",2.6)
Defx(8,"direction point for collar edge",155)
'--------------------------------------------- query length of necklines
cF = cPick(1,4,"Click neckline FRONT !","collar","!",nT)
If (not lCo(cF, "iO")) Then
FEnd(0)
Exit Program
Endif
qF = qCo(cF,"qq")
cB = cPick(2,4,"Click neckline BACK !","collar","!",nT)
If (not lCo(cB, "iO")) Then
FEnd(0)
Exit Program
Endif
qB = qCo(cB,"qq")
rClLng = rLngQ(qF)+rLngQ(qB)
If(rClLng<<rX(2)) Then
n
= nIBox("The necklines are too short !")
Exit Program
End If
'---------------------------------------------------------- points at CB
p1 = pXY(0,0)
p2 = pXY(0,rX(2))
p4 = pPRiLng(p2,rUp,rX(3))
p5 = pPRiLng(p4,rUp,rX(4))
p8 = pPRiLng(p1,rUp,rX(8))
p9 = pPRiLng(p1,rUp,rX(2)*rX(7))
'------------------------------------------- collar neck 0 approximation
rTarg = rClLng+rX(1)
rA = rClLng
p3 = pXY(rA,0)
rWi3= rRiPP(p3,p9)
q1 = qSpline(p3,rWi3,p2,rLe)
rIs= rLngQ(q1)
'-------------------------------------------------- values for 1st approx.
rA1
= 0
rIs1 = 0
rA2
= rA
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rIs2 = rIs
'--------------------------------------------------------- autom.approx.
For n = 1,10,1
rA = rNahInt(rA1,rIs1,rA2,rIs2,rTarg)
p3 = pXY(rA,0)
rWi3= rRiPP(p3,p9)
q1 = qSpline(p3,rWi3,p2,rLe)
rIs= rLngQ(q1)
If(rAbs(rIs-rTarg)<<0.01) Then
Exit For
End If
rA1 = rA2
rIs1 = rIs2
rA2 = rA
rIs2 = rIs
End For
'---------------------------------------------------------- collar point
p6 = pPRiLng(p3,rRi,rX(5))
p7 = pPRiLng(p6,rUp,rX(6))
'------------------------------------------------------ collar fold line
q2 = qSpline(p3,rWi3,p4,rLe)
'----------------------------------------------------------- collar edge
rWi7= rRiPP(p7,p8)
q3 = qSpline(p7,rWi7,p5,rLe)
'------------------------------------------------ output points + lines
AusP(p1,p2,p3,p4,p5,p6,p7)
AusQ(p2+p5)
AusQ(p3+p7)
AusQ(q1,q2,q3)
'----------------------------------------------------------------------End Program
'***********************************************************************

20.3 Collar neck with minimum as external function
As basis for various collar developments, a external
function qClNeck1() is to be programmed which
delivers a collar neck (Picture 20‐9) of a given length,
considering the following parameters:
 raise centre back
 raise centre front
 additional direction at the CF
 position of minimum in % (from CB)
The next page shows a test environment for the
function qClNeck1(). The actual function
qClNeck1() is shown on the following page. The
function qClNeck1() can also be saved in a new
module, together with further functions for collar
necks of different shapes.

Construction steps function qClNeck1():
from to direction distance
1
2
rCb (raise CB)

1
4
variable distance,

This distance is optimised
so that the collar neck
equals the length of rTarg.
1
3
rMin /100* variable dis‐

tance
4
5
rCf
(raise CF)

construct and optimise
collar neck
The collar neck is to run into the centre back at right
angle. In point p5 the curve is to have the direction
p3p5 plus the correction rRi5z.

p5

p2
p1

p3

p4
Picture 20‐9
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'***********************************************************************
Program Main()
' Test environment for development of the function qClNeck1()
'----------------------------------------------------------------------nVar n
rVar rClLng,rTarg
pVar p1,p2,p3,p4,p5
qVar qF,qB,q1
cVar cF,cB
rCon rRi=0,rLe=180,rUp=90,rDo=270
'-------------------------------------------------------------- x values
XTitel("collar neck for shirt collars")
Defx(1,"addition to collar neck line",0)
Defx(2,"raise CB",10)
Defx(3,"raise CF",5)
Defx(4,"additional direction collar stand in p5",10)
Defx(5,"position p3 between p1-p4 in %",66)
'-------------------------------------------- query length of necklines
cF = cPick(1,4,"Click neckline FRONT !","collar","!",nT)
If (not lCo(cF, "iO")) Then
FEnd(0)
Exit Program
Endif
qF = qCo(cF,"qq")
cB = cPick(2,4,"Click neckline BACK !","collar","!",nT)
If (not lCo(cB, "iO")) Then
FEnd(0)
Exit Program
Endif
qB = qCo(cB,"qq")
rClLng = rLngQ(qF)+rLngQ(qB)
If(rClLng<<rX(2)) Then
n
= nIBox("The necklines are too short !")
Exit Program
End If
rTarg= rClLng+rX(1)
'----------------------------------------------------- collar neck line
q1
= qClNeck1(rX(2),rX(3),rX(4),rX(5),rTarg,p1,p2,p3,p4,p5)
'---------------------------------------------------------------- output
AusP(p1,p2,p3,p4,p5)
AusQ(q1)
End Program
'***********************************************************************
'***********************************************************************
Function qClNeck1(rCb,rCf,rRi5z,rMin,rTarg,p1,p2,p3,p4,p5)
' ... calculates the collar neck line which has a minimum at rRi5 %
' between CB and CF. The parameters to be given:
'
rCb - raise CB
'
rCf - raise CF
'
rRi5 - additional direction in p5 (at CF)
'
rMin - position of minimum in percent (from CB)
'
rTarg- target length of the collar neck (incl. add) from CB to CF
' returned are the curve qClNeck1, which starts at CB,
' and the points p1 to p5.
'----------------------------------------------------------------------nVar n
rVar rA,rRi5,rIs,rA1,rIs1,rA2,rIs2
'----------------------------------------------------------------------rCon rRi=0,rLe=180,rUp=90,rDo=270
'---------------------------------------------------------- points at CB
p1
= pXY(0,0)
p2
= pPRiLng(p1,rUp,rCb)
'------------------------------------------------------- 0.approximation
rA
= rTarg
p3
= pPRiLng(p1,rRi,rMin/100*rA)
p4
= pPRiLng(p1,rRi,rA)
p5
= pPRiLng(p4,rUp,rCf)
rRi5 = rRiPP(p3,p5)+rRi5z
qClNeck1 = qSpline(p2,rRi,p3,rRi,p5,rRi5)
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rIs = rLngQ(qClNeck1)
'------------------------------------------------- values for 1st approx.
rA1 = 0
rIs1 = 0
rA2 = rA
rIs2 = rIs
'-------------------------------------------------------- autom. approx.
For n = 1,10,1
rA
= rNahInt(rA1,rIs1,rA2,rIs2,rTarg)
p3
= pPRiLng(p1,rRi,rMin/100*rA)
p4
= pPRiLng(p1,rRi,rA)
p5
= pPRiLng(p4,rUp,rCf)
rRi5 = rRiPP(p3,p5)+rRi5z
qClNeck1 = qSpline(p2,rRi,p3,rRi,p5,rRi5)
rIs = rLngQ(qClNeck1)
If(rAbs(rIs-rTarg)<<0.01) Then
Exit For
End If
rA1 = rA2
rIs1 = rIs2
rA2 = rA
rIs2 = rIs
End For
End Function
'***********************************************************************
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20.4 Shirt collar construction with application of the external function qClNeck1()
A shirt collar (Picture 20‐10) with the following x val‐
ues is to be constructed with application of the ex‐
ternal function qClNeck1() from the previous
section.
X Definition
Step
Value
1
addition collar length
0mm
2
raise CB
10mm
p1p2
3
raise CF
5mm
p4p5
4
additional direction
10°
collar stand in p5
5
stand width CB
25mm
p2p6
6
collar width CB
65mm
p6p7
7
overlap collar stand
20mm
p5p8
8
reduce stand width at p8p10 5mm
overlap
9
collar point in x
p4p11 15mm
10 collar point in y
p4p11 10mm
11 direction collar point
10°
12 position p3 between
66%
p1p4
p1‐p4
Construction steps:
from to direct. distance
1
2
x2 (raise CB)

1
4
variable distance, so that

collar neck = neckline + x1
1
3
x12 /100* variable distance

4
5
x3 (raise CF)

construct and optimise collar
neck line
The steps thus far are processed by the external
function qClNeck1(). All following steps are pro‐
grammed in the program Main().

2

6

9
7
8



x5
parallel to collar neck at dis‐
tance x5
end point of parallel
x6 (collar width)
x7 (overlap collar stand)


collar
neck
in p5
8
10 verti‐ x5‐x8 (reduce stand width at
cal as overlap)
before
4
11
x2+x5+x6+x10 (collar point

overlap in y)
11
11
x9 (collar point in x)

construct collar edge with di‐
rection x11 in p11
All curves are to run into the centre back at right an‐
gle.
6
5

Step‐by‐step guide:
Create the new project “shirt collar“ and open the
new module “collar necks“ in this project with Mod‐
ule → New.... The module appears in the variable list
under the section “Module“. Clicking, opens the
module. Copy the tested function qClNeck1()
from the previous section into the module “collar
necks“ and compile the new module. Then, select
the main module by clicking on Main.qpr in the
“Module“ section and develop the shirt collar ac‐
cording to the program instructions on the following
pages.
For development of a different collar with the same
collar neck line, the module “collar necks“ only has
to be inserted. Thus, the function qClNeck1() can
also be used, there.

p7

p11

p6

p10

p9
p2
p1

p5
p3

p8

p4
Picture 20‐10
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Content of Module collarnecks.qpr:
'***********************************************************************
Function qClNeck1(rCb,rCf,rRi5z,rMin,rTarg,p1,p2,p3,p4,p5)
' ... calculates the collar neck line, which has a minimum at rRi5 %
' between CB and CF. The parameters to be given:
'
rCb - raise CB
'
rCf - raise CF
'
rRi5 - additional direction in p5 (at CF)
'
rMin - position of minimum in percent (from CB)
'
rTarg- target length for collar neck (incl. add) from CB to CF
' returned are the curve qClNeck1, which starts at CB,
' and the points p1 to p5.
'----------------------------------------------------------------------nVar n
rVar rA,rRi5,rIs,rA1,rIs1,rA2,rIs2
'----------------------------------------------------------------------rCon rRi=0,rLe=180,rUp=90,rDo=270
'---------------------------------------------------------- points at CB
p1
= pXY(0,0)
p2
= pPRiLng(p1,rUp,rCb)
'------------------------------------------------------- 0.approximation
rA
= rTarg
p3
= pPRiLng(p1,rRi,rMin/100*rA)
p4
= pPRiLng(p1,rRi,rA)
p5
= pPRiLng(p4,rUp,rCf)
rRi5 = rRiPP(p3,p5)+rRi5z
qClNeck1 = qSpline(p2,rRi,p3,rRi,p5,rRi5)
rIs = rLngQ(qClNeck1)
'------------------------------------------------- values for 1st approx.
rA1 = 0
rIs1 = 0
rA2 = rA
rIs2 = rIs
'--------------------------------------------------------- autom.approx.
For n = 1,10,1
rA
= rNahInt(rA1,rIs1,rA2,rIs2,rTarg)
p3
= pPRiLng(p1,rRi,rMin/100*rA)
p4
= pPRiLng(p1,rRi,rA)
p5
= pPRiLng(p4,rUp,rCf)
rRi5 = rRiPP(p3,p5)+rRi5z
qClNeck1 = qSpline(p2,rRi,p3,rRi,p5,rRi5)
rIs = rLngQ(qClNeck1)
If(rAbs(rIs-rTarg)<<0.01) Then
Exit For
End If
rA1 = rA2
rIs1 = rIs2
rA2 = rA
rIs2 = rIs
End For
End Function
'***********************************************************************

Content of Module Main.qpr:
'***********************************************************************
Program Main()
' Shirt collar construction with automatic length adjustment
' of the collar neck line to the length of the measured neck
' after instructions by Mrs. Prof. H.Brückner, Berlin
'----------------------------------------------------------------------nVar n
rVar rClLng,rTarg,rRi5,rRi8,rRi11
pVar p1,p2,p3,p4,p5,p6,p9,p7,p8,p10,p11
qVar qF,qB,q1,q2,q3
cVar cF,cB
'----------------------------------------------------------------------rCon rRi=0,rLe=180,rUp=90,rDo=270

354

Chapter 20 Programming Language II

__________________________________________________________________________________________________________________________________
©Friedrich: Grafis ‐ Textbook, Edition 2017

'-------------------------------------------------------------- x values
XTitel("shirt collar")
Defx(1,"addition to collar neck line",0)
Defx(2,"raise CB",10)
Defx(3,"raise CF",5)
Defx(4,"additional direction collar stand in p5",10)
Defx(5,"collar stand width CB",25)
Defx(6,"collar width CB",65)
Defx(7,"overlap collar stand",20)
Defx(8,"reduce stand width at overlap",5)
Defx(9,"collar point overlap in x direction",15)
Defx(10,"collar point overlap in y direction",10)
Defx(11,"direction collar point",10)
Defx(12,"position p3 between p1-p4 in %",66)
'--------------------------------------------- query length of necklines
cF = cPick(1,4,"Click neckline FRONT !","collar","!",nT)
If (not lCo(cF, "iO")) Then
FEnd(0)
Exit Program
Endif
qF = qCo(cF,"qq")
cB = cPick(2,4,"Click neckline BACK !","collar","!",nT)
If (not lCo(cB, "iO")) Then
FEnd(0)
Exit Program
Endif
qB = qCo(cB,"qq")
rClLng = rLngQ(qF)+rLngQ(qB)
If(rClLng<<rX(2)) Then
n
= nIBox("The necklines are too short !")
Exit Program
End If
rTarg = rClLng+rX(1)
'------------------------------------------------------ collar neck line
q1 = qClNeck1(rX(2),rX(3),rX(4),rX(12),rTarg,p1,p2,p3,p4,p5)
'------------------------------------------------------ points p6 to p11
p6 = pPRiLng(p2,rUp,rX(5))
Paral(-rX(5):q2=q1)
p9 = pQend(q2)
p7 = pPRiLng(p6,rUp,rX(6))
rRi5= rRiQend(q1)
p8 = pPRiLng(p5,rRi5,rX(7))
rRi8= rRi5+90
p10 = pPRiLng(p8,rRi8,rX(5)-rX(8))
p11 = pPRiLng(p4,rUp,rX(2)+rX(5)+rX(6)+rX(10))
p11 = pPRiLng(p11,rRi,rX(9))
'----------------------------------------------------------- collar edge
rRi11 = rX(11)
q3 = qSpline(p7,rRi,p11,rRi11)
'---------------------------------------------------------------- output
AusP(p1,p2,p3,p4,p5,p6,p7,p8,p9,p10,p11)
AusQ(p2+p7,p9+p11,p5+p8,p8+p10,p10+p9,p9+p5)
AusQ(q1,q2,q3)
End Program
'***********************************************************************
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20.5 Construction component shoulder seam relocation with replacing Pos‐objects
So far, only new objects were transferred to the
Grafis record. For construction components which
are to be applied to existing objects, it must be pos‐
sible to access objects of the Grafis record. This is
possible with the so‐called Pos‐numbers.
Each object (point, line) of the Grafis record has an
unambiguous Pos‐number for identification.
The Pos‐number applies within one part and is auto‐
matically entered for each new object. All construc‐
tion steps of the Grafis record point to the respective
object via the Pos‐number.
The application of Pos‐numbers
Existing objects which are to be processed with a
construction component, are identified with the
function cPick(). The Pos‐numbers can be ex‐
tracted from the click container as whole number pa‐
rameters. Example:
cXx=cPick(1,1,tC,tT,tP,nT)
The significance of the parameters is explained on
page 20‐5.
The Pos‐number of the clicked point is extracted
from this container as follows:
nXx=nCo(cXx,"nr")
A point or a line of the Grafis record is replaced by
entering also the Pos‐number of the object to be re‐
placed for output from the programming language
program. In output instructions with Pos‐numbers,
only one object can be output, respectively. The Pos‐
numbers can be entered for points, lines and curves.
The Grafis record does not differentiate between
lines and curves; both are regarded as lines.
AusP(nXx,pXx)
nXx
Pos‐number of the point
pXx
point to be output
AusQ(nXx,qXx)or AusQ(nXx,sXx)
nXx
Pos‐number of the line
qXx
line/curve to be output
Application of Pos‐numbers in the construction
component “shoulder relocation“
Apart from the application of Pos‐numbers, this ex‐
ample should also clarify:
 The creation of a meaningful dialogue with the
user. First, the user is given the information and
then, is requested to click the required objects.
 The safety of the program has great signifi‐
cance. The program must later “react“, safely to
the different cases of applications. For the
shoulder relocation, the length of the shoulders
is compared and each corner is checked for
gaps and protruding lines.
 Each construction component should alter the
original objects as little as possible, even
though at first, no negative effects may be rec‐
ognised. Therefore, the original orientation of

the lines is reproduced at the end of the con‐
struction component.
 A sufficient comment is necessary. This is irre‐
spective of the fact, whether subsequent alter‐
ations/corrections are carried out by the origi‐
nal programmer or another person. When
working with the construction component
shoulder relocation, decide whether the com‐
ment is sufficient for you.
 A picture with point and line annotations ac‐
cording to Picture 20‐11 is also part of each pro‐
ject. This also applies to a short description of
the procedure.

q2

q5

q1

q6
q3

q4

Picture 20‐11

For the shoulder relocation, objects according to Pic‐
ture 20‐11 are assumed or prepared.
The programming language program for the shoul‐
der seam is organised as follows:
 create and display info mask for the user. The
user is informed about the pre‐requisites and
the application options.
 The curves are suitably allocated, so that the
program can be tested in the development en‐
vironment.
 Request the user to click the front neckline. The
Pos‐number of the ft neck is saved to nPos1 in
the process.
 Request the user to click the front shoulder.
The Pos‐number of the ft shoulder is saved to
nPos2 in the process.
 With the external function lcurve_orient_all(), orientate the neckline and shoul‐
der according to Picture 20‐11 check the cor‐
ner. If no clear corner is found, abort with a
message. Whether a curve was re‐orientated or
not, is saved under the variables lRota1 etc.
 Request the user to click the front armhole. The
Pos‐number of the ft armhole is saved under
nPos3.
 With the external function lcurve2_orient(), orientate the armhole line according to
Picture 20‐11 and check the corner. If no clear
corner is found, abort with a message.
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 Request the user to click the back armhole. The
Pos‐number of the bk armhole is saved as
nPos4.
 Request the user to click the back shoulder. The
Pos‐number of the bk shoulder is saved as
nPos5.
 With the external function lcurve_orient_all(), orientate the armhole and shoul‐
der according to Picture 20‐11 and check the
corner. If no clear corner is found, abort with a
message.
 Compare the front and back shoulder and abort
with a message, if necessary.
 Request the user to click the back neckline. The
Pos‐number of the bk shoulder is saved as
nPos6.
 With the external function lKurve2_orient(), orientate the neckline according to Pic‐
ture 20‐11 and check the corner. If no clear cor‐
ner is found, abort with a message.

Now, the actual transformation steps follow:
 Transform back armhole and shoulder to the
front and then link.
 Relocate shoulder point at the neck by x1 and
at the armhole by x2.
 Allocate the curves, again and reverse the
transformation.
 If a curve has been rotated, return it to its orig‐
inal orientation.
 Replace the curves of the construction record
with the new curves. The curves are output
onto the original Pos‐numbers.
The complete program Main() with the external
functions
lcurve_orient_all
and
lcurve2_orient in the Module “addition“ fol‐
lows.

Content of Module Main.qpr:
'***********************************************************************
Program Main()
'----------------------------------------------------------------------' Construction component relocate shoulder
'---------------------------------------------- Information for the user
' The relocate amount are controlled via x values.
' The construction component requires:
' - shoulder lengths identical in ft and bk
' - straight shoulder lines (no curves) and
' - no gaps between the curves and the shoulder lines.
'----------------------------------- Internal information of the program
' q1: neckline ft, q2: shoulder ft, q3: armhole ft
' q4: armhole bk, q5: shoulder bk, q6: neckline bk
' lRota1 to lRota6 show, whether the curve has be re-orientated.
' At the end of the program, the curves are output in their
' original orientation.
'----------------------------------------------------------------------lVar l,lRota1,lRota2,lRota3,lRota4,lRota5,lRota6
nVar n,nPos1,nPos2,nPos3,nPos4,nPos5,nPos6,nT
rVar r1,r2
pVar pSneck,pSarmh
sVar s1,s2
qVar q1,q2,q3,q4,q5,q6,q1t,q3t
tVar tInfo,t,tGen,tTop,t1
cVar c1,c2,c3,c4,c5,c6
'----------------------------------------------------------------------lCon
nCon
rCon
tCon
'--------------------------------------------------------------- x values
XTitel("Relocate shoulder")
Defx(1,"relocate amount at neckline to ft",10)
Defx(2,"relocate amount at armhole to ft",10)
'--------------------------------------------------- allocate the curves
q1
= qKop(pXY(0,0)+pXY(0,20))
q2
= qKop(pXY(0,20)+pXY(20,20))
q3
= qKop(pXY(20,20)+pXY(20,-20))
q4
= qKop(pXY(30,-20)+pXY(30,20))
q5
= qKop(pXY(30,20)+pXY(50,20))
q6
= qKop(pXY(50,20)+pXY(50,0))
'----------------------------------------------- query and check objects
tGen = "create no clear corner."+tC(13,10)+
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&
&

"Correct the corner and relocate"+tC(13,10)+
"the shoulder again !"
tTop = "Relocate shoulder"
'----------------------------------------------------------- neckline ft
tInfo= "Click front neckline !"
nT
= 0
c1
= cPick(1,4,tInfo,tTop,"i",nT)
q1
= qCo(c1,"qq")
'----------------------------------------------------------- shoulder ft
tInfo= "Click front shoulder !"
c2
= cPick(2,4,tInfo,tTop,"i",nT)
q2
= qCo(c2,"qq")
l
= lcurve_orient_all(q1,q2,lRota1,lRota2)
If(Not l) Then
t
= "The ft neckline curve and the ft shoulder"+tC(13,10)+tGen
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'------------------------------------------ shoulder line straight line?
If(rAbs(rLngQ(q2)-rAbstPP(pQanf(q2),pQend(q2)))>>0.05) Then
t
= "The shoulder line is curved."+tC(13,10)
&
+"This case is not prepared."
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'------------------------------------------------------------ armhole ft
tInfo= "Click ft armhole !"
c3
= cPick(3,4,tInfo,tTop,"i",nT)
q3
= qCo(c3,"qq")
l
= lcurve2_orient(q2,q3,lRota3)
If(Not l) Then
t
= "The curves ft shoulder and ft armhole"+tC(13,10)+tGen
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'------------------------------------------------------------ armhole bk
tInfo= "Click back armhole !"
c4
= cPick(4,4,tInfo,tTop,"i",nT)
q4
= qCo(c4,"qq")
'----------------------------------------------------------- shoulder bk
tInfo= "Click back shoulder !"
c5
= cPick(5,4,tInfo,tTop,"i",nT)
q5
= qCo(c5,"qq")
l
= lcurve_orient_all(q4,q5,lRota4,lRota5)
If(Not l) Then
t
= "The curves bk armhole and back shoulder"+tC(13,10)+tGen
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'----------------------------------------------- shoulder straight line?
If(rAbs(rLngQ(q5)-rAbstPP(pQanf(q5),pQend(q5)))>>0.05) Then
t
= "The shoulder line is curved."+tC(13,10)
&
+"This case is not prepared."
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'------------------------------------------------ compare shoulder lines
If(rAbs(rLngQ(q2)-rLngQ(q5))>>0.5) Then
t
= "The shoulder lines in ft and bk"+tC(13,10)
&
+"have different lengths !"
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'----------------------------------------------------------- neckline bk
tInfo= "Click back neckline !"
c6
= cPick(6,4,tInfo,tTop,"i",nT)
q6
= qCo(c6,"qq")
l
= lcurve2_orient(q5,q6,lRota6)
If(Not l) Then
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t
= "The curves bk shoulder and bk neckline"+tC(13,10)+tGen
n
= nIBox(t,"Relocate shoulder",24)
Exit Program
End If
'---------------------------- transform back neckline and armhole curves
s1
= sPP(pQanf(q5),pQend(q5))
s2
= sPP(pQend(q2),pQanf(q2))
DrehTr(s1,s2:q4,q6)
'----------------------------------------------------------- link curves
q1t = qKop(q1+q6)
q3t = qKop(q4+q3)
'----------------------------------------------- relocate shoulder point
pSneck = pQend(q1)
pSarmh = pQanf(q3)
pSneck = pQPlng(q1t,pSneck,-rX(1))
pSarmh = pQPlng(q3t,pSarmh,rX(2))
'------------------------------------------------ create all curves again
q1
= qQbisP(q1t,pSneck)
q2
= qKop(pSneck+pSarmh)
q3
= qQabP(q3t,pSarmh)
q4
= qQbisP(q3t,pSarmh)
q5
= qKop(pSarmh+pSneck)
q6
= qQabP(q1t,pSneck)
'------------------------------------------------ reset curves in the bk
DrehTr(s2,s1:q4,q5,q6)
'----------------------------------- rotate curves in original direction
If(lRota1) Then
q1
= -q1
End If
If(lRota2) Then
q2
= -q2
End If
If(lRota3) Then
q3
= -q3
End If
If(lRota4) Then
q4
= -q4
End If
If(lRota5) Then
q5
= -q5
End If
If(lRota6) Then
q6
= -q6
End If
'---------------------------------------------------------------- output
AusQ(nCo(c1,"nr"),q1)
AusQ(nCo(c2,"nr"),q2)
AusQ(nCo(c3,"nr"),q3)
AusQ(nCo(c4,"nr"),q4)
AusQ(nCo(c5,"nr"),q5)
AusQ(nCo(c6,"nr"),q6)
'----------------------------------------------------------------------End Program
'***********************************************************************

Content of Module addition.qpr
'***********************************************************************
Function lcurve_orient_all(q1,q2,lRota1,lRota2)
'----------------------------------------------------------------------' The curves are orientated so that the end point of the first curve
' is positioned, directly at the beginning of the second. If the
' curves were oriented, correctly the function has the value True,
' other wise the value False.
'----------------------------------------------------------------------nVar n
qVar q1t,q2t
pVar pEndq1,pAnfq2
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'------------------------------------- query variations, re-orientate curve
lcurve_orient_all= False
For n = 1,4,1
If(n==1) Then
q1t = q1
q2t = q2
lRota1 = False
lRota2 = False
Else If(n==2) Then
q1t = -q1
q2t = q2
lRota1 = True
lRota2 = False
Else If(n==3) Then
q1t = q1
q2t = -q2
lRota1 = False
lRota2 = True
Else If(n==4) Then
q1t = -q1
q2t = -q2
lRota1 = True
lRota2 = True
End If
pEndq1 = pQend(q1t)
pAnfq2 = pQanf(q2t)
If(rAbs(rAbstPP(pEndq1,pAnfq2))<<0.5) Then
lcurve_orient_all= True
q1
= q1t
q2
= q2t
Exit For
End If
End For
End Function
'***********************************************************************
'***********************************************************************
Function lcurve2_orient(q1,q2,lRota2)
'----------------------------------------------------------------------' The SECOND curve is orientated so that the end point of the first curve
' is positioned, directly at the beginning of the second. If the two
' curves were orientated, correctly the function has the value True,
' other wise it has the value False.
' lRota2 is True, if q2 was rotated.
' q1 is not rotated.
'----------------------------------------------------------------------nVar n
qVar q1t,q2t
pVar pEndq1,pAnfq2
'---------------------------------- query variation, re-orientate curves
lcurve2_orient = False
For n = 1,2,1
If(n==1) Then
q1t = q1
q2t = q2
lRota2 = False
Else If(n==2) Then
q1t = q1
q2t = -q2
lRota2 = True
End If
pEndq1 = pQend(q1t)
pAnfq2 = pQanf(q2t)
If(rAbs(rAbstPP(pEndq1,pAnfq2))<<0.5) Then
lcurve2_orient = True
q1
= q1t
q2
= q2t
Exit For
End If
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End For
'----------------------------------------------------------------------End Function
'***********************************************************************
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A.1 New in Grafis Patternmaking
New measurement system Basis_A
The new Optimass measurement system contains re‐
vised measurements for women, men and children
and also new figure types for underwear.
Part organisation
The content and the appearance of the part organi‐
sation have been revised. In addition to the part or‐
ganisation, a part rack has been added to the left of
the workspace. The part organisation can be docked
to this rack or displayed in a separate window. In the
part organisation, it is possible to mark a number of
parts and then, to delete them, to remove them or
to save them as a part module, see Section 14.2.
Part Assistant
The new part assistant speeds up derivation of pro‐
duction pattern pieces. The existing Grafis functions
from different Grafis menus have been compiled into
individual dialogues in the part assistant and opti‐
mised exactly for these processes, see Section 9.3.
Z‐values
The z values and corresponding dialogues have been
improved. The new entry assistant for z values sim‐
plifies the creation of z values and allows for case dif‐
ferentiation with up to three conditions. Further‐
more, new operands for creating z values have been
made available, such as the partial length. Inserting z
values into a previous record step enables adding z
values subsequently. The z values are now easier to
comprehend as the clicked operands are highlighted
in colour and the values are displayed graded in an
overview, see Section 12.2.

Size sorting in tables
In various tables, individual sizes such as S, M, L, XL,
and XXL are sorted according to their reference size.
This applies to the finished measurement table, edit‐
ing measurement charts, editing z values and editing
identification measurements in the Grafis notes of
the interactive constructions.
Pixel images
There are various new functions for scaling and posi‐
tioning and for image editing in the new Manage
pixel images menu. Loaded pixel images can be
stored as background images or as logos in the style,
see Section 15.8.
Quick measure
In addition to the normal measure, quick measure
has been introduced, started via the key combina‐
tion Ctrl+Shift+M. The user can measure point co‐or‐
dinates, line lengths and distances. These measure‐
ments are displayed in a list, one below the other.
Last opened files
In the pull‐down menu Files, the most recently
opened files are displayed under Recent files.
Zoom on active part
With the key combination Ctrl+F6, the active part is
zoomed.
Move/ zoom with space bar
Move/ zoom of the screen is started via the space
bar. Once move/ zoom is activated, the active part
can be moved separately on the screen with Ctrl. This
is particularly important in the new part assistant.
Edit symbols
In the pull‐down menu Extras, a new dialogue can be
opened via Edit symbols.... Here, set symbols can be
lengthened or shortened.
Symbol colour
All symbols of the active part are displayed in orange
– red and thus, highlighted in colour.
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A line can be defined as a symmetry line. The part is
automatically mirrored along this line in the marker.

 Perforation 30: perforation along three lines with
cutting line
 Marking line 10: template generation

Xgz values

New construction tools

Symmetry line

X, g and z values can be assigned to selected drag
points of the interactive constructions or tools, see
Section 13.3. Styles generated in Version 11 are up‐
dated and also obtain these adjustment possibilities.
Linking interactive tools with x, g and z values ena‐
bles hiding some existing functions. The affected
menus are now clearer and easier to learn.
Starting interactive constructions and tools via right
click
Interactive constructions and tools can be started by
right clicking the corresponding line. If more than
one interactive tool has been used at a line, the re‐
quired one can be selected.
Autostart tools
Via a new button in the menu

the user can de‐

cide whether the tool is started automatically after
call or not.
Updating click images
When calling any tool or interactive construction,
click images are automatically generated and saved.
They are updated during ‘reset click’. This applies
also to constructions and tools used for style devel‐
opment in Version 11. Saved images can now be
viewed as a click preview in the <F12> list.
New corner tools
 Corner 90 bevel: free slanting of corners
 Corner 100 bevel co‐ordinated: free slanting at
two positions simultaneously
 Corner 110 u‐shape: corner treatment with three
lines
 Corner 120 u‐shape co‐ordinated: corner treat‐
ment with three lines at two positions simultane‐
ously
Corner 130 step corner: corner treatment of a seam
with different seam allowancesNew fashioning
tools





Fastening 10: Velcro closure and straps
Notch 10: notch round or pointed
Notch 20: notch as incision
Notch 30: notch as incision at two positions sim‐
ultaneously
 Perforation 10: free perforation
 Perforation 20: perforation along a line

 Parallel 20: parallel co‐ordinated to a number of
lines
 Raster 20: raster along a line with start and end
distance, replacing Raster 10
 Link 20: free or constructive linking, replacing
Link 10
 Link 30: free or constructive linking at two posi‐
tions simultaneously
Revised tools
 Curve 10: this tool now also has options which
can be selected from the menu for adjusting in‐
teractive constructions.
 Tools with shape points, such as Curve 10, Link
10, 20 and 30, Corners 40, 50 and 110, Notch 20
and 30 now have more shape points if the base
points of the curve are placed close together.
 Many tools such as Line 10 and 20, Rectangle 10
and 20, Circle 10 and 20, Curve 10 and 20 and Link
10, 20 and 30 contain a new option Move base
point in mm or %.
 Corner 60: new option Apply length from top or
bottom, see Section 4.6.
 Corner 70: option for cut corner, apply length
from top or bottom, see Section 4.6
 Corner 80: additional notches
 Dart hood 10: arrow representation of fold direc‐
tion
 Raster 10: number of points increased to 50
 Pinch 20: option Permit release from base point
(Y/N) complemented by one entry allowing for
release of base points in direction of symmetry
axis.
 Pantograph 10: symbols are also graded
 Ruffle 10: error correction and revision of frill be‐
ginning and end.
 Trouser fly 10: output of double topstitch. New
drag area Stitch adjustment.
 Front edge 10 can be called into a separate part
from Version 12 onwards and therefore, has an
additional click for the shoulder.
Preallocation for tools during call
A new preallocation file is available where options
and different parameters of the tools can be preallo‐
cated. Further information can be obtained from the
Grafis Team.
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A.2 New in Grafis Marker making

A.3 New in the interactive constructions

Part organisation

Auto zoom

Content and appearance of the part organisation
have been revised. A part rack has been added to the
part organisation in the left area of the workspace.
The part organisation can be docked to this rack or
displayed in a separate window. In the part organisa‐
tion, it is possible to select a number of parts and
then to delete or remove them, see 14.2.

Auto zoom during drag area change can be switched
on or off in the context menu.

Edit symbols
In the pull‐down menu Extras, a new dialogue can be
opened via Edit symbols.... Here, set symbols can be
lengthened or shortened.
Place symmetrical pieces at the fold
For parts with a symmetry line, the user can deter‐
mine that they can only be placed at the fold and not
open.
Pattern pieces which have been constructed as half
pieces and have been assigned the line attribute
symmetry line are automatically mirrored in the
marker and recognised as symmetrical pieces.
Pixel images
There are various new functions for scaling and posi‐
tioning and for image editing in the new Manage
pixel images menu. Loaded pixel images can be
stored as background images, fills or as logos in the
marker, see Section 15.10.
Quick measure
In addition to the normal measure, quick measure
has been introduced, started via the key combina‐
tion Ctrl+Shift+M. You can measure point co‐ordi‐
nates, line lengths and distances. These measure‐
ments are displayed in a list, one below the other.
Last opened files
In the pull‐down menus Production style, Marker in‐
formation and Marker, the most recently opened
files are displayed under Recent files.
Zoom on active part
With the key combination Ctrl+F6, the active part is
zoomed.
Move/ zoom with space bar
Move/zoom of the screen is started via the space
bar. Once move/zoom is active, the active part can
be moved separately on the screen with Ctrl.
Export/ import
Data in cut‐data DXF format can now be imported
into or exported from Grafis marker.

New constructions
Corsage 10
Corsage 10 is a strapless body measurement bodice
with up to three panel seams in the front and up to
two panel seams in the back.
Characteristics of Corsage 10:
 Suitable for evening or bridal wear as well as lin‐
gerie
 Selection of hem or leg opening construction
 Stretch reduction adjustable lengthwise and
crosswise
 With Click bodice in the context menu, the cor‐
sage is bound to a bodice. Thus, the positions of
the two constructions are aligned.
Swimsuit 10
Swimsuit 10 is a finished measurement bodice with
different neck and armhole variations. In the front,
the user can choose between bust dart or cup finish‐
ing.
Bra 10
Bra 10 is a body measurement – finished measure‐
ment construction.
Characteristics of Bra 10:
 The cup can be made‐to‐measure or constructed
with an underwire as basis. The underwire shape
is incorporated in the cup construction.
 As an option, the waistline can be displayed. In
this way, the bra can be constructively linked to a
bodice or a bottom part.
 With Click bodice in the context menu, the bra is
displayed inside a bodice.
Wire 10
Wire 10 is a tool for tracing underwires imported as
DXF files and loaded as a background image.
Cup 10
Cup 10 is a tool for construction of upper and lower
cup pieces.
Sleeve 90
Sleeve 90 is a two‐seam sleeve construction with
new construction logic for the sleevehead: from in‐
side to outside. The objects of Sleeve 90 are compat‐
ible with Sleeve 30.
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Sleeve 100

Waistcoat 10

Sleeve 100 is a single‐seam sleeve construction with
new construction logic for the sleevehead: from in‐
side to outside. Objects of Sleeve 100 are compatible
with Sleeve 40.

 New option Variations of belly grading
 New option Variations side seam – waist accen‐
tuation
 New option Stack point at armhole or at centre
front
 New option Style length from…
 New option Adjust front length interactively or as
body measurement
 Relocation of bust level is possible
 The waistcoat can be adjusted for bodices with
sleeve
 An alternative hem construction is activated if
the front point is located in a corner position.

Revised constructions
Many of the new possibilities below are available ei‐
ther after calling the basic block or after test run of
styles from Version 11. In some cases, new function‐
alities are activated via a menu entry in the context
menu.
Furthermore, new and improved echoes and in‐
creased drag limits facilitate the adjustment of inter‐
active constructions. New auxiliary lines for clicking
the armhole diameter are available at the combined
armhole in all bodices. These auxiliary lines are re‐
quired for calling Sleeve 90 and Sleeve 100.
Many of the new features listed below are also de‐
scribed in the help for constructions.
Bodice 10, 50, 60
New construction logic for flaring the centre front.
For styles from Version 11, the new logic is activated
via the context menu. The belly ease can be specifi‐
cally adjusted. The bodice can be utilised for mens‐
wear and maternity wear.
Tailored jacket 20
 New option Position side panel to centre back or
to side seam
 New option Adjust front length interactively or as
body measurement
Jacket 10
 New option Stack point at front armhole or at
centre front
 New option Adjust style length based on body
height or as finished measurement
 New option Basic direction of side seam back
 New option Variations of belly grading
 New option First segment (mm / %)
 New option Adjust front length interactively or as
body measurement
 Relocation of bust level is possible
 New construction logic for shoulder seam reloca‐
tion as in Bodice 50. Activation via context menu.

Front and back part tools 20, 30, 40
 The direction drag cursor at the straight point of
the panel seam is flipped about 180° from 25mm
distance, allowing for finer direction adjustment.
 The dressage and the dressage area are displayed
in mm.
 The notch position bottom is displayed in % if the
value display is switched off.
Sleeve 30 and 40
New visualisation of sleeve position of the combined
sleeve.
Pocket 10 and 60
New logic for styling curved corners in the Basic
shape adjustment drag area. Curve with direction
drag cursors and fine curves for tight curve radiuses.
Collar 40, 50 and 60
The facing can be moved in x and y direction.
Trouser 10, 30, 40, 60 and 70
New option Adjust calf width via curve shaping or as
finished measurement.
Bodice 80
New option Apply length in mm or %. If the bodice is
to be reduced or increased in percentage it is advis‐
able to select the option Apply length in %.
Pant 10
The new option Enter width can be adjusted in the
drag area Leg opening. If this option is selected, the
width of the front panel seam is specified as finished
measurement and the leg opening curve is con‐
structed via three base points.
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Start installation

B.I Grafis Installation
Administrator rights and write permission
For a new installation of Grafis, normally the installa‐
tion program must be performed with administrator
rights. These rights are required for the creation of
the desktop icon for all users, the link of Grafis file
extensions with Grafis applications and the installa‐
tion for the dongle driver.

As a rule, all open Grafis applications should be
closed before installation. This includes Grafis Pat‐
ternmaking, Grafis Marker making, Grafis Setup and
Grafis Autonester. Grafis is usually delivered on CD
or DVD. If the Autostart function of the drive is ac‐
tive, the installation program starts automatically af‐
ter inserting the data carrier. If the installation does
not start automatically, it can be initiated manually
by starting the INSTALL.EXE on the data carrier. If

Under Windows 10 the installation is usually started
with the rights of the current user. If this user does
not have administrator rights, the INSTALL.EXE
should be executed as administrator with right click.
Initially, the new folder C:\GRAFIS contains write
permission for the current user only. All other users
only have read permission. This is insufficient for us‐
ing Grafis. Therefore, after installation, write permis‐
sion may have to be added for the user group ‘User’.
Under Windows 7 the installation program automat‐
ically demands administrator rights. If the installa‐
tion is to be carried out with simple user rights, for
example for installation on a substituted drive or a
network drive, the INSTUSR.EXE can be started in‐
stead of the INSTALL.EXE. This does not automati‐
cally demand administrator rights. However, crea‐
tion of the desktop icon is permitted for the current
user only. Dongle installation is normally not possible
and must be started separately at a later time. For
separate dongle installation start HASPU‐
serSetup.exe from C:\GRAFIS\HILFEN.
If Grafis is installed for the first time it may be re‐
quired to give write permission to the installation di‐
rectory (normally C:\GRAFIS) to normal ‘Users’ of the
computer.

Picture B‐1

Grafis has already been installed on the current com‐
puter, after the welcome window, you can choose
between the installation variations New/Complete
and Update, see Picture B‐1.
Installation New/Complete or Update
The variation New/Complete installs Grafis com‐
pletely and resets all existing settings and options to
the delivery conditions. Style data, individual meas‐
urement charts and basic blocks will not be lost. Plot‐
ter and export/ import settings, path settings and
window positions however, will be reset. Select this
variation if Grafis is being installed for the first time
or if an incomplete Grafis folder without functioning
application exists. With the button Installation in a
network Grafis can be configured for common use of
a number of workstations within a network. For
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more information, please refer to details later in this
section.
The variation Update should be selected if an exist‐
ing version of Grafis is to be updated. All existing set‐
tings for paths, window positions, recently opened
files, export/import settings, plotter setup etc. are
carried over or a query appears before overwriting
files.
Before updating an existing Grafis installation, a
backup of all existing data should be carried out. It is
sufficient to copy all Grafis directories in use from
the local computer and from the network onto a sep‐
arate medium or to save them as a copy on the local
drive.
Select target drive and options
In the next step, the target drive is selected. Grafis is
always installed in the folder \GRAFIS on the target
drive. The following options can be selected, see Pic‐
ture B‐2 as an example for the installation variation
New:

Set up icons for all users
With this option you determine for which user pro‐
files the Grafis icons are to be set up. If basically all
users of this computer work with Grafis, this switch
must be activated. If only the registered user is to
work with Grafis, this switch can be deactivated. If
the installation runs with simple user rights, i.e. with‐
out administrator rights, this option is inactive.
Link Grafis file extensions
This option activates the linking of the file extensions
*.MDL, *.PMD, *.SCB and *.SBI with the respective
Grafis program of the current installation. Files with
these extension can then be opened with double‐
click in Explorer.
Update measurement systems
This option is only available for an Update installa‐
tion, see Picture B‐3. With this option, the installa‐
tion of measurement systems can be specifically
switched on or off. Use this option if the basic Grafis
data is to be updated but the measurement systems
are to remain unchanged.

Picture B‐2
Picture B‐3

Install dongle driver
This option should always be activated. The installa‐
tion of the driver may only be omitted if the same or
a later version of Grafis has already been installed on
the computer. The driver installation itself checks if
a dongle driver is already installed and proposes up‐
dating or skipping the installation.

Installation in a network
For an installation of the New/Complete variation, a
further dialogue can be opened via the Installation in
a network button, see Picture B‐4. This dialogue per‐
mits moving six different folders or folder groups to
other drives for shared use in the network. The
folder or folder groups are:
• Measurement systems
• Forms
• Basic blocks
• Texts and text modules
• Plotter settings
• Symbols and export settings
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Over and above the already mentioned folders,
other types of data can be migrated to network
drives. For special configuration options right up to
establishing a ‘diskless workstation’, please contact
the Grafis Support.
Start installation
After having started the installation, all data is copied
to the corresponding target folders. In the variation
Update, targeted queries appear questioning
whether specific data is to be overwritten. If applica‐
ble, at the end of the copy process, a list of files is
displayed showing files which could not be copied as
they were write‐protected in the target drive or cur‐
rently in use.

Picture B‐4

If only style files are to be exchanged, it is not neces‐
sary to move these folders to the network. It is suffi‐
cient to assign a common network drive for the
Grafis users, activated in the Grafis Setup on the
Drives and Paths file card. This drive should ideally
be linked with the same drive letter on all Grafis user
workstations. This variation is recommended if a
number of independent users, such as service pro‐
viders or students, wish to exchange styles or if styles
to be provided for classes.
If measurement charts, forms and basic construc‐
tions are to be shared as well as the style data, these
entries must be moved to a shared network drive.
The drive letter for the network drive should be the
same on all Grafis workstations. During installation
on the first workstation, all data must be copied. For
further workstations the option Do not copy data.
They already exist. can be activated. This variation is
recommended for companies with a number of
workstations, in particular if data backup is carried
out via this central drive.

In the variation New/Complete, the setup program
starts automatically after copying is completed.
Here, fundamental setting for screen, available
drives or system language can already be under‐
taken.
If the option Install dongle driver has been activated,
the driver installation ‘Safenet Sentinel Runtime’ by
Safenet follows.

B.2 System adjustment Grafis Setup
The system ‘Setup’ is started automatically during
Grafis installation. It can be called at a later date
from within Grafis via the pull‐down menu Help →
Grafis Setup or by starting the setup.exe in
\grafis\hilfen\.
Changes to the Grafis Setup normally require a re‐
start of the respective Grafis program to take effect.
Screen file card

If other information (text modules, plotter settings,
symbols, export settings) are to be shared as well,
the corresponding folders can also be activated.
It is not absolutely necessary for all these folders to
be stored on the same network drive. Theoretically,
each of these data groups may use its own drive.
However, to ensure clarity, the data should only be
spread over different drives in exceptional circum‐
stances.

Picture B‐5

On the Screen file card Picture B‐6, the parameters
for a distortion‐free screen display can be adjusted.
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After the Grafis installation and after each adjust‐
ment of the display size on the screen these settings
should be checked and if necessary, adjusted.
To alter or check the settings click on Edit values. A
square appears which has to be adjusted to 10cm
length at the sides using the four buttons or by drag‐
ging the lines, see Picture B‐6. This ensures that a cir‐
cle is displayed as a circle and a square is shown as a
square on screen. For simplification of the setup, a
number of pre‐defined settings for particular display
types are available.

The selected drives can be moved from one side to
the other with the arrow buttons.

Picture B‐7

Picture B‐6

The Screen file card also offers a number of options
for illustration and display in the Grafis window.
From version 11 onwards, the menu on the right is
displayed with graphic symbols (buttons) as stand‐
ard. The button size can be determined on this file
card. A button size of 32 pixels is recommended for
a screen resolution of up to 1024x768. For a higher
resolution, 40 pixels are recommended.
Drives file card
The setting of drives is of fundamental importance.
It ensues on the Drives file card, see Picture B‐7. In
the Grafis drives list on the left, all drives on which
Grafis data is to be saved must be listed. One of the
Grafis drives has to be selected as the Grafis start
drive. This ensues in the field below the left window.
The Grafis start drive should always be accessible. It
is usually a local drive and ideally the original instal‐
lation drive.

Drive letters for removable disks are only indicated if
these data carriers are connected (e.g. USB sticks) or
if media is inserted (e.g. for removable disk drives).
CD/DVD or Blue‐ray drives are never suggested or
displayed.
The start commands for table calculation or text pro‐
cessing can be saved to permit a quick start directly
from within Grafis.
Network setup
The button Network setup opens a separate dialogue
window with the Grafis network configuration, see
Picture B‐8. Changes to these settings have funda‐
mental impact on saving of files and should only be
altered by a system administrator or experienced us‐
ers.
During installation it is possible to install specific
folders or folder groups on network drives. If this op‐
tion has not been used, folders can be moved to dif‐
ferent drives at a later date with the Network setup
dialogue in the setup program.
Initially, the dialogue shows the current situation. If
specific allocations have already been made, this will
show here. As well as paths for the different folders,
the button Relocate plus selection of a target drive
enables new allocation. The selection <basic drive>
resets previous relocation back to the original instal‐
lation drive. This allocation can be carried out sepa‐
rately for each measurement system in the upper list
area.
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The actual move is initiated via the button Relocate
now in the lower area of the window. Here, you can
also determine if
 the existing files are copied,
 existing files are overwritten without warning
or
 the files are removed from the original location
and are to be relocated to a new location.

Picture B‐9

Picture B‐8

If you waive copying the data, only the path entries
are altered during the move. Use this option if the
data has already been copied to the network drive
from another workstation.
Plotter file card
The Plotter file card (Picture B‐9) lists the plotters
available in Grafis. Only plotters marked as active
with ‘*’ in the first column are offered in Grafis.
Certain basic settings for the plotters can be adjusted
via Settings (Picture B‐10), such as the resolution or
the maximum paper width.
Configure serial port adjusts the output parameter
for direct output of plot data from Grafis to a COM
port.

Picture B‐10

Digitizer file card
Digitizing with Grafis is possible under the following
circumstances:
 The digitizer is connected to the Grafis com‐
puter.
 The WinTab driver for the digitizer is available
and installed.
 A 16 button cursor is connected.
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To test the WinTab driver the Tabtest.exe in the
\Grafis\Hilfen directory can be used. If Tabtest re‐
ports ‘No Info (Keine Info)’ the WinTab driver is not
installed correctly.

Picture B‐11

If the WinTab driver has been installed succesfully,
the following variables can be adjusted on the Digi‐
tizer file card (Picture B‐11):
Size of menu The distance p1=>p2 is 245mm
area
on the menu pads supplied. As
the pads can also be used en‐
larged or reduced proportion‐
ally, the current distance
p1=>p2 is to be entered in mil‐
limetres.
No. for OK but‐ cursor key for <OK>
ton
No. for Cancel cursor key for <Cancel>
button
Delay after key Delay after key press in mille‐
press
seconds
Digi‐Cursor
Standard... for normal digitizer
mouse key assignment
Numeric1... for numeric digi‐
tizer mouse, can be recognised
at numbers in left three col‐
umns and letters in the right
column
Numeric2... analogue Nu‐
meric1 with different key num‐
bering

Marker file card
The Marker file card (Picture B‐12) offers some basic
settings and options for the Marker making pro‐

Picture B‐12

gramme. Hem position defines the alignment for the
automatically selected grain line direction in the Pat‐
ternmaking and the Marker making, see section
18.10. Line types offers assignment of specific line
significance to line attributes, see section 18.11.
These parameters are fundamental and should be
determined once during installation of the pro‐
gramme and then maintained.
Furthermore, the following can be adjusted:
Minimum letter size … Minimum size for automati‐
cally set annotation for plot and print
Add size designation to Marker name…
During Save as… of a new marker, the placed
sizes are named in the suggested marker name.
Offer same directory for open and save…
For open and save only one common path is
saved.
Use Autonester… If the Autonester programme was
purchased it can be activated here.
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Toolbox file card
On the Toolbox file card (Picture B‐13), the combina‐
tion and organisation of the buttons in the toolbox
of Patternmaking and Marker making can be altered.

The basic language is the language in which the main
data is available. It is marked with ‘*’.
For use of Grafis in areas with non‐Latin letters, such
as Russian, Mandarin (Chinese) or Thai, extended
language options can be selected:
Use Window fonts for plot output
Here, Grafis switches to Windows fonts for display of
Grafis text in picture and plot/ printer output. Win‐
dows fonts tend to have double lines and therefore,
take significantly longer to plot with pen plotters.
Furthermore, they are more difficult to recognise on
the screen. However, the complete character set of
the selected language is available. This is important
for example in Mandarin.
Activate multi‐byte characters in Grafis texts
This option is connected to the previously described
option and must be used if the characters of the se‐
lected language are always coded with more than
one byte per character ‘multi‐byte’, such as for Man‐
darin.
Options file card

Picture B‐13

The Options file card (Picture B‐15) contains a num‐
ber of additional options.

The arrow buttons move the activated entries from
one side to the other. Up and down alters the order.
Language file card
As well as German and English, Grafis is available in
various other languages. The installed language
packages are offered for selection in this dialogue.

Picture B‐15

Picture B‐14

With the option auto‐save regular automatic saving
of the current style can be pre‐set. Save ensues in the
background every .... minutes. Entering 0 into this
field switches off the automatic save.
With the function graphic font you can choose be‐
tween different typefaces. The setting applies to out‐
put of text in drawings. The typeface GRAFIS2 is the
default setting. In case of Cyrillic or Thai characters
the selection of graphic fonts is limited. If the use of
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Windows fonts for plot output is activated under Ex‐
tended language options on the Language file card,
this setting has no effect.
Furthermore, you can choose to start text editing of
the x value list via simple click or double click.
If the patterns are not transferred correctly during
transfer via clipboard, the switch Clipboard with en‐
hanced metafile can be changed.
Check all production parts during save is useful for
companies where style development and marker is
carried out by different departments. Should an er‐
ror occur during creation of a style, with this option
the error is flagged up directly during saving of the
style before the style is opened in the Marker mak‐
ing.
Cache help files locally is only required if the Grafis
auxiliary files are loaded from networks and are not
displayed correctly.
Number of backup files determines how many
backup copies per style are saved. The backup copies
are saved in the same directory in which the original
style is saved and carry the extension *.bk0 for the
first backup, *.bk1 for the second backup etc.
With show BK? during open you can determine that
the backup files can also be opened directly through
switching of the data type.
Check MDL files on save activates a control after
writing of the data. Activate this option only if files
which can no longer be opened appear frequently.
Store preview for PDM systems in the style activates
saving of a screen shot in the style which can be used
by PDM programmes for file preview.
Hide mirrored basic blocks hides the mirrored basic
blocks in the call list.

Picture B‐16

Auto zoom during drag area change switches the
automatic zoom function during changing between
different drag areas within an interactive construc‐
tion on or off.
Open error log displays the record files created by
Grafis for patternmaking or marker making (SB). This
information may be required for Hotline support by
the Grafis Team.
Expert mode file card
A number of complex or rarely used functions can be
activated via this file card (Picture B‐16).

B.3 Grafis directory structure
Folders/Subfolders and their significance
\GRAFIS
Grafis.exe, GrafisSB.exe, *.INI files and help files
\GRAFIS\Forms
shapes of the interactive constructions
\GRAFIS\Hilfen
Setup.exe and various help tools
\GRAFIS\Masken
mask files
\GRAFIS\Menues
menu files
\GRAFIS\Module
projects of Grafis Programming language and
help files for the functions of the programming
language
\GRAFIS\Plotter
*.PLT control files of Grafis plotters
*.QUE plotter link files
\GRAFIS\Prog
constructions which can be called in all measure‐
ment systems
\GRAFIS\SB
markers and marker information
\GRAFIS\SB\Mas
size list for marker
\GRAFIS\Symbole
system files symbole.sys and interfac.sys, export
configurations
\GRAFIS\Texte
files of the typefaces and own standard texts
\GRAFIS\0440
files for the display of Grafis as partial translation
in English
\GRAFIS\0860
files for the display of Grafis as partial translation
in Mandarin
\GRAFIS\Damen_U
measurement system Womenswear UNICUT
\GRAFIS\Basis_A
measurement system Optimass
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Each measurement system is structured as follows
(Basis_A measurement system as example):
\GRAFIS\Basis_A\Interfac
export data
\GRAFIS\Basis_A\Kollekt
folders and subfolders with style files
\GRAFIS\Basis_A\Mas
folders and subfolders with measurement charts
\GRAFIS\Basis_A\Mask
program mask files for old Grafis programming
language
\GRAFIS\Basis_A\Prog
program files
\GRAFIS\Basis_A\Swert
grade rule patterns
\GRAFIS\Basis_A\ST
part modules
\GRAFIS\Basis_A\Xwert
X value tables for old Grafis programming lan‐
guage programs

B.4 Grafis.ini parameter
Area, Name and Description
[SCREEN]
WIDTHMM=300
Screen width in mm (visible image)
HIGHTMM=225
Screen height in mm (visible image)
BACKGROUND=0
Background colour (0‐black, 15‐white)
MENUFONTHIGHT=14
Type size in right menu
CONTINUOUS_SEAM=0
Show seam line as continuous (charcoal grey) line
[PATH]
DRIVES=AC
Letters for available Grafis drives
STARTUPDRIVE=2
Consecutive no. of Grafis start drive
TABCALCRUN=
Path for table calculation
TEXTPROCRUN=
Path for text processing
WPADRUN=zzz
Path for text program WordPad (C:\Program
Files\Accessories\wordpad.exe);
set during installation by the install program ac‐
cording to the windows version

PATHMASK=
Path for masks \Grafis\MASKEN
PATHMENU=
Path for menus \Grafis\MENUES
PATHPLOT=
Path for plotter driver \Grafis\PLOTTER
PATHSYMB=
Path for symbol file \Grafis\SYMBOLE
PATHTEXT=
Path for text files \Grafis\TEXTE
PATHPROG=
Path for measurement system independent pro‐
gramming language programs \Grafis\PROG
PATHFORM=
Path for shapes \Grafis\FORMS
PATHMODULE=
Path for module developments (programming)
\Grafis\Module
PATHTEMP=
Path for temporary working files \Grafis\Temp
PATHDAT=
Path for *.DAT and Material.DBA
RUN01M=zzz
RUN02M=zzz ...
Additional menu entry (menu text) for user defined
programs (e.g. management programs, design pro‐
grams, data converters)
RUN01L=zzz
RUN02L=zzz ...
Start command for respective entry
[OPTIONS]
SAVEMINUTES=0
Time elapsed between automatic save in minutes
GRAFISFONT=Grafis2
Name of Grafis font used (default = Grafis2)
EDITONCLICK=1
Edit (x values) with single click
ENHMETAFILE=0
Copy to clipboard as Enhanced Metafile (0=no,
1=yes)
FIXTOOLBUTTONS=32
Size of buttons in toolbox (32 or 40)
FIXMENUBUTTONS=40
Size of buttons in the right menu (32 or 40)
USEMBRAM=xx
Use xx % of installed RAM
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SHOWAVICURSOR=0
Special cursor for recording of screen sequences:
1=active, 0=inactive
CYCLESTATUSBAR=1
Continuous messages in the status line (0=no,
1=yes)
SAUMNR=0
Hem number menu usable (0=no, 1=yes)
CATHELP=0102
Entry help for category; how many digits are to be
found from which place
MATHELP=
Entry help for material; In which position can the
code letter be found.
XEDITINLINE=0
Edit entry in x value box analogous to part organi‐
sation (0=no, 1=yes)
CHECKFDTONLY=0
Checking method for connections:
0=standard option, connected style file is originally
check to the file date. If there is a difference the file
is opened and the content is checked.
1=only date/time are checked; Alteration here
means alteration in any part irrespective of con‐
tent.
2=extended mode; As 0 but alteration date is auto‐
matically entered for certain actions within the
style.
NOPARAMUPDT=0
Update WITH part parameter not permitted (0=no,
1=yes)
EXTERRMSGLINK=0
Extended error message for unsoluble connection
(0=no, 1=yes)
TITLECMAX=45
Length of path displayed in the title bar
PIECENN=NN
Standard entry for empty/new pattern pieces
ZOOMFAKT=2.0
Zoom factor for zoom function
NODK4003MEM=0
Switch off sticky function for separate menu (0=no,
1=yes)
NODK4004MEM=0
Switch off sticky function for parallel menu (0=no,
1=yes)
NODK4005MEM=0
Switch off sticky function for corners menu (0=no,
1=yes)
NODK4017MEM=0
Switch off sticky function for attribute menu (0=no,
1=yes)
MENUFONT=Courier
Menu font (True‐type font)

MENUCHARHIGHTCORR=0
Height correction value for character height at
right menu
MENUCHARSET=0
Character set for menu font (right menu)
DELEXPLISTONSAVE=0
Delete export record list ‘Last output’ when save
style with ‘Save as...’
DK5012EH=0
Show function ‘hook in’ at insert menu
REBUILD_ON_MDLCALL=1
Automatic test run after calling a construction
SYSTEMBEEP=2
system sound
0 = no sound
1 = beep over integrated PC loudspeaker
2 = Windows standard signal (pling)
CHECK_GRD_PTS=0
Extended grade point check
PRESET_DRAG_ARROW=1
Preset of yellow drag arrow at dragging
0 ‐ like until Jan/2006 (during a Grafis session the
orientation remains unchanged ) <standard until
1/2006>
1 ‐ One preset ‘right’ per drag session <standard
from 2/2006>
CHECKMDLONSAVE=0
Automatic check of perimeter of production pieces
when saving the style
HIDE_MIRFOLD=0
Hide all PROG sub‐folders with mirrored construc‐
tions
ALLOW_CPRMDL=0
Allow module combinations in measurements
PROG folders
ALLOW_PRG_FOLDER=0
Allow sub‐ folders with PRG programs (compatibil‐
ity to V8)
USE_TTF=0
Use Windows True‐type fonts as printing font
PTTFCHARSET=0
Character set for plot font
PTTF_SUPP_UNICODE=0
Recognize unicode characters in plot texts auto‐
matically
PTTF_FACE=Courier New
Plot font Courier New
PTTF_PITCH=48
‘pitch’ and ‘familiy’ values for plot font
CACHE_CHM
Cache CHM files of net drives locally
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BAKMAX=1
Maximum number of style backup copies (x=num‐
ber)
LANGUAGE=0000
Language or country code for masks and menu
texts (four digits)
LANGNAME=
Name of selected language
TXTDIRAUTOM
Pre‐set direction automatic in text menu
TXTSZEAUTOM
Pre‐set scale automatic in text menu
MTABEXTRACT_MODE
Measurement chart extract method
0 ‐ only extract if not available <default>
1 ‐ only extract if different date or size, after query
2 ‐ always extract without query
DRAGZONEMENUPOS=0
Position context menu in interactive environment:
0 ‐ absolute (300,100) on current screen
1 ‐ at mouse position <default>
NO_GRD_ZOOM=0
No zoom during start of grade rule pattern edit
GRD_GRP_ADD=0
Group grade rules additive
FORCE_PDM_COMPAT= 0
Allow compatibility with old PDM Programme up
to V9
MDL_PREVIEW_IMAGE= 0
Store MDL style with preview image for Bizzoflex
MARKLINE_CUTLINE=0
Generate marking line directly with attribute cut
internal line
DIALOGFONTHIGHT=8
Text size for system font (dialogue font)
STACKMOTHERPCS=0
Recorded stack also in mother parts
STACKBOUNDARY=1
Stack at part circumference
DISABLE_FIXED_LINTYPES=0
Generally disable old line type assignments
SHOW_BAKFILES=0
Offer opening BK? files
ENABLE_GRDTAB_SUBPATH=1
Managing measurement charts in subfolders (ex‐
pert switch)
ENABLE_GRDTAB_ALTREF=1
Use of alternative reference size (expert switch)
SAVE_VERIFY=0
Plausibility check of write process. The file content
is tested for structural logic. The file is not com‐
pared byte by byte.

SWITCH_SEAMADDITION=0
Function remove seam allowance (expert switch)
DELETE_SEAMADDITION=1
Delete allowance for function remove seam allow‐
ance, with =0 the old contour is changed to dashed
attribute
ENABLE_EXTDXVAL=1
Additional functions in the x value window (expert
switch)
ENABLE_GRDTAB_MEMMAP=1
Memorise import size assignement (expert switch)
[INTERFACE]
LINE51=>....<
Output for header GerberEPN: collection
LINE52=>....<
Output for header GerberEPN: style
LINE53=>....<
Output for header GerberEPN: part number
LINE54=>....<
Output for header GerberEPN: part name
LINE55=>....<
Output for header GerberEPN: line format
LINE56=>....<
Output for header GerberEPN: base size
LINE57=>....<
Format for size name
IMPNONLECTRA=1
0‐ when importing AAMA data Lectra‐AAMA data
is expected (Lectra does not supply notch points for
graded contours)
1‐when importing general AAMA data is expected
USEEPNCONV=0
EPN direct output using EPNCONV or EPNIN
(0/1=normal);
Special option =2: Data is copied directly to the
folder defined in EPNCONVPROG.
EPNCONVPROG=xx
Path for program file for EPN direct output
EPNSORT=0
Subsequent sorting of sizes in the EPN file (0=no,
1=yes)
EPNGRADGRAIN=0
Graded grain line in EPN file (0=no, 1=yes)
EPNCATEND=
End character or limit for category name (for part
names with name elements of different lengths)
EPNNOSPACES=0
Remove spaces from part names and categories
(0=no, 1=yes)
EPNUSELONGNAMES=0
EPN file: permit long file names (more than 8.3)
(0=no, 1=yes)
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EPNNUMBERONLY=0
EPN file: always reduce size designation to num‐
bers (if possible) (0=no, 1=yes). This option can
completely replace the entry LINE57 (see above).
GRAINDOWN=0
Automatic grain line detection: select grain line in
direction hem/bottom (1) or away from hem/top
(0)
AAMASMOOTHPT=0
Consider smooth points (intermediate curve
points) during AAMA file import (0=no, 1=yes)
ANNOTASPIECE
Use ‘annotation’ as piece name
DXFEXP_STARTLAYER
Standard DXF Export: first layer No. ...
DXFIMP_IGN_BLOCKS
Standard DXF Import: ignore ‘blocks’ entries
DXFEXP_NAMEMODE
Name modus for DXF file
0 = according to old standard (style_<part
No.>.DXF)
1 = DXF file will be created with dialogue ‘Save as’
2 = DXF file name will be created using the part
name (style+<part name>.DXF)
Spaces and ‘.\/:*?’ are changed into ‘_’.
DXFIMP_CIRC2DRILLRAD
Radius of circle to drill hole conversion
IGN_GRADE_REF
Ignore AAMA/ASTM line type ‘grade’
IGN_PLAID_REF
Ignore AAMA/ASTM line type ‘plaid’
IGN_STRIPE_REF
Ignore AAMA/ASTM line type ‘stripe’
MIN_SLITNOTCH_LEN
Preset minimum ‘slit’ notch lenght for import (gen‐
eral)
MIN_VNOTCH_LEN
Preset minimum ‘v’ notch lenght for import (gen‐
eral)
OPTNSALWY
Open options dialogue at every export
AAMASAVEAS
Save packed DXF files with ‘Save as...’ dialogue
DUPL_PCE_MODE=1
Treatment of double piece names:

0 = pack everything into one part
1 = create a second/ another part
AAMA_ACCEPT_FFPTS=0
Import or omit free function points as points
AAMA_CHK_DOUBLE_RULES=0
Check for double grade rules on a point
[PRINTER]
LEADINGBLANKS=xx
Number of leading blanks for print output
MAXCHARPERLINE=x
Maximum number of characters per line for print
output
MANAGER=zzz
Path for plot manager empty
NOEMPTYPAGES=
Do not print empty pages (only for Windows print)
(0=no, 1=yes)
PORTNAMEMODE2K=
use alternative port name for direct output under
Windows 2000 (0=no, 1=yes)
NOPOSRESET=x
Do not store position of parts in plot dialogue
[DIGITIZER]
DIGISTOP=0
Waiting time after digitizer mouse click in millisec‐
onds
SCHABLONEMM=205
Distance P1‐P2 of digitizer template in mm
DIGIOK=1
Digitizer mouse key code for OK button
DIGIQUIT=4
Digitizer mouse key code for Quit‐Button
LUPE=>..<
Digitizer mouse key assignment
ALLOW_KEYB_KEYS=1
Accept keyboard strokes as digitizer mouse clicks
[SYMBOL]
GRAINLINE=13
Symbol number for grain line
DRILLHOLE=10
Symbol number for drill hole
AUXDRILLHOLE=14
NOTCH=1
VNOTCH=4
CASTLENOTCH=2
LABEL_SYM=18
optional: Label symbol number
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[SERIALPORT]
BAUDRATE=9600
Baud rate for plot output to serial port
PARITY=0
Parity for plot output to serial port (0=none, 1=odd,
2=even)
DATABIT=8
Data bits for plot output to serial port
STOPBIT=1
Stop bits for plot output to serial port
FLOW=8
Serial communication, handshake settings, possi‐
ble variations:
(CTS/RTS):
Hardware
handshake
(Pause)
FLOW=8236
Grafis‐Standard (Hardware/Spezial): FLOW=8
Hardware handshake ‘mode com1:9600,n,8,1’:
FLOW=4112
Software
handshake
(XON/XOFF)
‘mode
com1:9600,n,8,1,x’: FLOW=4880
[TOOLBOX2]
B01=xx…B25=xx
Assigning toolbox in Grafis Patternmaking; the pos‐
sible parameter are listed in the Grafis.ini.
[TOOLBOXS]
B01=xx…B25=xx
Assigning toolbox in Grafis Marker making; the
possible parameter are listed in the Grafis.ini.
[MARKER] Pre‐settings for marker making
BLGINIT=7000
Standard value for material length in mm
MINPLOTLETTER=30
Minimum letter height for plot in tenth of mm
(mm/10)
MINPRINTLETTER=20
Minimum letter height for printing via Windows in
tenth of mm (mm/10)
PIECETEXTLETTER
Height of piece annotation (mm/10)
MARKERTEXTLETTER
Height of marker annotation ( mm/10)
PIECETEXTLINLETTER
Height of text at annotation lines (mm/10)
TITLECMAX=50
Maximum length for path entry in Grafis title bar
ADDSIZETOFNAME=0
Suggest size name for standard marker name
(0=no, 1=yes)
BASEPATHSCB=x
Base directory for marker files \Grafis\SB
BASEPATHSBI=x
Base directory for marker information files
BASEPATHMDL=x
Base directory for production style files

RESETPPARAM=0
Reset layout parameter for rack pieces (0=no,
1=yes)
ONEPATHONLY=0
Remember only one path for open and save (0=no,
1=yes)
NOFLIP=0
Do not permit flip with click at crosshair during
crosshair display (0=no, 1=yes)
NOTURN=0
Do not permit turn with click at crosshair during
crosshair display (0=no, 1=yes)
CHECKCHAIN=0
Update prompt for chain plot (0=no, 1=yes)
ALLOW_SAVE_ON_CHECKCHAIN=1
Allow save after update
USESAVEFILE=1
Work with local copy (and write protection) (0=no,
1=yes)
BAKMAX=1
Number of backup copies
USE_MKX=1
Cut order planning interface on/off
MKXMODE=0
Mode for reading marker orders (0= Cut order
planning (default), 1=Lago)
MKXSBEX=zzzz
Exchange directory for Grafis marker data in direc‐
tion Cut order planning
MKXSBIM=zzzz
Exchange directory for Cut order planning marker
request in direction Grafis
MKXMDEX=zzzz
Exchange directory for Grafis style data in direction
Cut order planning
MKXSB_ADD_FILE=0
Output to a file MKXSBEX is the complete path to
the target file
ALLWAYS_SMALLFILE=0
Always set option ‘delete superfluous data’ (0=no,
1=yes)
STRECHVALUEONGRAIN=0
Preset stretch value switch ‘relate to grain line of
pieces’ (0=no, 1=yes)
AUTONESTERPATH=
Directory for Grafis Autonester
AUTONESTERKEY=
Release code for Autonester application
AUTONESTER_INCFOLDERNAME=0
Include path when determining name (n levels)
MDLACTMOD=0
Mode for updating styles
0 = discard piece properties (also for same style)
2 = transfer piece properties for identical ID or per
category
3 = transfer piece properties (ID, piece text, mate‐
rial)
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SCBOPENLIST
Structure of list view for ‘Open marker...’ dialogue
(detail view)
0 = end list at this point
1 = file size
2 = date/time
3 = marker width
4 = marker length
5 = one letter for material code
6 = efficiency
7 = style name if available
8 = size list
9 = U/B (usage per bundle)
10= total length of perimeters
STATUSWDTHF01..08
Arrangement of status line
1 = part number/ part name
2 = size
3 = length
4 = efficiency
5 = U/B (usage per bundle)
6 = width
7 = current rotation angle
8 = warning symbol
PLTSAVEAS_JOB=0
Create job file also when plot to ‘FILE:’ (Save As)
OLDMDLNOTIFY=0
Always display old warning message at non‐exist‐
ing production style.
MOVEUP_PIC
Create preview image at ‘Complete marker up‐
wards’
0 = no (standard)
1/2 = yes as bitmap
3 = yes as Metafile
SPLITCURVE_ENABLE=0
Split pieces with wavy line
SPLITCURVE_STRT=10
Starting distance for wavy line
SPLITCURVE_HGHT=10
Height of wavy line
SPLITFREEHAND_ENABLE=0
Allow splitting of pieces by freehand
ZOOMSIZEVAL=2.5
Size of material in proportion to screen at <F6>
zoom (value in 1/X of screen size; standard = 2.5)
PLOT_RESTOREPOS=1
Restore original piece position after piece plotting
(standard=‘yes’)
SHOW_ALL_OPTPCS=0
Display also exchangeable pieces which are not in
use

PMDLBASEPATH=
Basic path for production styles (for search)
OPTIPLAN_LOADSCB=0
Instead of styles markers are loaded as templates
(0=no, 1=yes)
PSCBBASEPATH=
Basic path for marker templates (for search)
SCBBASEPATH=
Basic path for search of placed markers
MKCOLORMODE=0
Colour mode for piece display
0= normal (7 colours in 3 shades)
1= only one shade (7/1)
2= two shades (7/2)
3= continuous, one shade (7/c)
4= continuous, two shades (7x2/c)
5= continuous, three shades (7x3/c)
PCSWINLNS=2
Counter window pieces/placed line number
PATHSBMAS=r:\grafis\sb\mas\
Path to SB\MAS folder
PLOT_NORESETDISTANCE=0
Do not reset distance value during plotter change
CUTPLOT_FOLLOW_THE_LINES=1
Plot‐cut import with/without Follow Lines (expert
switch)
DXFEXPMODE=1
Export mode for DXF markers (0‐standard, 1‐
AAMA‐like mode)
ENABLE_BDL_FLIP=1
Swap bundle direction (expert switch)
ENABLE_ENH_REPEAT=1
Further repeat options (expert mode)
ENABLE_BG_PIC=1
Background image (expert switch)
ENABLE_PMD_SZOPT=1
Special production style options (sizes)
ENABLE_SHRINK_ASST=1
Shrinkage assistant (expert switch)

B.5 Printer/Plotter Setup
The dialogue Printer/Plotter Setup opens via
 the pull‐down menu File → Printer/Plotter
Setup or
 in the plot menu with change.
In this dialogue all settings for pattern output to plot‐
ters/ printers are carried out.
Fundamentally, the following output options are
available:
1. Printer/ Plotter with installed Windows driver
2. Printer/ Plotter without Windows driver for di‐
rect output to LPT or COM interface
3. Plot to file.
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Printer/ Plotter with installed Windows driver
These devices are marked with (Win) in output to
field. The printer setup button opens a further dia‐
logue, see Picture B‐17.

Picture B‐18

Picture B‐17

Printer/Plotter without Windows driver for direct
output to LPT or COM interface
These devices have no particular indicator in the out‐
put to field. A further dialogue opens via the Settings
button, see Picture B‐17.
For directly connected devices, the corresponding in‐
terface must be selected in this dialogue. If the re‐
quired device is not contained in the output to list,
please read the explanations in section B.6.
Plot to file
Plot to file is only possible for printer/plotter without
Windows driver. Select the prepared plotter in the
Plot file dialogue. Pressing the Settings button opens
the Plotter Setup dialogue where the option con‐
nected to must be set to ‘FILE’, see Picture B‐18. Hav‐
ing accepted these settings, the next plot with this
type of plotter will create a file. The file name choice
is unrestricted, e.g. ‘Trouser345.plt’.
Depending on the operating system, type of plotter
and connection option, the output of plot files may
vary. Some devices, in particular large format inkjet
plotters (Algotex, TkT, Brainpower, Lectra Alys) are
delivered with their own plot software which work
directly with the plot files.

If the plotter is connected directly to the computer
via LPT or COM port (parallel or serial interface), you
can also work with a COPY command. To send a plot
file to a plotter click on Start → Run.... on the win‐
dows desktop. Enter the following into the Open
field:
copy e:\test.plt com2:
e:\test.plt must be the complete path to the
plot file including its name.
com2: is the interface to which the plotter is con‐
nected.
Output to USB interfaces and plotter with direct net‐
work connection (printer port) with the COPY com‐
mand is not possible. In this case, the Grafis plot
manager, described in Appendix D can be deployed.
Controlling a plotter via ‘WINSPOOL” for plotter
connected via USB or network (printer port)
Plotter connected via USB or network (printer port)
cannot be fed directly with data via an interface. In
this case, Grafis offers the possibility to use a win‐
dows printer driver as a forwarding entity via the
‘WINSPOOL’ option. A windows driver matching the
plotter, which allows forwarding plot data
(PASSTHROUGH) must be installed. As a rule, drivers
included in the Windows delivery content or HP driv‐
ers fulfil these requirements.
If the driver does not fulfil the requirement or no
Windows driver is available for the plotter, the de‐
vices ‘Generic/ Text only’ or ‘HP/ Hewlett Packard
HPGL‐2‐Plotter’, delivered with Windows, can be in‐
stalled.
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The following step‐by‐step process must be com‐
pleted to activate plotting via ‘WINSPOOL’:
 File → Printer/Plotter Setup
 Click on Edit button
 Enter ‘WINSPOOL:’ (Picture B‐19)

Picture B‐19

 Click on Edit button again
 A window for selection of all printer drivers
available on the PC appears. Select the driver
for the plotter to be driven or the ‘Text only’ or
‘Hewlett Packard HP‐GL‐2’ plotter described
above, see Picture B‐20.

Line types/Output of line attributes
The individual options have the following signifi‐
cance:
 unchanged
All line types are available.
 output broken attribute lines as dashed lines
The plotter differentiates only between contin‐
uous and dashed lines.
 all as continuous lines
The plotter draws everything as continuous
lines.
 use line types like pen
The settings area for colours is active. The col‐
our numbers are interpreted as line type num‐
bers. In this case, the printout is single‐coloured
but with different line types. If one pen per size
is active, every size is printed with a different
line type like on a paper sewing pattern.
The available six colours are coded through colour
numbers: 1‐ black, 2 – red, 3 – yellow, 4 – green, 5 –
turquoise, 6 – blue.
Options in the dialogue Printer setup for Windows
printers

Picture B‐20

 Confirm with OK.
If the driver does not support forwarding data, an er‐
ror message appears during plotting. In this case, re‐
peat the process with the printer driver ‘Generic/
Text only’.
Pens and line types
The settings for pens/colours and line types are of
similar significance in the two dialogues.
Pens/Tools/Colours
From Version 11 onwards you can print in colour
with Windows printers.
If the device is to use one colour/tool only, e.g. one
pen or one knife, select single pen no. and enter the
number for the colour/the tool. Select several pens if
you want to use different tools. Select the corre‐
sponding number for colour/pen in the fields perim‐
eter, internal objects, texts/annotation and point
markers. Select one pen per size to output each size
with a different tool.

Useful are values between 0 and 6 for the line width.
If certain line types are no longer recognisable, re‐
duce the line weight step‐by‐step.
Windows printers offer the option to add an addi‐
tional margin around the plot image. This is particu‐
larly important when printing to PDF printer drivers.
PDF printer drivers offer the full format (A4, A3 etc.)
and it may be possible that the print image of a PDF
file does not fit fully onto the connected printer. If
the page is adjusted to the available page size, it
loses its scale. If it is not adjusted, areas along the
edge may be missing. When printing with PDF printer
drivers it is recommended to set an additional mar‐
gin of 10mm. Thus, PDF files can be output to a num‐
ber of different printer models in original scale.
Options in the dialogue Plotter setup for devices
without Windows driver
If job file is active, a job file is created during plot out‐
put. The job file is only useful when working with the
plot manager. It contains information about the plot
such as length, width, content, scale, bundle no.
Speed/Acceleration
Entering a value for speed can reduce the plot speed.
A percentage value relating to the maximum speed
is to be given. Analogous to the speed, the accelera‐
tion can also be reduced. Enter a percentage value
relating to the maximum acceleration.
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Optimisation of plot output
The individual options have the following signifi‐
cance:
 complete parts
The plotter optimises the plot path relating to
the piece. This may mean frequent tool
changes.
 least tool change
The plotter optimises the plot path with as little
tool changes as possible.
 none
No plot path optimisation, e.g. for inkjet plot‐
ter.

B.6 Plotter adjustment and printer/plotter
in a network
Grafis can support all plotters and printers with avail‐
able Windows drivers. These devices are set up in
Windows Control Panel. Further options are availa‐
ble in the File pull‐down menu under Printer/ Plotter
setup. Setup and application of these devices is de‐
scribed in section B.5.
Plotter adjustment
The adjustment of plotters without Windows drivers
ensues in Grafis with plot code files with the exten‐
sion .PLT and plotter queue files with the extension
.QUE. The files are stored in the directory
\Grafis\Plotter. For some plotters PLT and QUE files
are already prepared. Setup and application of these
devices is described in section B.1.
The following basic options can be set in the Grafis
setup on the Plotter file card for prepared plotters:
maximum paper width, plotter resolution, number
of pens or colours, zero point position, request for
each page.
For output of patterns Grafis directly supports the
following output devices:
• all Hewlett Packard plotters (e.g. DesignJet,
Draftmaster), which process HPGL
• Encad Cadjet 2, Encad T‐200 and NovaJet
• Canon iPF‐Serie (if HP/GL is supported)
• Summa plotter and cutter (e.g. S‐Class)
• Graphtec plotter and cutter
• Wild plotter and cutter TA40, TA400, TA500,
TA10
• Zünd plotter and cutter
• Mutoh plotters of iP, XP, XP‐C and AC series
• Gerber plotter AP300 and AP700 (with special
adjustment only!)
• all unlisted plotter which work directly with
HP/GL or HP/GL‐2
• DM/PL‐compatible, i.e. Ioline devices (Summit
series)

Furthermore, a range of inkjet plotter exists which
can output HPGL data via a plot software included in
the delivery:
• Algotex plotter
• Gamma Tech plotter
• Lectra Alys series
• Gerber Infinity series
The devices in the following list have already been
prepared in the Grafis installation and can be acti‐
vated in the setup on the Plotter file card:
Plotter driver Controllable plotter/printer
file
Algotex
Algotex
Projet,
ClassicJet,
Streamjet, Windjet, Wavejet,
Powerjet various widths (default
set to 180cm)
HP/GL‐2
all HP‐GL/2‐compatible plotter
and printer, e.g. HP Designjet,
Canon iPF, Encad T‐200, and
many more
Summa
Summa cutter S‐Class
S160‐TX
Graphtec
e.g. Graphtec CE 3000‐120 AP
Gerber
Gerber Infinity series and other
Infinity
Gerber plotter with plot man‐
ager
Lectra Alys
Lectra Alys series (ink jet plotter)
with plot software
TKT Brain
TkT Brainpower plotter
Wild TA500
Wild plotter TA 500
Zünd
Zünd L800
If your plotter is not contained in the above list,
please obtain the following information:
1. Is a driver for the printer available for your op‐
erating system? If yes, it should be installed as
a Windows printer.
2. Is the plotter HPGL‐compatible (can it process
HPGL‐language)? If yes, it can be addressed as
a HP‐plotter.
3. Is the plotter compatible with one of the de‐
vices mentioned above? If yes, it can possibly
be controlled with the respective control file.
Is the answer NO to all the questions, a special plot‐
ter control file is required for the device. It can only
be generated by experienced specialists. Basis for
the generation of a plotter control file is a plotter
manual which can be obtained from the supplier or
manufacturer in most cases. Generating a new plot
code file requires special knowledge about control‐
ling plotters. It is realised by the Grafis team as part
of a service agreement.
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Shared use of printers/plotters with Windows driv‐
ers
As a rule, printer and plotter with Windows drivers
can be used from various Grafis workstations within
a network without special settings. It is merely re‐
quired to enable the printer in the printer setup of
the computer to which it is connected. Other work‐
stations can also address and use the printer via this
sharing. The simplest way to connect to the network
printer is to search for the PC within the network en‐
vironment. Here, all available network printers are
listed. Select the required printer with a right‐mouse
click and select Connect… from the menu, see Pic‐
ture B‐21.

Picture B‐21

For printer or plotter directly connected to the net‐
work via a so‐called printer port, installation of the
supplied driver on all computers to use the printer or
plotter is required. Proceed as for a normal device
installation under Windows.
Shared use of printer/plotter without Windows
driver or direct output of plot data
If an older plotter is to be connected to Grafis via the
network, verify that the plotter can process HPGL
data. Only in this case can the plotter be supplied
with plot data directly from Grafis.
To enable the plotter via the network, a Windows
driver must be installed on the host PC. If no Win‐
dows driver is available for the device, use the ‘Ge‐
neric/ text only’ driver supplied with Windows (or if
still available the ‘HP/Hewlett Packard HP‐GL/2’
driver). This driver must then be connected to the in‐
terface to which the plotter is connected and ena‐
bled in the network. The name used should be the
actual name of the plotter. Please ensure that no test
page is printed during setup of the printer driver. En‐
abling ensues as described in the previous section.

The printer driver must be connected on the client
PCs also as described in the previous section. Use
‘WINSPOOL’ in Grafis as the output target, see sec‐
tion B.1. Alternatively, the plot manager may be
used, the setup is explained in Appendix D.

B.7 Settings for EPN export to Gerber
Options in Grafis.ini
Experienced users can control the export with the
following switches in the Grafis.ini, section [INTER‐
FACE]:
DATAINTERFACE=x default output format (1=Grafis,
2=EPN, 4=AAMA/DXF, 0=menu selection) 0
EPNSORT=0 Subsequent sorting of sizes after export
(1=on, 0=off)
EPNGRADGRAIN=0 Graded grain line (1=on, 0=off)
EPNCATEND=‐ End character or delimiter for cate‐
gory name (e.g. ‘‐’ or ‘_’)
EPNNOSPACES=0 Remove spaces from part name
and category (0=no, 1=yes)
EPNUSELONGNAMES=1 Permit long file names
(more than 8.3) (0=no, 1=yes)
GRAINDOWN= Automatic grain line detection; Select
grain line in direction hem/downwards (=1) or
away from hem/upwards (=0)
EPNNUMBERONLY= always reduce size designation
to numbers (if possible) (1=on, 0=off)
EPNCONVPROG=... external program file for EPN di‐
rect output (e.g. c:\grafis\hilfen\epnconv.exe)
The EPN file contains a header with three pre‐set
fields in which the information part name (1‐20), cat‐
egory (A‐40) and part description (41‐60) is ex‐
pected. These fields can be collated by the user from
the Grafis designation for collection, style, part num‐
ber and text. This is determined in the Grafis.INI file
in the [INTERFACE] area via entries in LINE51 to
LINE56. Here, it is specified from which position of
the Grafis text how many characters are transferred
to which position in the header. The following en‐
tries in the [INTERFACE] area are also relevant:
LINE51=>....<
Output for header GerberEPN: collection
LINE52=>....<
Output for header GerberEPN: style
LINE53=>....<
Output for header GerberEPN: part number
LINE54=>....<
Output for header GerberEPN: part name
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LINE55=>....<
Output for header GerberEPN: line format
LINE56=>....<
Output for header GerberEPN: base size
LINE57=>....<
Format for size name
Options in Interfac.sys
The file \GRAFIS\SYMBOLE\INTERFAC.SYS defines
the interpretation of the different Grafis symbols for
output to an interface file. It applies especially to the
output to Gerber systems.
Gerber Accumark systems have a code letter for each
object (line, symbol). The assignment of these codes
to the Grafis lines and symbols ensues in the INTER‐
FAC.SYS file. This file contains only ASCII characters
and can be edited in any editor. Symbols and line
types not assigned in this file will not be exported.
Furthermore, the file contains details about the min‐
imum distance between two grade points (this is also
the minimum distance between notches). This dis‐
tance is checked during export. A warning message
appears if the distance falls below the determined
value. The piece is still exported.

The file contains the interpretation instruction for
one Grafis symbol per line.
The first digit gives the symbol type. The following
applies:
1 = line symbol. Symbols output only in connection
with lines, e.g. notches.
2 = point symbol: These symbols can be positioned
anywhere and do not have to be connected to
a line, e.g. buttonholes or drillholes.
3 = point symbol. In general as 2, but they contain
two points for output (for special Gerber sys‐
tems)
The second digit states the number of the Grafis
symbol to be defined for interpretation.
A field with up to 10 digits follows. Here, it has to be
defined which letter or letter combination is to be
used for the symbol in the file. For line symbols
(type 1) two letters are significant, for point symbols
(type 2 and 3) only one letter is significant.
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The mode of operation for the Autonester was ex‐
plained in chapter 18.17.

Hardlock is to be connected only after the driver in‐
stallation. A system reboot may be required.

Preparation/System requirements

When using Grafis and Grafis Autonester on the
same PC, it is necessary to connect both hardlocks.
The hardlocks and their corresponding drivers are
compatible.

The Grafis Autonester functions independently from
the Grafis Marker making program. It can run on a
separate computer that has been setup for this pur‐
pose. Communication between the marker making
software and the Autonester ensues via nesting job
orders and nesting job solutions. These job orders
are saved in the Grafis Autonester directory. If the
Autonester runs on a separate computer, the Grafis
Autonester directory must be enabled in the net‐
work. If Autonester and Grafis Marker making run on
the same computer this is not necessary.
Please note that the Autonester puts demands on
the system during nesting. Since it is the processor
that is mostly affected, this may slow down the sys‐
tem if working with other software (such as Grafis)
at the same time. Also please note that the processor
generates more heat under full load than under nor‐
mal conditions. For computers which do not have op‐
timum ventilation this can lead to problems with the
stability of the whole system. Laptops in particular
are not suitable. We recommend the following mini‐
mum requirements for a computer that is to be con‐
figured especially for use with the Grafis Autonester:
 Intel Pentium i3/i5/i7 or AMD Athlon, Dual‐ or
Quad‐Core
 minimum 2 GB RAM
 The other components can be according to
mass‐market PC standards. There are no partic‐
ular requirements for graphic cards or hard disk
size.

The Grafis Autonester is entered into the Autostart
folder of the start menu during installation. This will
start the Grafis Autonester automatically and make
it available for nesting jobs after each new start of
the computer. The entry in the Autostart folder can
be deleted if this is not required.
Setup of the Marker making software
After the successful installation of the Autonester, a
link between Grafis Marker making and Grafis Auton‐
ester has to be established. All Grafis workstations

Installation
The Grafis Autonester is installed from the Grafis CD
via its own installation program. Connect the USB‐
Hardlock only after installing the Autonester. The file
can be found on the CD in the folder \Tools\Auton‐
ester and is called "Autonstr.exe". After starting the
installation program you are guided through the in‐
stallation process.
Select a target network directory that can be enabled
for other users (e.g. C:\Autonester) for the installa‐
tion. If installing Autonester on a local workstation,
install directly in the recommended directory
C:\Grafis\AUTONESTER or on the appropriate Grafis
drive.
After the Autonester installation is complete, the
hardlock driver setup required for the program
(Safenet Sentinel) starts automatically. The USB‐

Picture C‐1

must be able to save files to the Autonester direc‐
tory.
The path for the Autonester directory is now entered
in the setup of each Grafis workstation. To enter the
path start Setup (e.g. via Start → Programs → Grafis
→ Setup) and select the Marker making tab. Check
Use Autonester and enter the path for the Auton‐
ester application (GrafisAN.exe) with Search, see Pic‐
ture C‐1.
End Setup with OK. The Autonester is now set up on
this Grafis workstation.

386
Appendix C Installing and Setting up the Autonester
___________________________________________________________________________________________
©Friedrich: Grafis – Help, Edition 2017

Prepare and send Autonester orders
Finished marker as well as unplaced marker job or‐
ders can be sent to the Autonester. A job order can
be sent as soon as a marker file is open and the
marker making mode is active. A nesting job order is
created with Marker → Send to Autonester. All pat‐
tern pieces are returned to their original position (ro‐
tation and mirror) and unplaced is selected.
Grafis Marker making saves the job order file directly
into the Grafis Autonester directory. The order file
contains all the information (e.g. piece perimeters
and laying parameters) required by the Autonester
for the calculation. If the Autonester is active and set
to automatic mode, calculation of the nesting job
starts automatically after a few seconds.
The marker file can be closed during calculation. The
user can also continue working on the marker. How‐
ever, please note:
 The basic structure of the marker must not be
altered. In particular the order and amount of
sizes and pieces and the marker parameters of
the pieces.
 The marker file must be saved before closing.
This also saves the information about the sent
job order file. Otherwise, opening the com‐
pleted nesting job may no longer be possible.
Taking these two points into account, the user can
 prepare a number of markers,
 send them to Autonester and
 save them under a new names
in a short space of time. The Autonester processes
the nesting job orders successively.
Loading Autonester solutions
When the Autonester has calculated a solution or an
interim solution, a file is entered into the Autonester
directory. To load this file the respective marker
must be open and the marker making mode must be
active. Load the solution via Marker → Load Auton‐
ester file. When opening a marker file with an avail‐
able solution, a message box appears asking if the so‐
lution is to be accepted.

After accepting an Autonester solution, it is possible
that individual pieces do not appear to be placed de‐
spite the correct calculation of the marker in the
Grafis Marker making software. This is due to the dif‐
ferent ways in which Grafis Marker making and Au‐
tonester operate. Should this happen, attempt to
place the pieces in question by moving the surround‐
ing pieces slightly. If this does not work a certain op‐
eration parameter in Autonester can be changed.
This results in slightly reduced marker efficiency but
the situation mentioned above occurs less often.
Options for marker making with Autonester
Grafis Autonester supports all fabric and laying pa‐
rameters that can be entered in the Grafis Marker
making. These are:
Material/ fabric:
 fabric width
 spread type
 fabric faults
 repeat
 shrinkage values
 global buffer
Piece parameters:
 raster rotation (45/90/180°)
 free rotation angle
 fixed rotation angle
 flip allowance
 tolerance (buffer, block addition)
 symmetry switch for folded or tubular material
Use of shrinkage values that do not relate to the
grain line in a piece is not possible. Otherwise, the
shape of a piece would be altered during a rotation.
The Autonester cannot automatically take this into
account. The automatic splitting of pieces is also not
possible with the Autonester ‐ even if this option is
enabled in the marker, e.g. automatic splitting of the
crutch point from a trouser leg.
Check carefully that the correct piece parameters are
set before sending the nesting job order. The Auton‐
ester will use all possible rotation options! It is often
the case that more options are enabled for marker
making than should be permitted. During manual
marker making, the human operator can compen‐
sate for any exceptions. This procedure is not possi‐
ble when using the Autonester.
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Double placement time (2x)
The time used by Autonester for nesting is doubled
between the min‐max limits. This option is useful
when the Autonester has to calculate markers more
efficiently i.e. better fabric utilization.
Place sizes together
Individual sizes are placed in blocks within the
marker (interlocking multi‐size markers).
Send to Autonester (active piece only)

Picture C‐2

To change the enabled Autonester marker options,
use the dialogue window Marker → Autonester op‐
tions, see Picture C‐2.
In this dialogue window the following can be disa‐
bled:
 use of raster rotation (45/90/180°),
 use of free rotation (rotation tolerance) and
 use of flip allowance.
Omit pieces not required
This option is valid only for pieces where the param‐
eter Piece can remain unplaced has been checked on
the file card Pieces. This Autonester option defines if
a piece should or should not be placed.
Do not return pieces to original position before out‐
put
If the first three options have been enabled and the
pieces in the marker have not been rotated or
flipped, you do not have to select return and switch
to unplaced when sending nesting orders.
Position placed pieces without transformation
This option allows you to define certain rotation or
flip transformations for single pieces. The Auton‐
ester will not rotate or flip/mirror any pieces that
have already been placed even if this has been ena‐
bled in the piece parameters.
Non‐flipped pieces on the top ply (closed spread)/
Position unmirrored pieces in lower material half
(folded lay)
When laying on tubular fabrics or folded face‐to‐face
spreads, it is possible that all non‐flipped pieces are
to be cut from the top ply (lower half of the ply on
the screen). The Autonester, however, places the
flipped pieces for best efficiency. Therefore it can be
expedient to lay all non‐flipped pieces (those occur‐
ring only once in the spread) on the top ply i.e lower
half of the ply on the screen.

Only active pieces (placed pieces or pieces on the lay‐
ing field) will be sent to the Autonester when this op‐
tion is enabled. Pieces still in reserve will be ignored.
This option is useful when only certain groups of
pieces are to be automatically placed.
Opening an Autonester file …
If the link between a marker and an Autonester job
order has been lost (e.g. a marker was not saved af‐
ter the order was sent to the Autonester), this option
can be used to import the corresponding Autonester
file. It is important that the Autonester file matches
the current marker. If not the pieces will be jumbled
or not placed.
These options, when set, are saved and apply per‐
manently.
Autonester user interface
Mode
The Autonester operates automatically if the switch
Automatic mode is set. In automatic mode the job
order list is compiled automatically. Incoming Auton‐
ester jobs are registered every 10 seconds. The order
of the job entries can be altered. As soon as an entry
appears in the jobs list, calculation of the marker be‐
gins. Once a job order calculation is finished, calcula‐
tion of the next job order begins automatically.
Calculation time
The quality of a nesting solution at constant place‐
ment time is dependent on the amount of pieces to
be placed. More calculation time should be allowed
for markers with a large number of pieces than for
simple markers. The given placement time is calcu‐
lated on the basis of the number of pieces and a time
factor per pattern piece. The resulting amount is lim‐
ited by a minimum and a maximum value. In the
above screenshot, placement time is set to 3 seconds
per piece with a minimum of 1 minute and a maxi‐
mum of 10 minutes placement time. The most ap‐
propriate time values depend on computer proces‐
sor speed and the requirements of the marker mak‐
ing department (quick response, high efficiency etc).
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Status
As soon as a nesting job order is
being processed, the name and
current status of the job order
can be found in a window in the
top left corner. The progress bar
displays the selected calculation
time, the time elapsed, the num‐
ber of interim solutions and the
current length. If the option
without preview is not selected
an additional preview window
displaying the current status of
the calculation appears. Calcula‐
tion of the current job order can
be stopped by closing the pre‐
view window or with Cancel if re‐
quired. Comments or error mes‐
sages for the current order ap‐
pear in the Record window. The
entries in this list can be clicked
individually. They appear in full
in a separate dialogue box.
Options
Generating monitoring files
Standardised monitoring files for the nesting job or‐
ders are generated. These files are important for er‐
ror diagnostics. Activate this option only if you have
been requested to do so ‐ e.g. by the Grafis Hotline.
Work without preview window
The preview of the nesting solution in progress is not
displayed. Select this option if the graphic display of
the nesting solution is not required or not desired.
Marker window always on top
This option displays the marker preview window al‐
ways on top of all other windows. This enables the
user to simultaneously work with the Grafis Marker
making program and follow the progress in the pre‐
view window. This option is only useful if Autonester
and Grafis Marker making run on the same system.
Save result as a Bitmap file
If this option is activated and the preview window is
open, a Bitmap file of the nesting job result can be
generated. The Bitmap file will be saved under the
same name as the nesting job in the Autonester
folder.

Picture C‐3

Placing pieces without transformation options
This option disables any allowance for rotation and
flipping of the pieces to be placed. All pattern pieces
will be placed in their original orientation.
Retaining backup copy files of nesting job orders
When an Autonester nesting job order (*.ANA) has
been fulfilled, the job order is deleted. When this op‐
tion is active, backup copy files (*.ANB) can be gen‐
erated. These are saved in the Autonester folder.
This option is useful not only for error diagnostics but
also for statistical evaluation of Autonester utiliza‐
tion.
Delete all job results older than…
All Autonester job results (*.ANL) are saved in the
Autonester folder even if they have been transferred
to Grafis Marker making. Thus it is always possible,
at a later date, to reset the marker file to that of the
Autonester status. To avoid an overflowing Auton‐
ester folder, this option can be activated to delete
older no longer needed Autonester job results
(*.ANL). The time span is given in 1 monthly inter‐
vals. All corresponding files such as bitmaps (*.BMP)
and backup files (*.ANB) are also deleted.
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Options in the Grafis.ini for the Autonester applica‐
tion
A series of entries for the Autonester are found in the
text block [MARKER] in GRAFIS.INI. All entries begin
with AUTONESTER, see section B.5.
The entries AUTONESTERPATH and AUTONESTERKEY
can be regulated in the setup program. AUTON‐
ESTERPATH specifies the Autonester directory where
nesting job orders and nesting job results are saved.
If the Autonester is to be displayed in the marker
menu, AUTONESTERKEY must not be set to "0".
In addition, there are the options AUTONESTER_SOL
and AUTONESTER_INCFOLDERNAME. After import‐
ing an Autonester nesting solution, AUTON‐
ESTER_SOL shakes the marker so that all pieces are
shifted to the left i.e. as close to the beginning of the
marker as possible. AUTONESTER_INCFOLDERNAME
is to include the directory in the file name. This
avoids ambiguity when assigning file names to Au‐
tonester nesting job orders. The number specifies
how many directory levels are to be included in the
file name ‐ 1 to 3 levels are recommended. The op‐
tions AUTONESTERTIME and AUTONESTEREXEC are
not in use at this time
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The plot manager is a stand‐alone windows program.
It can be used independently from any GRAFIS instal‐
lation. This program runs on operating systems Win‐
dows XP/7/8 or 10. It can also be used on older PCs.

If the plotter is connected to a serial interface
COMx:, the following parameters must also be se‐
lected: baudrate, parity and protocol. These are
found in Use mode command.

Installing the plot manager

If the plotter is connected via USB or a network, se‐
lect Send via Windows Printer Driver and activate
Show plot command.

The installation is started using the program PLOT‐
MGR!.EXE. This file is found either on the Grafis CD
or on the local Grafis workstation in the folder
\GRAFIS\HILFEN. Double clicking the *.EXE file will
start the installation.
The plot manager requires an independent directory
on the plotter server – e.g. C:\PLOTTER. The plot
server is the computer to which the plotter is con‐
nected. If the plot server is to be controlled via a net‐
work, the directory must be enabled or it should be
a directory on the net drive. A target directory is re‐
quested at the beginning of the installation.
After the installation is complete, the plot manager
setup will start, see Picture D‐1.
Setup the options in the following categories Plot
command, Plot.bat ‐ Configuration and Options ac‐
cording to the existing system.

The scroll bar Calculate plot time specifies the crite‐
ria which the plot manager uses to calculate the es‐
timated plotting time.
The remaining settings should be left unaltered.
All settings and options are saved in the PLOT‐
MGR.INI file in the current folder. An explanation of
each option in this file is to be found at the end of
this text.
The installation program adds an icon to the Auto
start folder so that the plot manager starts automat‐
ically after user login.
The following files are required for setup and use of
the program if the plot manager should not or can‐
not be installed with the installation tool: PLOT‐
MGR.EXE (plot manager program), PLOTCTL.EXE (re‐
mote control program), SETUPMGR.EXE (plot man‐
ager setup program). These files
are copied to a folder for future
use as the enabled target folder
for plot files in the network. The
PLOTMGR.EXE program file
should be linked in the Auto start
folder for automatic start up.
Then, run SETUPMGR.EXE to
complete PLOT.BAT setup and
software configuration.

Picture D‐1
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Plot process with low priority
If the computer is used for other
applications as well, it is useful to
run the plot process with low sys‐
tem load. For this purposed acti‐
vate this option. An intermediate
state of this switch is available
which is reserved for special ap‐
plications.
Cancel plot
The current plot job is aborted.
Plot picture
Sends the selected plot file to the
plotter.
Insert pause
A pause command is inserted in
the list before the selected plot
job. The plot manager de‐acti‐
vates automatically and waits for
user input.
Move up
Moves the selected plot job up
one position.
Picture D‐2

Plot manager options
The plot manager user interface is illustrated in Pic‐
ture D‐2. The options are as follows

Move to 1st position

Moves the selected plot job to
the first position. It will be executed as the next job.
Move down

Plotting active

Moves the selected plot job down one position.

The plot manager is set to stand‐by mode. The cur‐
rent directory is scanned every 10 seconds for new
plot jobs. If new plot jobs arrive they will be pro‐
cessed automatically.

Delete picture

Hide output window

Now plotting
This plot is in process.

All plot job commands are issued in a DOS window.
At the beginning, it is possible to make this DOS win‐
dow visible for control purposes by de‐activating this
option. An intermediate setting for this switch is
available which always shows the DOS window with‐
out reduction. Thus, the plot process runs with total
system load. This option is required if the data does
not arrived sufficiently fast at the plotter (only for
very slow PCs).
Plot path analysis in LOG file
For control purposes, the plot manager runs an au‐
tomatic log file (PLOTMGR.LOG). This file captures
every plot job processed with name, date, time and
plot duration. Set this option if further information
(total line length, pen up length, number of pen se‐
lect commands, etc.) is required. This additional in‐
formation can also be found in PLOTMGR.LOG

Deletes the selected plot job.
Further displayed information:

Length
Length of the plot in meters.
Estimated time
Estimated data transfer time ‐ this is the time that
the plot manager needs to transfer the data. It is not
the actual plotting time. These two values are only
the same when the plotter has a small memory i.e. is
not able to store the plot file. If the plot manager is
in non‐stop use, the estimated data transfer time is
very close to the plotting time.
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The following information is always given for the plot
selected on the left of the list.
Creation
Date and time of the plot job creation
Created by (*)
The user name of the plot jobs creator.
Length (*)
Plot length in meters
Time
Estimated output time
Source (*)
Source file from which the plot was issued
Scale (*)
Scale of the plot (e.g. 1:1 for original size or 1:5 for
minis)
1st bundle (*)
If a marker is being plotted, the number of the first
bundle in the marker is shown here.
Contents (*)
If a chain of markers is being plotted, the list of the
markers is shown here.
(*)
This readout appears only when the Grafis
Layplan program generates the job file. These dis‐
plays are empty if the Grafis Patternmaking program
has generated the job files.
At the bottom of the list there are two additional
readout displays. These are for the total plot length
and the total plot time of the complete list of job
files.
Starting the plot manager
To create plot jobs in the Grafis Patternmaking and
Marker making programs, the plot manager does not
need to be active. Only the plot manager directory
must be available. If this directory is located on a sep‐
arate PC, it must be running. The plot manager has
to be started when plot jobs are to be plotted. The
close button (upper right corner) minimizes the plot
manager to prevent a shut down during plotting. To
shut down the plot manager use the Close button in
lower right corner. This button is only available when
no current job is being processed.
If the plot manager should always be on standby,
create a shortcut to the plot manager program in the
auto start folder. The installation sets this up auto‐
matically.

Configuring the plot manager in Grafis
In the Grafis plot window, click on the Settings but‐
ton to the right of the selected plotter. Click Edit in
the new window and enter the target drive and di‐
rectory in the display connected to. End the entry
with ‘\’ e.g. ‘P:\ ’ or ‘C:\PLOTTER\’ if the plotter is
connected to the PC. If the option job file has been
selected, job files are generated for the plot job. This
displays more detailed information about the plot
job in the plot manager. Click Edit again and close
this box with OK. All plots generated with this plotter
setting will be sent to the selected target directory.
File names are generated automatically. As each
plotter will have own plotter settings you can work
with any number of plot managers and therefore any
number of plotters. Alternatively, a single plotter
with various settings (different tools, velocity, paper
width etc.) can also be used.
Access to the plot manager in a network
A network plot server PC is recommended in compa‐
nies with a large number of plots per hour. This can
be a simple PC (minimum 133 MHz) with Windows
operating system. More than one plotter can be con‐
nected to this PC depending on the number of serial
and parallel ports available. Each plotter must have
its own directory for its own plot manager. This di‐
rectory can also be located on the network if the
server is running around the clock. The advantage
here is that plots can be generated even if the plot
server PC is switched off. The PC can then be
switched on when plotting should start. A remote
check of the plot manager can be achieved using
PLOTCTL.EXE. This program allows users to check the
status (with a slight time delay) of the plot manager
from any where on the network. PLOTCTL.EXE must
be located in the same directory as PLOTMGR.EXE.
Please note: the plot manager may only be started
once. It may only be started on the plot server. The
remote check program, on the other hand, can be
started as often as required.
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Activating the plotting process using ‘WINSPOOL’
for USB plotters or through network (Printerport)
Plotters connected via USB or network (Printerport)
do not have the ability for a direct data transfer in‐
terface. In this case, Grafis offers the possibility of us‐
ing the option ‘WINSPOOL:’ to relay the plot files
through a Windows printer driver. A Windows
printer driver for the selected plotter must be in‐
stalled which supports the PASSTHROUGH of the plot
files. Generally the standard plotter drivers from
Windows or driver from HP fulfil this requirement.
If the driver does not fulfill this requirement or there
is no driver for the selected plotter, install the Win‐
dows device ‘Generic/Text only’ or ‘HP/Hewlett
Packard HPGL‐2‐Plotter’, see Picture D‐3.
To start the plotting process using ‘WINSPOOL:’ com‐
plete the following sequence:
 Start the plot manager
 Click the button right of the command line.
 Enter ‘WINSPOOL:’.
 Click the button right of the command line to
save entry.
 A popup window with all available printer drivers
appears. Choose the driver for the selected plot‐
ter or alternatively ‘Text only’ or ‘Hewlett Pack‐
ard HP‐GL‐2 Plotter’.
 Confirm with OK.

NAME
Contains the name of the plotter. This name will be
shown in the title bar of the plot manager and can
be used to differentiate between several plotters.
PLOTBYTES
The plot manager stores the number of plot bytes
processed.
PLOTSECONDS
The plot manager stores the time in seconds of the
plots processed. The two values PLOTBYTES and
PLOTSECONDS are used to calculate the estimated
plot time.
PLOTMMETER
The plot manager stores the length in millimetres
that have been plotted. The two values PLOTMME‐
TER and PLOTSECONDS are used to calculate the
estimated plot time.
TIMECALCBYTES
Contains the weighting value for the calculation of
the estimated plot time. The value range from 0 to
100. 100 calculates the time based on file size only
(PLOTBYTES). 0 calculates the time based on plot
length only (PLOTMMETER; advantageous for ink
jet plotters). A value in between are a mixture of
the two.

If the driver does not support
PASSTHROUGH, an error message
appears. In this case, repeat the
above sequence using the printer
driver ‘Generic/Text only’
The PLOTMGR.INI options in de‐
tail
Under certain circumstances, fur‐
ther options of the plot manager
in PLOTMGR.INI can be adapted
for the plotter or the local situa‐
tion. Here is a short explanation of
options that cannot be changed
via the plot manager window.
COMMAND
Contains the plot command that
will be executed with each plot
job.

Picture D‐3
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PLOTTIMER
Contains the time interval in seconds for checking
the plot directory for new jobs. It is also the maxi‐
mum pause time between job.
RETRYTIMER
Contains the time interval in seconds for the start
of a retry after an error message.
CHECKTIMER
Contains the time interval in seconds for checking
the status of the current job.
SHOWCMD
When this is set to ‘1’, the plot command line will
be shown in the plot manager window. Then it can
be changed from the user interface.
MINSECONDS
Contains the minimum amount of time that plot
job needs. This command can be used to detect er‐
rors.
RETRYENDLESS
Raise the retry output to endless. Normally the plot
manager stops after three attempts.
Configuration example: Encad Cadjet 2 is connected
to a Grafis PC and additional Grafis workstation PCs
in the network
The Encad Cadjet 2 is connected to the PC via a par‐
allel port. If an additional printer is needed, the PC
requires a second parallel port (LPT2:). The following
configuration is recommended:
Create the folder C:\CADJET for the plot manager in
the directory C:\ . The folder ‘Cadjet’ is a shared
folder and has read/write access that can be secured
using a password. Copy the file PLOTMGR.EXE to this
folder. The PLOTMGR.INI contains following com‐
mand line:
COMMAND=c:\command.com
/c copy %d lpt2:
In the GRAFIS.INI at this PC add the entry MAN‐
AGER=C:\CADJET under the heading [PRINTER]. In
the Grafis Layplan program under plotter setup, en‐
ter ‘C:\CADJET\’ in the display field connected to.
Now configure the additional Grafis workstation PCs.
Search for the ‘Cadjet’ folder and connect to drive P:
using a right mouse click. Do not forget the option
‘restore connection’. Enter ‘P:\’ in the display field
connected to of plotter setup in Grafis at these addi‐
tional workstation PCs.

The estimated plot time averages a few seconds be‐
cause the plotter has enough memory to store mul‐
tiple plot files. It goes with the real plot time only if
the plotter is under continuous operation.
Configuration example: Algotex plotter connected
to a separate PC and additional Grafis workstation
PCs in the network
Algotex plotters are supplied with a configured PC or
are connected to an available PC (WaveJet and
WindJet series). The plotter driven by a self‐con‐
tained plotter control program that runs on Win‐
dows. This program is monitoring a folder for incom‐
ing HPGL plot files, e.g. c:\algotex\hpgl. This folder is
entered in the setup of the plotter control program.
Create a directory C:\PLOTTER on the plotter PC. En‐
able this folder as shared folder ‘Plotter’ in the net‐
work. The additional Grafis workstation PCs have ac‐
cess to this folder as described above. Drive P: is con‐
nected. Copy the following files to C:\PLOTTER on
the plotter PC: PLOTMGR.EXE, PLOTCTL.EXE, the ad‐
ditional help program FILEEXST.EXE (to be found un‐
der C:\GRAFIS\HILFEN) and a PLOT.BAT. The
PLOT.BAT contains the following:
@echo off
copy ‘%1’ c:\algotex\hpgl\plot.hpg
fileexst.exe
c:\algotex\hpgl\plot.hpg
The program FILEEXST.EXE stops the execution of
PLOT.BAT as long as the specified file exists. The Al‐
gotex plot program deletes the file as soon as the
plot is finished.
Add the following command to PLOTMGR.INI:
COMMAND=plot.bat %d
Set the value TIMECALCBYTES=0. The estimated plot‐
ting time will be calculated based on the plot length
in millimetres. This value is comparatively accurate.
Configure the additional Grafis workstation PCs as
above. Additionally an icon to the program
P:\PLOTCTL.EXE should be added to each desktop so
that the workstation user has access to the plot
queue to view and change the queue.
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Configuration example: Gerber AP320 plotter con‐
nected to a separate plotter PC, additional Grafis
workstation PCs in the network and a file server
with plot files on drive H:
Create the folder H:\AP320 on drive H:. Copy the files
PLOTMGR.EXE, PLOTCTL.EXE and APCHECK.EXE (to
be found under C:\GRAFIS\HILFEN) to this folder. In‐
stall the Gerber plot program PLOTGBER to folder
C:\GERBTEST on drive C:. Additionally copy the file
GBSHIFT.EXE to C:\GERBTEST.
Add the following entries to the file PLOTMGR.INI:
COMMAND=plot.bat %d
TIMECALCBYTES=100
RETRYENDLESS=1
The PLOT.BAT contains the following:
@echo off
copy ‘%1’ c:\gerbtest\plot.0$$
c:
cd \gerbtest
copy gbshift.ini gbshift.ret
gbshift.exe plot.0$$
plotgber.exe plot.0$$ 2
h:
cd \ap320
apcheck.exe
if exist error.log copy
c:\gerbtest\gbshift.ret
c:\gerbtest\gbshift.ini
del c:\gerbtest\plot.0$$
Set the value TIMECALCBYTES=100. The estimated
plotting time will be calculated based on the size of
the plot file. This value is comparatively accurate. Ad‐
ditionally, a special plot driver file (ap320.plt) is re‐
quired for the Grafis workstations. It contains the ex‐
actly determined feed length. This file can be re‐
quested from the Grafis Hotline or the Grafis dealer.
Configure the additional Grafis workstation PCs as
above. The target directory should be ‘H:\AP320\’,
where H: is connected automatically on login.

Configuration example: HP Designjet 510 using the
HPGL‐2 option connected to a network
The HP plotter is assigned an IP number automati‐
cally during installation. This is used by the PC printer
driver to access the plotter. Install the driver in‐
cluded with the HP plotter. Send a test plot to plotter
via the Windows driver.
Install the plot manager as described above. Select
the option Show plot command during the setup (in
the SETUPMGR program). After starting the plot
manager activate the plot command prompt by click‐
ing the adjacent button. Enter ‘WINSPOOL:’. Save
the entry by clicking the adjacent button again. A
popup window with all available printer drivers ap‐
pears. Choose the previously installed HP driver (HP
Designjet) and confirm with OK.
If the HP driver does not support PASSTHROUGH, ad‐
ditionally install the standard Windows driver ‘Ge‐
neric/Text only’ to the same network interface as the
HP driver. Choose this from the popup window in‐
stead of the HP driver and confirm with OK.

